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Manual Information

Revision History Each page of the document has the document part number followed by 
a revision letter at the bottom of the page. This letter identifies the 
document’s update level. The revision history of this document is 
summarized in the table below.

Manual Purpose This manual supplies technical information for service representatives 
and technical personnel so they can maintain the equipment to the 
assembly level. Use it as a guide for maintenance and electrical repairs 
considered field repairable. Where necessary the manual identifies 
additional sources of relevant information and or technical assistance. 

See the operator manual for the instructions necessary to operate the 
equipment safely in accordance with its function and intended use. 

Chapter Content This manual is organized into chapters and appendices:

1 Introduction Describes the service manual and chapter contents. Provides general 
information on safety, service requirements, equipment symbols, and 
serial number identification.

2 Equipment Overview Describes the equipment and its characteristics, connector locations, 
and preparation for use.

3 Installation Describes how MUSE CV system installation procedures.

4 Assembly Procedures This chapter contains the current assembly procedures used to build 
MUSE CV system components when manufactured by GE Marquette.

Table 1-1. Revision History

Revision Date Comment

A 16 March 1998 Initial release of manual.

B 3 August 1998 Added network backup information to IMS 
chapter. Added RAID information.

C 10 November 1998 Updated parts lists and UPS maintenance 
information. Deleted vendor manuals.

D 20 February 1999 Updated parts lists.

E 16 March 1999 Extended manual to version 005B software.

F 7 October 1999 Revised to reflect new Intel file server, new 
client hard drive, new laser printer, new 15-
inch monitor, new client CD drive.
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5 Integrated Maintenance Suite Describes how use the Integrated Maintenance Suite (IMS) to back and 
archive data on the MUSE CV system. Also describes how to use IMS for 
disaster recovery.

6 Troubleshooting Provides overall and specific troubleshooting help.

7 Maintenance Contains a preventive maintenance schedule, instructions for opening 
the unit, and cleaning guidelines. 

8 MUSE Network Writer Module Contains theory, description of controls and indicators, assembly and 
disassembly instructions, and maintenance and troubleshooting 
procedures for the MUSE Network Writer.

9 Parts Lists Contains parts lists for reference in repairing the unit at the assembly 
level.

Appendices A list of abbreviations is provided in Appendix A. Technical 
Specifications are found in Appendix B. 

Manual Conventions The following is a list of conventions used throughout the manual.

n Items shown in Bold text are keys on the keyboard, text to be 
entered, or hardware items such as buttons or switches on the 
equipment.

n To perform an operation which appears with a plus (+) sign 
between the names of two keys, you press and hold the first key 
while pressing the second key once. This is called a keystroke 
combination.

For example, “Press Ctrl + Esc” means to press and hold down 
the Ctrl key while pressing the Esc key. 

n When instructions are given for typing a precise text string with 
one or more spaces, the point where the spacebar must be 
pressed is indicated as:  <Space>. The purpose of the < > 
brackets is to ensure you press the spacebar when required.

n Enter means to press the “Enter” or “Return” key on the 
keyboard. Do not type “enter”.

n Italicized items are software terms which identify menu items, 
buttons, or options in various windows.
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Related Manuals See these documents if you need additional information.

Table 1-2. MUSE CV system Related Documents

Part Number Name

419931-001 MUSE CV information system Operator’s Manual (version 005A)

421619-001 MUSE CV information system Operator’s Manual (version 005B)

Laser Printer
Hewlett-Packard Company
11311 Chinden Boulevard
Boise, Idaho 83714 U.S.A.

C4118-91060 HP LaserJet 4000, 4000T, 4000N, and 4000TN Printers User’s Guide

C4118-90972 HP LaserJet 4000 and 4000N Printers Getting Started Guide

5966-5171 HP JetDirect Printer Server Software Installation Guide

UPS (Intel File Server)
POWERVAR

05141270 Uninterruptible Power Supply 400VA-2200VA

Modem
Multi-Tech Systems, Inc.

2205 Woodale Drive
Mounds View, MN 55112 U.S.A.

82027804 Quick Reference Guide ZDX MultiModem 

DAT Tape Drive
Hewlett-Packard Company
11311 Chinden Boulevard
Boise, Idaho 83714 U.S.A

C1533-90901 HP C1533A DDS-2 Tape Drive User’s Manual

C1533-90903 Connecting HP DDS Tape Drives in PC Environments

409623-001 Storage Device Cleaning Information

Printer

OKIDATA
532 Fellowship Road

Mount Laurel, New Jersey
08054

59230803 Microline 320/321 Setup Guide

59230903 Microline 320/321 Epson/IBM Compatible Reference Guide

Graphic’s Card

ATI Technologies Inc.

10701F2320 User’s Guide mach 64
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SCSI Host Adapter Card
Adaptec, Inc.

691 South Milpitas Blvd.
Milpitas, CA 95035

510888-00 User’s Guide — AHA-2940 Ultra/2940 Ultra Wide PCI-to-Ultra SCSI Host Adapter with 
SCSI Select

510889-00 Installation Guide — AHA-2940 Ultra/2940 Ultra Wide PCI-to-Ultra SCSI Host Adapter 
with SCSI Select

Networking
Thomas-Conrad Corporation

12301 Technology Blvd.
Austin, Texas 78727

615-10006-002 TC4145 16/4 Token Ring Adapter Plug and Play ISA Installation Guide

615-4050-004 TC4050 Token Ring MAU Installation Guide

Ethernet Adapter Circuit Board 
(Used in networked file servers, 

acquisition server/processing 
stations, and workstation 

computers)

Western Digital Corporation
2445 McCabe Way
Irvine, CA 92714
(800) 847-6181
(714) 863-0102
TLX 910-595-1139

EtherCard Plus Ethernet Station Adapter User Installation Guide

Standard Microsystems 
Corporation
(800) SMC-4-YOU in USA
(800) 833-4-SMC in Canada
(516) 273-3100 elsewhere

EtherCardPLUS Elite 16 Series manual

SCSI Host Adapter (Used in file 
servers, acquisition server/

processing stations, and 
workstation computers)

Future Domain Corporation
2801 McGaw Avenue
Irvine, CA 92714
(714) 253-0400   
FAX (714) 253-0913

Future Domain TMC-1660/TMC1680 User’s Guide

Adaptec
691 South Milpitas Blvd.
Milpitas, CA 95035
(408)945-8600

Adaptec AHA-1540B/1542B User’s Manual

Table 1-2. MUSE CV system Related Documents (Continued)

Part Number Name
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Hercules Graphics Interface

Hercules Computer Technology, 
Inc.
912 Parker Street
Berkeley, CA 94710
TELEX 754063 HERCULES UD

Hercules Graphics Station Card Owner’s Manual

Digital Audio Tape (DAT) Drive

Archive Corporation
1650 Sunflower Avenue
Costa Mesa, CA 92626
(714) 641-1230
FAX: (714) 641-2590

Quick Installation Guide for Pythion DAT Tape Drives

Python DDS-DC Data Compression DAT Tape Drives Product Description Manual (for 
models 4322, 4542, and 4352)

Archive Information Manager User’s Manual (DOS Version)

Bar Code Reader

Hewlett Packard Co.

HP KeyWand Bar Code Reader Technical Reference Manual (Part Number HBCK-1915)

HP KeyWand Bar Code Reader Installation and Operation Guide (Part Number HBCK-
1910)

Table 1-2. MUSE CV system Related Documents (Continued)

Part Number Name
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Safety Information

Responsibility of the
Manufacturer

GE Marquette Medical Systems is responsible for the effects of safety, 
reliability, and performance only if:

n Assembly operations, extensions, readjustments, modifications, 
or repairs are carried out by persons authorized by GE 
Marquette.

n The electrical installation of the relevant room complies with 
the requirements of the appropriate regulations.

n The equipment is used in accordance with the instructions for 
use.

General This device is intended for use under the direct supervision of a licensed 
health care practitioner.

The device stores ECGs generated by a computerized analysis program 
which can be used as a tool in ECG tracing interpretation. This 
computerized interpretation is only significant when used in 
conjunction with clinical findings. All computer-generated tracings 
should be overrread by a qualified physician.

To ensure patient safety, use only parts and accessories manufactured 
or recommended by GE Marquette Medical Systems.

Contact GE Marquette Medical Systems for information before 
connecting any devices to this equipment that are not recommended in 
this manual.

If the installation of this equipment, in the USA, will use 240 V rather 
than 120 V, the source must be a center-tapped, 240 V, single-phase 
circuit.

Parts and accessories used must meet the requirements of the 
applicable IEC 601 series safety standards, and/or the system 
configuration must meet the requirements of the IEC 601-1-1 medical 
electrical systems standard.

The use of ACCESSORY equipment not complying with the equivalent 
safety requirements of this equipment may lead to a reduced level of 
safety of the resulting system. Consideration relating to the choice shall 
include:

n use of the accessory in the PATIENT VICINITY; and

n evidence that the safety certification of the ACCESSORY has 
been performed in accordance to the appropriate IEC 601-1 
and/or IEC 601-1-1 harmonized national standard.
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Equipment Symbols See the OEM manual(s) for the following devices for an explanation of 
the symbols appearing on the equipment.

n HP LaserJet Printer 4000N

n Sony Monitors (15, 17, and 20”)

n Intel System Boxes

u File Server

u Client workstation

n POWERVAR Uninterruptible Power Supply (UPS)

n MAU Token Ring Thomas Conrad

n RSS and CSI Multitech Modems 

n HP C1533A DDS-2 Tape Drive (DAT Drive)

n OKIDATA Dot Matrix Printer

Symbols not found in the OEM manuals are explained below.

This symbol means that you must pay attention to the documents delivered with this 
equipment. It calls attention to the things to which you must pay special attention 
during operation and when the equipment is operated in conjunction with other 
equipment.

In Europe, this symbol means dangerous or high voltage. In the United States, this 
symbol represents the caution notice below:

Intel File server

Power on/off light. Turns on when the system power is on.

Hard disk light. Turns on when the system reads or writes to the hard disk.

CAUTION
To reduce the risk of 
electric shock, do NOT 
remove cover (or back).
Refer servicing to 
qualified personnel.

M15287-16B
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Power control button.

Compaq File Server

Any surface or area of the equipment marked with these symbols indicates the 
presence of a hot surface or hot component. If this surface is contacted, the 
potential for injury exists. To reduce risk of injury from a hot component, allow the 
surface to cool before touching.

Any surface or area of the equipment marked with these symbols indicates the 
presence of electrical shock hazards. The enclosed area contains no operator 
serviceable parts. To reduce risk of injury from electrical shock hazards, do not open 
this enclosure.

Any RJ-45 receptacle marked with these symbols indicates a Network Interface 
Connection. To reduce risk of electrical shock, fire, or damage to the equipment, do 
not plug telephone or telecommunications connectors into this receptacle.

This label or equivalent is located on the surface of your CD-ROM drive. This label 
indicates that the product is classified as a CLASS 1 LASER PRODUCT.

UPS (Compaq File Server)

This symbol indicates you should not discard the UPS or the batteries in the trash. 
The UPS may contain sealed, lead-acid batteries. Batteries must be recycled.

CD-ROM Drive

CD headphone jack.

Adjustment control dial.

CD eject button.

Pb
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The bar code on the MAC 8 acquisition assembly which allows you to acquire 
records from a diskette.

MUSE Network Writer

Power switch. Press I to turn power ON. Press O to turn power OFF.

Attention — Read manual. The amber writer fault LED under this symbol means that 
the writer door is open or a paper jam has occurred.

Paper out. This amber LED is lit when the MUSE Network Writer is out of paper.

Power on/ECG printing. This green LED is on solid when power is applied to the 
MUSE Network Writer. It flashes when the writer is printing.

Fuse.

READ
DISKETTE

WARNING

Replace only with the 
same type and rating 
of fuse.

M15287-2B
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Alternating current (AC).

High Voltage. Only qualified service personnel should remove cover.

M13495, MD1280-26, MD1280-28, MD1280-29, M13546, MD1280-17, M14819

MD1280-18, M15295-154A, M15295-120A, MD1011-166, M15295-152A, M13571, M13504A

WARNING

High voltages exist in 
unit. Use insulated 
tools. Remove jewelry. 
Use only one hand 
when possible.

M15287-19B
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Warnings and Cautions

DANGER
Do NOT use in the 
presence of flammable 
anesthetics.

M15287-1B

CAUTION
This equipment contains no user 
serviceable parts. Refer servicing to 
qualified service personnel.

M15287-38A

CAUTION

M15287-16B

To reduce the risk of 
electric shock, do NOT 
remove cover (or back). 
Refer servicing to 
qualified personnel.

WARNING

This is Class I 
equipment. The mains 
plug must be connected 
to an appropriate power 
supply.

M15287-5C

WARNING

Replace only with the
same type and rating 
of fuse.

M15287-2B

WARNING

Disconnect patient 
from unit BEFORE
connecting personal 
computer to unit.

M15287-12C

WARNING

Turn off power and 
disconnect power cord 
from AC power source 
before removing the 
cover.

M15287-23C

CAUTION
U.S. Federal law restricts this device to 
sale by or on the order of a physician.

M15287-17B
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Service Information

Service Requirements Refer equipment servicing to GE Marquette Medical Systems’ 
authorized service personnel only. Any unauthorized attempt to repair 
equipment under warranty voids that warranty.

It is the user’s responsibility to report the need for service to GE 
Marquette Medical Systems or to one of their authorized agents. 

Failure on the part of the responsible individual, hospital, or institution 
using this equipment to implement a satisfactory maintenance schedule 
may cause undue equipment failure and possible health hazards.

Regular maintenance, irrespective of usage, is essential to ensure that 
the MUSE CV information system will always be functional when 
required
Revision F1-14 MUSE CV information system
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Equipment Identification Every GE Marquette Medical Systems device has a unique serial number 
for identification. The serial number appears on the product label on 
the base of each unit.

Table 1-3. Equipment Identifications

Item Name Description

A name of device MUSE CV information system

B manufacturer Marquette Medical Systems, Inc. 

C serial number Unique identifier

D device characteristics One or two letters that further describe the unit, for example: P = prototype not 
conforming to marketing specification; R = refurbished equipment; S = special 
product documented under Specials part numbers; U = upgraded unit

E division F = Cardiology G = Monitoring J = Cath Lab

F product sequence number Manufacturing number (of total units manufactured)

G product code Two-character product descriptor 
AA = MUSE Tower File Server
AB = MUSE Desktop File Server
AC = MUSE Communication Server
AG = MUSE File Server
AF = MUSE Client SDLC
AH = MUSE Client
SC = MUSE Modem Acquisition Station
SE = MUSE 5000 system
SF = MUSE 1000 system
SH = MUSE 5000 Acquisition Server
SK = MUSE Network Station
SR = MUSE Telephone Retrieval Station
ST = MUSE Network Writer
SU = S-5000 File Server (Additional)
SV = Remote Work Station
S8 = MUSE 3000 System
TE = MUSE Gateway Station

H year manufactured 7 = 1997, 8 = 1998, (and so on)

I month manufactured A = January, B = February, C = March, D = April, E = May, F = June, G = July, 
H = August, J = September, K = October, L = November, M = December

MD1113-022B
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FCC Requirements

Modem Requirements The modem in your GE Marquette device is designed to comply with 
FCC part 68, U.S. Telecommunication Requirements. See the 
equipment label on the GE Marquette device for the FCC registration 
number and the ringer equivalence number. The device is designed to 
be used on standard device telephone lines. Connection to telephone 
company-provided coin service (central office implemented systems) is 
prohibited. Connection to party lines service is subject to state tariffs.

The goal of the telephone company is to provide you the best service it 
can. In order to do this, it may occasionally be necessary for them to 
make changes in their equipment, operations, or procedures. If these 
changes might affect your service or the operation of your equipment, 
the telephone company will give you notice, in writing, to allow you to 
make any changes necessary to maintain uninterrupted service. If you 
have any questions about your telephone line, such as how many pieces 
of equipment you can connect to it, the telephone company will provide 
this information upon request.

In certain circumstances, it may be necessary for the telephone 
company to request information from you concerning the equipment 
which you have connected to your telephone line. Upon request of the 
telephone company, provide the FCC registration number and the 
ringer equivalence number (REN) of the equipment which is connected 
to your line; both of these items are listed on the equipment label. The 
sum of all of the RENs on your telephone lines should be less than 5 in 
order to assure proper service from your telephone company. In some 
cases, a sum of 5 may not be usable on a given line.

If any of your telephone equipment is not operating properly, you 
should immediately remove it from your telephone line, as it may cause 
harm to the telephone network. If the telephone company notes a 
problem, they may temporarily discontinue service. When practical, 
they will notify you in advance of this disconnection. If advance notice is 
not feasible, you will be notified as soon as possible. When you are 
notified, you will be given the opportunity to correct the problem and 
informed of your right to file a complaint with the FCC.

An analog telephone line is required. A digital PBX line will not work.

Emissions (Interference)
Requirements

This GE Marquette device has been tested and complies with the limits 
for a Class B computing device in accordance with the specifications in 
Part 15 of the FCC rules. These rules are designed to provide reasonable 
protection against radio-frequency interference. However, there is no 
guarantee that interference will not occur in a particular installation.

You can tell whether this device is causing interference by turning it off. 
If the interference stops, it was probably caused by the device.
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System Characteristics

General Description The MUSE CV system is a multiple data-type system designed for 
managing cardiology data. It allows you to edit and store data acquired 
from many different areas. Data may be acquired from areas within the 
hospital, as well as from areas not directly connected to the hospital 
such as emergency care and outreach facilities.

The MUSE CV system has a file server running Windows NT which is 
networked to one or more workstations. The products range from a low-
cost, single data-type system to multiple data-type systems with many 
workstations and virtually unlimited ECG storage capabilities. Options 
can be added to the standard configuration to suit a customer’s 
particular needs.

Compaq Proliant 3000R, 450MHZ PII, 512K, 128MB RAM, rack- 
mountable

Hardware The MUSE CV system is configured with an Intel-based file server. There 
are two file server options:

1. Intel 440BX file server with 500MHz Pentium® III processor 
with 100-MHz system bus; 512 KB integrated L2 cache, 256MB 
DIMM PC100 ECC, Seagate 18GB LVD 1-inch hard drive, Sony 
40X IDE CD-ROM drive, 

2. Compaq Proliant 3000R with 450MHz, Pentium 450MHZ PII, 
512K, 128MB RAM, rack- mountable Compaq

Intel File Server The Intel file server comes equipped with the following system 
peripherals: a keyboard, Microsoft mouse, 3.5" floppy diskette drive, 
CD-ROM drive, and a Hewlett-Packard digital audio tape (DAT) drive. In 
addition, a typical system includes a POWERVAR uninterruptible power 
supply (UPS) and a 56Kbps Multi-tech modem for remote system 
support (RSS).

The UPS conditions incoming power to protect your MUSE CV system 
from power surges and drops. During a power outage, the UPS supplies 
battery power to the system long enough to let you do a system 
shutdown and turn off the equipment. Two versions are available, a 
110 - 127 VAC, 60 Hz, 1.5 KVA unit, or a 220 - 240 VAC, 50 Hz, 1.4 KVA 
unit.

NOTE
The telephone line must be an analog
telephone line for communication with the
host MUSE CV system to work properly.
Newer digital telephone systems will not
work with this equipment.
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Compaq RAID File Server The Compaq RAID file server features RAID Level 5, the preferred 
method of redundant hard drive configuration for efficient, fault-
tolerant data storage. The RAID server can be supplied with or without a 
rack. The Compaq file server include back-up systems, redundant 
power supplies, fans, and NIC network integration cards. Also included 
with the RAID file server are: a DDS3 DAT drive for data backup and 
archive. The Compaq RAID server can be configured with a 2- or 4-port 
KVM switch for servicing “headless” clients.

The optional UPS conditions incoming power to protect your MUSE CV 
system from power surges and drops. During a power outage, the UPS 
supplies battery power to the system long enough to let you do a system 
shutdown and turn off the equipment.

Desktop Workstation The desktop workstation is based on Intel’s 233 MHz Pentium II 
microprocessor with passive heatsink. It comes standard with 64MB of 
RAM and one 2.1GB hard drive.

Synchronous Modem Module Finally, a synchronous modem module (SMM) is available to handle 
your data transfer requirements. Like the workstation client, the modem 
module is based on Intel’s 233MHz processor. It comes standard with 
64MB RAM, one 2.1GB hard drive, and a CD-ROM drive. Available as 
optional equipment for the comm server are:

■ Network Kit (Thin, Thick, or Twisted-pair Ethernet; or Token 
Ring)

■ MEI Multimodem
■ Fax option
■ CSI modem
■ 1500 Defibrillator modem
■ Holter Connection 

Optional Equipment The following optional equipment may be purchased with your MUSE 
CV system.

■ Monitor - 15”, 17”, or 20”

■ HP LaserJet 4050N printer *

■ MUSE Network Writer (thermal printer) *

■ MEI Modem *

■ CSI Modem *

■ MAC 8 Local Acquisition cable. *

* Not available on the file server.

NOTE
The telephone line must be an analog
telephone line for communication with the
host MUSE CV system to work properly.
Newer digital telephone systems will not
work with this equipment.
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Monitors

The Sony monitors are part of the Sony Multiscan series and 
incorporate the Trinitron display technology. The 15” monitor has a 
physical resolution of 1024 x 768, while the 17” and 20” monitors have a 
physical resolution of 1280 x 1024. All of the monitors are color.

Printers

The HP LaserJet 4050N printer contains 8MB RAM, and prints all reports 
including Holter, stress, echo, pacemaker, resting and hi-res ECG’s on 
standard paper. For additional information on this printer, please refer 
to the OEM manual.

The MUSE network writer is a thermal writer which allows you to print 
ECG’s and MUSE CV system reports on thermally-sensitive paper. It 
requires the Network Writer interface board be installed in the 
controlling computer. For additional information on the MUSE 
Network Writer, please refer to Chapter 6, “MUSE Network Writer 
Module”.

Modems

MEI modems can be added for communication with GE Marquette 
resting ECG analysis systems, and fax machines. They are only 
necessary when system components are required to communicate over 
telephone lines.

Do not confuse the MEI modem, also known as the SDLC modem, with 
the CSI/RSS modems in the system. The MEI modem can be used to 
send and receive data to MAC VU, MAC 8, MAC PC, MAC 15, and MAC II 
resting ECG analysis systems, and can also send FAX reports to group 
3-compatible FAX machines. FAX support requires the MAC 8 local 
acquisition cable or network writer/local acquisition port interface pcb 
assembly in the controlling computer.

A CSI modem is also used for communication with MAC VU and MAC 8 
resting ECG analysis systems, but in addition it lets the MUSE CV system 
communicate with remote workstations over standard telephone lines. 

MEI Modem

The MEI modem contains 2 modems, the FAX modem and the SDLC 
modem. The MEI modem was designed because no off-the shelf 
modems did all the functions that were necessary. In addition, existing 
modems generated too many interrupts to the host computer, slowing 
the computer down too much. The MEI modem makes fewer, larger 
data transfers, reducing overhead for the host computer.

NOTE
The MEI modem requires analog telephone
lines to communicate with other GE
Marquette Medical Systems equipment. It
will not work with the digital phone systems
that are becoming more and more common.
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Versions 001A and 001B of MUSE software required the first MEI 
modem to be in the acquisition server/processing station and the 
second MEI modem to be in the file server. Starting with 001C software, 
both MEI modems can go into the acquisition server/processing station. 
For all versions of software, third and fourth MEI modems must go into 
an additional workstation computer that is at another node on the 
network.

Following are summaries of the 4 modems and the RS232 port on the 
MEI modem board.

■ Bell 201 Modem

The Bell 201 modem is a 2400 baud modem that will also 
communicate at slower rates of 1200 or 300 baud. This modem 
is used to communicate with GE Marquette MAC II, MAC 12, 
MAC 15, MAC PC, MAC PC Cellular, MAC 6, and MUSE Network 
products. 

■ Hayes “AT” Modem 

The Hayes “AT” modem communicates at 2400, 1200, or 300 
baud with the MAC VU. 

■ FAX Modem 

FAX modem software was implemented with 002A software. 
This modem sends reports at 9600 baud to any group 3 FAX 
machine. FAXes cannot be sent from a FAX machine to the 
MUSE CV system. 

■ Voice Modem 

The voice modem provides digital voice recording and 
playback. There are 2 connectors for the voice modem. The first 
is for a standard telephone line and the second is for a headset. 
The voice modem will record voice messages from another 
telephone or a headset. The data is stored on the hard disk to be 
played back later.

■ RS232 Serial Port 

The RS232 serial port is used with external modems. This is 
most useful in foreign markets, where pre-approved modems 
are used.

The RS232 connector (J6) is not accessed via the computer’s 
back or top panel. It is an internal 10-pin connector that can be 
connected in 1 of 2 ways. It can either be connected to the 
computer’s internal COMM port, or it can be connected to an 
external connector found in an adjacent expansion slot.
Revision F2-6 MUSE CV information system
419931-012



Equipment Overview: System Characteristics
MAC 8 Local Acquisition cable

The MAC 8 local acquisition cable is needed whenever ECGs are to be 
acquired locally from a MAC 8 resting ECG analysis system. It uses the 
MUSE Network Writer interface circuit board to communicate with the 
computer. 

Software The MUSE CV system is capable of acquiring data from a variety of 
sources, both within and outside the hospital. Data is acquired via a 
network, floppy diskette, direct line, or telephone transmission. Users 
may view and measure ECG waveforms, edit and confirm the acquired 
data, and create an assortment of configurable data reports.

The MUSE CV system software is a menu driven program which 
operates within Microsoft Windows. The overall program is divided into 
“applications”. Each application includes many related operations. For 
example, the System Status Application includes operations that let you 
display lists of errors, events, pending tasks, and print queues.

Network Functions Computers may be networked to each other via thin, thick, or twisted 
pair ethernet. Every MUSE CV system comes equipped from the factory 
with the customer selected network interface. 

TCP/IP is the standard networking protocol for the MUSE CV system.

Workstation Setup
Guidelines

Workstation clients can be set up to be “turnkey” or “multi-use” 
depending on the user’s needs. Clients can also be set up for “MUSE 
Authentication” or “NT Authentication”. The terms are defined below:

Turnkey Workstation ■ 16- or 32-bit systems
■ Dedicated to the operation of the MUSE CV system
■ Only MUSE CV system software is installed
■ MUSE CV system software starts automatically when 

workstation starts
■ Typically, additional MUSE tasks are running

Multi-Use Workstation ■ 16- or 32-bit systems
■ Additional third party applications may be installed.
■ The MUSE CV system software does not start automatically
■ Typically, does not have additional MUSE tasks running. (The 

user is not always running the MUSE CV system software.)

MUSE Authentication ■ 16- or 32-but systems
■ For Windows 95/98, the Primary Network Login must be 

Windows Logon.
■ MUSE Login (ICIS0250.exe) provides authentication.
■ Must have an NT Domain User Account for the computer to log 

in as. This is typically MUSEXXX (where XXX is the node id)
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NT Authentication ■ 32-bit systems only
■ For Windows 95/98, the Primary Network Logon must be Client 

for Microsoft Networks.
■ Provides a one-time login to all MUSE and third party resources.
■ Must have an NT Domain User Account for the user.
■ Must have a MUSE User account (USERS.BTR)
■ Must have an entry in the MUSE NT Users database 

(NTUSERS.BTR) that maps the NT domain account to the 
corresponding MUSE User account.

Characteristics of a Turnkey
Workstation

■ Minimize is hidden system-wide and Exit is hidden from MUSE 
Login.

■ Computer automatically reboots when necessary.
■ 16-bit turnkey systems:

◆ A Starting MUSE entry is added to AUTOEXEC.BAT
◆ MUSE Authentication is always used.

■ 32-bit turnkey systems:
◆ A Start MUSE CV shortcut is added to the startup group.
◆ MUSE Authentication is the default and in most cases it is 

the best choice. However, NT Authentication can be used.
◆ When using NT Authentication, selecting the Exit menu will 

logout the user.
◆ When using NT Authentication, MUSE tasks will not start 

until someone is logged in.

Characteristics of a Multi-Use
Workstation

■ Minimize is typically available system-wide and Exit is available 
from MUSE Login.

■ Exiting MUSE returns the user to the Desktop.
■ 16-bit multi-use workstations:

◆ A Start MUSE CV icon must be added manually and the 
Starting MUSE entry must be removed from 
AUTOEXEC.BAT

◆ MUSE Authentication is always used.

■ 32-bit multi-use workstations:
◆ A Start MUSE CV icon can be added to the Desktop during 

installation or can be run from the taskbar by selecting  
Start → MUSE CV Information System → Start MUSE CV.

◆ NT Authentication is the default and in most cases it is the 
best choice. However, MUSE Authentication can be used.
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Preparation for Use

The following interconnect diagrams give a general overview of how 
your workstation should be set up. There are too many variations to 
show all of them, but enough information should be provided so 
someone reasonably familiar with computer system installations should 
have no problem.

Step-by-step instructions for setting your workstation up for the first 
time can be found in the sections following the interconnect diagram. 
Use the interconnect diagram as a reference when following these 
instructions. Please refer to the supplied OEM manuals and the “System 
Components, Controls, Indicators, and Locations” section in this 
chapter for more specific information.

WARNING

This is Class I 
equipment. The mains 
plug must be connected 
to an appropriate power 
supply.

M15287-5C

WARNING

M15287-7C

Keep leakage current 
within acceptable limits
when connecting
auxiliary equipment to
this device.

DANGER
Do NOT use in the 
presence of flammable 
anesthetics.

M15287-1B

WARNING

Disconnect patient 
from unit BEFORE
connecting personal 
computer to unit.

M15287-12C

NOTE
MUSE CV system operation may be affected
if large machines with high current draws are
connected to the same electrical circuit as
the MUSE CV system. It is recommended
that the MUSE CV system be connected to a
power source away from these machines.
Revision F 2-9MUSE CV information system
419931-012



Equipment Overview: Preparation for Use
Intel File Server
Interconnect Diagram

The interconnect diagram below shows a typical setup for an Intel file 
server with SDLC modem module.
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RAID File Server
Interconnect Diagram

The interconnect diagram below shows a typical setup for a RAID file 
server.
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Client Interconnect
Diagram

The interconnect diagram below shows a typical client setup.
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Furniture If furniture was ordered with the MUSE CV system, unpack it and set it 
up in the desired location. If existing furniture is being used, ensure that 
it is set up in the desired location before continuing.

Uninterruptible Power
Supply (UPS)

1. Unpack the UPS and place it in a location near where you plan 
to set up the workstation. An area on the floor and under the 
desk is recommended. Keep in mind that the unit needs to be 
accessible.

2. Ensure that the power switch on the back of the unit is in the 
OFF position.

3. Connect the UPS power cord into a 20 amp power outlet 
dedicated to the workstation.

4. Connect the UPS serial cable from the UPS serial port to COM2 
on the file server.

NOTE
Refer to the file server and client description
diagrams in the “System Components,
Controls, Indicators, and Locations” section
for the recommended placement of
equipment.

NOTE
Do not connect your laser printer to the UPS.
The large periodic current draw of the printer
will trigger the low voltage alarm on the UPS.
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Client 1. Unpack the system box and place it in a location near the UPS.

2. Note the location of the items on the back of the system box. 
You need to know where each of the controllers or connectors 
are to properly set up your system.

Detailed descriptions of these items are in the original 
equipment manufacturer (OEM) manual you received with your 
system, and further defined in the “System Components, 
Controls, Indicators, and Locations” section in this chapter. You 
can also use the interconnect diagrams for locating the proper 
connectors.

3. Verify that the input power selection switch on the back of your 
system box is set correctly for your environment. The voltage 
visible on the switch is the voltage at which the system is set to 
operate.

4. Ensure the power control button, located on the front of the 
client hardware, is off. Also ensure that the system power enable 
switch on the back of the desktop server is in the off position by 
pressing the end marked 0.

5. Connect the AC power cord to the AC power receptacle on the 
back of the system box and to one of the power outlets on the 
back of the UPS.

Monitor 1. Unpack the monitor and place it on the desktop. The monitor 
may also be placed on top of the client.

2. Verify that the power switch is in the off position.

3. Connect the AC power cord to the power receptacle on the back 
of the monitor and to one of the power outlets on the back of the 
UPS.

4. Connect one end of the video cable to the back of the monitor 
and connect the other end to the appropriate port on the back 
of the system box. Use the interconnect diagrams as a reference.

NOTE
Be sure to connect the monitor to the file
server and not the modem module.
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Modem Module 1. If a modem module was ordered, unpack it and place it in a 
location near the UPS.

2. Note the location of the items on the back of the system box. 
You need to know where each of the controllers or connectors 
are to properly set up your system.

Detailed descriptions of these items are in the original 
equipment manufacturer (OEM) manual you received with your 
system, and further defined in the “System Components, 
Controls, Indicators, and Locations” section in this chapter. See 
“Client Interconnect Diagram” on page 2-12 for locating the 
proper connectors.

3. Ensure the power switch on the back of the unit is in the off 
position by pressing the end marked 0.

4. Connect the AC power cord into the AC receptacle on the back 
of the system box and to one of the power outlets on the back of 
the UPS.

MAC 8 Acquisition Cable If your system contains the optional MAC 8 cable, connect one end of 
the cable (PN 700716-001) to COM1 on the back of the client. See the 
interconnect diagram for the exact location.

NOTE
The modem module does not use a
keyboard or a monitor.

WARNING

Disconnect patient 
from unit BEFORE
connecting personal 
computer to unit.

M15287-12C
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RSS Multitech Modem 1. Unpack the modem and place it in a location near the file 
server.

2. Ensure that the power switch located on the side of the modem 
is in the off position.

3. Attach the AC power cord to the modem and to the UPS.

4. Connect one end of the RS232 cable to the COM2 port on the 
back of the file server. Connect the other end to the RS232 port 
on the back of the modem. Use the “Intel File Server 
Interconnect Diagram”as a reference.

5. Connect one end of the phone wire to the LINE jack on the back 
of the modem and connect the other end to the appropriate 
phone jack in the wall.

CSI Multitech Modem 1. Unpack the modem and place it in a location near the file server 
or the appropriate node.

2. Ensure that the power switch located on the side of the modem 
is in the off position.

3. Attach the AC power cord to the modem and to the UPS.

4. Connect one end of the RS232 cable to the RS232 port on the 
back of the modem. Connect the other end as follows:

◆ If your communication server is equipped with the MAC6/8 
acquisition assembly, connect the RS232 cable to the COM2 
port on the back of the communication server.

◆ If your communication server does not have the MAC6/8 
acquisition assembly, then connect the RS232 cable to the 
COM1 port on the back of the communication server.

Use the “File Server Interconnect Diagram” as a reference.

5. Connect one end of the phone wire to the LINE jack on the back 
of the modem and connect the other end to the appropriate 
phone jack in the wall.
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Keyboard and Mouse 1. Ensure the system power is off.

2. Connect the keyboard/bar code wand cable to the 6 pin 
keyboard port on the back of the system box and to the port on 
the back of the keyboard. Use the interconnect diagrams as a 
guide.

3. Connect the mouse cable to the 6 pin mouse port on the back of 
the system box. See the interconnect diagram for the exact 
location.

Network Connection

Thin or Thick Ethernet If you are using thin or thick ethernet for your MUSE CV system 
network, connect your network cable to the appropriate port on the 
ethernet network card on the back of the system box. 

Twisted Pair 1. If your network is twisted pair, unpack the 3Com Linkbuilder 
hub and place it near your system box or in the location 
designated by your customer’s IS department.

2. Connect each system box to the network by running your 
twisted pair wire from the twisted pair network port on the back 
of the system box to a port on the hub.

Refer to the interconnect diagrams if needed.

If necessary, multiple hubs may be linked together to 
accommodate a large number of workstations.

Enterprise Network If you are connecting to the customer’s enterprise network, your system 
contains a “special”. An RSA should be involved in the installation. 

Printers

HP LaserJet 1. If you are connecting the HP laser printer to your system, 
unpack the HP LaserJet and place it in the desired location.

2. Follow the installation instructions provided in the HP manuals 
which accompanied your shipment of equipment.

NOTE
Power should always be OFF when
connecting or disconnecting the keyboard or
mouse.

NOTE
Do NOT plug your laser printer into the
Uninterruptible Power Supply (UPS).
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3. To connect your printer to the controlling computer, plug one 
end of the printer cable into the PARALLEL port on the back of 
the printer. Connect the other end to the LASER PRINTER port 
on the back of the system box. Use the interconnect diagram as 
a guide.

JAM RECOVER Setting

After connecting your printer, ensure that the JAM RECOVER setting is 
turned on. 

MUSE Network Writer 1. If you are connecting the MUSE network writer to your system, 
unpack the printer and place it in the desired location.

2. To connect your printer to the controlling computer, plug one 
end of the printer cable into the MUSE NETWORK WRITER 
port on the back of the system box. Connect the other end to the 
CTLR BD port on the back of the printer. Use the File Server 
Interconnect Diagram as a guide.

3. Plug one end of the AC power cord into the back of the printer 
and the other end into an outlet on the back of the UPS.
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Powering On and System Shutdown

Introduction The section includes the following procedures:

■ Powering on the workstation

■ Powering off the workstation

■ Exiting from MUSE CV system software to DOS

Powering On the
Workstation

Power on your client as specified below. Additional information can be 
found in your file server’s OEM manual.

1. Verify that all system components such as the monitor, 
keyboard, etc. are connected. All connections should be made 
while the system is off.

2. Turn on the UPS power switch.

3. Turn on peripheral devices, monitors, and printers.

4. Turn on the power enable switch on the back of your desktop 
and communication servers.

5. Press the power control button on the front of your system to 
turn it on. The system will power up and immediately begin the 
power-on self test (POST).

6. Make sure the Authorization window appears.

NOTE
If a laser printer is part of the system, do not
plug it into the uninterruptible power supply
(UPS). In some environments, the cycling of
power in the laser printer will cause the UPS
alarm to sound (approximately every
minute).

NOTE
System shutdown procedures are described
in chapter 4, “Integrated Maintenance Suite”.
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Checkout the Workstation

Final Checkout Perform the following for all applicable options. Use this manual and 
the MUSE CV system operator’s manual for reference.

1. Client Initialization - Power up all clients and ensure each 
initializes, error free, and you can log in.

2. Diskette Acquisition - Acquire test ECGs via electrocardiograph 
diskettes and ensure they plot according to report distribution.

3. Phone Acquisition - Acquire test ECGs via remote 
electrocardiograph modems and ensure they plot according to 
report distribution.

4. Local Acquisition - Acquire test ECGs via the MAC 8 acquisition 
cable and ensure they plot according to report distribution.

5. Holter - Locally transmit data from the Holter to the MUSE CV 
system.

6. TRAM Module - Test that data is successfully flowing from the 
TRAM to the MUSE CV system.

7. MAC LAB - Test that data can be sent from the MAC LAB to the 
MUSE CV system.

8. SDLC - Acquire test ECGs via remote SDLC modems.

9. CSI - Acquire test ECGs via remote CSI modems.

10. RSS - Contact Tech Support to ensure remote logon is possible.

11. Remote Query - Test CSI modem connections if system has 
Remote Query.

12. Edit - View and edit an ECG from the Edit List.

13. Writer/Printers - Test writers to ensure they plot. Check for 
burned out dots, especially in the bar code region.

14. FAX - FAX a record to test fax modems.

15. On-line Archives - If the system has on-line archive drives, 
ensure that backup tapes are up to date.

16. Backups - Perform a non-scheduled backup. See chapter 4, 
“Integrated Maintenance Suite” for details. Check that all tapes 
are being successfully used. Replace tapes that are past their 
intended life span (customer should store old tapes for safe 
keeping).
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System Components, Controls, Indicators, and Locations

This section provides a description of the MUSE CV system hardware. 
The first diagram is a typical setup containing an Intel tower and 
modem module. The second diagram shows a typical setup using a 
client.

Intel File Server System  

Table 2-4. Intel File Server System Description

Item Name Description

A modem module Stores system’s modems.

B RSS modem Used by service to provide remote system support.

C monitor Displays information, messages, etc.

MD1313-20A

A B C D

EFGH
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D Hub Hub used in twisted pair networks. This item is optional. A MAU may be 
used instead for token ring networks.

E file server System box. Contains the power supply, hard disk drive, RAM, central 
processing unit, etc.

F mouse An input device used to move the cursor and select items on the display. 
The mouse is standard on the system.

G keyboard The keyboard is an input device. Use the keyboard to type information 
when required by the system.

H UPS The UPS automatically provides temporary power to the MUSE CV system 
in the event of a power interruption. 

Table 2-4. Intel File Server System Description (Continued)

Item Name Description
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RAID File Server System The figure below shows the RAID file server configuration in rack.  

Table 2-5. RAID File Server System Description

Item Name Description

A Modem Rack Can hold up to 12 modems.

B Keyboard Drawer Pulls out to allow access to the keyboard.

C Monitor Displays data on the screen. See the OEM manual for operational details.

D Keyboard-Video-Monitor (KVM) 
switch

Used to switch between PC1, PC2, and the file server.

E Hub Connects PC1, PC2, and the file server to the network.

MD1313-40A
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F PC1 and PC 2 Contains CSI and/or SDLC modems.

G File Server Stores mirrored copies of MUSE CV system database.

H Uninterruptible Power Supply 
(UPS)

Provides uninterruptible AC power in case of a power failure or power 
conditioning.

Table 2-5. RAID File Server System Description (Continued)

Item Name Description
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Workstation Client
System

This section provides a description of the MUSE CV system hardware. 
The hardware associated with a typical workstation client configuration 
is shown.

Table 2-6. Workstation Client System Description

Item Name Description

A client The system box which contains the power supply, hard disk drive, RAM, 
central processing unit, etc.

B CSI modem Used to communicate with MAC VU and MAC 8 resting ECG analysis 
systems.

C monitor Displays information, messages, reports, ECGs, etc.

D HP LaserJet 4000N printer Optional Laser printer used to print various reports on standard paper.

E mouse Input device used to move the mouse cursor and select items on the 
display.

 

MD1313-4A

A DCB
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F keyboard The keyboard is an input device. Use the keyboard to type information 
when required by the system.

G bar code reader Used to select and edit ECGs. Makes the system easier to use for those not 
used to working with computers.

Table 2-6. Workstation Client System Description (Continued)

Item Name Description
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Intel File Server- Front

Table 2-7.  File Server – Front

Item Name Description

A Diskette ejector button Press to eject diskette.

B Diskette drive activity LED When lit, drive is being accessed.

C CD-ROM drive Used to install software.

D DAT drive Used to backup and make archive copies of data.

E System power on LED When lit continuously, indicates presence of DC power in the system. LED 
goes out when the power is turned off or the power source is disrupted.

F System push-button power on/
off switch

When pressed momentarily, turns the system DC power on or off. Does 
NOT remove AC power from the system.

G Reset push-button switch When pressed momentarily, resets the system and causes power-on self 
test (POST) to run.

H Hard drive green LED When lit, a SCSI or IDE hard drive is being accessed.
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Intel File Server – Back

Table 2-8.  File Server – Back

Item Name Description

A Network controller status LEDs Activity, Link, and Speed of data transfer (see “File Server Network Status 
LEDs” for more information)

B Network connector port Connects to ethernet.

C VGA monitor connector Connects to monitor.

D Serial port A, COM2 Connects to RSS modem.

E Mouse and keyboard connectors Connect to mouse and to keyboard (interchangeable).

F Parallel port Not used.

G Serial port B, COM1 Connects to UPS (extended via ribbon cable from back panel to system 
board).

H AC input power connector Connects to UPS

I Power supply fan Provides ventilation to power supply.
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J Side cover grip handle Used to remove side cover when servicing file server.

K Loop for padlock (padlock not 
supplied)

Install padlock for security. (Padlock not supplied)

Table 2-8.  File Server – Back (Continued)

Item Name Description

Table 2-9. File Server Network Status LEDs

LED What to Look For Description

DS3, Activity (Act) ● On, or
❇ Blinking

❍ Off

The network controller is sending or receiving data over the network. The 
frequency of flashes varies with the amount of network traffic.

The network controller is not sending or receiving data over
the network.

DS2, Link ● On

❍ Off

Valid link to the LAN: The network controller and hub are receiving power; 
the cable connection between the controller and hub are good.

The controller and hub are not receiving power; the cable connection 
between the controller and hub is faulty; or there is a driver configuration 
problem.

DS1, Speed ● On

❍ Off

Network controller is operating at 100 Mbps transfer speed.

Network controller is operating at 10 Mbps transfer speed.
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Compaq File Server Rear Panel
Connectors

Table 2-10. ProLiant 3000 Rear Panel Connectors

Item Description

A System I/O board rear connectors (See “System I/O Board 
Connectors” for more information)

B Power supply connector.

C Netelligent 10/100 TX UTP PCI controller connector (RJ-45)

A B C

MD1313-98A
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System I/O Board Connectors

Table 2-11. ProLiant Server System I/O Board Connectors

Item Description

A Video

B External SCSI

C Mouse

D Serial Port B

E Serial Port A

F Keyboard

G Parallel/Printer Port

H Auxiliary Fan

I Processor Power Module 1

J CPU Redundant Fan

K CPU Fan

L Power

M Power Switch

N Power Supply

O Integrated Management Display (IMD)

A B C D

EFG

H

I

J

KLMNOPQRSTU

V

W

MD1313-99A
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P Processor Power Module 2

Q Diskette Drive

R CD-ROM Drive

S I2O

T SCSI Port 2

U SCSI Port 1

V I/O Fan

W I/O Redundant Fan

Table 2-11. ProLiant Server System I/O Board Connectors (Continued)

Item Description
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Client – Front

Table 2-12. Client – Front

Item Name Description

A IR filler panel

B Cooling vents (must not be 
blocked)

Used to provide ventilation to the power supply. Must not be blocked.

C Filler panel for optional floppy 
disk drive bay

D Indicators ■ Top – power/sleep
■ Middle – hard disk activity
■ Bottom – message waiting

E CD-ROM drive Used to for software upgrades and for accessing technical manuals on CD-
ROM. For more information see “CD-ROM Drive” on page 2-37.

F Diskette drive Used for software updates.

G Power switch Used to turn power on and off.

H Reset button (recessed) Used to reboot the client.

I USB connector Not used

J Audio out connector Can be used for dictation option.

K Audio in connector Can be used for dictation option.

MD1313-19A

A

C D E F

B

GHIJK
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Client – Back

Table 2-13. Client – Back

Item Name Description

A Power supply mounting tabs

B Power supply

C Power setting switch Can be set for 115VAC or 230VAC.

D Power supply mounting screws Used when removing the power supply.

E Add-in card filler panels If client is a modem module, these panels contain telephone connectors.
If client is a workstation, these panels contain connectors for MUSE 
Network writer, TRAM, Holter, etc.

F Rear chassis cooling holes Provide ventilation for power supply.

G Connector location for 
accelerated graphics port (AGP) 
card

Not used.

H  NLX I/O motherboard back panel 
connectors

For more details see “NLX I/O Mother Board” on page 2-35.

I AC power connector Connects to AC power outlet.

MD1313-2A
H

A B C D E F

I

G
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NLX I/O Motherboard Back Panel
Connectors

Table 2-14. NLX I/O Mother Board

Item Name Description

A Line in connector Not used.

B Microphone In connector Connects to headphone (dictation option only).

C Line Out connector Connects to headphone (dictation option only).

D LAN connector Connects to ethernet.

E Universal Serial Bus (USB) 
connector

Not used.

F Serial Port 2 connector Connects to CSI modem.

G Mouse/keyboard 
connectors

Connect to mouse and to bar code reader.

H Serial Port 1 connector Connects to MAC 8 resting ECG analysis system for local acquisition of ECGs.

I Parallel port Connects to HP LaserJet printer.

J Video connector Connects to monitor.

MD1313-17A

A B C D E F G H I J
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DAT Drive

DAT Tape Drive Front Panel Display

The Tape light (left) uses green to show tape activity as follows:

■ Slow flashing green while the tape is being loaded or unloaded.

■ Steady green when the tape is loaded.

■ Fast flashing green when read or write operations occur.

The Clean / Attention light (right) uses amber to show the following 
conditions:

■ Slow flashing amber to indicate that the heads need cleaning or 
the cartridge is near the end of its useful life.

■ Steady amber to indicate a hard fault.

Table 2-15. DAT Drive

Item Name Description

A tape light See “DAT Tape Drive Front Panel Display” below.

B clean/attention light See “DAT Tape Drive Front Panel Display” below.

C unload button Press to remove DAT tape.

A B C

MD1313-9A

Tape
Clean/

Attention Meaning

Activity — load or unload

Activity — read or write

Cartridge loaded, drive online

Cleaning needed

Fault

Self-test in progress

Any

Any

Key

Off

Steady Green

Steady Amber

Flash Green
(1/2s on, 1/2s off

Flash Amber
(1/2s on, 1/2s off

Fast Flash Green
(1/4s on, 1/4s off)
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CD-ROM Drive

Table 2-16. CD-ROM Drive

Item Name Description

A headphone connector Connect headphones here.

B variable control dial Use to vary CD volume.

C LED Light indicates CD-ROM drive activity.

D eject button Press to remove CD-ROM.

A B C D

MD1313-10A
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Intel File Server Installation

Back Up and Shut Down
the System (Upgrades

Only)

1. If this is a forklift upgrade, do a non-scheduled complete backup 
of the file server you are about to replace. See the “MUSE CV 
Information System Operator’s Manual” for information on how 
to perform a non-scheduled complete backup.

2. After the backup, shut down the system as described in the 
“MUSE CV Information System Field Service Manual”.

Connect File Server Connect the new file server to other components as shown below.

Phone Jacks

RSS
Modem

I
0

ON

ON

OFF

SET
UP

COMM
PORT

OFF

1
2

3
4

5
6

7
8

UPS Keyboard

HUB

Mouse

File Server

SDLC Modem Module

Monitor

{

Other Nodes

700139-001

Phone
Jack

{Other
Nodes

Telephone Cables (PN 80159-014)
Twisted Pair Cables (PN 408997-001)

MD1313-12A

421341-001

Synchronous Modem Module
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Configure TCP/IP 1. If the MUSE CV Information System file server is a primary 
domain controller (PDC), login to the domain using the 
MUSEAdmin account.

◆ User name = Muse Admin

◆ Password = Muse!Admin

If it is a member server in an existing hospital domain, login 
locally to file server using the Administrator account.

◆ User name = Administrator

◆ Password = Never!Mind

2. Select Start → Settings → Control Panel.

3. Double click the Network icon.

4. Select the Protocols tab.

5. Highlight TCP/IP Protocol. Then, select the Properties... button.

6. Verify that the Specify an IP Address radio button is selected.

7. Enter the IP Address, Subnet Mask, and Default Gateway.

8. Select the Advanced... button.

9. Select the Add... button under the Gateways list.

10. Enter the IP Address of the gateway and select the Add button. 
Repeat this step as needed for additional gateways.

11. Select the OK button in the Advanced IP Addressing dialog 
box.

NOTE
To log into the MUSE CV Information
System file server locally when it is a
member server in an existing hospital
domain, make sure the computer name (ie.
MUSE$$$001) is highlighted in the domain
box of the logon screen. If the MUSE CV
Information System file server is a primary
domain controller, logging into the domain is
the only option. Keep this in mind when
future steps require logging in locally to the
MUSE CV Information System file server or
logging in to the domain.

NOTE
If no additional gateways exist, skip to step
12. Otherwise, continue with step 8.

NOTE
If no DNS servers exist, skip to step15.
Otherwise, continue with step 12.
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12. Select the DNS tab.

13. Select Add for DNS Service Search Order.

14. Enter the IP address of the DNS Server and select Add. Repeat 
this step as needed.

15. Select the WINS Address tab.

16. Enter the IP address of the Primary WINS Server.

17. Enter the IP address of the Secondary WINS Server if one exists.

18. Verify that the Enable DNS for Windows Resolution box is 
unchecked unless you are told to check it by the network 
administrator.

19. Verify that the Enable LMHOSTS Lookup box contains a check 
mark.

20. Select Close at the bottom of the Network dialog box.

21. Select Yes when asked Do you want to restart you computer 
now?

22. Edit the lmhosts file in C:\winnt\system32\drivers\etc. Create 
an entry for the PDC in the domain the MUSE file server will be 
joining. Be sure to use the DOM and PRE switches. Look at the 
sample file lmhosts.sam for an example.

NOTE
If no WINS Servers exist, proceed to step 19.
Otherwise, continue with step 15.

NOTE
If DNS or WINS is being used, if the MUSE
file server is a PDC, or if the MUSE file
server is on the same subnet as a domain
controller, TCP/IP configuration is complete.
Otherwise, continue with step 22.

NOTE
If the MUSE file server is a member server,
continue with “Adding the MUSE System File
Server to the Hospital Domain (Member
Server Only)”.

If the MUSE system file server is a PDC, go
to “Configuring Email Notification of the IMS
Log”.
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Adding the MUSE System
File Server to the
Hospital Domain

(Member Server Only)

1. Log on to the MUSE CV system file server as Administrator.

◆ User name = administrator (name is not case sensitive)

◆ Password = Never!Mind (Password IS case sensitive)

2. Select Start → Settings → Control Panel.

3. Double click the Network icon.

4. Select the Identification tab. Then, select the Change... button.

5. Verify that the Domain radio button is selected.

6. Enter the name of the domain to join.

7. Verify that the Create a Computer Account in the Domain box is 
checked.

8. Enter the User Name and Password of an account with the 
ability to add a computer to the domain and select OK.

9. At the Are you sure you want to move this computer... message 
select Yes.

10. At the domain welcome message select OK.

11. Select Close.

12. Select Yes when asked Do you want to restart your computer 
now?

NOTE
An account with the ability to add a computer
to a domain is typically a domain
administrator account. Someone from the IS
department will have to enter the User Name
and Password unless they are willing to give
this information to Marquette personnel.
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Create MUSE NT Domain
Accounts

Next, create a MUSE NT domain account. This can be done by using the 
cvuser utility described in “Create User Accounts Using CVUSER” or by 
using User Manager for Domains as described in “Create User Accounts 
Using User Manager for Domains”. Either method can be used.

Create User Accounts Using
CVUSER

1. Login to the domain using a domain administrator account.

2. Select Start → Programs → Command Prompt.

3. Type cvuser <Space> MUSEAdmin <Space> MUSE$$$001
(MUSE$$$001 is the computer name of the MUSE CV system 
file server)

4. Type cvuser <Space> MUSEBkgnd <Space> MUSE$$$001
(MUSE$$$001 is the computer name of the MUSE CV system 
file server)

NOTE
The user/names used here are the
Marquette suggested user/names

If other user/names are required by the
customer, use them in place of the
suggested names. Inform Tech Support if
different user/names are used.

If using customer required user/names in
place of the suggested user names,
remember to use these names for the
remainder of the instructions.

NOTE
IS department personnel will do this unless
they are willing to give out the user name
and password for a domain administrator
account.

NOTE
The cvuser utility exists in the c:\mei
directory of the MUSE CV Information
System file server. If cvuser is run from the
MUSE CV Information System file server,
the MUSE$$$001 parameter is not required
in the following steps.
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5. Type cvuser <Space> MUSEXXX <Space> MUSE$$$001
(MUSEXXX corresponds to the computer name of all MUSE 
nodes except for the file server)

Create User Accounts Using User
Manager for Domains

1. Log in to the domain using a domain administrator account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select User → New User.

Create the MUSEAdmin User Account

1. Enter User Name MUSEAdmin.

2. Enter Full Name MUSEAdmin.

3. Enter Description MUSE CV Information System 
Administrator.

4. Enter Password Muse!Admin.

5. Confirm the Password.

6. Uncheck the User Must Change Password at Next Logon box.

7. Check the Password Never Expires box.

NOTE
The cvuser utility will create new user
accounts in the domain as well as place
newly created user accounts into the local
MUSE Users group on the MUSE CV system
file server.

The MUSEAdmin and MUSEBkgnd
accounts will also be placed in the local
Administrators group on the MUSE CV
Information System file server. Therefore if
using the cvuser utility, skip “Updating MUSE
File Server Local Groups” and go directly to
“Configuring User Options” on page 3-11.

NOTE
The user/names used here are the
Marquette suggested user/names

If other user/names are required by the
customer, use them in place of the
suggested names. Inform Tech Support if
different user/names are used.

If using customer required user/names in
place of the suggested user names,
remember to use these names for the
remainder of the instructions.
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8. Select Add.

Create the MUSEBkgnd User Account

1. Enter User Name MUSEBkgnd.

2. Enter Full Name MUSEBkgnd.

3. Enter Description MUSE CV Information System 
Background Task.

4. Enter Password Muse!Bkgnd.

5. Confirm the Password.

6. Uncheck the User Must Change Password at Next Logon box.

7. Check the Password Never Expires box.

8. Select Add.

Create User Accounts for MUSE CV Information System Nodes

1. Enter User Name MUSEXXX (where XXX corresponds to a 
MUSE node id).

2. Enter Full Name MUSEXXX (where XXX corresponds to a MUSE 
node id).

3. Enter Description MUSE CV Information System User.

4. Enter Password Muse!XXX (where XXX corresponds to a MUSE 
node id).

5. Confirm the Password.

6. Uncheck the User Must Change Password at Next Logon box.

7. Check the Password Never Expires box.

8. Select Add.
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Updating MUSE File
Server Local Groups

1. Log on to the MUSE CV system file server as MUSEAdmin.

◆ User name = museadmin (name is not case sensitive)

◆ Password = Muse!Admin (Password IS case sensitive)

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

Add Users to the Local
Administrators Group

1. Double click on the Administrators group.

2. Select Add.

3. Verify that the domain name is highlighted in the List Names 
From box. Select it if it is not highlighted.

4. Highlight the MuseAdmin account and select Add.

5. Highlight the MuseBkgnd account and select Add.

6. Select OK.

7. Select OK at the Local Group Properties dialog box.

Add Users to the Local MUSE
Users Group

1. Double click the MUSE Users group in the Group list.

2. Select Add.

3. Verify that the domain name is highlighted in the List Names 
From box. Select it if it is not highlighted.

4. Highlight the MuseAdmin account and select Add.

5. Repeat step 4 for MuseBkgnd and all Musexxx accounts where 
xxx is the MUSE node id.

6. Select OK.

7. Select OK in the Local Group Properties dialog box.

8. Select User → Exit to exit User Manager for Domains.
Revision F3-10 MUSE CV information system
419931-012



Installation: Intel File Server Installation
Configuring User Options 1. Log in to the domain as MuseAdmin with the case sensitive 
password Muse!Admin

2. At the Welcome to Windows NT screen select Close.

3. Move the My Briefcase folder to the Recycle Bin.

Set the Taskbar options. 1. Select Start → Settings → Taskbar….

2. Select Always on top.

3. Select Show small icons in Start menu.

4. Select Show clock.

5. Select OK to exit.

Set the Screen Saver

1. Right click on the desktop, select Properties.

2. Select the Screen Saver tab.

3. Select the Logon Screen Saver.

4. Check Password Protected.

5. Set the Timeout to 15 minutes.

6. Select OK to exit.

Set the Command Prompt options:

1. Select Start → Settings → Control Panel → Console.

2. Select the Options tab.

3. Select Large for the Cursor Size.

4. Select the Layout tab.

5. Enter 80 for the Screen Buffer Width.

6. Enter 50 for the Screen Buffer Height.

7. Enter 80 for the Window Width.

8. Enter 50 for the Window Height.

9. Select OK to exit.

Set the Explorer Options

1. Double click My Computer.

2. Select View → Toolbar.

NOTE
The second time logging into the domain as
MUSEAdmin, there will be a checkbox
labeled Show this Welcome Screen…
message. Uncheck the box so the message
will not appear any more.
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3. Select View → Options.

4. Select Browse folders by using a single window that changes as 
you open each folder.

5. Select the View tab.

6. Select Show all files.

7. Select Display the full path in the title bar.

8. Deselect Hide file extensions for known file types.

9. Select Display compressed files and folders with alternate color.

10. Select OK to exit.

Updating User Account
for MUSE Services

1. Log on to the domain using the MUSEAdmin account.

2. Select Start → Programs → Command Prompt.

3. Type:

cvsinst <Space> Hospitaldomain\MUSEBkgnd 
Muse!Bkgnd d:\vol000\system\sysinf\services.asc

(where “Hospitaldomain” is the domain that the MUSE CV 
system is a member of)

4. Type exit and press Enter to close the Command Prompt 
window. 

Configuring IMS Updating the User Account for IMS

1. Select Start → Run.

2. Type dcomcnfg and click OK.

3. In the Distributed COM Configuration Properties application 
list, choose MUSE-CV IMS Cserver and select Properties... .

4. Select the Identity tab.

5. Verify that the This User radio button is selected.

6. Type Hospitaldomain\MUSEBkgnd in the User field where 
Hospitaldomain is the hospital domain to which the MUSE 
system belongs.

7. Type Muse!Bkgnd for Password and Confirm Password.

8. Select OK.

9. At the Distributed COM Configuration Properties dialog box, 
select OK.

Configuring Email Notification of the IMS Log

If the user wants the IMS_RPT.LOG file emailed, configure the log file 
reporting mechanism.
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1. Install the temporary IMS Email support utility BLAT.EXE. 
BLAT.EXE – INSTALL <smtp address>, where smtp is replaced 
by the site’s email server.

2. Uncomment and modify the IMSRPT.BAT file’s BLAT.EXE entry.

◆ The -i parameter should be the name of your server.

◆ The -f parameter should be the Email address of the primary 
technician.

◆ Use the -t parameter to include all of the addresses of users 
that should receive a copy of the IMS summary file.

◆ For example: blat %1\ims_rpt_%2.log -s "MUSE-IMS %2" -i 
MUSESTJ001 -f joe.smith@diageng.mei.com -t 
john.brown@diageng.mei.com, 
mary.kline@diageng.mei.com

In this example, the from field in the Email message is the 
MUSE CV Information System file server named 
MUSESTJ001. The user account of the sender is the primary 
tech, Joe Smith. The Email message is sent to John Brown 
and Mary Kline.

Configuring Nightly Auto Run Time

1. Select Start → Run.

2. Type cvis0122 and select OK.

3. Select Set Auto Run Time... from the System menu.

4. Using the WinAt application, right click in the white client area. 
Add the command cvis0122 -autorun and set the hour of 
operation. Exit the WinAt application.

5. Exit MUSE-IMS.

Install Network Printing If the MUSE CV system has a network printer, install it at this time. See 
“Installing Network Printers” for details.
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Defining a New MUSE CV
System User

Defining users of the MUSE CV system is a four-part process.

■ Define an NT user account
■ Include the NT user account into an NT local group called 

MUSE Users on the MUSE CV system file server.
■ The user must also be defined within the MUSE CV system 

application. (This is no different from how users were defined in 
pre-Windows NT versions of the MUSE system.)

■ Map a Windows NT user account to a MUSE CV system account.

Defining a Windows NT User
Account

Windows NT user accounts for the MUSE CV system should be domain 
accounts. These accounts must be created by someone who has the 
ability to add users to the domain. This is typically done by a domain 
administrator. If the MUSE CV system file server is its own primary 
domain controller, the Administrator account or the MUSEAdmin 
account (if it exists) should be used to create new domain accounts. If 
the MUSE CV system file server is a member server in an existing 
hospital domain, someone from the hospital IS department who can log 
on as a domain administrator must create the new accounts.

The procedures below explain how to create the required MUSE CV 
system Windows NT user accounts. The preferred and easier way to 
create the accounts is to use the cvuser utility found in the c:\mei 
directory of the MUSE CV system file server. User Manager for Domains 
can also be used to manually create the accounts. Hospital IS 
department personnel will also create NT user accounts for hospital 
personnel that will use the MUSE CV system. These accounts will not be 
created using the steps below. They will be created in the way the 
hospital normally creates Windows NT user accounts.

Creating User Accounts Using
CVUSER

1. Login to the domain using a domain administrator account.

2. Select Start → Programs → Command Prompt.

3. Type cvuser <Space> MUSEAdmin <Space> MUSE$$$001 
(where $$$ is a three character abbreviation for the customer 
name and MUSE$$$001 is the computer name of the MUSE CV 
system file server).

4. Type cvuser <Space> MUSEBkgnd <Space> MUSE$$$001

NOTE
IS department personnel will do this unless
they are willing to give out the user name and
password for a domain administrator account.

NOTE
The cvuser utility exists in the c:\mei
directory of the MUSE CV system file server.
If cvuser is run from the MUSE CV system
file server, the MUSE$$$001 parameter is
not required.
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5. Type cvuser <Space> MUSEXXX <Space> MUSE$$$001 
(where XXX corresponds to a MUSE node id).

Creating User Accounts Using
User Manager for Domains

1. Log in to the domain using a domain administrator account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select User → New User.

Create the MUSEAdmin User
Account

1. Enter User Name MUSEAdmin

2. Enter Full Name MUSEAdmin.

3. Enter Description MUSE CV Information System 
Administrator.

4. Enter Password Muse!Admin.

5. Confirm the Password.

6. Uncheck the User Must Change Password at Next Logon box.

7. Check the Password Never Expires box.

8. Select Add.

Create the MUSEBkgnd User
Account

1. Enter User Name MUSEBkgnd.

2. Enter Full Name MUSEBkgnd.

3. Enter Description MUSE CV Information System 
Background Task.

4. Enter Password Muse!Bkgnd.

5. Confirm the Password.

6. Uncheck the User Must Change Password at Next Logon box.

7. Check the Password Never Expires box.

8. Select Add.

NOTE
The cvuser utility will place new newly created
user accounts into the local MUSE Users group
on the MUSE CV system file server. The
MUSEAdmin and MUSEBkgnd accounts will
also be placed in the local Administrators group
on the MUSE CV system file server. Therefore
if using the cvuser utility, skip “Adding Windows
NT User Accounts to Windows NT Local
Groups” and go directly to “Adding a User to the
MUSE CV System”.
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Create User Accounts for MUSE
Nodes

1. Enter User Name MUSEXXX (where XXX corresponds to a 
MUSE node id).

1. Enter Full Name MUSEXXX (where XXX corresponds to a MUSE 
node id).

2. Enter Description MUSE CV Information System User.

3. Confirm the Password.

4. Uncheck the User Must Change Password at Next Logon box.

5. Check the Password Never Expires box.

6. Select Add.

Adding Windows NT User
Accounts to Windows NT

Local Groups

All Windows NT user accounts that will be using the MUSE CV system 
must be members of the MUSE Users local group. This NT group is a 
local group on the MUSE CV system file server. In addition, the 
MUSEAdmin and MUSEBkgnd accounts must also be members of the 
local Administrators group on the MUSE CV system file server.

Add Users to the Local
Administrators Group

The following steps are performed only if the MUSEAdmin or 
MUSEBkgnd accounts have been newly created. Otherwise skip these 
steps and go to “Add Users to the Local MUSE Users Group”.

1. If the MUSE CV system file server is a primary domain 
controller, login to the domain using the MUSEAdmin account. 
If it is a member server in an existing hospital domain, login 
locally to file server using the Administrator account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Double click on the Administrators group listed under Groups in 
the bottom half of the screen.

4. Select Add.

5. Verify that the domain name is highlighted in the List Names 
From box. If it is not highlighted, select it .

6. Highlight the MUSEAdmin account and select Add.

7. Highlight the MUSEBkgnd account and select Add.

8. Select OK.

NOTE
To log into the MUSE CV system file server
locally when it is a member server in an
existing hospital domain, make sure the
computer name (i.e.. MUSE$$$001) is
highlighted in the domain box of the logon
screen. If the MUSE CV system file server is
a primary domain controller, logging into the
domain is the only option.
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9. Select OK at the Local Group Properties dialog box.

10. Select User → Exit to exit User Manager for Domains.

Add Users to the Local MUSE
Users Group

1. Login to the domain using the MUSEAdmin account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. At the Do you want to select another domain… message select 
Yes.

4. Enter MUSE$$$001 in the domain box (where $$$ is a three 
character abbreviation for the customer name and 
MUSE$$$001 is the computer name of the MUSE CV system file 
server).

5. Select OK.

6. Double click on the MUSE Users group listed under Groups in 
the bottom half of the screen.

7. Select Add.

8. Verify that the proper domain name is highlighted in the List 
Names From box. If it is not highlighted, select it.

9. Highlight the MUSEAdmin account and select Add.

10. Repeat step 9 for MUSEBkgnd and all MUSEXXX accounts 
where XXX is the Muse node number.

11. Repeat steps 8 and 9 for all Windows NT accounts for everyone 
who will use the MUSE CV system.

12. Select OK.

13. Select OK at the Local Group Properties dialog box.

14. Select User → Exit to exit User Manager for Domains.

NOTE
When adding MUSEAdmin and MUSEBkgnd
to the MUSE Users group, the proper
domain is the one that the MUSE CV system
is a member of. When adding a user account
of hospital personnel to the MUSE Users
group, choose the domain that the user
account belongs to.

NOTE
Step 8 is especially important when adding
users to the MUSE Users group from trusted
domains. The proper domain must be
specified in order to find the user.
Revision F 3-17MUSE CV information system
419931-012



Installation: Intel File Server Installation
Adding a User to the
MUSE CV System

The MUSE CV system requires all users to have a MUSE user account in 
addition to a Windows NT user account. These accounts are created the 
same way they have been in previous versions of the MUSE CV system 
software. A brief description of creating an account will be given here. 
For more information, see the “MUSE CV information system operator’s 
manual”.

1. Login to the domain using the MUSEAdmin account.

2. Select Start → Programs → MUSE CV Information System → 
Start MUSE CV.

3. From within the MUSE CV system, select System → System 
Setup.

4. Select Select List → Users.

5. Fill in the user fields appropriately. (Consult the “MUSE CV 
information system operator’s manual” for more information.)

6. Select OK.

7. Select Options → Save Changes.

Mapping a Windows NT
User to a MUSE CV

System User

The NT Users program maps or associates a Windows NT user account 
with a MUSE CV system user account. This mapping is necessary for a 
user to logon at a workstation where the MUSE CV system software was 
installed with the Use MUSE Login? question answered No. This allows 
NT authentication of a domain user. When the domain user starts the 
MUSE CV system application, the MUSE CV system checks to see if the 
NT user account is mapped to a MUSE CV system account. If it is, the 
user is authenticated and the Edit List appears. If it is not, an error 
message will appear and access to the MUSE CV system is denied. If the 
user will logon only at workstations where the MUSE CV system 
software was installed with the Use MUSE Login? question answered 
Yes, then the mapping or association between a Windows NT user 
account and a MUSE CV system user account is not needed. MUSE CV 
system authentication will be used. This means that the user will be 
presented with a MUSE CV system Authorization window when the 
MUSE CV system application is started.

1. Login to the domain using the MUSEAdmin account.

2. Select Start → Programs → MUSE CV Information System → 
Setup → NT Users.

3. Select Users → New.

4. Enter the NT User Name.

5. Select the MUSE site that the MUSE user is defined in.

6. Select the MUSE user name.

NOTE
The name should be in the form Domain
Name\User Name.
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7. Select OK.

8. Repeat as needed for all users.

Windows NT Domain
Trusts (PDCs Only)

When the MUSE CV system file server functions as the primary domain 
controller of its own domain, it is possible that the hospital IS 
department will not add domain user accounts for hospital personnel to 
the MUSE CV system domain. These people may already have accounts 
in an existing hospital domain or the hospital IS department will create 
accounts for them in an existing hospital domain to keep user account 
administration easier. If this is the case, a domain trust will need to be 
established. A trust must be created between each hospital domain that 
contains user accounts of hospital personnel desiring to use the MUSE 
CV system and the MUSE CV system domain. The MUSE CV system 
domain will be the trusting domain and the hospital domain will be the 
trusted domain. Creating the trust replaces creating the Windows NT 
user accounts as described in “Defining a Windows NT User Account”. 
The steps in “Adding Windows NT User Accounts to Windows NT Local 
Groups”, “Adding a User to the MUSE CV System”, and “Mapping a 
Windows NT User to a MUSE CV System User” should be performed as 
described.

Trusting of Hospital Domain(s) by
the MUSE Domain

NT Domain Trust Setup in the Hospital Domain

1. Login to the hospital domain using a domain administrator 
account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select Policies → Trust Relationships… .

4. Select the Add button to the right of the Trusting Domain box.

5. Enter the MUSE CV system domain name in the Domain field.

6. Enter a password. In the Password field. (This step is optional.)

7. Select OK. The MUSE CV system domain name should appear in 
the Trusting Domains box.

NT Domain Trust Setup in the MUSE CV System Domain

1. Login to the MUSE CV system domain using the MUSEAdmin 
account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select Policies → Trust Relationships… .

NOTE
If the “trusted domains” relationship is
established before the “trusting domains”
relationship, it can take up to 15 minutes for
the trust to take effect.
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4. Select the Add button to the right of the Trusted Domains box.

5. Enter the hospital domain name in the Domain box.

6. If a password was entered in “NT Domain Trust Setup in the 
Hospital Domain”, enter the same password in the Password 
box.

7. Select OK.

The hospital’s domain name should appear in the Trusted 
Domains box.

Trusting of the MUSE by Hospital
Domain(s)

NT Domain Trust Setup in the MUSE CV System Domain

1. Login to the MUSE domain using the MUSEAdmin account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select Policies → Trust Relationships… .

4. Select the Add button to the right of the Trusting Domain box.

5. Enter the hospital domain name in the Domain field.

6. Enter a password. In the Password field. (This step is optional.)

7. Select OK. The hospital’s domain name should appear in the 
Trusting Domains box.

NT Domain Trust Setup in the Hospital Domain

1. Login to the hospital domain using the domain administrator 
account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select Policies → Trust Relationships… .

4. Select the Add button to the right of the Trusted Domains box.

5. Enter the MUSE CV system domain name in the Domain box.

6. If a password was entered in “NT Domain Trust Setup in the 
MUSE CV System Domain”, enter the same password in the 
Password box.

7. Select OK.

The MUSE CV system domain name should appear in the 
Trusted Domains box.

NOTE
If the “trusted domains” relationship is
established before the “trusting domains”
relationship, it can take up to 15 minutes for
the trust to take effect.
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Verifying Network Setup
(Win 95 Clients)

For all Windows 95 clients, verify the network setup.

1. Double-click the Network icon from the Control Panel window.

2. Verify that TCP/IP is the only protocol in the list.

3. Click File and Print Sharing… .

4. Make sure all check boxes are checked. Click OK.

5. Click File and Print Sharing ...

6. Click Properties.

7. Verify Browser Master is selected in the Property Area.

8. Click pull-down Value and select Disabled.

9. Click OK.

10. Click TCP\IP. Click Properties.

11. Click the radio button Specify and IP address.

12. Verify/enter the IP Address of the node.

node_id

13. Verify/enter the Subnet Mask of the node.

14. Click DNS Configuration tab.

15. Click radio button Enable DNS.

16. Verify/enter the Host name.

17. Click OK.

18. Click Client for Microsoft Networks icon and click Properties.

19. In the Logon validation section, click Log on to Windows NT 
domain.

20. Verify/edit the Windows NT Domain:

◆ If MUSE file server is the Primary Domain Controller, verify/
edit MUSE$$$

◆ If MUSE file server is a member server, verify/edit hospital’s 
domain

21. Click the Quick Logon radio button.

22. Click OK.

23. Click Primary Network Logon pull down and select Windows 
Logon.

24. Click OK.

25. Click Yes to restart the computer.

26. Verify MUSEXXX is in the User Name field.

27. Type Muse!XXX in the Password edit field.

28. Verify Domain field
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◆ If MUSE file server is the Primary Domain Controller, verify/
edit MUSE$$$

◆ If MUSE file server is a member server, verify/edit hospital’s 
domain

29. Verify that the Save this password… check box is checked.

30. Click OK.

Verifying Network
Setups (WFW Clients)

For all WFW clients, verify the network setup as described in this 
section.

1. Select Program Manager → Network → Network Setup.

2. Click the Drivers... button.

3. Highlight Microsoft TCP/IP and then click the Setup... button.

4. If DHCP was selected in the Pre-Build Site Survey (419931-007), 
check the Enable Automatic DHCP Configuration checkbox.

5. If a static IP Address was entered in the Site Survey, enter IP 
Address, Subnet Mask, and Default Gateway.

6. If WINS Server was entered in the Site Survey, enter WINS Server 
IP address.

7. If Secondary WINS Server was entered in the Site Survey, enter 
Secondary WINS Server IP address.

8. If DNS was checked in Site Survey, select the DNS... button.

◆ Enter Domain Name.

◆ Enter IP addresses in list.

◆ Select OK.

9. Select Advanced... button in TCP/IP Configuration window.

◆ If DNS was checked in Site Survey, check the Enable DNS for 
Windows Name Resolution checkbox.

◆ If LMHOSTS was checked in Site Survey, check the Enable 
LMHOSTS Lookup checkbox.

◆ Select OK.

10. Select OK.

11. Select Close.

12. Select OK in the next two windows.

13. Select Continue.

14. Select Main → Control Panel → Network and verify the 
following:

◆ Computer Name MUSE$$$$XXX
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◆ Workgroup MUSE$$$ (if file server is PDC)
Workgroup [Hospital Domain] (if file server 
member server)

◆ Default Logon Name MUSEXXX

15. Select Startup button.

◆ Verify Logon On to Windows NT... checkbox is checked.

◆ Enter MUSE$$$ (if file server is PDC)
Enter [Hospital Domain] (if file server is member server)

◆ Verify Don’t Display Message... checkbox is checked.

◆ Select OK.

16. Close Program Manager.

17. Select OK to confirm your choice.

18. Press Ctrl + Alt + Delete to restart computer.

The first time you start MUSE a screen appears prompting you 
enter Name, Password, and Domain. Name and Domain will 
already be entered correctly. 

19. Enter Muse!XXX (where XXX = Node_id) for Password and 
select OK.

NOTE
The Password prompt appears only the first
time you logon. It will not be necessary to
enter this information every time you logon.
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Installing Windows NT
Server 4.0

Service Pack 4

1. Make sure that you are logged in as Administrator.

2. Insert the MUSE Software CD in CD-ROM drive.

3. Click Start → Run... .

4. Type Z:\BAT\SP4MDAC.BAT and left click OK.

System will automatically copy files and setup apps.

5. At the Microsoft Windows Year 2000... prompt, left click Yes to 
restart system.

NOTE
If you are reinstalling ANYTHING from the
original Windows NT 4.0 CD-ROM, you
MUST REINSTALL the Windows NT 4.0 Service
Pack. If you do not need to reinstall Windows
NT 4.0 Service Pack, continue with “Creating
an Emergency Repair Disk”.
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Creating an Emergency
Repair Disk

This is the final step in the MUSE CV Information System installation 
process. Before performing the following steps, the file server and 
clients should be installed and working on the network. Once all nodes 
can login to the domain and appear to be functioning properly, the 
emergency repair disk can be created.

1. Insert a floppy disk.

2. Select Start → Run.

3. Type rdisk <Space> /s and press Enter.

4. At the Setup can create an Emergency Repair disk... screen, select 
Yes.

5. At the Label a floppy disk... screen, select OK.

6. At the Windows NT repair information contains... screen, select 
OK.

7. Remove the floppy disk, date and label it MUSE$$$001 
Emergency Repair Disk, where $$$ is the three-character 
abbreviation for the hospital name.

Merging Residual Data
into the Database

If this is a “forklift upgrade” (file server is replacing a Marquette DEC-
based tower or a PC-based MUSE system file server), the customer’s 
database was previously copied and sent to Marquette for conversion. 
The converted database is on the new file server. Any additional data 
which the customer collected since the copy of the database was sent to 
Marquette for conversion is referred to as “residual data”.

See “MUSE CV information system Merging Residual Data (Version 
005A)” (PN 419931-017) for detailed procedures.
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Installing Network Printers

Introduction Marquette Medical Systems, Inc. only supports printer that it sells. 
PostScript output must be Adobe PostScript Level 2 raw output.

The HP 4000N PostScript printer drivers must be used for network 
printing. The drivers are on the CD-ROM (PN 420858-001).

Validation has been done on the drivers that ship with Windows NT 4.0 
and Windows 95 (not to be confused with the MUSE CV Word printer 
drivers – (PN 419637-000) – which is the proper printer driver for 
Windows for Workgroups operating system).

If network printing is not used, the PostScript printer must be 
connected to a MUSE node via the printer port. A MUSE CV device is 
configured for this printer, and it is not required to have an operating 
system printer driver loaded for normal MUSE operation.

The following three general options exist for MUSE network printing:

1. Networked printers served by the MUSE CV file server or 
another Windows NT printer server.

2. Networked printers served by a Novell print server

3. Microsoft’s peer to peer shared printer connected to the printer 
port of a MUSE client or customer client.

Option # 1 is the preferred configuration for network printing option for 
the MUSE CV system.

The customer is responsible for installing the Netware Client onto the 
MUSE-CV system. This is not the responsibility of Marquette.
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Configuring a MMS
Network Printer

This section serves as a quick guide to configure the HP LaserJet 4000N 
as a network printer. For more complete details on setup see the 
printer’s manual.

Before You Begin Before you begin, obtain the following necessary information:

■ Printer’s IP address

■ Printer’s Subnet mask

■ Printer’s default gateway

Set Up The Printer All setup of the printer is done using the display panel located on the 
front/top of the printer.

1. Press + Menu seven times until the EIO2 JetDirect Menu is 
displayed.

2. Press + Item once or until the cfg network=no * is displayed.

3. Press Value + and select to display the cfg network=yes.

4. Press Item + so the Novell=off item is displayed.

5. Press Item + so the DLC/LLC=off item is displayed

6. Press Item + so the TCP/IP=off item is displayed (if the item is 
TCP/IP=on than skip to the next step). Press Value + and select 
to change TCP/IP=on.

7. Press Item + so the ETALK=off item is displayed.

8. Press Item + so the cfg TCP/IP=no item is displayed. Press 
Value + and select to display cfg TCP/IP=yes.

9. Press Item + to display bootp=no.

10. Press Item + to display IP byte 1=xxx. Press the Value + key 
until the desired most significant byte for the IP address is set 
and press Select.

11. Press Item + to display IP byte 2=xxx. Press the Value + key 
until the desired byte for the IP address is set and press Select.

12. Press Item + to display IP byte 3=xxx. Press the Value + key 
until the desired byte for the IP address is set and press Select.

13. Press Item + to display IP byte 4=xxx. Press the Value + key 
until the desired byte for the IP address is set and press Select.

14. Press Item + to display SM byte 1=xxx. Press the Value + key 
until the desired value for the item is set and press Select.

15. Press Item + to display SM byte 2=xxx. Press the Value +key 
until the desired value for the item is set and press Select.

16. Press Item + to display SM byte 3=xxx. Press the Value + key 
until the desired value for the item is set and press Select.

17. Press Item + to display SM byte 4=xxx. Press the Value + key 
until the desired value for the item is set and press Select.
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18. Press Item + five times to display GW byte 1=xxx (leave the LG 
byte values set to the default). Press the Value + key until the 
desired value for the item is set and press Select.

19. Press Item + to display GW byte 2=xxx. Press the Value + key 
until the desired value for the item is set and press Select.

20. Press Item + to display GW byte 3=xxx. Press the Value + key 
until the desired value for the item is set and press Select.

21. Press Item + to display GW byte 4=xxx. Press the Value + key 
until the desired value for the item is set and press Select.

22. Press Item + to display the Timeout=120 value.

23. Press Go when setup is complete.

Printout of Printer’s Configuration To printout the printer’s configuration follow the steps below.

1. From the ready state, press the Menu button one time to 
display the information menu.

2. From the information menu, press the Item + button two times 
to display the Print printer configuration.

3. The current printer configuration will be printed.

Configuring MUSE CV
System to Print to

Printers Shared by the
Server To properly configure and test network printer ensure the following:

1. Ensure that the Network Printing option is enabled on the 
MUSE CV system.

2. Each network printer must be physically attached to the 
network which the printer server is on.

3. Each network printer must be configured with TCP/IP.

Follow the steps below to setup a network printer for use by the MUSE 
CV Information system using the MUSE CV Information system file 
server as the print server.

1. Configure the printer to be a TCP networked printer.  The 
printer requires a unique IP address, subnet mask, and default 
gateway that is specific to the printer’s installation area.  Refer to 
“Configuring a MMS Network Printer” or the OEM manual 
which shipped with the printer for detailed instructions.

2. Connect the printer to the network.

3. Use TCP service Ping to ensure proper accessibility over the 
network to the printer from the NT print server.  For a MS-DOS 
prompt on the NT print server, type ping <Space> 

NOTE
Use this guide to setup a network printer for
any Windows NT Server.
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xxx.xxx.xxx.xxx (where xxx.xxx.xxx.xxx is the IP address of the 
printer).

4. Logon to the MUSE CV system file server using a local 
administrator account.

5. Select My Computer → Printers.

6. Select Add Printer.

Ensure that the My Computer radio button is selected and select 
Next.

7. Select Add Port.

8. From the Available Printer Ports box, select the LPR Port option 
and select the New Port button.

9. Type the IP address of the new printer in the Name or Address of 
Server field.

10. Type raw in the Name of printer or print queue field and select 
OK.

11. Select Close.

12. In the Add Printer Wizard dialog box select Have Disk... .

13. Insert the MUSE Software CD (PN 420858-001) and type 
z:\hpprint\nt and select OK.

14. Select HP LaserJet 4000 Series PS and select Next>>.

15. Enter the printer logical name as it appears on the Pre-Build Site 
Survey for this system.

16. Verify that the Keep Existing Driver radio button is selected and 
select Next.

17. At the Add printer wizard printer name, enter a name (i.e. 
hplj4000n01)

18. At the Do you want your Windows-based… message, verify that 
the No radio button is selected and select Next.

19. Select the Shared radio button, enter a share name, and select 
Next.

20. At the Would you like to print a test page? message, select Finish.

21. At the Printer test page completed message, select Yes.
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22. Add the printer as a MUSE CV Information system device. See 
the “MUSE CV information system operator’s manual” for more 
information.

Configuring MUSE CV
System to Print to Novell

Shared Printers

The Gateway (and Client) Services for Netware (GSNW) need to be 
installed to print to printers driven by Novell.  To add GSNW:

1. Log on to the file server using a local administrator account.

2. Select Start → Settings → Control Panel.

3. Double click the Network icon.

4. Click the Services tab.

5. Click Add.

6. Click Gateway (and Client) Services for Netware, and click OK.

7. Type the path to the GSNW files, and click Continue.

8. In the Client Servies for NetWare Dialog box, check Preferred 
Server and enter None for the Select Preferred Server field.

9. Restart the computer for the changes to take effect.  After the 
changes take effect, there will be a GSNW icon added to the 
Control Panel window.

Activating the Gateway Before enabling a gateway on a computer running Windows NT Server:

1. A user account must be set up on the NetWare network with the 
necessary rights for the printers you want to access.

2. The NetWare server must have a group named NTGATEWAY 
with the necessary rights for the printers you want to access.

3. The NetWare user account you use must be a member of the 
NTGATEWAY group.

If MUSE CV Word is required to print to a NetWare printer, install the 
NetWare gateway.  The NetWare gateway service allows the MUSE CV 
system file server the capability of re-sharing the Novell printer shares.  
This enables a central administration point for the NetWare printing 
from the MUSE CV system.  Follow the steps below to activate the 
NetWare gateway.

NOTE
When setting up the device in the MUSE CV
information system, define it with a type of
Postscript, check the Remote device
checkbox, and enter a UNC Name of
(\\servername\sharename)
where (\\servername)  is the name of the
MUSE CV information system file server and
\sharename is the name of the share
specified when adding the printer with the
NT print wizard.
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1. In the Gateway Services for NetWare dialog box, verify that the 
preferred server field is None or as specified by the customer’s 
IS support.

2. Click Gateway.

3. Select the Enable Gateway check box.

4. Type the NetWare user account created to logon to the NetWare 
server from a computer running Windows NT Server, and click 
Add.  This account should be MUSEBkgnd with a password of 
Muse!Bkgnd).

Now this network printer must be configured within the MUSE 
application, see “MUSE CV information system operator’s manual” for 
more information on configuring a MUSE CV system remote/network 
printer.

Configuring Peer to Peer
Printers

This section explains how to configure MUSE CV system network 
printers which are local printers shared by Windows NT, Windows 95, or 
Windows for Workgroup 3.11.

Windows NT 1. Logon to the NT 4.0 workstation using a local administrator 
account.

2. Select My Computer → Printers.

3. Select Add Printer.

4. Ensure that the My Computer radio button is selected and select 
Next.

5. From the Available Printer Ports box, select the LPT Port option 
which the printer is attached to and press the Next>> button.

6. In the Add Printer Wizard dialog box select Have Disk... .

7. Insert the MUSE Software CD (PN 420858-001) and type 
z:\hpprint\nt and select OK.

8. Select HP LaserJet 4000 Series PS and select Next>>.

9. Do not mark this printer as the default printer.

10. Enter the printer logical name as it appears on the Pre-Build Site 
Survey for this system.

11. Check the Shared box and enter the same share name from the 
printer name field in step 8.

12. Answer/verify Yes when prompted Would you like to print a test 
page? And select Finish.

13. Verify that the test page printed properly.
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Windows 95 Verify that the client’s file and print sharing is set so it may share its 
printers on the network.  This setup must take place after the network is 
setup.  Select Start → Control Panel → Networking. Verify that the File 
and Print Sharing service is loaded and active.  For more details see the 
proper installation section on network setup for the Windows 95 client.

1. Select Start → Settings → Printers.

2. From the Printers screen, double-click on Add Printer.

3. Select Local Printer and select Next>> .

4. In the Add Printer Wizard dialog box select Have Disk... .

5. Insert the MUSE Software CD (PN 420858-001)

6. From copy manufacturer’s files from screen, type 
z:\hpprint\win95 and select Next>> ..

7. Select HP LaserJet 4000 Series PS and select Next>>.

8. Check the printer port that the printer is physically connected to 
and select Next>> .

9. On the assigned name screen, type the Printer Name as 
specified from the pre-build survey.

10. Answer/verify Yes for the question: would you like to print a test 
page and select Finish.

11. Verify that the test page successfully prints.

12. From the Printers screen select the newly added printer.

13. Select File → Sharing... and check the Shared As button and 
enter the share name for the printer as specified in the pre-build 
survey.

Windows for Workgroups Verify that file and print sharing has already been activated in the 
previous build sets.

1. In the Control Panel window, double-click the Printers icon.

2. Check the Use Print Manger box.

3. In the List of Printers box, select/verify Install unlisted or 
Updated Printer.

4. Select the Install button.

5. Insert the MUSE Software CD (PN 420858-001).

6. Type z:\hpprint\wfw for the path.

7. Select OK in the Install Driver window.

8. Select the HP LaserJet 4000 Series PS 1200 driver and select OK.

9. From the Main program group, double-click the Printer 
Manager icon.

10. Share the printer by selecting Printer → Share Printer As… .

11. Enter the share name in the Share As: field as specified by the 
pre-build survey.
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Troubleshooting This section serves as a troubleshooting guide from frequently 
encountered problems with the installation and setup of MUSE CV 
network printing.

MUSE CV Checkout 1. Ping the IP address of the network printer from the file server or 
print server.

2. Select Start → Settings → Control Panel → Services and verify 
that CVIS0007 service is started.

3. Create a remote device in the MUSE CV system and print several 
reports or ECGs to the network printer.

4. Restart the MUSE CV system as described in chapter 4, 
“Integrated Maintenance Suite”.

Connectivity to the Printer If you are trying to print to a printer served by NT, it is likely that you will 
need a user account setup in the domain where the print server resides. 
That user must be setup to have PRINT permissions for that printer 
share (by default NT sets up this permission for EVERYONE and MUSE-
CV is setup to allow MUSE Users print rights). Verify that you can 
connect to the printer from a MS-DOS window. Type the following 
command:

NET <space> USE <Space> LPT3: <space> \\computer name\printer 
share name

If this command completes successfully than network printing from the 
MUSE CV system will work.

The printer name as it appears in the Network Neighborhood is not the 
printer’s share name. Verify that the share name is correct by looking at 
the share properties of the printer.

If this command fails try the following:

Ping <space> <IP Address> (where <IP Address> is the IP Address 
assigned to the printer)

If the printer replies, this is an indication that the printer is assigned the 
proper IP address.

Ping <space> <IP Address> (where <IP Address> is the IP Address 
assigned to the Printer Server)

If the printer server does not reply, this is an indication that there is a 
problem with NetBIOS name resolution. You may need to specify an 
LMHOSTS entry for the printer server and/or its NT domain, see 
LMHOSTS.SAM for more information on configuring LMHOSTS.

Error 67, The network name cannot be found

This error indicates that the wrong share name or computer name is 
being used for the net use command. Verify the proper share name of 
the printer by looking on the computer which is sharing the printer. Use 
caution since the printer name configured in NT does not have to match 
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the share name of the printer. The actual share name of the printer may 
be communicated incorrectly as the printer name.

If Pinging the printer server works, try doing a NET VIEW on the printer 
server as follows:

NET <Space> VIEW <Space> \\“Computername”

This command will return a list of resources for the printer server. In this 
list, verify the share name of the printer that you wish to print to.

If NET VIEW returns ERROR 6118, this is an indication that no Master 
Browser exists on the computer’s local network segment. If there are 
only WFWG nodes on the network segment, setup one of the nodes to 
be a Master Browser by following the steps below:

Use a text editor (such as MS-DOS Editor or Windows for Workgroups 
Notepad) to edit the SYSTEM.INI file on one machine in the workgroup 
and add the following entry to the [Network] section: 

        MaintainServerList=yes

You can also set a second computer in the workgroup to Auto and the 
remainder at "no." On each computer that you edit the SYSTEM.INI file, 
you must quit and restart Windows for Workgroups.

Error 5, Access denied message

This error is an indication that MUSE$$$XXX does not have proper 
access to the printer and/or NT printer server. Network printing on NT 
uses the MUSEBknd account which is located on the NT domain which 
the MUSE fileserver is logged into. This user account may need to be 
configured to have access to the print server and/or printer.

MUSE CV System Errors Error 1801: Task: 7, Error opening printer (\\xxx\xxx)

This error is an indication that the node running network printing 
cannot find the printer. Verify that the name is setup properly as a 
MUSE device (especially ensure the MUSE CV system Device Type is 
POSTCRIPT) 

No Output From Printer

Ensure that the MUSE CV system was shutdown and restarted if a MUSE 
CV system device has been added.

NOTE
By using LMHOSTS, it is not necessary to
“browse” the computer that has the shared
resources. It is nice to NET VIEW the
resources of that computer to verify the
printer share name.
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Defining a New MUSE CV System User

Introduction Defining users of the MUSE CV system is a four-part process.

■ Define an NT user account

■ Include the NT user account into an NT local group called 
MUSE Users on the MUSE CV system file server.

■ The user must also be defined within the MUSE CV system 
application. (This is no different from how users were defined in 
pre-Windows NT versions of the MUSE system.)

■ Map a Windows NT user account to a MUSE CV system account.

Defining a Windows NT
User Account

Windows NT user accounts for the MUSE CV system should be domain 
accounts. These accounts must be created by someone who has the 
ability to add users to the domain. This is typically done by a domain 
administrator. If the MUSE CV system file server is its own primary 
domain controller, the Administrator account or the MUSEAdmin 
account (if it exists) should be used to create new domain accounts. If 
the MUSE CV system file server is a member server in an existing 
hospital domain, someone from the hospital IS department who can log 
on as a domain administrator must create the new accounts.

The procedures below explain how to create the required MUSE CV 
system Windows NT user accounts. The preferred and easier way to 
create the accounts is to use the cvuser utility found in the c:\mei 
directory of the MUSE CV system file server. User Manager for Domains 
can also be used to manually create the accounts. Hospital IS 
department personnel will also create NT user accounts for hospital 
personnel that will use the MUSE CV system. These accounts will not be 
created using the steps below. They will be created in the way the 
hospital normally creates Windows NT user accounts.

Creating User Accounts Using
CVUSER

1. Login to the domain using a domain administrator account.

2. Select Start → Programs → Command Prompt.

3. Type cvuser <Space> MUSEAdmin <Space> MUSE$$$001 
(where $$$ is a three character abbreviation for the customer 

NOTE
IS department personnel will do this unless
they are willing to give out the user name
and password for a domain administrator
account.
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name and MUSE$$$001 is the computer name of the MUSE CV 
system file server).

4. Type cvuser <Space> MUSEBkgnd <Space> MUSE$$$001

5. Type cvuser <Space> MUSEXXX <Space> MUSE$$$001 
(where XXX corresponds to a MUSE node id).

Creating User Accounts Using
User Manager for Domains

1. Log in to the domain using a domain administrator account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select User → New User.

Create the MUSEAdmin User
Account

1. Enter User Name MUSEAdmin

2. Enter Full Name MUSEAdmin.

3. Enter Description MUSE CV Information System 
Administrator.

4. Enter Password Muse!Admin.

5. Confirm the Password.

6. Uncheck the User Must Change Password at Next Logon box.

7. Check the Password Never Expires box.

8. Select Add.

NOTE
The cvuser utility exists in the c:\mei
directory of the MUSE CV system file server.
If cvuser is run from the MUSE CV system
file server, the MUSE$$$001 parameter is
not required.

NOTE
The cvuser utility will place new newly created
user accounts into the local MUSE Users group
on the MUSE CV system file server. The
MUSEAdmin and MUSEBkgnd accounts will
also be placed in the local Administrators group
on the MUSE CV system file server. Therefore
if using the cvuser utility, skip “Adding Windows
NT User Accounts to Windows NT Local
Groups” and go directly to “Adding a User to the
MUSE CV System”.
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Create the MUSEBkgnd User
Account

1. Enter User Name MUSEBkgnd.

2. Enter Full Name MUSEBkgnd.

3. Enter Description MUSE CV Information System 
Background Task.

4. Enter Password Muse!Bkgnd.

5. Confirm the Password.

6. Uncheck the User Must Change Password at Next Logon box.

7. Check the Password Never Expires box.

8. Select Add.

Create User Accounts for MUSE
Nodes

1. Enter User Name MUSEXXX (where XXX corresponds to a 
MUSE node id).

1. Enter Full Name MUSEXXX (where XXX corresponds to a MUSE 
node id).

2. Enter Description MUSE CV Information System User.

3. Confirm the Password.

4. Uncheck the User Must Change Password at Next Logon box.

5. Check the Password Never Expires box.

6. Select Add.

Adding Windows NT User
Accounts to Windows NT

Local Groups

All Windows NT user accounts that will be using the MUSE CV system 
must be members of the MUSE Users local group. This NT group is a 
local group on the MUSE CV system file server. In addition, the 
MUSEAdmin and MUSEBkgnd accounts must also be members of the 
local Administrators group on the MUSE CV system file server.

Add Users to the Local
Administrators Group

The following steps are performed only if the MUSEAdmin or 
MUSEBkgnd accounts have been newly created. Otherwise skip these 
steps and go to “Add Users to the Local MUSE Users Group”.

1. If the MUSE CV system file server is a primary domain 
controller, login to the domain using the MUSEAdmin account. 
If it is a member server in an existing hospital domain, login 
locally to file server using the Administrator account.

NOTE
To log into the MUSE CV system file server
locally when it is a member server in an
existing hospital domain, make sure the
computer name (i.e.. MUSE$$$001) is
highlighted in the domain box of the logon
screen. If the MUSE CV system file server is
a primary domain controller, logging into the
domain is the only option.
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2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Double click on the Administrators group listed under Groups in 
the bottom half of the screen.

4. Select Add.

5. Verify that the domain name is highlighted in the List Names 
From box. If it is not highlighted, select it .

6. Highlight the MUSEAdmin account and select Add.

7. Highlight the MUSEBkgnd account and select Add.

8. Select OK.

9. Select OK at the Local Group Properties dialog box.

10. Select User → Exit to exit User Manager for Domains.

Add Users to the Local MUSE
Users Group

1. Login to the domain using the MUSEAdmin account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. At the Do you want to select another domain… message select 
Yes.

4. Enter MUSE$$$001 in the domain box (where $$$ is a three 
character abbreviation for the customer name and 
MUSE$$$001 is the computer name of the MUSE CV system file 
server).

5. Select OK.

6. Double click on the MUSE Users group listed under Groups in 
the bottom half of the screen.

7. Select Add.

8. Verify that the proper domain name is highlighted in the List 
Names From box. If it is not highlighted, select it.

9. Highlight the MUSEAdmin account and select Add.

10. Repeat step 9 for MUSEBkgnd and all MUSEXXX accounts 
where XXX is the Muse node number.

NOTE
When adding MUSEAdmin and MUSEBkgnd
to the MUSE Users group, the proper
domain is the one that the MUSE CV system
is a member of. When adding a user account
of hospital personnel to the MUSE Users
group, choose the domain that the user
account belongs to.
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11. Repeat steps 8 and 9 for all Windows NT accounts for everyone 
who will use the MUSE CV system.

12. Select OK.

13. Select OK at the Local Group Properties dialog box.

14. Select User → Exit to exit User Manager for Domains.

Adding a User to the
MUSE CV System

The MUSE CV system requires all users to have a MUSE user account in 
addition to a Windows NT user account. These accounts are created the 
same way they have been in previous versions of the MUSE CV system 
software. A brief description of creating an account will be given here. 
For more information, see the “MUSE CV information system operator’s 
manual”.

1. Login to the domain using the MUSEAdmin account.

2. Select Start → Programs → MUSE CV Information System → 
Start MUSE CV.

3. From within the MUSE CV system, select System → System 
Setup.

4. Select Select List → Users.

5. Fill in the user fields appropriately. (Consult the “MUSE CV 
information system operator’s manual” for more information.)

6. Select OK.

7. Select Options → Save Changes.

NOTE
Step 8 is especially important when adding
users to the MUSE Users group from trusted
domains. The proper domain must be
specified in order to find the user.
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Mapping a Windows NT
User to a MUSE CV

System User

The NT Users program maps or associates a Windows NT user account 
with a MUSE CV system user account. This mapping is necessary for a 
user to logon at a workstation where the MUSE CV system software was 
installed with the Use MUSE Login? question answered No. This allows 
NT authentication of a domain user. When the domain user starts the 
MUSE CV system application, the MUSE CV system checks to see if the 
NT user account is mapped to a MUSE CV system account. If it is, the 
user is authenticated and the Edit List appears. If it is not, an error 
message will appear and access to the MUSE CV system is denied. If the 
user will logon only at workstations where the MUSE CV system 
software was installed with the Use MUSE Login? question answered 
Yes, then the mapping or association between a Windows NT user 
account and a MUSE CV system user account is not needed. MUSE CV 
system authentication will be used. This means that the user will be 
presented with a MUSE CV system Authorization window when the 
MUSE CV system application is started.

1. Login to the domain using the MUSEAdmin account.

2. Select Start → Programs → MUSE CV Information System → 
Setup → NT Users.

3. Select Users → New.

4. Enter the NT User Name.

5. Select the MUSE site that the MUSE user is defined in.

6. Select the MUSE user name.

7. Select OK.

8. Repeat as needed for all users.

NOTE
The name should be in the form Domain
Name\User Name.
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Windows NT Domain
Trusts (PDCs Only)

When the MUSE CV system file server functions as the primary domain 
controller of its own domain, it is possible that the hospital IS 
department will not add domain user accounts for hospital personnel to 
the MUSE CV system domain. These people may already have accounts 
in an existing hospital domain or the hospital IS department will create 
accounts for them in an existing hospital domain to keep user account 
administration easier. If this is the case, a domain trust will need to be 
established. A trust must be created between each hospital domain that 
contains user accounts of hospital personnel desiring to use the MUSE 
CV system and the MUSE CV system domain. The MUSE CV system 
domain will be the trusting domain and the hospital domain will be the 
trusted domain. Creating the trust replaces creating the Windows NT 
user accounts as described in “Defining a Windows NT User Account”. 
The steps in “Adding Windows NT User Accounts to Windows NT Local 
Groups”, “Adding a User to the MUSE CV System”, and “Mapping a 
Windows NT User to a MUSE CV System User” should be performed as 
described.

Trusting of Hospital Domain(s) by
the MUSE Domain

NT Domain Trust Setup in the Hospital Domain

1. Login to the hospital domain using a domain administrator 
account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select Policies → Trust Relationships… .

4. Select the Add button to the right of the Trusting Domain box.

5. Enter the MUSE CV system domain name in the Domain field.

6. Enter a password. In the Password field. (This step is optional.)

7. Select OK. The MUSE CV system domain name should appear in 
the Trusting Domains box.

NT Domain Trust Setup in the MUSE CV System Domain

1. Login to the MUSE CV system domain using the MUSEAdmin 
account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select Policies → Trust Relationships… .

4. Select the Add button to the right of the Trusted Domains box.

5. Enter the hospital domain name in the Domain box.

NOTE
If the “trusted domains” relationship is
established before the “trusting domains”
relationship, it can take up to 15 minutes for
the trust to take effect.
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6. If a password was entered in “NT Domain Trust Setup in the 
Hospital Domain”, enter the same password in the Password 
box.

7. Select OK.

The hospital’s domain name should appear in the Trusted 
Domains box.

Trusting of the MUSE by Hospital
Domain(s)

NT Domain Trust Setup in the MUSE CV System Domain

1. Login to the MUSE domain using the MUSEAdmin account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select Policies → Trust Relationships… .

4. Select the Add button to the right of the Trusting Domain box.

5. Enter the hospital domain name in the Domain field.

6. Enter a password. In the Password field. (This step is optional.)

7. Select OK. The hospital’s domain name should appear in the 
Trusting Domains box.

NT Domain Trust Setup in the Hospital Domain

1. Login to the hospital domain using the domain administrator 
account.

2. Select Start → Programs → Administrative Tools → User 
Manager for Domains.

3. Select Policies → Trust Relationships… .

4. Select the Add button to the right of the Trusted Domains box.

5. Enter the MUSE CV system domain name in the Domain box.

6. If a password was entered in “NT Domain Trust Setup in the 
MUSE CV System Domain”, enter the same password in the 
Password box.

7. Select OK.

The MUSE CV system domain name should appear in the 
Trusted Domains box.

NOTE
If the “trusted domains” relationship is
established before the “trusting domains”
relationship, it can take up to 15 minutes for
the trust to take effect.
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Adjusting Fmtopts.xxx Print Settings

Starting with software version 005A, the MUSE CV system uses a print 
library for PC-based plot formatting. For each data type, report 
formatting can be adjusted by editing its appropriate Fmtopts.xxx file 
using any text editor (where the xxx file extension indicates the data 
type). The path to the Fmtopts files is d:\vol000\system\sysinf\.

When opened with the Notepad accessory, the d:\vol000\system\sysinf\ 
Fmtopts.ecg file appears as shown below.

MD1313-1A
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Change the Font To change a particular font, edit the appropriate FontNum line using the 
following information:

For example, in the figure shown, the title is currently set to be the 
Helvetica font.

To change the title to the Times Roman font, change the “2” to a “1” as 
shown.

Change the Font Modifier To change a font modifier, edit the appropriate FontModifier line using 
the following information:

Change Sizes All sizes are in 1/100 mm.
0x## numbers are hexadecimal numbers.
0## numbers are octal numbers.
## numbers are decimal numbers.

FontNum Settings

Number PS/PCL/FAX Thermal

0 Courier Monospaced

1 Times Roman Proportional

2 Helvetica Proportional

bTitleFontNum : 0x2

Helvetica

bTitleFontNum : 0x1

Times Roman

FontModifier Settings

Number PS/PCL/FAX Thermal

0 none N/A

1 Bold N/A

2 Italic N/A

3 Bold Italic N/A
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General Rules for Editing
Fmtopts.xxx Files

1. Edit only the following lines:

wWaveformThickness
bTitleFontNum
bTitleFontModifier
bTitleFontSize
bDiagnosisFontNum
bDiagnosisFontModifier
bDiagnosisFontSize
bPrimaryFontNum
bPrimaryFontModifier
bPrimaryFontSize
Do not delete or add any lines in the Fmtopts.xxx files.

2. Do not rearrange any lines in the Fmtopts.xxx files.

3. Changing font sizes may have some unusual effects on a 
thermal printer. If the system has a thermal printer, remember 
to print a report to it as part of your test.

4. Changing lines other than those that are listed in step 1 may, or 
may not, affect the printouts.

5. Changing the Fmtopts.xxx files will change Web page formatting 
of these reports.
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4 Assembly Procedures
The following assembly procedures are contained in this chapter:

MUSE File Server AP MUSE File Server Rev A

MUSE Tower File Server (Intel) AP 900124-701 Rev T

MUSE RAID/Rack File Server (Compaq) AP 901107-XXX Rev P

MUSE Workstation with Windows 95 AP 901070-W95 Rev G

MUSE Workstation with WFW 3.1.1 AP 901070-WFW Rev G

HIS Test Box AP 901070-HIS Rev H

Butter Server/Workstation TP 419040-001 Rev F
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1. PURPOSE

This procedure is intended as a guideline for the Software assembly of the following
MUSE products:

MUSE Redwood Tower File Server ..................................................................900124-701
MUSE Venus Tower File Server...................................................................... 900124-6XX
MUSE Raid File Server.................................................................................... 421519-1XX

2. SCOPE

This document applies to the GE Marquette Medical Systems (GEMMS) – Milwaukee
manufacturing operation.

3. RELATED DOCUMENTS

MUSE Network Series Manual
QS1004......................................................................................Product Burn-In Guidelines
QS1003............................................ Quality Assurance Device History Record Guidelines
TP-MUSE 5A.............................................................................. MUSE 5A Test Procedure

4. EQUIPMENT REQUIRED
All equipment is “OR EQUIVALENT”

Complete MUSE Tower File Server Customer Order
MUSE Software CD 5A.................................................................................... 420858–001
MUSE Software CD 5B .................................................................................... 422436–001
Compaq SmartStart CD..................................................................................... 421586–003
Compaq Management CD................................................................................. 421854–003
MUSE MFG Tooling CDs ............................................................................S1404 – S1406
Boot Disk.....................................................................................................................S1407
MUSE File Server Configurator..................................................................................S1408

5. SPECIAL CONDITIONS

None.

6. COMPAQ DRIVE ARRAY INITIALIZATION  – COMPAQ Server ONLY

NOTE:   Perform this section only if you are installing a Compaq File Server. If not, go
to “IMAGECAST PROCEDURE” section.

6.1. Power–up the system.

6.2. Load the Compaq SmartStart CD into the CD–ROM drive immediately after
power–up.

NOTE:  The SmartStart CD is a bootable CD. The system will boot–up using this
CD to run the initial setup utilities.

6.3. <F1> to continue.

6.4. Left click “Run System Erase Utility” icon, left click OK.
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6.5. At the “Warning” prompt left click Yes.

NOTE:  SmartStart will now erase any previous system setup.

6.6. At the “System has been erased. Cycle system power now” screen, cycle power
on the system.

NOTE:  The system will again boot–up from the SmartStart CD in order to
continue with the initial setup.

6.7. At the Language selection screen, left click the English button.

6.8. At the Country/Time Selection screen, verify “United States” is selected for both
the country and the keyboard, set the appropriate Date and Time according to
where the system is going, left click Next.

NOTE:  PM time should be entered in Military (24) time.

6.9. At the Systems Settings Summary screen left click Continue.

6.10. At the SmartStart License Screen left click the “I Agree” check box, left click
OK.

6.11. At the SmartStart Path Screen left click the “Manual Configuration” installation
path radio button, left click Begin.

6.12. At the Operating System Settings screen left double–click the “Microsoft” folder
and left click the “Microsoft Windows NT Server version 4.0 – English” check
box.

NOTE:  This is the first check box under the Microsoft folder.

6.13. Left click Next.

6.14. Left click Continue.

6.15. Verify “Continue with SmartStart” is selected. <ENTER>

6.16. At the “Reboot” screen. <ENTER>

6.17. At the “Unconfigured Controller” screen left click Next.

6.18. At the “Operating System Settings” screen verify “Microsoft Windows NT 3.5X,
4.0 or later” is selected, left click Next.

6.19. Verify “ (RAID 5)…” radio button is selected, and the “Use Online Spare” check
box is selected, left click Next.

6.20. Left click Next to accept the configuration.

6.21. Left click Done.

6.22. Left click Controller >> Save Configuration.
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6.23. Left click Controller >> Exit.

NOTE:  The system will reboot and automatically run through some
configuration setups for a minute or two before the next step.

6.24. At the “Disk Builder” screen left click Next.

6.25. Remove the SmartStart CD from the CD–ROM drive.

NOTE:  Since the SmartStart CD is a bootable CD, it must be removed from the
CD–ROM drive. If it is only ejected from the CD–ROM drive and the
system is subsequently rebooted, the CD–ROM drive will automatically
reload any CD that has not been removed from the drive when it
initializes at boot time.

6.26. Left click Continue to begin the operating system setup. The system will reboot.

6.27. Configuring the KVM Switch Box – COMPAQ SERVER RACK ONLY

6.27.1. <Print Scrn> to access the Console Configuration Reporting (CCR)
interface.

6.27.2. At the “CCR Selection” screen <F2>

6.27.3. Press the <RIGHT> arrow key to move the highlight to the setup
menu.

6.27.4. Using the <UP> and <DOWN> arrow keys, move the highlight to
NAMES. <ENTER>

6.27.5. With the highlight on the Port1 name (“COMPUTER 1” by default),
type FILE SERVER.

6.27.6. <ENTER> to save the new name.

6.27.7. Using the <UP> and <DOWN> arrow keys, move the highlight to
FLAG. <ENTER>

6.27.8. At the “Flag Attributes” screen, highlight the Enabled setting and
change it to “NAMES TIMED” by using the <+> and <–> keys to
adjust the value.

6.27.9. <ENTER> to save the changed value.

6.27.10. <ESC> to exit CCR.
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7. IMAGECAST PROCEDURE

7.1. Perform the following based on the File Server:

PRIMARY DOMAIN CONTROLLER ONLY

If File Server is attached to the backbone, remove network cable from the NIC
card to ensure that the File Server is NOT attached to the network.

MEMBER SERVER ONLY
Make sure that the File Server is attached to the backbone.

7.2. Insert into Tooling floppy S1407 into floppy drive and power up.

7.3. Insert appropriate S1404 – S1406 Tooling CD into CD-ROM drive.

7.4. At the DOS prompt, follow prompts to choose which platform you are installing,
select accordingly <ENTER>

7.5. At the blue “ImageCast IC3 Client…” screen, once the system starts copying data,
remove the floppy.

7.6. System will take approximately 7-9 minutes to complete the process. It will
reboot twice and then present you with the Windows NT logon. Remove the
MUSE MFG Tooling CD.

8. NETWORK SETUP – PRIMARY DOMAIN CONTROLLER ONLY

NOTE:  Perform this section only if you are installing a Primary Domain Controller. If
not, goto “NETWORK SETUP – MEMBER SERVER ONLY” section.

8.1. Press <CTRL><ALT><DEL> to access logon prompt.

Logon as the following:

User Name:...........................................................................................MuseAdmin
Password: ............................................................................................Muse!Admin
Domain Redwood......................................................................MUSEHOSPITAL
Domain Compaq .........................................................................MUSECOMPAQ

NOTE:  Password is Case sensitive … type in exactly.

8.2. Perform the following based on the File Server:

COMPAQ FILE SERVER

Compaq Insight Manager needs to be running at all times. Minimize the
application whenever you restart or reboot the system.

8.3. Right click Network Neighborhood icon to access menu and left click
Properties.
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8.4. Left click Change button.

8.5. At the “Identification Changes” window, type in the following:

Computer Name ..............................................................................MUSE$$$XXX
Domain Name...........................................................................................MUSE$$$

NOTE: Password is Case sensitive … type in exactly.

8.6. Left click OK .

8.7. At the “Network Configuration” prompt, left click OK.

8.8. At the “Warning” prompt, left click Yes.

8.9. At the “Network Configuration” prompt, left click OK.

8.10. Left click “Protocols” tab.

8.11. Left click Properties.

8.12. Left click “Specify an IP address” radio button.

8.13. Type in the following:

IP Address ..................................................................................................128.9.9.1
Subnet Mask...........................................................................................255.255.0.0

8.14. Left click OK.

8.15. Left click Close.

8.16. At the “Network Settings Change” left click Yes to restart system.

9. NETWORK SETUP – MEMBER SERVER ONLY

NOTE:   Perform this section only if you are installing a Member Server. If not, goto
“INSTALL SHIELD APPLICATION” section.

9.1. If during the process the “Service Control Manager” error box appears, left click
OK to close.

9.2. Press <CTRL><ALT><DEL> to access logon prompt.

9.3. Logon as the following:

User Name:.......................................................................................Administrator
Password: .............................................................................................Never!Mind

Domain Redwood:...............................................................MUSEHOSPITAL001
Domain Compaq ...................................................................MUSECOMPAQ001

NOTE:  Password is Case sensitive … type in exactly.



Revision: A

AP MUSE FILE SERVER, REV A, PAGE 8 OF 34

9.4. Perform the following based on the File Server:

COMPAQ FILE SERVER

NOTE:  Compaq Insight Manager needs to be running at all times.  Minimize the
application whenever you restart or reboot the system.

9.5. Right click Network Neighborhood icon to access menu and left click
Properties.

9.6. Left click Change button.

9.7. At the “Identification Changes” window, the “Computer Name” edit field is
highlighted. Type in the name of the File Server as it is called out on the Pre-
Build.

NOTE: If no name is given use the convention MUSE$$$001. Where $$$ is the
acronym of the hospital or organization that is buying the File Server.

9.8. Left click OK.

9.9. At the “Warning” prompt, left click Yes.

9.10. At the “Network Configuration” prompt, left click OK.

9.11. Left click Change button.

9.12. Left click “Workgroup:” radio button.

9.13. Left click the edit field. Type WORKGROUP.

9.14. Left click OK.

9.15. At the “Warning” prompt, left click Yes.

9.16. At the “Network Configuration” prompt, left click OK.

9.17. Left click Close.

9.18. At the “Network Settings Change” left click Yes to restart system.

9.19. If the “Service Control Manager” error box appears, left click OK to close.

9.20. Press <CTRL><ALT><DEL> to access logon prompt.

9.21. Logon as the following:

User Name:.......................................................................................Administrator
Password: .............................................................................................Never!Mind

NOTE:  Password is Case sensitive … type in exactly.
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9.22. Right click Network Neighborhood icon to access menu and left click
Properties.

9.23. Left click Change button.

9.24. Left click “Domain:” radio button. The edit field is presently filled with
DOMAIN.

9.25. Left click the edit field and verify MUSESIG.

9.26. Left click “Create a Computer Account…” check box.

9.27. Type in the following:

User Name:...........................................................................................MuseAdmin
Password: ............................................................................................Muse!Admin

NOTE:  Password is Case sensitive … type in exactly.

9.28. Left click OK.

9.29. At the “Network Configuration” prompt, left click OK.

9.30. Left click Close.

9.31. At the “Network Settings Change” left click Yes to restart system.

10. INSTALL SHIELD APPLICATION

10.1. Press <CTRL><ALT><DEL> to access logon prompt.

10.2. Logon as the following:

User Name:...........................................................................................MuseAdmin
Password: ............................................................................................Muse!Admin

Domain ( PDC )........................................................................................MUSE$$$
Domain ( Member ).................................................................................MUSESIG

NOTE:  Password is Case sensitive … type in exactly.

10.3. If the “Service Control Manager” error box appears, left click OK to close.

10.4. Insert Tooling floppy S1408 into floppy drive.

10.5. Left click Start >> Run

10.6. Type A:\SETUP.EXE and left click OK.

10.7. At the “Welcome” screen, left click Next.

10.8. At the “Type of File Server” screen, left click the radio button which is
appropriate for the File Server you are building.
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10.9. Left click Next.

10.10. At the “User Information” screen fill in the following edit fields:

Name: ............................................................................................Hospital’s Name
Company: ......................................................................... Hospital’s Organization
Serial: ............................................................. XXXXXOEMXXXXXXXXXXXX

NOTE:  The Serial Number can be found on the NT 40 CD package. It must be
entered in the format listed.

10.11. Left click Next.

10.12. At the “Adjust File Server and Domain Name” screen fill in the following fields:

File Server: ......................................................................................MUSE$$$XXX
Domain: ( PDC ) ......................................................................................MUSE$$$

NOTE:  MUSE$$$ = Domain name.

Domain: ( Member )................................................................................MUSESIG

NOTE:  The domain field should already have MUSESIG typed in.

10.13. Left click Next.

10.14. At the “OFM Serial Number” screen fill in the following edit field:

Serial #: .........................................................................XX-XXXX-XXXX-XXXX

NOTE: The Serial Number can be found on the Open File Manager CD package.
It must be entered in the format listed.

10.15. Left click Next.

10.16. At the “Adjust Area Code” screen fill in the following edit field:

Area Code:........................................................................................................XXX

10.17. Left click Next.

10.18. At the “Adjust Time Zone” screen, left click the radio button which is appropriate
for the time zone the File Server is going to.

10.19. Left click Next.

10.20. At the “User Count Administrator” screen, remove the IS floppy and insert the
appropriate Btrieve floppy into the A: drive and left click Add License.

10.21. At the “License Increased” screen, left click OK.

10.22. Remove the Btrieve floppy and reinsert the IS floppy.

10.23. Left click Close.
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10.24. At the “Btrieve Complete” prompt, left click OK.

10.25. Perform the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY

10.25.1. At the “MUSE Services Complete” prompt, left click OK.

10.26. At the “Setup Complete” screen, remove the IS floppy and verify “Yes, I want to
restart my computer now” radio button is selected. Left click Finish to restart the
computer.

11. SYSTEM TWEAKS

11.1. Press <CTRL><ALT><DEL> to access logon prompt.

11.2. Logon as the following:

User Name:...........................................................................................MuseAdmin
Password: ............................................................................................Muse!Admin

Domain: ( PDC ) ......................................................................................MUSE$$$
Domain: ( Member )................................................................................MUSESIG

NOTE:  Password is Case sensitive … type in exactly

11.3. Perform the following based on the File Server:

COMPAQ FILE SERVER

11.3.1. Under the “Device Name” section, right click MUSECOMPAQ001 to
highlight and activate menu.

11.3.2. Left click Delete from >> List of All Devices.

11.3.3. At the “Warning” prompt, left click Yes.

11.3.4. Minimize “Insight Manager” application.
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11.4. Perform the following based on the File Server:

Redwood or Venus with more than One Hard Drive:
NOTE:  If your system has two or three hard drives installed, perform this
section. If not, goto “INCREASE LICENSE COUNT FOR NT – 20, 50 OR 100
ONLY” section.

11.4.1. Left click Start >> Programs >> Administrative Tools >> Disk
Administrator.

11.4.2. Left click OK.

11.4.3. Left click OK.
.

11.4.4. Hold the <Ctrl> while left clicking the “D Drive” in Disk 0 and the
“Free Space” in Disk 1.  This will highlight both areas.

NOTE:  If Disk 2 is applicable, highlight it also.

11.4.5. Left click Partition >> Extend Volume Set.

11.4.6. Verify that maximum size value is entered for logical drive.  Left click
OK.  Both areas will turn yellow.

11.4.7. Left click Partition >> Commit Changes Now…

11.4.8. At the “Confirm” prompt, left click Yes.

11.4.9. At the “Confirm” prompt, left click Yes.

11.4.10. At the “Disk Administrator” left click OK.

11.4.11. At the “Disk Administrator” left click OK.  System will restart.

NOTE:  System will take approximately 45 minutes to an hour to
complete this task.

11.5. INCREASE LICENSE COUNT FOR NT – 20, 50 OR 100 ONLY

NOTE:  Most File Servers have a 10 (ten) user license setup. If the Sales Order
calls out for more, complete this section to add more licenses. If not, goto “Adjust
Date & Time” section.

11.5.1. Make sure you are logged in as MuseAdmin.

11.5.2. Left click Start >> Settings >> Control Panel >> Services

11.5.3. Left click “License Logging Service” to highlight.

11.5.4. Left click Startup and set the radio button to MANUAL.

11.5.5. Left click OK.

11.5.6. Left click Start.

11.5.7. Left click Close.
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11.5.8. In the “Control Panel” window, left double-click Licensing icon.

11.5.9. Left click Add License.

11.5.10. In the “Quantity” field type in the amount of licenses you want to add.
You already have 10 licenses logged in the system. If you want to add
more, then you type in the extra amount that you need.

NOTE:  If, for example, the Sales Order calls out for 20 licenses, you
would then type in 10. Ten licenses plus 10 more equals twenty.

11.5.11. Left click OK.

11.5.12. At the “Per Server Licensing” prompt, left click “I agree that” radio
button.

11.5.13. Left click OK.

11.5.14. Verify that the license count equals what the Sales Order calls out.

11.5.15. Left click OK.

11.5.16. In the “Control Panel” window, left double-click Services icon.

11.5.17. Left click “License Logging Service” to highlight.

11.5.18. Left click Startup and set the radio button to DISABLED.

11.5.19. Left click OK.

11.5.20. Left click Close.

11.5.21. Close “Control Panel” window.

11.6. Adjust Date & Time

11.6.1. Left click Start >> Settings >> Control Panel >> Date/Time

11.6.2. Adjust Date & Time / Time Zone accordingly to the area the File
Server is going.

11.6.3. Left click OK.

11.6.4. Close “Control Panel” window.
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11.7. Perform the following based on the File Server:

PDC SERVER INSTALL ONLY

11.7.1. Left click Start >> Programs >> Administrative Tools (Common)
>> Server Manager

11.7.2. Under the “Type” field, find and left click the File Server that is
Windows NT Backup.
NOTE:  This will be either be MUSECOMPAQ001 or
MUSEHOSPITAL001

11.7.3. Left click Computer >> Remove from Domain

11.7.4. At the “Server Manager” prompt, left click Yes.

11.7.5. At the “Server Manager” prompt, left click OK.

11.7.6. Close “Server Manager” window.

11.8. Verify Open File Manager.

11.8.1. Left click Start >> Programs >> Open File Manager >> Open File
Manager

11.8.2. Left click System >> Scan

11.8.3. Left click the “+” to the left of the Domain in which the File Server is
in:

PDC .........................................................................................MUSE$$$
Member...................................................................................MUSESIG

11.8.4. You should now be able to see the File Server’s Computer Name. Left
click and verify a green Check mark by the side.

11.8.5. Left click File >> Exit.

11.9. Add client nodes to the File Server.

11.9.1. Left click Start >> Programs >> Command Prompt

11.9.2. At the “DOS prompt” window, type CVUSER MuseXXX <ENTER>

NOTE:  XXX is the number of the node that you want to add. The
corresponding password will be Muse!XXX. Repeat this step for as
many users that you will have connecting to the File Server.

11.9.3. Type Exit <ENTER>

11.10. Change and update IIS Users.

11.10.1. Left click Start >> Programs >> Administrative Tools (Common)
>> User Manager for Domains
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11.10.2. Perform the following based on the File Server:

MEMBER SERVER INSTALL ONLY

11.10.2.1. Left click User >> Select Domain…

11.10.2.2. Type MUSE$$$XXX in the “Domain” edit field.

11.10.2.3. Left click OK.

NOTE:  MUSE$$$XXX = File Server name.

11.10.3. Left click “IUSR_******001” to highlight it.

NOTE:  This is the “Internet Guest Account”

11.10.4. Left click User >> Rename

11.10.5. In the “Change To:” edit field type in IUSR_MUSE$$$XXX

NOTE:  MUSE$$$XXX = File Server name.

11.10.6. Left click OK.

11.10.7. Left click “IWAM_******001” to highlight it.

NOTE:  This is the “Web Application Manager Account”

11.10.8. Left click User >> Rename

11.10.9. In the “Change To:” edit field type in IWAM_MUSE$$$XXX

NOTE:  MUSE$$$XXX = File Server name.

11.10.10. Left click OK.

11.10.11. Left click User >> Exit

11.10.12. Left click Start >> Programs >> Windows NT 4.0 Option Pack >>
Microsoft Internet Information Server >> Internet Service
Manager

11.10.13. At the “Tip of the Day” window, left click Close.

11.10.14. In the left windowpane, left click Internet Information Server to
highlight.

11.10.15. In the right windowpane, right click MUSE$$$XXX to activate menu
and left click Properties.

NOTE:  MUSE$$$XXX = File Server name.

11.10.16. In the “Master Properties” area, left click Edit.

11.10.17. Left click “Directory Security” tab.
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11.10.18. In the “Anonymous Access and Authentication Control” box, left click
Edit.

11.10.19. At the “Authentication Methods” window, left click Edit.

11.10.20. In the “User Name” edit field, type IUSR_MUSE$$$XXX

NOTE:  MUSE$$$XXX = File Server name.

11.10.21. Left click OK.

11.10.22. Left click OK.

11.10.23. Left click OK.

11.10.24. Left click OK.

11.10.25. Left click Console >> Exit.

11.10.26. At the “Microsoft Management Console” prompt, left click Yes.

11.11. Adjust DCOMCNFG.

11.11.1. Left click Start >> Run

11.11.2. Type DCOMCNFG. Left click OK.

11.11.3. Select MUSE-CV IMS CServer. Left click Properties.

11.11.4. Left click “Security” tab.

11.11.5. At the “Use Custom Access Permissions” radio button area, left click
Edit.

11.11.6. There will be 4 instances of “Account Unknown” shown. Left click
Remove 4 times to remove all cases.

NOTE:  Interactive and System should be visible.

11.11.7. Left click Add.

11.11.8. Left click “List Names From” and choose the local domain:

PDC .......................................................................................MUSE$$$*
Member.......................................................................\\MUSE$$$XXX*

11.11.9. Left double-click Muse Users group.

11.11.10. Left click Show Users.

11.11.11. Left double-click Administrator.

11.11.12. Left double-click IUSR_MUSE$$$XXX.

11.11.13. Left double-click IWAM_MUSE$$$XXX.
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11.11.14. Verify that the four new entries appear in the “Add Names” window.

11.11.15. Left click OK.

11.11.16. Left click OK.

11.11.17. At the “Use Custom Launch Permissions” radio button area, left click
Edit.

11.11.18. There will be 3 instances of “Account Unknown” shown. Left click
Remove 3 times to remove all cases.

NOTE:  Interactive, Administrators and System should be visible.

11.11.19. Left click Add.

11.11.20. Left click “List Names From” and choose the local domain:

PDC .......................................................................................MUSE$$$*
Member.......................................................................\\MUSE$$$XXX*

11.11.21. Left double-click Muse Users group.

11.11.22. Left click Show Users.

11.11.23. Left double-click IUSR_MUSE$$$XXX.

11.11.24. Left double-click IWAM_MUSE$$$XXX.

11.11.25. Verify that the three new entries appear in the “Add Names” window.

11.11.26. Left click OK.

11.11.27. Left click OK.

11.11.28. Perform the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY

11.11.28.1. Left click “Identity” tab.

11.11.28.2. Verify “This User” radio button is selected.

11.11.28.3. In the “User” edit box, type MUSE$$$\MUSEBkgnd

NOTE:  MUSE$$$ = domain name of File Server

11.11.29. Left click OK.

11.11.30. Left click OK.
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11.12. Adjust pcAnywhere User.

11.12.1. Left click Start >> Programs >> pcAnywhere32 >> pcAnywhere

11.12.2. Left click BE A HOST PC.

11.12.3. Right click on MODEM icon and left click Properties.

11.12.4. Left click “Callers” tab.

11.12.5. Verify “Use NT user privileges” radio button is selected.

11.12.6. Left double-click Add User icon.

11.12.7. Verify “User” radio button is selected. Left click Next.

11.12.8. In the “What domain…” pull down, select the MUSE$$$XXX.

NOTE:  MUSE$$$XXX = File Server name.

11.12.9. In the “Select the account…” pull down, select Administrator.

11.12.10. Left click Next.

11.12.11. Left click Finish.

11.12.12. Left click OK.

11.12.13. Left click Exit.

11.13. Adjust Modem settings

11.13.1. Left click Start >> Settings >> Control Panel >> Modems

11.13.2. Left click Properties.

11.13.3. Left click “Connection” tab.

11.13.4. Left click Advanced…

11.13.5. Type in the “Extra Settings” edit box ATM0.

11.13.6. Left click OK.

11.13.7. Left click OK.

11.13.8. Left click Close.

11.13.9. Close “Control Panel” window.
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12 INSTALLING NETWORK PRINTER SUPPORT

NOTE:  Perform this section only if you are installing a Network Printer. If not, goto
“INSTALLING LOCAL PRINTER SUPPORT” section.

12.1. Log in as Administrator.

12.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

12.3. Left click Start >> Settings >> Printers

12.4. Left double-click icon Add Printer.

12.5. At the “Add Printer Wizard” screen, verify the radio button “My Computer” is
selected. Left click Next.

12.6. Left click Add Port.

12.7. From the “Available Printer Ports” section, left click LPR Port.

12.8. Left click New Port.

12.9. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
In the “Name or address…” edit field type XXX.XXX.XXX.XXX
NOTE:  XXX.XXX.XXX.XXX = the IP of the Printer.

MEMBER SERVER INSTALL
In the “Name or address…” edit field type $$$$$$$$$$
NOTE:  $$$$$$$$$$ = the name of the Printer based on Menu Printout.

12.10. In the “Name of printer or print…” edit field type raw.

12.11. Left click OK. Left click Close.

12.12. Left click Next.

12.13. Left click Have Disk.

12.14. Type Z:\HPPRINT\NT and left click OK.

12.15. Left click HP LaserJet 4000 Series PS in the “Printers” section.

12.16. Left click Next.

12.17. In the “Printer Name” section, type a unique name for the printer.

NOTE:  Default name should suffice unless otherwise stated by Pre-Build
Survey.

12.18. Left click Next.

12.19. Left click the radio button “Shared” and type in the edit a unique name.
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NOTE:  For one (1) printer, use LJ4K01.  If more, increase number.  Default
name should suffice unless otherwise stated by Pre-Build Survey.

12.20. Left click Next.

12.21. Verify the radio button Yes is selected and left click Finish to print a test page.

12.22. If the page printed successfully, left click Yes.

12.23. Close all visible windows.

13. INSTALLING LOCAL PRINTER SUPPORT

NOTE:  Perform this section only if you are installing a Local Printer. If not, goto
“UPS INSTALLATION – COMPAQ FILE SERVER WITH UPS ONLY ”
section.

13.1. Log in as Administrator.

13.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

13.3. Left click Start >> Settings >> Printers

13.4. Left double-click icon Add Printer.

13.5. At the “Add Printer Wizard” screen, verify the radio button “My Computer” is
selected. Left click Next.

13.6. From the “Available Ports” section, left click the radio button that the printer is
attached to.

13.7. Left click Next.

13.8. Left click Have Disk.

13.9. Type Z:\HPPRINT\NT and left click OK.

13.10. Left click HP LaserJet 4000 Series PS in the “Printers” section.

13.11. Left click Next.

13.12. In the “Printer Name” section, type a unique name for the printer.

NOTE:  Default name should suffice unless otherwise stated by Pre-Build
Survey.

13.13. Left click Next.

13.14. Left click the radio button “Shared” and type in the edit a unique name.

NOTE:  For one (1) printer, use LJ4K01.  If more, increase number.
Default name should suffice unless otherwise stated by Pre-Build Survey.

13.15. Left click Next.

13.16. Verify the radio button Yes is selected and left click Finish to print a test page.
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13.17. If the page printed successfully, left click Yes.

13.18. Close the “Printers” window.

14. UPS INSTALLATION – COMPAQ FILE SERVER WITH UPS ONLY

NOTE:   Perform this section only if you are installing Compaq UPS. If not, goto
“MUSEWEB INSTALLATION” section.

14.1. Make sure that the COMPAQ Management CD is in the CD-ROM drive.

14.2. Left click Start >> Run.

14.3. Type Z:\CPQCPM\AGENTS\NT\ENG\SETUP.EXE and left click OK.

14.4. At the “Compaq Power…” prompt, left click Yes.

14.5. Left click Continue.

14.6. Verify the “No” radio button is selected for the computer to be a part of a UPS
group, left click Continue.

14.7. At the “Communications Port Selection” screen, verify the “Standard” radio
button and COM1 are selected. Left click Continue.

14.8. Set Shutdown Timing Options to the following:

Wink Time (Seconds)............................................................................................60
Power Failure Countdown Time (Minutes)...........................................................10
Time Needed to Down System (Seconds).............................................................90

14.9. Left click Continue.

14.10. At the Install Path screen, left click Continue.

14.11. At the “The Compaq Power Management Software was successfully installed…”
screen, left click OK.

14.12. Left click OK to the restart your computer prompt.

NOTE:  System will not shut down at this time.

14.13. Left click Start >> Run.

14.14. Type Z:\CPQCPM\INSIGHT\ENG\SETUP.EXE and left click OK.

14.15. At the “Welcome” screen, left click Next.

14.16. At the “Choose Destination Location” screen, left click Next.
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14.17. At the “Information” screen, left click OK.

14.18. Left click OK to Setup is complete.

14.19. Restart the system.

14.20. Logon as MuseAdmin.

14.21. Wait until the “Compaq Insight Manager” application starts up.

14.22. Under “Device Name”, locate MUSE$$$XXX and wait until it turns green. Left
double–click it.

14.23. Left click the Recovery button.

14.24. Left click the UPS button.

14.25. Left click the Alert Handling button.

14.26. Left click “0 –$MACHINE is on battery…. shutdown in $MINUTES mins”

14.27. Right click the mouse icon next to “Disabled” text underneath the “Execute
Command” text and left click Set from the popup menu.

NOTE:  When you place the cursor over the text “Disabled” a mouse cursor will
appear. When this happens, right click to activate Set popup menu.

14.28. Left click the “Execute Command” check box and type in the edit field UPS.BAT
SHUTMUSE

14.29. Left click Set. System will now store data.

14.30. Select “2 –$MACHINE shutdown has been cancelled”

14.31. Right click the mouse icon next to “Disabled” text underneath the “Execute
Command” text and left click Set from the popup menu.

NOTE: When you place the cursor over the text “Disabled” a mouse cursor will
appear. When this happens, right click to activate Set popup menu.

14.32. Left click the “Execute Command” check box and type in the edit field UPS.BAT
CANCEL

14.33. Left click Set. System will now store data.

14.34. After Insight Manager is finished storing data, left click Close.

14.35. At the “UPS MUSE$$$XXX” screen, left click Close.

14.36. At the “MUSE$$$XXX Recovery” screen, left click the Environment button.
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14.37. Right click the mouse icon next to  “Shut Down” text next to the “Degraded
Action:” text and left click Set from the popup menu.

14.38. Verify “New Value” is set to “Continue”

14.39. Left click Set.

14.40. Left click Close.

14.41. At the “MUSE$$$XXX Recovery” screen, left click Close.

14.42. At the “Device – MUSE$$$XXX” screen, left click Close.

14.43. Left click Start >> Programs >> Compaq System Tools >> Compaq
Integrated Management Log Viewer

14.44. Left click Log >> Clear All Entries

14.45. Left click Clear.

14.46. Left click Yes.

14.47. Close the “Compaq Integrated Management Log View” window.

15. MUSEWEB INSTALLATION

NOTE:  Perform this section only if you are installing MUSEWEB. If not, goto
“MUSE MAIL MESSAGING INSTALLATION” section.

15.1. Log in as MuseAdmin.

15.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

15.3. Left click Start >> Run

15.4. Type Z:\MUSE32\SETUP.EXE and left click OK.

15.5. At the “Welcome” screen, left click Next.

15.6. At the “Software License Agreement” screen, left click Yes.

15.7. At the “Select MUSE CV System NODE Type” screen, verify that the “File
Server” radio button is selected.

15.8. Left click Next.

15.9. At the “Select MUSE CV…” screen, uncheck the “MUSE CV Application” check
box.

15.10. Left click “MUSE CV Web” check box.

15.11. Left click Next.

15.12. At the “Setup Complete” screen, left click Finish.
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15.13. Left click Start >> Run

15.14. Type Z:\ADOBE\AR32E301.EXE and left click OK.

15.15. At the “This will install Adobe Acrobat…” screen, left click Yes.

15.16. At the “Welcome” screen, left click Next.

15.17. At the “License Agreement” screen, left click Yes.

15.18. At the “Destination Directory” screen, Left click Next.

15.19. At the “Setup Complete” screen, uncheck the “Display Acrobat Reader 3.01 Read
Me file” check box, left click Finish.

15.20. Left click OK to the “Setup is complete” message.

16. MUSE MAIL MESSAGING INSTALLATION

NOTE: Check customer order to see if this is an ordered option. If Yes, install the
following. If not, go to “MUSEUP” section.

16.1. Install the IIS 4.0 SMTP Server

16.1.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

16.1.2. Left click Start >> Programs >> Windows NT 4.0 Option Pack >>
Windows NT 4.0 Option Pack Setup.

16.1.3. Left click Next.

16.1.4. Left click Add/Remove.

16.1.5. Left double-click the “Internet Information Server (IIS)” in the
“Components” list.

16.1.6. At the “Internet Information Server (IIS)” screen, left click the “SMTP
Service” check box.

16.1.7. Left click OK.

16.1.8. Left click Next.

16.1.9. Left click Next to accept the default mailroot directory.

16.1.10. Left click Finish.

16.2. Configure the IIS 4.0 SMTP Server

16.2.1. Left click Start >> Programs >> Windows NT 4.0 Option Pack >>
Microsoft Internet Information Server >> Internet Service
Manager.

16.2.2. Left click “show tips on startup” to uncheck and left click Close.
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16.2.3. In the left window pane, left click the “+” sign to the left of the
“Internet Information Server” to open.

16.2.4. Left click the “+” sign to the left of “MUSE$$$XXX” to open.

16.2.5. Right click “Default SMTP Site” to access menu and left click
“Properties.”

16.2.6. Left click “Messages” tab and type in the following:

Maximum Message Size (kilobytes) ..............................................30000
Maximum Session Size (kilobytes) ................................................30000

16.2.7. Left click “Delivery” tab and type in the following:

Smart Host ..............................................................................MUSESIG

16.2.8. Left click “Directory Security” tab.

16.2.9. In the “Relay Restrictions” section, left click Edit…

16.2.10. Left click “Allowed to Relay” radio button.

16.2.11. Left click OK.

16.2.12. Left click OK.

16.2.13. Left click Console >> Exit.

16.2.14. Left click Yes to console settings.

16.2.15. Left click Start >> Settings >> Control Panel >> Services.

16.2.16. Make sure the following is set for the “Microsoft SMTP Service”

Startup.....................................................................................Automatic
Status ...........................................................................................Started

16.2.17. Left click Close.

16.2.18. Close “Control Panel.”

16.3. Install EMWAC POP3 Server Software

16.3.1. Left click Start >> Run.

16.3.2. Type Z:\POP3\INSTALL.BAT C:\WINNT and left click OK.

16.3.3. At the “Does the MUSE File Server…” prompt, verify NO is
highlighted and press. <ENTER>

16.3.4. At the “Registry Editor” prompt, left click OK.
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17. MUSEUP

17.1. Make sure that you are logged in as MuseAdmin.

17.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

17.3. Left click Start >> Programs >> Command Prompt

17.4. Type Z: <ENTER>

17.5. Type CD\MUSEUP <ENTER>

17.6. Type INSTALL –U <ENTER>

17.7. At the “License…” prompt, verify Yes <ENTER>

17.8. Type EXIT <ENTER>

17.9. Left click Start >> Shut Down…

17.10. Left click “Restart the computer?” radio button

17.11. Left click Yes. System will now restart.

18. CONVERSION INSTALLATION

Perform one of the following based on the Sales Order:

CONVERSION INSTALL ONLY

Give system to the Conversion team.  When they return it back to you, complete the rest
of this Assembly Procedure.

NO CONVERSION OR NEW SYSTEM INSTALL ONLY

Continue with this Assembly Procedure.

19. OPTIONS DISK INSTALLATION

19.1. Make sure that you are logged in as MuseAdmin.

19.2. Start MUSE by left double–clicking on icon Start MUSE CV

19.3. Left click System >> System Setup.

19.4. Left click System >> Install Options.

19.5. Copy “Authorization Code” and proceed to MUSE Options station to set up the
Options Disk #419719–001.

19.6. Once completed, insert Options disk into floppy drive and left click Install.

19.7. Verify “Registered Name” and “Installed Options List” data to be correct.

19.8. Remove floppy.
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19.9. Close MUSE application and restart NT.

20. CATH LAB INSTALLATION ONLY

NOTE:  Check customer order to see if this is as an ordered option.  If Yes, install the
following.  If not, go to next section.

20.1. Cath options must be turned on via the Options disk.

20.2. The file “APPLIST.ASC” must be edited and the “!” in front of Configure Cath
Lists… must be removed.
The file “BACKTASK.ASC” must be edited and the “;” in front of
324,\\MUSE$$$XXX must be removed.

21. MAC-LAB INSTALLATION ONLY

NOTE:  Check customer order to see if this is as an ordered option. If Yes, install the
following. If not, go to next section.

21.1. Share Drive for access.

21.1.1. Left click Start >> Run

21.1.2. Type Z:\MUSEDB\MLABADD.BAT and left click OK.

21.2. The file “APPLIST.ASC” must be edited and the “!” in front of MAC-LAB
Assistant… must be removed.

22. ACC DATA EXPORT INSTALLATION ONLY

NOTE:   Check customer order to see if this is as an ordered option. If Yes, install the
following. If not, go to next section.

22.1. ACC options must be turned on via the Options disk.

22.2. The file “APPLIST.ASC” must be edited and the “!” in front of ACC Data
Export…  must be removed.

23. INVENTORY MANAGEMENT AND SCHEDULE BOARD INSTALLATION ONLY

NOTE:  Check customer order to see if this is as an ordered option. If Yes, install the
following. If not, go to next section.

23.1. Inventory Management option must be turned on via the Options disk.

23.2. Schedule Board option must be turned on via the Options disk.

23.3. The file “BACKTASK.ASC” must be edited and the “;” in front of 612,1,1 must
be removed. Also, the “1,1” must be changed to the number of the client that will
running it.

NOTE:  Only one instance of 612 can be activated on a networked system.
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24. TFTP SERVER INSTALLATION ONLY

NOTE:  Check customer order to see if a Gateway client is to be installed. If Yes, install
the following. If not, go to next section.

24.1. The file “BACKTASK.ASC” must be edited and the line 325,1,1 must be added.
Also, the “1,1” must be changed to the number of the client that will running it.

24.2. The file “BACKTASK.ASC” must be edited and the 340,1,1 must be added.
Also, the “1,1” must be changed to the number of the client that will running it.

25. TESTING

At this point, the install of the MUSE File Server is complete. Complete any necessary
client installations and start the overall testing using TP MUSE 5. After successful
completion of the TP, return to this point and complete this AP.

26. CONVERSION FINAL CHECKOUT

Perform one of the following based on the Sales Order:

CONVERSION INSTALL ONLY

Give system to the Conversion team.  When they return it back to you, complete the rest
of this AP.

NO CONVERSION OR NEW SYSTEM INSTALL ONLY

Continue with this AP.

27. CLEANUP

27.1. Emptying Recycle Bin.

27.1.1. Make sure that you are logged in as MuseAdmin.
27.1.2. Right click on Recycle Bin icon.
27.1.3. Select “Empty Recycle Bin”
27.1.4. Left click Yes.
27.1.5. Reboot.

27.2. Disk Maintenance.

27.2.1. Make sure that you are logged in as MuseAdmin.

27.2.2. Left click Start >> Programs >> Diskeeper >> Diskeeper.

27.2.3. Close “Welcome” window.

27.2.4. Left click Defragment >> Select Disk.

27.2.5. Left click C:[NTFS].

27.2.6. Left click OK.

27.2.6.1. Process will now start and may take 5-10 minutes.
27.2.6.2. Let click OK when done.
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27.2.7. Left click Defragment >> Select Disk.

27.2.8. Left click D:[NTFS].

27.2.9. Left click OK.

27.2.9.1. Process will now start and may take 5-10 minutes.
27.2.9.2. Left click OK when done.

27.2.10. Left click Advanced Tools >> Boot-Time Defragmentation.

27.2.11. Left click C:[NTFS].  Left click “Directory Consolidation” check box.
Left click Set.  Verify Directory Consolidation Set.

27.2.12. Left click D:[NTFS].  Left click “Directory Consolidation” check
box. Left click Set.  Verify Directory Consolidation Set.

27.2.13. Left click Close.

27.2.14. At the “Diskeeper” prompt, left click OK, left click OK.

27.2.15. Close “Diskeeper” window.

27.2.16. Reboot system.

NOTE:  This process will reboot your system a few times. Wait until
you get a logon screen before continuing.

28. CREATING AN EMERGENCY REPAIR DISK

28.1. Make sure that you are logged in as MuseAdmin.

28.2. Insert a floppy into A: drive

28.3. Select Start >> Run

28.4. Type RDISK /S. Left click OK.

28.5. At the “Setup can create an Emergency Repair disk...” Screen, left click Yes.

28.6. At the “Label a floppy disk...” screen, left click OK.

28.7. At the “Windows NT repair information contains...” screen, left click OK.

28.8. Remove the floppy, date and label it as MUSE$$$XXX Emergency Repair Disk

29. TAPE BACKUP

29.1. Make sure that you are logged in as MuseAdmin

29.2. Left click Start >> Programs >> MUSE CV Info System >> Integrated
Maintenance Suite >> Manual Backup

29.3. Insert “MONDAY” tape.
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29.4. Left click Normal Daily.  Backup process will start.

29.5. Left click Start >> Programs >> MUSE CV Info System >> Integrated
Maintenance Suite >> Manual Backup

29.6. Insert “MONTHLY SERVICE” tape.

29.7. Left click Monthly Backup.  Backup process will start.

NOTE:  Check MUSE error log to verify backups ran correctly.

29.8. CONVERSION INSTALL ONLY

29.8.1. Left click Start >> Programs >> MUSE CV Info System >>
Integrated Maintenance Suite >> Advanced

29.8.2. Insert “CONVERSION” tape.

29.8.3. Left click Backup Archive >> Do Manual Backup

29.8.4. Highlight all volumes.

29.8.5. Left click OK.  Backup process will start.

NOTE:  If volumes are large enough this process may ask for multiple
tapes to be inserted.

29.8.6. Upon completion, give tape to Conversion and let them visually inspect
the system.

29.8.7. Multiple Archived Volumes

NOTE:  Complete this section only if there are more then two
volumes.

NOTE:  Vol0 and Vol[with the greatest number] should not be
selected. They are both active and will be done in the Daily Tape
process. Only select the Vol’s that are in between these two. They are
not active and will not be backed up unless told to do so. Also, for
every additional volume, you must have two extra tapes that must be
added to the sales order as separate line items.

For example, if you have the following scenario:
Vol0 È Template Volume – will be backed up in Daily Tape. Do not
select.
Vol1 È Archive Volume – You will create two [2] VOLUME 1 tapes
and backup.
Vol2 È Archive Volume – You will create two [2] VOLUME 2 tapes
and backup.
Vol3 È Active Volume – will be backed up in Daily Tape. Do not
select.

29.8.7.1. Left click Start >> Programs >> MUSE CV Info System >>
Integrated Maintenance Suite >> Advanced



Revision: A

AP MUSE FILE SERVER, REV A, PAGE 31 OF 34

29.8.7.2. Insert VOLUME X tape.

NOTE:   X = the number of the volume.

29.8.7.3. Left click Backup Archive >> Do Manual Backup

29.8.7.4. Highlight the appropriate VolX.

29.8.7.5. Left click OK.  Backup process will start.

29.8.7.6. Upon completion, remove tape, put in the second tape and
repeat section.  If there are more volumes to backup, like in the
example, repeat this section. For every volume there should be
two identical backup tapes that will be SENT to the customer.

30. REMOVE TEMPORARY USERS – MEMBER SERVER ONLY

Perform the following based on the Sales Order:

MEMBER SERVER

30.1. Log in as Administrator. In the “Domain” pull down box select MUSE$$$XXX

30.2. Left click Start >> Programs >> Administrative Tools >> User Manager for
Domains.

30.3. Left double-click “MUSE Users” in bottom window.

Select all users and left click Remove.
Left click OK.

30.4. Left double-click “Administrators” in bottom window.

Select all users, except for Administrator, and left click Remove.
Left click OK.

30.5. Left double-click “Users” in bottom window.

Select all users, except the Administrator, and left click Remove.
Left click OK.

30.6. Left click Policies >> User Rights.

Left click check box “Show Advanced Users Rights”
Pull down “Right” menu, select Log on as a Batch Job.
Select “MUSE Background user and left click Remove.
Pull down “Right” menu, select Log on as a Service.
Select all users and left click Remove.
Left click OK.

30.7. Close “User Manager” window.
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31. SET SCREEN RESOLUTION – COMPAQ FILE SERVER ONLY

Perform the following based on the Sales Order:

COMPAQ FILE SERVER

31.1. Left click Start >> Settings >> Control Panel >> Display

31.2. Left click “Settings” tab.

31.3. Change the “Desktop Area” to be set at 640 by 480.

31.4. Left click OK.

31.5. At the “Display Settings” prompt, left click OK.

NOTE:  The display will be noticeably larger.

31.6. Close Control Panel.

32. SHUTDOWN FILE SERVER

32.1. Left click Start >> Shutdown.

32.2. Verify “Shutdown the Computer?” radio button is selected.

32.3. Left click Yes.

32.4. At the “Shutdown Computer” prompt, power down the File Server.

33. CONFIGURING COMPAQ UPS – COMPAQ FILE SERVER WITH UPS ONLY

NOTE: Perform the following ONLY IF the UPS option is included with the system and
then check (RAID Voltage Options located on Pre–build) to see if the UPS should be
configured for 100v, 220v, or 240v and perform the following.

If the UPS is domestic 120v and does not need to be reconfigured for 100v, 220v, or
240v, then skip this section.

33.1. Perform one of the following based on the (RAID Voltage Options):

CAUTION:  DO NOT press the OFF button while the UPS is in configuration
mode.  Doing so places the unit in Standby mode and disconnects the load.
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100 VAC UPS CONFIGURATION ONLY – JAPAN

Press the ON and Test/Alarm Reset buttons at the same time for one beep – see
Figure 1–1. (The UPS is now in Configuration mode)

Press the ON button until the 100/208v function LED is selected – see Appendix
Figure 1–1. (The UPS beeps as you scroll through each function LED and the
selected function LED blinks.)

Press the Test/Alarm Reset button to turn the 100/208v function on. (The
Function Status LED turns on when the function is on and off when the function
is off.)

Press the ON and Test/Alarm Reset buttons at the same time to return to
Operation mode. (Changes take effect immediately after returning to Operation
mode.)

220 VAC UPS CONFIGURATION ONLY – FOREIGN

Press the ON and Test/Alarm Reset buttons at the same time for one beep – see
Figure 1–1. (The UPS is now in Configuration mode)

Press the ON button until the 110/220v function LED is selected – see Appendix
Figure 1–1. (The UPS beeps as you scroll through each function LED and the
selected function LED blinks.)

Press the Test/Alarm Reset button to turn the 110/220v function on. (The
Function Status LED turns on when the function is on and off when the function
is off.)

Press the ON and Test/Alarm Reset buttons at the same time to return to
Operation mode. (Changes take effect immediately after returning to Operation
mode.)

240 VAC UPS CONFIGURATION ONLY – FOREIGN

Press the ON and Test/Alarm Reset buttons at the same time for one beep – see
Figure 1–1. (The UPS is now in Configuration mode)

Press the ON button until the 127/240v function LED is selected – see Appendix
Figure 1–1. (The UPS beeps as you scroll through each function LED and the
selected function LED blinks.)

Press the Test/Alarm Reset button to turn the 127/240v function on. (The
Function Status LED turns on when the function is on and off when the function
is off.)

Press the ON and Test/Alarm Reset buttons at the same time to return to
Operation mode. (Changes take effect immediately after returning to Operation
mode.)
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34. APPENDIX

100/208 V function LED

127/240 V function LED

120/230 V function LED (Default)

Function Status LED

Test/Alarm Reset Button

OFF Button

ON Button

110/220 V function LED

Figure 1-1.  UPS Button and LED Function in Configure Mode
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1. PURPOSE

This procedure is intended as a guideline for the assembly of the following MUSE
products:

MUSE Tower File Server...................................................................................900124-701

Based on what is called out on the customer order and the new OMAR structure, a
technician will be able to reference this document in order to create a system with
Windows NT40 as its operating system.

2. SCOPE

This document applies to the GE Marquette Medical Systems, Milwaukee manufacturing
operation.

3. RELATED DOCUMENTS

3.1. ................................................................................. MUSE Network Series Manual
3.2. QS1004..........................................................................Product Burn-In Guidelines
3.3. QS1003................................ Quality Assurance Device History Record Guidelines
3.4. TP-MUSE 5A.................................................................. MUSE 5A Test Procedure
3.5. MF1348 ....................................... PC to PC MUSE & Conversion Check-off Sheet
3.6. MF1349 .................................... DEC to PC MUSE & Conversion Check-off Sheet

4. EQUIPMENT REQUIRED
All equipment is “OR EQUIVALENT”

4.1. Complete MUSE Tower File Server Customer Order
4.2. MUSE QA Calibrated Test ECG(s) Diskettes ...........................................MT-3561
4.3. Three SIGLAB 230VAC power cables (for 230VAC systems only)
4.4. MUSE Software CD 5A.........................................................................420858-001
4.5. MUSE Software CD 5B .........................................................................422436-001
4.6. Tool Disk.......................................................................................................S00171

5. SPECIAL CONDITIONS

The following test procedure will apply to both 115 VAC 50-60Hz systems as well as
230 VAC 50Hz systems.

6. PROCEDURE

6.1. Assembly of Vendor Equipment

6.2. Initial Set-up of Vendor Equipment

6.2.1. 100/115 VAC 50-60Hz Systems

Assemblies (115VAC 50-60Hz) - connect power cord supplied with
computer and monitor to standard 115VAC 60Hz outlet.

6.2.2. 230 VAC 50Hz Systems

Assemblies (230VAC 50Hz) - connect SIGLAB 230VAC power cable
to power connector on back of computer, monitor, and printer, then to
230VAC 50Hz power source.
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6.2.3. Connect monitor signal cable to the video connector on back of
computer.

6.2.4. Connect MICROSOFT Mouse into Mouse Connector port on back of
computer.

6.2.5. If you are building a system with a Cybex KVM 2/4 port switch,
connect all keyboard, mouse and monitor ports from the Server into the
necessary slots on the switch.

7. UPGRADING THE BIOS TO VERSION 2.1

Note: Physically examine the present BIOS settings upon boot.  If the value is
greater than 2.1, DO NOT perform this section.

7.1. Insert Tool Disk S00171.
7.2. Boot computer.
7.3. At the A:\prompt, type 1. <ENTER>
7.4. Wait until copy process completes. System will reboot automatically.
7.5. Remove the floppy.
7.6. <F2> to enter setup utility.
7.7. At the Bios Setup Utility Screen. <F9>
7.8. "Load default configuration now" Verify Yes. <ENTER>
7.9. <F10> "Save configuration changes and exit now!"
7.10. Verify Yes. <ENTER> System will now reboot.

8. SETTING BIOS VALUES

8.1. Boot system.  <F2> to enter setup utility.
8.2. Set the appropriate “System Time” and “System Date.”
8.3. Go to “Boot” tab and set the “Boot Device Priority” to the following:

Diskette Drive
ATAPI CD-ROM Drive
Hard Drive
Removable Devices
Diagnostic Boot

8.4. <F10> "Save configuration changes and exit now!"
8.5. Verify Yes. <ENTER>
8.6. System will reboot.

9. WINNT40 (PRIMARY DOMAIN CONTROLLER AND MEMBER) SERVER
INSTALLATION

9.1. Installing Windows NT Server 4.0

9.1.1. Boot Strapping

9.1.1.1. Boot up your system.

9.1.1.2. Load the Windows NT 4.0 Server compact disk into the CD-
ROM drive.

9.1.1.3. At the “Welcome to Setup” screen. <ENTER>
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9.1.1.4. At the “Setup has recognized the following mass storage
devices...” screen. <ENTER>

9.1.1.5. At the “Setup has determined that one or more of your hard
disks has more than 1024 cylinders...” screen. <ENTER>

9.1.1.6. At the “Setup has determined that your computer's startup hard
disk...” screen, press C

9.1.1.7. At the “Windows NT Licensing Agreement” screen, <Page
Down> repeatedly to read the license and F8 to agree.

9.1.1.8. At the “Setup has determined that your computer contains the
following...” screen. <ENTER>

9.1.1.9. Perform one of the following based on the amount of hard
drives installed:

Two or more hard drives:
Verify that on ID0 on bus0 the text Unpartitioned space is
highlighted.

Note: The lower or second or third drive will be formatted at a
later point.  Do not select it.

9.1.1.10. At the “The list below shows existing partitions and space
available...” screen, Press C

9.1.1.11. At the “You have asked Setup…” screen, backspace to clear
the present entry and type 2048 to create a 2GB C drive.
<ENTER>

9.1.1.12. At the “The list below shows existing partitions and space
available...” screen, select “New (Unformatted)”. <ENTER>

9.1.1.13. At the “The partition you have chosen is newly created...”
screen, select “Format the partition using the NTFS file
system.” <ENTER> This will take approximately 5-7 minutes.

9.1.1.14. At the “Setup installs Windows NT files onto your hard disk...”
screen. <ENTER>

Note:  Verify that the default directory is \WINNT.

9.1.1.15. At the “Setup will now examine your hard disk(s)...” screen.
<ENTER>

Note:  Setup will now start copying files.

9.1.1.16. At the “This portion of Setup has completed...” screen, remove
the Windows NT 4.0 CD from the CD-ROM drive. <ENTER>

Note:  System will reboot twice to properly format all drives.
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9.1.2. Gathering Information About Your Computer

9.1.2.1. Reinsert the Windows NT Server CD when prompted, wait One
(1) minute, and click OK.  Setup will copy files to your hard
drive.

9.1.2.2. At the “Welcome to the Windows NT Setup Wizard...” screen,
left click Next to begin “1) Gathering information about your
computer”.

9.1.2.3. At the “Name and Organization” screen, enter the hospital name
in the Name Field. In the Organization field, enter the name of
the organization the hospital is affiliated with, if the hospital is
not affiliated with an organization, then enter the hospital name
again. Left click Next.

9.1.2.4. When prompted, enter the CD key number from the certificate,
Left click Next.

9.1.2.5. Verify the radio button “Per Server for” is selected and based on
the number of Btrieve licenses purchased; select the appropriate
number for “concurrent connections.”  Left click Next.

9.1.2.6. At the “Computer Name” screen, enter MUSE$$$XXX in the
Name field - where $$$ is an acronym for the hospital and XXX
is the MUSE node number of the computer.

Note:  This value represents the name of the computer.
Reference the Pre-Build Survey to verify this is correct.

9.1.2.7. Left click Next.

9.1.2.8. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
ONLY

At the “Server Type” screen, select the “Primary Domain
Controller” radio button. Left click Next.

MEMBER SERVER INSTALL ONLY

At the “Server Type” screen, select the “Stand-Alone
Server” radio button. Left click Next.

9.1.2.9. At the “Administrator Account” screen, type in the password
Never!Mind in both edit fields.

Note:  The password is case sensitive.

9.1.2.10. Left click Next.

9.1.2.11. At the “Emergency Repair Disk” screen, select “No, do not
create...” radio button. Left click Next.
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9.1.2.12. At the “Select Components” screen do the following:

Note:  The shortcut to selecting all features is to Uncheck the
appropriate box and re-check the same box with a single left
click. Do this slowly so you don't cause a double-click.

The “Accessibility Options” box should be empty.
The “Accessories” box should be white with a black check.
Verify that the “Communications” box is white with a black
check.
The “Games” check box should be empty.
The “Multimedia” box should be white with a black check.
The “Windows Messaging” box will be gray with a black check
after performing the following steps:
Left double-click the “Windows Messaging” text.

The “Windows Messaging” check box should be checked.
The “Internet Mail” check box should be checked.
The “Microsoft Mail” check box should be Unchecked.

Left click OK.

9.1.2.13. Left click Next.

9.1.3. Installing Windows NT Networking

9.1.3.1. At the “Setup is now ready to guide you through installation...”
screen, Left click Next to begin “2) Installing Windows NT
Networking”.

9.1.3.2. At the “Windows NT needs to know how this computer should
participate on a network...” screen, verify “Wired to the
network” is selected. Left click Next.

9.1.3.3. At the “Microsoft Internet Information Server lets you share...”
screen, Uncheck the box “Install Microsoft Internet Information
Server”. Left click Next.

9.1.3.4. At the “To have setup start searching for a network Adapter...”
screen, Left click Start Search.

9.1.3.5. If the search succeeded in selecting the appropriate NIC card,
left click Next.

9.1.3.6. At the “Select the networking protocols that are used...” screen,
Uncheck all network protocols except for “TCP/IP Protocol”.
Left click Next.

9.1.3.7. At the “Listed below are the service that will be installed...”
screen, left click the Select from list button to add the
following additional services.

Select “Microsoft TCP/IP Printing” and left click OK.
Select “Network Monitor Tools and Agent” and left click
OK.
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Left click Next.

9.1.3.8. At the “Windows NT is now ready to install networking
components...” screen left click Next.

9.1.3.9. At the “Intel PROSET” window, left click OK.

9.1.3.10. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
ONLY
At the “If there is a DHCP server on your network...”
message box left click No.

At the “Microsoft TCP/IP Properties” window, fill in the
following fields with the appropriate data
Note:  Reference the Pre-build survey to verify these IP’s.

IP Address: .........................128.9.9.1
Subnet Mask:..................255.255.0.0

Left click OK.

MEMBER SERVER INSTALL ONLY

At the “If there is a DHCP server on your network...”
message box left click Yes.

Note:  System must be attached to MEI network backbone.

9.1.3.11. At the “You may use this page to disable network bindings…”
screen, left click Next.

9.1.3.12. Left click Next to start the network.

9.1.3.13. Perform one of the following based on the File Server:

Note:  Reference the Pre-Build Survey to verify this is correct.

PRIMARY DOMAIN CONTROLLER INSTALL
ONLY

At the “You have requested that Windows NT create a
Primary Domain Controller…” screen, enter MUSE$$$
(where $$$ is the acronym for the hospital) in the Domain
field. Left click Next.

Note:  This is the Domain name you are creating for the
hospital. This may take a few minutes to register.
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MEMBER SERVER INSTALL ONLY

At the “Select whether your computer will be participating
in a workgroup or domain…” screen, Verify “Computer
Name” is correct.

Left click “Domain” radio button.
Type MUSESIG
Left click on “Create a Computer Account in the Domain”
check box.
Left click Next
In the “User Name” field, type MuseAdmin
In the “Password” field, type Muse!Admin

Left click OK

9.1.4. Finishing Setup

9.1.4.1. At the “Setup is almost finished...” screen, left click Finish to
begin “3) Finishing Setup”.

9.1.4.2. At the “Date/Time Properties” property page set the date, time,
and time zone appropriately to where the machine is going. Left
click Close.

At the “Detected Display” message box, left click OK and
configure your video as follows:

Color Palette ................................................................256 colors
Desktop Area .................................................1024 by 768 pixels
Refresh Frequency.........................................................75 Hertz

9.1.4.3. Left click the Test button and verify the settings.  Once the
settings have been verified left click OK.

9.1.4.4. At the “Windows NT has been installed successfully...” screen,
remove the Windows NT 4.0 Server CD from the CD-ROM
drive.

9.1.4.5. Left click Restart Computer.

9.2. Move the CD drive letter to Z:

9.2.1. Log in as Administrator.

Note:  You must press <CTRL><ALT><DEL> to logon.

Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY
In the “Domain” pull down box, select MUSE$$$
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MEMBER SERVER INSTALL ONLY
In the “Domain” pull down box, select MUSE$$$XXX

Note:  MUSE$$$XXX = Local Computer Name

9.2.2. Type for password Never!Mind

9.2.3. At the “Welcome” window left click Close

9.2.4. Left click Start >> Programs >> Administrative Tools >> Disk
Administrator.

9.2.5. Left click OK if its the first time its been used.

9.2.6. Left click the “CD-ROM 0” box.

Note:  Present drive letter is D:

9.2.7. Left click Tools >> Assign Drive Letter.

9.2.8. Pull down “Assign Drive Letter” and select Z: and left click OK.

9.2.9. Left click Yes to the “This new drive letter will happen immediately
dialog.”

9.3. Partition and formatting One (1) D: drive

Note:  If you are installing a system with more than one hard drive installed, skip
this section and go to the next section “Partition and formatting Two or
Three D: drives.”

9.3.1. Left click “Free Space” area in Disk 0.

9.3.2. Left click Partition >> Create Extended.

9.3.3. Left click OK. Left click Yes.

9.3.4. Left click “Free Space” area in Disk 0.

9.3.5. Left click Partition >> Create.

9.3.6. Verify that maximum size value is entered for logical drive. Left click
OK.

9.3.7. Left click Partition >> Commit Changes Now…

9.3.8. At the “Changes have been made to your hard disk configuration…”
screen, left click Yes.

9.3.9. At the “Disks were updated successfully” screen, left click OK.

9.3.10. Left click the “D:” unknown area in Disk 0.

9.3.11. Left click Tools >> Format.

9.3.12. Pull down “File System” and select “NTFS”.
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9.3.13. Left click Start.

9.3.14. Left click OK to “Warning…”

Note:  Formatting the D: drive can take in excess of 20 minutes.

9.3.15. Left click OK to “Format complete.”

9.3.16. Left click Close.

9.3.17. Close “Disk Administrator” window.

9.4. Partition and formatting Two or Three D: drives

9.4.1. Hold the <Ctrl> while left clicking the “Free Space” in Disk 0 and the
“Free Space” in Disk 1.  This will highlight both areas.

Note:  If Disk 2 is applicable, highlight it also.

9.4.2. Left click Partition >> Create Volume Set.

9.4.3. Verify that maximum size value is entered for logical drive.  Left click
OK.  Both areas will turn yellow.

9.4.4. Left click Partition >> Commit Changes Now…

9.4.5. At the “Confirm” prompt, left click Yes.

9.4.6. At the “Confirm” prompt, left click Yes.

9.4.7. At the “Disk Administrator” left click OK.

9.4.8. At the “Disk Administrator” left click OK.  System will restart.

9.4.9. Logon as Administrator.

9.4.10. At the “Welcome” window, uncheck the “Show this welcome…” box
and left click Close.

9.4.11. Left click Start >> Programs >> Administrative Tools >> Disk
Administrator.

9.4.12. Left click the yellow colored “D:” unknown area in Disk 0.

9.4.13. Left click Tools >> Format.

9.4.14. Pull down “File System” and select “NTFS”.

9.4.15. Left click Start.

9.4.16. Left click OK to “Warning…”

Note:  Formatting the D: drive can take in excess of 20 minutes.

9.4.17. Left click OK to “Format complete”
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9.4.18. Left click Close.

9.4.19. Close “Disk Administrator” window.

9.5. Disable CD Autoplay and Update NT Source Path

9.5.1. Insert the MUSE Software CD in CD-ROM drive.

9.5.2. Left click Start >> Run.

9.5.3. Type REGEDIT Z:\REG\CD_CHNGS.REG and left click OK.

9.5.4. Left click OK at the Registry Editor message box.

9.5.5. Remove the MUSE Software CD

9.6. Installing Tape Device

9.6.1. Insert the Windows NT 4.0 Server CD. If the “Windows NT CDROM”
screen appears, close the window.

9.6.2. Left click Start >> Settings >>Control Panel >> Tape Devices.

9.6.3. At the “New SCSI Tape Device Found” message box, left click OK.
Files will be copied to the system.

9.6.4. At the “Tape Devices” property page, verify HPC1537A is selected,
left click OK.

9.6.5. Close “Control Panel” window.

9.6.6. Remove the Windows NT 4.0 Server CD from the CD-ROM drive.

9.7. Installing Windows NT Server 4.0 SP4 and Microsoft Data Access Components
2.0 SP1

9.7.1. Insert the MUSE Software CD is in the CD-ROM drive.

9.7.2. Left click Start >> Run.

9.7.3. Type Z:\BAT\SP4MDAC.BAT and left click OK.

Note:  System will automatically copy files and setup apps.

9.7.4. At the “Microsoft Windows Year 2000…” prompt, left click Yes to
restart system.

9.8. Installing Internet Explorer 4.01 SP2

9.8.1. Log in as Administrator.

9.8.2. At the “Welcome” window, uncheck the “Show this welcome…” box
and left click Close.
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9.8.3. Left click Start >> Run.

9.8.4. Type Z:\BAT\IE401SP2.BAT and left click OK.

Note:  System will automatically copy files, setup apps and restart
system.

9.9. Setting up the environment

9.9.1. Log in as Administrator.

9.9.2. Close the “Welcome – Microsoft Internet Explorer” window.

9.9.3. Enable Schedule Service to startup automatically and stop Licensing.

9.9.3.1. Left click Start >> Settings >> Control Panel >> Services.
9.9.3.2. Left click on “Schedule”.
9.9.3.3. Left click Startup and set the radio button AUTOMATIC.
9.9.3.4. Left click OK.
9.9.3.5. Left click on “License Logging Service”
9.9.3.6. Left click Startup and set the radio button DISABLED.
9.9.3.7. Left click OK.
9.9.3.8. Left click Close.

9.9.4. Turn off debugging.

9.9.4.1. Left double-click the icon System.

9.9.4.2. Left click “Startup/Shutdown” tab.

9.9.4.3. Left click to uncheck the “Write debugging information to:”
check box.

9.9.4.4. Left click OK.

9.9.4.5. Left click NO at the “System settings change” window.

9.9.5. Set the computer description

9.9.5.1. Left double-click the icon Server.

Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
ONLY

In the “Description” edit box type MUSE$$$ PDC (MUSE
File Server)

Note:  Where “MUSE$$$” is the name of the Primary
Domain that was created during the NT network setup.
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MEMBER SERVER INSTALL ONLY

In the “Description” edit box type MUSE File Server

9.9.5.2. Left click OK.

9.9.5.3. Close “Control Panel” window.

9.9.6. Turn on Auditing

9.9.6.1. Left click Start >> Programs >> Administrative Tools >>
User Manager for Domains.

9.9.6.2. Left click Policies >> Audit.

9.9.6.3. Left click the radio button “Audit these Events.”

9.9.6.4. Fill out the matrix as follows:

SUCCESS FAILURE

Logon on Logoff X
File and Object Access
Use of User Rights
User and Group Management X
Security Policy Changes X X
Restart, Shutdown, and System X X
Process Tracking X

9.9.6.5. Left click OK and close “User Manager” window.

10. POWERVAR UPS SOFTWARE

Note:  The following condition must be met before continuing on with this section:
A UPS attached with proprietary cord to COM1 of the server.

10.1. Install main software

10.1.1. Make sure the MUSE Software CD is in the CD-ROM drive.

10.1.2. Left click Start >> Run.

10.1.3. Type Z:\LANSAFE\V40\SETUP.EXE and left click OK.

10.1.4. At the “Failsafe III Installation Options” screen, verify the following:

COM1 is selected.
UPS model is “PowerRite Pro II”
Default directory is “C:\FS3\”.

10.1.5. Left click Install.

10.1.6. At the “FailSafe III Install” window, left click OK.

10.1.7. Close all visible windows and reboot the system.
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10.2. Configure UPS environment

10.2.1. Log in as Administrator.

10.2.2. Uncheck the box “Show this next time…” and close the “Welcome –
Microsoft Internet Explorer” window.

10.2.3. Verify that a Battery Icon is visible in the bottom right corner of the
taskbar.

10.2.4. Left click Start >> Programs >> FailSafe III >> FailSafe III
Console.

10.2.5. Wait till “Power Monitor Communications OK” is visible at the bottom
of the window.

10.2.6. Left click Setup >> Customize Alerts.

10.2.7. Left click “0-$MACHINE is on battery…shutdown”.

10.2.8. Left click check box “Execute Command”.

10.2.9. Type in edit field UPS.BAT SHUTMUSE

10.2.10. Left click “0-$MACHINE is on battery…shutdown”.

10.2.11. Left click “2-$MACHINE shutdown has been cancelled”.

10.2.12. Left click check box “Execute Command”.

10.2.13. Type in edit field UPS.BAT CANCEL

10.2.14. Left click OK.

10.2.15. Close “FailSafe III Console” application.

11. CONFIGURING ADMINISTRATOR DESKTOP

11.1. Set the screen saver.

11.1.1. Right click on the desktop, left click Properties.
11.1.2. Left click the “Screen Saver” tab.
11.1.3. Choose the Logon Screen Saver from “Screen Saver” pull down

menu.
11.1.4. Left click “Password Protected” check box.
11.1.5. Verify “Wait” is set to 15 minutes.
11.1.6. Left click OK to exit.

11.2. Move the Desktop icons to the Recycle Bin.

11.2.1. Right click on icon My Briefcase and select Delete.
11.2.2. Left click Yes to confirm delete.
11.2.3. Right click on icon Install Internet Information…  and select Delete.
11.2.4. Left click Yes to confirm delete.
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11.3. Set the taskbar options

11.3.1. Left click Start >> Settings >> Taskbar…
11.3.2. Verify “Always on top” is selected.
11.3.3. Left click “Show small icons in Start menu.”
11.3.4. Verify “Show Clock” is selected.
11.3.5. Left click OK to exit.

11.4. Set the Explorer Options

11.4.1. Left double-click “My Computer” icon.
11.4.2. Left click View >> Toolbar. Toolbar should appear in window.
11.4.3. Left click View >> Options…
11.4.4. Left click the radio button “Browse folders by using a single window

that changes as you open each folder.”
11.4.5. Left click the “View” tab.
11.4.6. Left click the radio button “Show all files.”
11.4.7. Left click the check button “Display the full path in the title bar.”
11.4.8. Un-select “Hide file extensions for known file types.”
11.4.9. Left click the check button “Display compressed files and folders with

alternate color.”
11.4.10. Left click OK. Close “My Computer” window.

11.5. Set the command prompt options

11.5.1. Left click Start >> Settings >> Control Panel >> Console.
11.5.2. Left click the “Options” tab. Default.
11.5.3. Left click the radio button “Large.”
11.5.4. Left click the “Layout” tab.
11.5.5. Enter 80 for the “Screen Buffer Size Width”. Default.
11.5.6. Enter 50 for the “Screen Buffer Size Height”.
11.5.7. Enter 80 for the “Window Size Width”. Default.
11.5.8. Enter 50 for the “Window Size Height”.
11.5.9. Left click OK. Close “Control Panel” window.

12. MICROSOFT INTERNET INFORMATION SERVER 4.0 INSTALLATION

12.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

12.2. Left click Start >> Run.

12.3. Type Z:\MUSEWEB\SETUP.CMD and left click OK.

12.4. At the “Setup” prompt, left click Yes.

12.5. At the “Setup” prompt, left click Yes.

Note:  Setup window will appear and start copying files. This procedure will last
for about 5-7 minutes. It will automatically reboot the system.



Revision: T

AP 900124-701, REV T, PAGE 17 OF 43

13. INSTALLING NETWORK PRINTER SUPPORT

Note:  The following conditions must be met before continuing on with this section:
The printer must be configured using Jet Admin on the RSS Test PC.
If PDC: A printer connected to the Switch with an IP and Gateway set.
If Member: A printer connected to the MEI network with a known name.
Check customer order to see if it is called out as an option.

13.1. Log in as Administrator.

13.2. Left click Start >> Settings >> Printers

13.3. Left double-click icon Add Printer.

13.4. At the “Add Printer Wizard” screen, verify the radio button “My Computer” is
selected. Left click Next.

13.5. Left click Add Port.

13.6. From the “Available Printer Ports” section, left click LPR Port.

13.7. Left click New Port.

13.8. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
In the “Name or address…” edit field type XXX.XXX.XXX.XXX
Note:  XXX.XXX.XXX.XXX = the IP of the Printer.

MEMBER SERVER INSTALL
In the “Name or address…” edit field type $$$$$$$$$$
Note:  $$$$$$$$$$ = the name of the Printer based on Menu Printout.

13.9. In the “Name of printer or print…” edit field type raw.

13.10. Left click OK. Left click Close.

13.11. Left click Next.

13.12. Left click Have Disk.

13.13. Type Z:\HPPRINT\NT and left click OK.

13.14. Left click HP LaserJet 4000 Series PS in the “Printers” section.

13.15. Left click Next.

13.16. In the “Printer Name” section, type a unique name for the printer.

Note:  Default name should suffice unless otherwise stated by Pre-Build Survey.

13.17. Left click Next.
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13.18. Left click the radio button “Shared” and type in the edit a unique name.

Note:  For one (1) printer, use LJ4K01.  If more, increase number.
Default name should suffice unless otherwise stated by Pre-Build Survey.

13.19. Left click Next.

13.20. Verify the radio button Yes is selected and left click Finish to print a test page.

13.21. If the page printed successfully, left click Yes. If not left click NO and follow the
instructions to troubleshoot the problem.

13.22. Close all visible windows.

14. INSTALLING LOCAL PRINTER SUPPORT

Note:  The following condition must be met before continuing on with this section:
A printer configured and attached to the LPT port on the server.
Check customer order to see if it is called out as an option.

14.1. Log in as Administrator.

14.2. Left click Start >> Settings >> Printers

14.3. Left double-click icon Add Printer.

14.4. At the “Add Printer Wizard” screen, verify the radio button “My Computer” is
selected. Left click Next.

14.5. From the “Available Ports” section, left click the radio button that the printer is
attached to.

14.6. Left click Next.

14.7. Left click Have Disk.

14.8. Type Z:\HPPRINT\NT and left click OK.

14.9. Left click HP LaserJet 4000 Series PS in the “Printers” section.

14.10. Left click Next.

14.11. In the “Printer Name” section, type a unique name for the printer.

Note:  Default name should suffice unless otherwise stated by Pre-Build Survey.

14.12. Left click Next.

14.13. Left click the radio button “Shared” and type in the edit a unique name.

Note:  For one (1) printer, use LJ4K01.  If more, increase number.
Default name should suffice unless otherwise stated by Pre-Build Survey.

14.14. Left click Next.

14.15. Verify the radio button Yes is selected and left click Finish to print a test page.
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14.16. If the page printed successfully, left click Yes. If not left click NO and follow the
instructions to troubleshoot the problem.

14.17. Close the “Printers” window.

15. DISKEEPER FOR WINDOWS NT SERVER 4.0 INSTALLATION

15.1. Make sure that you are logged in as Administrator.

15.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

15.3. Left click Start >> Run.

15.4. Type Z:\DISKPR\V40\X86\SETUP.EXE and left click OK.

15.5. At the “Welcome” screen, left click Next.

15.6. At the “Software License Agreement” screen, left click Yes.

15.7. At the “Choose Destination Location” screen, verify default directory is
C:\ExecSoft\Diskeep and left click Next.

15.8. At the “Choose Destination Location” screen, verify “Diskeeper” is program
folder and left click Next.

15.9. At the “Registration” screen, left click Next.

15.10. Left click the check box “Yes, I want to Launch Diskeeper.”

15.11. Left click Finish.

15.12. Left click Close in the “Welcome window.”

15.13. Left click Options >> Event Logging.
Verify/change the following table:

X Service Start and Stop
X Defrag Start and Stop

Defrag Files
Moved Files
Disk Information
File Information
Directory Information
Pagefile Information
MFT Information

15.14. Left click OK.

15.15. Close the “Diskeeper” window.
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15.16. Diskeeper 4.1 Patch Installation

15.16.1. Left click Start >> Run.
15.16.2. Type Z:\DISKPR\V40\X86\PATCH\DK4UPDATE_I.EXE and left

click OK.
15.16.3. At the “Welcome” screen, left click Finish.
15.16.4. Left click Next.
15.16.5. Left click Yes.
15.16.6. Left click Finish.

16. PCANYWHERE32 8.0 INSTALLATION

Note:  The following condition must be met before continuing on with this section:
A 56K MultiTech modem attached to COM2 of the server.

16.1. Installing main program.

16.1.1. Remove the MUSE Software CD.  Insert the pcAnywhere CD into the
CD-ROM drive.

16.1.2. Left click Start >> Run.

16.1.3. Type Z:\CDINST.EXE and left click OK.

16.1.4. Highlight and left click on the Install Software option in the
“pcAnywhere CD-ROM installation Utility.”

16.1.5. At the “Welcome” screen left click Next.

16.1.6. At the “User Information” screen Enter/Verify information, left click
Next.

16.1.7. Read/verify the license agreement and left click Yes.

16.1.8. Accept the destination directory location and left click Next.
Verify default directory is C:\Program Files\pcANYWHERE.

16.1.9. Review the setup information on the “Setup Review” screen and left
click Next. Program will begin installing file to the computer.

16.1.10. Left click Next on “Symantec Support Solutions” screen.

16.1.11. Left click Next on “How to Reach Us” screen.

16.1.12. Left click Next on “Windows 95 Solutions” screen.

16.1.13. Left click Skip on “Online registration” screen.

16.1.14. Left click No to skip viewing the Readme file.

16.1.15. Left click Finish to restart the computer.

16.1.16. Remove the pcAnywhere CD from drive.
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16.2. Installing pcAnywhere Host Service

16.2.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

16.2.2. Log in as Administrator.

16.2.3. Left click Start >> Programs >> pcANYWHERE32 >>
pcANYWHERE.

16.2.4. If “Smart Setup Modem” window appears, do the following:

16.2.4.1. Left click Add Modem.

16.2.4.2. Left click check box “Don’t detect my modem…” Left click
Next.

16.2.4.3. Left click Have Disk

16.2.4.4. Type Z:\MULTITECH\NT

16.2.4.5. Left click OK

16.2.4.6. Left click MultiTech Systems MT5600ZDX

16.2.4.7. Left click Next

16.2.4.8. Left click COM2. Left click Next.

16.2.4.9. In the “What area(city) code …” edit box type YYY

Note:  YYY = The area code of the city.

Verify radio button “Tone Dialing” is selected. Left click Next.

16.2.4.10. Left click Finish.

16.2.4.11. Verify modem is MultiModem MT5600ZDX. Left click Next.

16.2.4.12. Verify TCP/IP is selected. Left click Next.

16.2.4.13. At the “Please select a port…” choose COM2. Left click
Finish.

16.2.5. Left click the BE A HOST PC button.

16.2.6. Right click on the MODEM icon and select the Properties dialog.

16.2.7. Verify/select MultiModem 5600ZDX is selected in the “Connection
Info” tab.

16.2.8. Left click “Settings” tab.

16.2.9. Verify/select in “Host Startup” Run Minimized is checked.

16.2.10. Verify/select in “Host Startup” Run as Service is checked.
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16.2.11. Verify/select in “Host Options” Wait for Anyone is checked.

16.2.12. Verify/select in both sections, in “Security” Log off user is checked.

16.2.13. Left click “Callers” tab.

16.2.14. Left click Use NT user privileges radio button.

16.2.15. Left double-click on “Add User” icon and do the following:

16.2.15.1. Verify “User”  radio button is selected. Left click Next.

16.2.15.2. In the “What domain…” select the MUSE file server
(Make sure you choose the machine name like MUSE$$$XXX
and not the domain name like MUSE$$$)

16.2.15.3. In the “Select the account…” select Administrator and left
click Next. Left click Finish.

16.2.16. Left click the “Security Options” tab.

16.2.17. In “Connection Options” left click the Blank this PC screen after
connection made.

16.2.18. Left click OK to save the properties settings for the MODEM
connection.

16.2.19. Left double-click the MODEM icon button to launch the service.

16.3. Switching pcAnywhere Host Service to Automatic

16.3.1. Left click Start >> Settings >> Control Panel >> Services.

16.3.2. Highlight the pcANYWHERE Host Service.

16.3.3. Left click Startup button and set the radio button AUTOMATIC.

16.3.4. Left click OK.

16.3.5. Verify that the “pcANYWHERE Host Service” has a status of
STARTED and a startup of AUTOMATIC, left click Close.

16.3.6. Close “Control Panel” window.

17. NT 4.0 SERVER RESOURCE KIT INSTALLATION

17.1. Make sure that you are logged in as Administrator.

17.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

17.3. Left click Start >> Run.

17.4. Type Z:\NTRESKIT\SETUP.EXE and left click OK.

17.5. At the “Do you agree to these terms…” screen left click Accept.



Revision: T

AP 900124-701, REV T, PAGE 23 OF 43

17.6. At the “Windows NT Server…” screen, Left click Continue.

17.7. At “Name” enter in the hospital's name.

17.8. At “Organization” enter in the hospital's affiliation or the hospital’s name again.
Left click OK.

17.9. Left click OK.

17.10. Accept the destination directory location and left click OK.
Verify the default directory is C:\NTRESKIT.

17.11. Left click Custom/Complete and left click Continue.

17.12. Left click OK to complete setup.

18. ST. BERNARD'S OPEN FILE MANAGER VERSION 5.1 INSTALLATION

18.1. Make sure that you are logged in as Administrator.

18.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

18.3. Left click Start >> Run.

18.4. Type Z:\OFM\V51\SETUP.EXE and left click OK.

18.5. At the “Welcome” screen, left click Next.

18.6. At the “Software License Agreement” screen, left click Yes.

18.7. At the “User Information” screen type in the following:

Name: MUSE$$$001
Company: Hospital Name
Serial: See OFM package for number

18.8. Left click Next.

18.9. At the “Choose Destination Folder” screen, verify default location to be
“C:\Program Files\OFM” left click Next.

18.10. At the “Select Program Folder” screen, verify default folder to be “Open File
Manager” left click Next.

18.11. At the “Start Copying Files” screen left click Next.

18.12. At the “Setup Complete” screen left click Finish.

18.13. At the “Open File Manager” window, left double click “OFM” icon.

18.14. Left click on the “+” sign to the left of the “Microsoft Windows Network” to
open.

18.15. Left click on the “+” sign to the left of the Domain in which the File Server is in.
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PDC ....................................................................................... MUSE$$$
Member ................................................................................. MUSESIG

18.16. You should now be able to see the File Server’s Computer Name in which you are
installing OFM to. Right click on “MUSE$$$001” and left click Install from the
pop-up menu.

18.17. At the “Install OFM” screen left click “MUSE$$$001” under the “System”
section and left click Install.

18.18. Left click Start and verify the green check mark by the Computer Name.

18.19. Left click File >> Exit and close all visible windows.

19. BTRIEVE 7.0 INSTALLATION – 5B ONLY

19.1. Make sure that you are logged in as Administrator.

19.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

19.3. Left click Start >> Run.

19.4. Type Z:\BTRIEVE\V70_3\SETUP.EXE and left click OK.

19.5. At the “Pervasive.SQL Install Welcome” window, left click Next.

19.6. At the “Pervasive.SQL Setup Type” window, left click Custom.

19.7. At the “Select Server Engines” window, left click “Scalable SQL” to uncheck the
box and verify “Btrieve” to be the only box checked. Left click Next.

19.8. At the “Select Client Components Installation Directory” window, verify
C:\PVSW\ and left click Next.

19.9. At the “Select Components to Install” uncheck all boxes EXCEPT for “Client
Programs” and “Btrieve” and left click Next.

19.10. At the “Question” window “You selected to not install the ODBC…” left click
NO.

19.11. At the “Select Pervasive.SQL Software Folder” verify Pervasive SQL 7 and left
click Next.

19.12. At the “Select Services Mode” screen verify “Automatic” and left click Next.

19.13. Verify settings and left click Next.

Note:  System will copy files.

19.14. At the “Setup User Count License” screen, insert the appropriate Btrieve floppy
into the A: drive and left click Install License.

19.15. At the “User Count License” screen, left click OK.
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19.16. At the “32-bit Btrieve Functionality Check” screen left click Skip.

19.17. At the “Question” window, left click NO. Remove floppy from the A: drive.

19.18. Left click Finish to restart system.

20. BTRIEVE 6.15 INSTALLATION – 5A ONLY

20.1. Make sure that you are logged in as Administrator.

20.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

20.3. Left click Start >> Run.

20.4. Type Z:\BTRIEVE\V615\XX\INSTALL.EXE and left click OK.

Note:  XX = the amount of licenses purchased.

20.5. At the “Pervasive Welcome” window left click Next.

20.6. At the “Installation Options” window left click Next.
Verify that all boxes are checked.

20.7. At the “Choose Destination Location” window left click Next.
Verify the default directory is c:\bti\winnt.

20.8. At the “Install will copy files…” left click Yes.

20.9. At the “Btrieve for Windows NT Service has been installed and is running…”
prompt left click Yes to stop it now.

20.10. At the “What type of program group...” Left click Next.
Verify radio box “Common Program Group…” is selected.

20.11. At the “Would you like to view...” left click No.

20.12. At the “Install is complete...” screen, left click OK. Close window.

21. VISUAL BASIC 4 INSTALLATION – 5A ONLY

21.1. Make sure that you are logged in as Administrator.

21.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

21.3. Left click Start >> Run

21.4. Type Z:\VISUALB4\SETUP.EXE and left click OK.

21.5. Left click OK.

21.6. Verify directory to be C:\PROJECT1\. Left click button.

21.7. At the “Project1 Setup…” message box, left click OK.
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22. MUSE MAIL MESSAGING INSTALLATION

Note:  Check customer order to see if this is an ordered option. If Yes, install the
following. If not, go to next section.

22.1. Install the IIS 4.0 SMTP Server

22.1.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

22.1.2. Left click Start >> Programs >> Windows NT 4.0 Option Pack >>
Windows NT 4.0 Option Pack Setup.

22.1.3. Left click Next.

22.1.4. Left click Add/Remove.

22.1.5. Left double-click the “Internet Information Server (IIS)” in the
“Components” list.

22.1.6. At the “Internet Information Server (IIS)” screen, left click the “SMTP
Service” check box.

22.1.7. Left click OK.

22.1.8. Left click Next.

22.1.9. Left click Next to accept the default mailroot directory.

22.1.10. Left click Finish.

22.2. Configure the IIS 4.0 SMTP Server

22.2.1. Left click Start >> Programs >> Windows NT 4.0 Option Pack >>
Microsoft Internet Information Server >> Internet Service
Manager.

22.2.2. Left click “show tips on startup” to uncheck and left click Close.

22.2.3. In the left window pane, left click the “+” sign to the left of the
“Internet Information Server” to open.

22.2.4. Left click the “+” sign to the left of “MUSE$$$XXX” to open.

22.2.5. Right click “Default SMTP Site” to access menu and left click
“Properties.”

22.2.6. Left click “Messages” tab and type in the following:

Maximum Message Size (kilobytes) ..............................................30000
Maximum Session Size (kilobytes) ................................................30000

22.2.7. Left click “Delivery” tab and type in the following:

Smart Host ..............................................................................MUSESIG

22.2.8. Left click “Directory Security” tab.
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22.2.9. In the “Relay Restrictions” section, left click Edit…

22.2.10. Left click “Allowed to Relay” radio button.

22.2.11. Left click OK.

22.2.12. Left click OK.

22.2.13. Left click Console >> Exit.

22.2.14. Left click Yes to console settings.

22.2.15. Left click Start >> Settings >> Control Panel >> Services.

22.2.16. Make sure the following is set for the “Microsoft SMTP Service”

Startup.....................................................................................Automatic
Status ...........................................................................................Started

22.2.17. Left click Close.

22.2.18. Close “Control Panel.”

22.3. Install EMWAC POP3 Server Software

22.3.1. Left click Start >> Run.

22.3.2. Type Z:\POP3\INSTALL.BAT C:\WINNT and left click OK.

22.3.3. At the “Does the MUSE File Server…” prompt, verify NO is
highlighted and press. <ENTER>

22.3.4. At the “Registry Editor” prompt, left click OK.

23. MUSE SOFTWARE INSTALLATION – 5A ONLY

23.1. Install MUSE Application Files

23.1.1. Make sure that you are logged in as Administrator.

23.1.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

23.1.3. Left click Start >> Programs >> Command Prompt.

23.1.4. Type Z: <ENTER>

23.1.5. Type CD\MUSE <ENTER>

23.1.6. Type INSTALL 1 <ENTER>

23.1.7. At the “License…” prompt, verify Yes. <ENTER>

23.1.8. At the “Time Zone Environment Variable”, select accordingly.
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Note:  This will depend on the city you are shipping to.

23.1.9. At the “Add a Start MUSE CV Shortcut to the Desktop” prompt, verify
Yes. <ENTER>

23.1.10. Perform the following based on the File Server:

MEMBER SERVER INSTALL ONLY

Type CVUSER MuseAdmin <ENTER>
Type CVUSER MuseBkgnd <ENTER>

23.2. Perform one of the following based on the Sales Order:

CONVERSION INSTALL ONLY
If your system requires a customer database to be placed on the system, notify the
appropriate member of conversion to do this.  When done, they will call you back
to continue with the install.

NO CONVERSION OR NEW SYSTEM INSTALL ONLY
If your system is NEW or DOES NOT need a customer’s database installed on it,
install the default MUSE Database Files.

Type CD\MUSEDB <ENTER>
Type INSTALL 5000 <ENTER>
At the “License…” prompt, verify Yes. <ENTER>

23.3. Perform one of the following based on the File Server:

MEMBER SERVER INSTALL ONLY

Type cvsinst MUSESIG\MUSEBkgnd Muse!Bkgnd d:\vol000\system\sysinf\services.asc
<ENTER>

23.4. MUSE CV WEB INSTALLATION ONLY

Note:  Check customer order to see if this is an ordered option. If Yes, install the
following. If not, go to next section.

23.4.1. Install MUSE CV WEB

23.4.1.1. Type CD\MUSEWEB <ENTER>

23.4.1.2. Type INSTALL Z:\MUSEWEB\ <ENTER>

23.4.1.3. At the “License…” prompt, verify Yes. <ENTER>

23.4.2. Install Adobe Acrobat Reader

23.4.2.1. Left click Start >> Run

23.4.2.2. Type Z:\ADOBE\AR32E301.EXE and left click OK.

23.4.2.3. At the “This will install Adobe Acrobat…” screen, left click
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Yes.

23.4.2.4. At the “Welcome” screen, left click Next.

23.4.2.5. At the “License Agreement” screen, left click Yes.

23.4.2.6. At the “Destination Directory” screen, Left click Next.

23.4.2.7. At the “Setup Complete” screen, uncheck the “Display Acrobat
Reader 3.01 Readme file” check box, left click Finish.

23.4.2.8. Left click OK to the “Setup is complete” message.

23.5. MUSE WORD DATABASE INSTALLATION ONLY

Note:  Check customer order to see if MUSE CV Word is an ordered option.  If
Yes, install the following. If not, go to next section.

23.5.1. Type CD\MUSEWDDB <ENTER>

23.5.2. Type INSTALL <ENTER>

23.6. Install MUSE Update files

23.6.1. Type CD\MUSEUP <ENTER>

23.6.2. Type INSTALL -U <ENTER>

23.6.3. At the “License…” prompt, verify Yes. <ENTER>

23.7. Type EXIT. <ENTER>

23.8. Reboot the system.

24. MUSE SOFTWARE INSTALLATION – 5B ONLY

24.1. MUSE CV Server and MUSE CV Web Installation

24.1.1. Log in as Administrator.

24.1.2. If any Btrieve 7.0 folders are open in the tool bar, close them now.

24.1.3. Left click Start >> Run

24.1.4. Type Z:\MUSE32\SETUP.EXE and left click OK.

24.1.5. At the “Welcome” screen, left click Next.

24.1.6. At the “Software License Agreement” screen, left click Yes.

24.1.7. At the “Select MUSE CV System NODE Type” screen, verify that the
“File Server” radio button is selected.

24.1.8. Left click Next.

24.1.9. At the “Select MUSE CV…” screen, make sure “MUSE CV
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Application” check box is selected.

24.1.10. If you are installing MUSE CV Web, left click “MUSE CV Web”
check box.
Check customer order to see if this is an ordered option. If Yes, install
the MUSE CV Web. If not, do not check, skip this and move on.

24.1.11. Left click Next.

24.1.12. At the question screen “Add MUSE CV Desktop icon,” verify that the
Yes radio button is selected and left click Next.

Note:  System will copy files.

24.1.13. At the “Setup Complete” screen, verify “Yes, I want to restart my
computer now” radio button is selected and left click Finish to restart
the computer.

24.2. Perform the following based on the File Server:

MEMBER SERVER INSTALL ONLY

24.2.1. Make sure that you are logged in as Administrator.

24.2.2. Left click Start >> Programs >> Command Prompt.

24.2.3. Type CVUSER MuseAdmin <ENTER>

24.2.4. Type CVUSER MuseBkgnd <ENTER>

24.2.5. Type EXIT. <ENTER>

24.3. Perform one of the following based on the Sales Order:

CONVERSION INSTALL ONLY
If your system requires a customer database to be placed on the system, notify the
appropriate member of conversion to do this.  When done, they will call you back
to continue with the install.

NO CONVERSION OR NEW SYSTEM INSTALL ONLY
If your system is NEW or DOES NOT need a customer’s database installed on it,
install the default MUSE Database Files.

24.3.1. Make sure that you are logged in as Administrator.

24.3.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

24.3.3. Left click Start >> Run

24.3.4. Type Z:\MUSEDB\SETUP.EXE and left click OK.

24.3.5. At the “Welcome” screen, left click Next.

24.3.6. At the “Software license agreement” screen, left click Yes.
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Note:  System will copy files.

24.3.7. At the “Question” prompt, left click No and left click Next.

24.3.8. At the “Setup Complete” screen, left click “NO” radio button and left
click Finish.

24.4. Perform one of the following based on the File Server:

MEMBER SERVER INSTALL ONLY

24.4.1. Left click Start >> Programs >> Command Prompt.

24.4.2. Type cvsinst MUSESIG\MUSEBkgnd Muse!Bkgnd
d:\vol000\system\sysinf\services.asc <ENTER>

24.4.3. Type EXIT. <ENTER>

24.5. MUSE CV WEB INSTALLATION ONLY

Note:  Check customer order to see if this is an ordered option. If Yes, install the
following. If not, go to next section.

24.5.1. Install Adobe Acrobat Reader

24.5.1.1. Left click Start >> Run

24.5.1.2. Type Z:\ADOBE\AR32E301.EXE and left click OK.

24.5.1.3. At the “This will install Adobe Acrobat…” screen, left click
Yes.

24.5.1.4. At the “Welcome” screen, left click Next.

24.5.1.5. At the “License Agreement” screen, left click Yes.

24.5.1.6. At the “Destination Directory” screen, Left click Next.

24.5.1.7. At the “Setup Complete” screen, uncheck the “Display Acrobat
Reader 3.01 Readme file” check box, left click Finish.

24.5.1.8. Left click OK to the “Setup is complete” message.

24.6. Install MUSE Update Files

24.6.1. Left click Start >> Programs >> Command Prompt
24.6.2. Type Z: <ENTER>
24.6.3. Type CD\MUSEUP <ENTER>
24.6.4. Type INSTALL -U <ENTER>
24.6.5. At the “License…” prompt, verify Yes. <ENTER>
24.6.6. Type EXIT <ENTER>

24.7. Reboot the system.

25. TESTING THE MUSE CV WEB INSTALLATION
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Note:  Perform this section only if the MUSE CV WEB option has been installed,
otherwise go to the next section.

25.1. Log in as the following:

User ......................................................................................................MuseAdmin
Password..............................................................................................Muse!Admin

Domain PDC ............................................................................................MUSE$$$
Domain Member......................................................................................MUSESIG

25.2. At the “Welcome” window, left click Close.

25.3. Close the “Welcome – Microsoft Internet Explorer” window.

25.4. Make sure that the MUSE Software CD is in the CD-ROM drive.

25.5. Left click Start >> Run.

25.6. Type Z:\BAT\ADDTMPUS.BAT and left click OK.

25.7. Verify the commands completed successfully.

25.8. Press any key to close the command prompt window.

25.9. Left click Start >> Shut Down…

25.10. Select the “Close all programs and…?” radio button.

25.11. Left click Yes.

25.12. Log in as the following:

User ..................................................................................................CVWEBTEST
Password...................................................................................................cvwebtest

Domain PDC ............................................................................................MUSE$$$
Domain Member..............................................................................MUSE$$$XXX

Note:  MUSE$$$XXX = local machine

25.13. At the “Welcome” window left click Close.

25.14. Close the “Welcome – Microsoft Internet Explorer” window.

25.15. Left double-click the “Internet Explorer” icon on the desktop.

25.16. Left click Next.

25.17. At the “Setup Options screen”, select the “I already have an Internet
connection…” radio button, left click Next.

25.18. Left click Finish.

25.19. Left click Stop to abort finding Microsoft Web Site or left click OK at the “A
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connection with the server…” prompt.

25.20. Left click in the Address bar of the Internet Explorer window, type
MUSE$$$XXX. <ENTER>

25.21. In the “Enter Network Password” window, enter the following:

User name.........................................................................................CVWEBTEST
Password...................................................................................................cvwebtest

25.22. Left click OK.

25.23. Verify that the “Welcome to the MUSE® CardioVascular Information System
Website” homepage is displayed.

25.24. Close the Internet Explorer window.

25.25. Left click Start >> Shut Down…

25.26. Select the “Close all programs and…?” radio button.

25.27. Left click Yes.

25.28. Log in as Administrator

25.29. Left click Start >> Run.

25.30. Type Z:\BAT\DELTMPUS.BAT and left click OK.

25.31. Verify the commands completed successfully.

25.32. Press any key to close the command prompt window.

25.33. Left click Start >> Shutdown…

25.34. Select the “Restart” radio button. System will reboot.

26. SETTING UP MUSE ENVIRONMENT

26.1. Log in as MuseAdmin. Password is Muse!Admin.

Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY
In the “Domain” pull down box select MUSE$$$

MEMBER SERVER INSTALL ONLY
In the “Domain” pull down box select MUSESIG

26.2. If the “Welcome” window appears, left click Close.

26.3. If the “Welcome – Microsoft Internet Explorer” window appears, close it.

26.4. Adding nodes to the server

26.4.1. Left click Start >> Programs >> Command prompt
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26.4.2. Type CVUSER MuseXXX. <ENTER>

Note:  XXX is number of the node that you want to add.

The corresponding password will be Muse!XXX.

Repeat this step for as many users that you will have connecting to the
server.

26.4.3. Type Exit. <ENTER>

26.5. Configuring IMS

26.5.1. Left click Start >> Run

26.5.2. Type DCOMCNFG. Left click OK.

26.5.3. Select MUSE-CV IMS Cserver. Left click Properties.

26.5.4. Left click the “Security” tab.

26.5.5. Left click the “Use Custom Access Permissions” radio button. Left
click Edit button.

26.5.6. Left click Add.

26.5.6.1. Left click “List Names From” and choose the local domain:
PDC .............................................................................MUSE$$$
Member...........................................................\\MUSE$$$XXX*

26.5.6.2. Left double-click Muse Users group.

26.5.6.3. Left double-click System group.

26.5.6.4. Verify they appear in “Add names” window along with “Type
of Access” being Allow Access. Left click OK.  Left click OK

26.5.7. Left click the “Use Custom Launch Permissions” radio button. Left
click Edit button.

26.5.8. Left click Add.

26.5.8.1. Left click “List Names From” and choose the local domain:
PDC .............................................................................MUSE$$$
Member...........................................................\\MUSE$$$XXX*

26.5.8.2. Left double-click Muse Users group.

26.5.8.3. Left double-click System group.

26.5.8.4. Verify they appear in “Add names” window along with “Type
of Access” being Allow Launch. Left click OK.  Left click
OK

26.5.9. Left click “Identity” tab.
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26.5.10. Left click “This User” radio button.

26.5.11. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY
In the “User” edit box type MUSE$$$\MuseBkgnd

Note:  Where MUSE$$$ = domain name of PDC.

MEMBER SERVER INSTALL ONLY
In the “User” edit box type MUSESIG\MuseBkgnd

26.5.12. In the “Password” edit box type Muse!Bkgnd and confirm the
password.

26.5.13. Left click OK.

26.5.14. Left click OK.

26.6. Verify that IMS is configured properly.

26.6.1. Insert Cartridge into Tape Backup unit.
26.6.2. Left click Start >> Run.
26.6.3. Type CVIS0122. Left click OK.
26.6.4. Verify that the MUSE-IMS window is launched, close window.

26.6.5. Left click Start >> Run.

26.6.5.1. Type D:\VOL000\SYSTEM\SYSINF\IMS.INI. Left click
OK.

26.6.5.2. Add the following to the section – 5A ONLY

[Backup]
LastWeek=
ThisWeek=
UpdateOFM=FALSE

26.6.5.3. Change section to the following:

[AUTORUN]
BACKARC=FALSE
INTEGRITY=FALSE

26.6.5.4. Save file.

26.6.6. Left click Start >> Run.

26.6.7. Type SOON CVIS0122   –AUTORUN. Left click OK .

Note:  A window should appear and close down.
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26.6.8. Start MUSE.

26.6.8.1. Left click Start >> Programs >> MUSE CVIS >>
Start MUSE CV.

26.6.8.2. Left click System >> System Status

26.6.8.3. Left click Select List >> Event Log

26.6.8.4. Visually check for the following entries

“IMS Started”
“IMS Ended”

26.6.8.5. Exit MUSE application. Left click System >> Exit.

26.6.9. Left click Start >> Run.

26.6.9.1. Type D:\VOL000\SYSTEM\SYSINF\IMS.INI. Left click
OK.

26.6.9.2. Change section to the following:

[AUTORUN]
BACKARC=TRUE
INTEGRITY=TRUE

26.6.9.3. Save file.

26.6.10. Configure nightly Auto Run time

26.6.10.1. Left click Start >> Run.
26.6.10.2. Type CVIS0122. Left click OK.
26.6.10.3. Left click System >> Set AutoRun Time.
26.6.10.4. Right click in the white Client area that is launched.
26.6.10.5. Left click Add.
26.6.10.6. Type in the command box CVIS0122   –AUTORUN
26.6.10.7. Set the days and hours of operation.

26.6.10.7.1. The “Every”  radio button should be selected.
26.6.10.7.2. Left click on every day of the week.
26.6.10.7.3. Set the time for 3:00 am.
26.6.10.7.4. Left click OK .

26.6.10.8. Verify a green check, all days chosen and time set to 3:00am.
26.6.10.9. Close all visible windows.

26.6.11. Installing Options Disk

26.6.11.1. Start MUSE by left double-clicking on icon Start MUSE CV

26.6.11.2. Left click System >> System Setup.

26.6.11.3. Left click System >> Install Options.
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26.6.11.4. Copy “Authorization Code” and proceed to MUSE Options
station to set up the Options Disk #419719-001.

26.6.11.5. Once completed, insert Options disk into floppy drive and left
click Install.

26.6.11.6. Verify “Registered Name” and “Installed Options List” data to
be correct.

26.6.11.7. Remove floppy.

26.6.11.8. Close MUSE application and restart NT.

26.7. CATH LAB INSTALLATION ONLY

Note:  Check customer order to see if this is as an ordered option.  If Yes, install
the following.  If not, go to next section.

26.7.1. Cath options must be turned on via the Options disk.

26.7.2. The file “APPLIST.ASC” must be edited and the “!” in front of
Configure Cath Lists… must be removed.
The file “BACKTASK.ASC” must be edited and the “;” in front of
324,\\MUSE$$$XXX must be removed.

26.8. MAC-LAB INSTALLATION ONLY

Note:  Check customer order to see if this is as an ordered option. If Yes, install
the following. If not, go to next section.

26.8.1. Share Drive for access.

26.8.1.1. Left click Start >> Run

26.8.1.2. Type Z:\MUSEDB\MLABADD.BAT and left click OK.

26.8.2. The file “APPLIST.ASC” must be edited and the “!” in front of
MAC-LAB Assistant… must be removed.

26.9. ACC DATA EXPORT INSTALLATION ONLY

Note:  Check customer order to see if this is as an ordered option. If Yes, install
the following. If not, go to next section.

26.9.1. The file “APPLIST.ASC” must be edited and the “!” in front of ACC
Data Export… must be removed.

26.10. INVENTORY MANAGEMENT AND SCHEDULE BOARD
INSTALLATION ONLY

Note:  Check customer order to see if this is as an ordered option. If Yes, install
the following. If not, go to next section.

26.10.1. Inventory Management option must be turned on via the Options disk.

26.10.2. Schedule Board option must be turned on via the Options disk.
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26.10.3. The file “BACKTASK.ASC” must be edited and the “;” in front of
612,1,1 must be removed. Also, the “1,1” must be changed to the
number of the client that will running it.

Note:  Only one instance of 612 can be activated on a networked
system.

26.11. TFTP SERVER INSTALLATION ONLY

Note:  Check customer order to see if a Gateway client is to be installed. If Yes,
install the following. If not, go to next section.

26.11.1. The file “BACKTASK.ASC” must be edited and the line 325,1,1 must
be added. Also, the “1,1” must be changed to the number of the client
that will running it.

26.11.2. The file “BACKTASK.ASC” must be edited and the 340,1,1 must be
added. Also, the “1,1” must be changed to the number of the client that
will running it.

26.12. Installing the Bar Code font – 5A ONLY

26.12.1. Logon as MuseAdmin.
26.12.2. Left click Start >> Settings >> Control Panel >> Fonts.
26.12.3. Left click File >> Install New Font …
26.12.4. Choose C:\mei directory.
26.12.5. Left click 3 of 9 Barcode (TrueType).
26.12.6. Left click OK .
26.12.7. Close all visible windows.

27. CONFIGURING MuseAdmin DESKTOP

27.1. Set the screen saver.

27.1.1. Right click on the desktop, left click Properties.
27.1.2. Left click the “Screen Saver” tab.
27.1.3. Choose the Logon Screen Saver from “Screen Saver” pull down

menu.
27.1.4. Left click “Password Protected” check box.
27.1.5. Verify wait is set to 15 minutes.
27.1.6. Left click OK to exit.

27.2. Move the “My Briefcase” folder to the Recycle Bin.

27.2.1. Right click on icon My Briefcase and select Delete.
27.2.2. Left click Yes to confirm delete.

27.3. Set the taskbar options

27.3.1. Left click Start >> Settings >> Taskbar…
27.3.2. Verify “Always on top” is selected.
27.3.3. Left click “Show small icons in Start menu.”
27.3.4. Verify “Show Clock” is selected.
27.3.5. Left click OK to exit.
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27.4. Set the Explorer Options

27.4.1. Left double-click “My Computer” icon.
27.4.2. Left click View >> Toolbar. Toolbar should appear in window.
27.4.3. Left click View >> Options…
27.4.4. Left click the radio button “Browse folders by using a single window

that changes as you open each folder.”
27.4.5. Left click the “View” tab.
27.4.6. Left click the radio button “Show all files.”
27.4.7. Left click the check button “Display the full path in the title bar.”
27.4.8. Un-select “Hide file extensions for known file types.”
27.4.9. Left click the check button “Display compressed files and folders with

alternate color.”
27.4.10. Left click OK. Close “My Computer” window.

27.5. Set the command prompt options

27.5.1. Left click Start >> Settings >> Control Panel >> Console.
27.5.2. Left click the “Options” tab. Default.
27.5.3. Left click “Large” from the “Cursor Size” section.
27.5.4. Left click the “Layout” tab.
27.5.5. Enter 80 for the “Screen Buffer Size Width.” Default.
27.5.6. Enter 50 for the “Screen Buffer Size Height.”
27.5.7. Enter 80 for the “Window Size Width.” Default.
27.5.8. Enter 50 for the “Window Size Height.”
27.5.9. Left click OK. Close “Control Panel” window.

*****************************************
Note:  At this point, the install of the MUSE File Server is complete.

Complete any necessary client installations and start the overall testing using TP MUSE 5A at
this time.

After successful completion of the TP, return to this point and complete the AP.
****************************************

28. BURN-IN PROCEDURE

No burn-in is necessary with MUSE systems.

29. CLEANUP

Perform one of the following based on the Sales Order:

CONVERSION INSTALL ONLY
Give system to the Conversion team.  When they return it back to you, complete
the rest of this AP.

NO CONVERSION OR NEW SYSTEM INSTALL ONLY
Continue with this AP.

29.1. Emptying Recycle Bin.

29.1.1. Right click on Recycle Bin icon.
29.1.2. Select “Empty Recycle Bin”
29.1.3. Left click Yes.
29.1.4. Reboot.
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29.2. Disk Maintenance.

29.2.1. Make sure that you are logged in as Administrator.

29.2.2. Left click Start >> Programs >> Diskeeper >> Diskeeper.

29.2.3. Close “Welcome” window.

29.2.4. Left click Defragment >> Select Disk.

29.2.5. Left click C:[NTFS].

29.2.6. Left click OK.

29.2.6.1. Process will now start and may take 5-10 minutes.
29.2.6.2. Let click OK when done.

29.2.7. Left click Defragment >> Select Disk.

29.2.8. Left click D:[NTFS].

29.2.9. Left click OK.

29.2.9.1. Process will now start and may take 5-10 minutes.
29.2.9.2. Left click OK when done.

29.2.10. Left click Advanced Tools >> Boot-Time Defragmentation.

29.2.11. Left click C:[NTFS].  Left click “Directory Consolidation” check box.
Left click Set.  Verify Directory Consolidation Set.

29.2.12. Left click D:[NTFS].  Left click “Directory Consolidation” check
box. Left click Set.  Verify Directory Consolidation Set.

29.2.13. Left click Close.

29.2.14. At the “Diskeeper” prompt, left click OK, left click OK.

29.2.15. Close “Diskeeper” window.

29.2.16. Reboot system.

Note:  This process will reboot your system a few times. Wait until you
get a logon screen before continuing.

30. CREATING AN EMERGENCY REPAIR DISK

30.1. Log in as Administrator.
30.2. Insert a floppy into  A: drive
30.3. Select Start >> Run
30.4. Type RDISK /S. Left click OK.
30.5. At the “Setup can create an Emergency Repair disk...” Screen, left click Yes.
30.6. At the “Label a floppy disk...” screen, left click OK.
30.7. At the “Windows NT repair information contains...” screen, left click OK.
30.8. Remove the floppy, date and label it as MUSE$$$XXX Emergency Repair Disk
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30.9. Restart System.

31. TAPE BACKUP

31.1. Log in as MUSE ADMIN

31.2. Left click Start >> Programs >> MUSE CV Info System >> Integrated
Maintenance Suite >> Manual Backup

31.3. Insert “MONDAY” tape.

31.4. Left click Normal Daily.  Backup process will start.

31.5. Left click Start >> Programs >> MUSE CV Info System >> Integrated
Maintenance Suite >> Manual Backup

31.6. Insert “MONTHLY SERVICE” tape.

31.7. Left click Monthly Backup.  Backup process will start.

Note:  Check MUSE error log to verify backups ran correctly.

31.8. CONVERSION INSTALL ONLY

31.8.1. Left click Start >> Programs >> MUSE CV Info System >>
Integrated Maintenance Suite >> Advanced

31.8.2. Insert “CONVERSION” tape.

31.8.3. 5A INSTALLS:  Left click Backup Archive >> Backup Paths
5B INSTALLS:  Left click Backup Archive >> Do Manual Backup

31.8.4. Highlight all volumes.

31.8.5. Left click OK.  Backup process will start.

Note:  If volumes are large enough this process may ask for multiple
tapes to be inserted.

31.8.6. Upon completion, give tape to Conversion and let them visually inspect
the system.

31.8.7. Multiple Archived Volumes

Note:  Complete this section only if there are more then two volumes.

Note:  Vol0 and Vol[with the greatest number] should not be selected. They are
both active and will be done in the Daily Tape process. Only select the
Vol’s that are in between these two. They are not active and will not be
backed up unless told to do so. Also, for every additional volume, you
must have two extra tapes that must be added to the sales order as separate
line items.
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For example, if you have the following scenario:
Vol0 È Template Volume – will be backed up in Daily Tape. Do not select.
Vol1 È Archive Volume – You will create two [2] VOLUME 1 tapes and
backup.
Vol2 È Archive Volume – You will create two [2] VOLUME 2 tapes and
backup.
Vol3 È Active Volume – will be backed up in Daily Tape. Do not select.

31.8.7.1. Left click Start >> Programs >> MUSE CV Info System >>
Integrated Maintenance Suite >> Advanced

31.8.7.2. Insert VOLUME X tape.

Note:   X =  the number of the volume.

31.8.7.3. 5A INSTALLS:  Left click Backup Archive >> Backup Paths
5B INSTALLS:  Left click Backup Archive >> Do Manual
Backup

31.8.7.4. Highlight the appropriate VolX.

31.8.7.5. Left click OK.  Backup process will start.

31.8.7.6. Upon completion, remove tape, put in the second tape and
repeat section.  If there are more volumes to backup, like in the
example, repeat this section. For every volume there should be
two identical backup tapes that will be sent to the customer.

32. REMOVE TEMPORARY USERS

FOR MEMBER SERVER INSTALL ONLY

32.1. Log in as Administrator. In the “Domain” pull down box select MUSE$$$XXX

32.2. Left click Start >> Programs >> Administrative Tools >> User Manager for
Domains.

32.3. Left double-click “MUSE Users” in bottom window.

32.3.1. Select all users and left click Remove.
32.3.2. Left click OK.

32.4. Left double-click “Administrators” in bottom window.

32.4.1. Select all users, except for Administrator, and left click Remove.
32.4.2. Left click OK.

32.5. Left double-click “Users” in bottom window.

32.5.1. Select all users, except the Administrator, and left click Remove.
32.5.2. Left click OK.
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32.6. Left click Policies >> User Rights.

32.6.1. Left click check box “Show Advanced Users Rights”
32.6.2. Pull down “Right” menu, select Log on as a Batch Job.
32.6.3. Select “MUSE Background” user and left click Remove.
32.6.4. Pull down “Right” menu, select Log on as a Service.
32.6.5. Select all users and left click Remove.
32.6.6. Left click OK.

32.7. Close “User Manager” window.

*****************************************
NOTE:  AT THIS POINT, YOU ARE READY TO SHIP THE SYSTEM.
REFERENCE TP MUSE 5A FOR PROPER SHIPPING INSTRUCTIONS.

*****************************************
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1. PURPOSE

This procedure is intended as a guideline for the assembly of the following MUSE
products:

1.1. MUSE RAID File Server ...................................................................... 421519–101
1.2. MUSE RACK/RAID File Server with UPS 100–120V........................ 421519–102
1.3. MUSE RACK/RAID File Server with UPS 200–240V........................ 421519–103

Based on what is called out on the customer order and the new OMAR structure, a
technician will be able to reference this document in order to create a system with
Windows NT 4.0 as its operating system.

2. SCOPE

This document applies to the Marquette Medical Systems (MMS) – Milwaukee
manufacturing operation.

3. RELATED DOCUMENTS

3.1. .................................................................................MUSE Network Series Manual
3.2. QS1004.........................................................................Product Burn–In Guidelines
3.3. QS1003.................................Quality Assurance Device History Record Guidelines
3.4. TP–MUSE 5A ..................................................................MUSE 5A Test Procedure
3.5. MF1348 .......................................PC to PC MUSE & Conversion Check–off Sheet
3.6. MF1349 ....................................DEC to PC MUSE & Conversion Check–off Sheet

4. EQUIPMENT REQUIRED
All equipment is “OR EQUIVALENT”

4.1. Complete MUSE Tower File Server Customer Order
4.2. MUSE Software CD 5A........................................................................ 420858–001
4.3. MUSE Software CD 5B .........................................................................422436-001
4.4. Compaq SmartStart CD......................................................................... 421856–003
4.5. Compaq Management CD..................................................................... 421854–003
4.6. Compaq Network Interface Card Drivers ............................................. 422723–001

5. SPECIAL CONDITIONS

None

6. PROCEDURE

6.1. Assembly of Vendor Equipment

6.1.1. Connect UPS power cord into 220 VAC 50–60 HZ outlet or special 115
VAC 30 Amp L5–30 type receptacle depending on the UPS type.

6.1.2. Connect the monitor signal cable to the Keyboard/Monitor/Mouse Switch
Box (KVM Switch Box) monitor connector.
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6.1.3. Connect the power cord from the monitor to an open receptacle on the
UPS. Use the power cord supplied with the monitor or a power cord
supplied with the UPS depending on the UPS type.

6.2. Configuring the Compaq Server

6.2.1. Power–up the system.

6.2.2. Load the Compaq SmartStart CD into the CD–ROM drive immediately
after power–up.

Note:  The SmartStart CD is a bootable CD. The system will boot–up
using this CD to run the initial setup utilities.

6.2.3. <F1> to continue.

6.2.4. Left click “Run System Erase Utility” icon, left click OK.

6.2.5. At the “Warning” prompt left click Yes.

Note:  SmartStart will now erase any previous system setup.

6.2.6. At the “System has been erased. Cycle system power now” screen, cycle
power on the system.

Note:  The system will again boot–up from the SmartStart CD in order to
continue with the initial setup.

6.2.7. At the Language selection screen, left click the English button.

6.2.8. At the Country/Time Selection screen, verify “United States” is selected
for both the country and the keyboard, set the appropriate Date and Time
according to where the system is going, left click Next.

Note:  PM time should be entered in Military (24) time.

6.2.9. At the Systems Settings Summary screen left click Continue.

6.2.10. At the SmartStart License Screen left click the “I Agree” check box, left
click OK.

6.2.11. At the SmartStart Path Screen left click the “Manual Configuration”
installation path radio button, left click Begin.

6.2.12. At the Operating System Settings screen left double–click the “Microsoft”
folder and left click the “Microsoft Windows NT Server version 4.0 –
English” check box.

Note:  This is the first check box under the Microsoft folder.

6.2.13. Left click Next.

6.2.14. Left click Continue.
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6.2.15. Verify “Continue with SmartStart” is selected. <ENTER>

6.2.16. At the “Reboot” screen. <ENTER>

6.2.17. At the “Unconfigured Controller” screen left click Next.

6.2.18. At the “Operating System Settings” screen verify “Microsoft Windows
NT 3.5X, 4.0 or later” is selected, left click Next.

6.2.19. Verify “ (RAID 5)…” radio button is selected, and the “Use Online Spare”
check box is selected, left click Next.

6.2.20. Left click Next to accept the configuration.

6.2.21. Left click Done.

6.2.22. Left click Controller >> Save Configuration.

6.2.23. Left click Controller >> Exit.

Note: The system will reboot and automatically run through some
configuration setups for a minute or two before the next step.

6.2.24. At the “Disk Builder” screen left click Next.

6.2.25. Remove the SmartStart CD from the CD–ROM drive.

Note:  Since the SmartStart CD is a bootable CD, it must be removed
from the CD–ROM drive. If it is only ejected from the CD–ROM drive
and the system is subsequently rebooted, the CD–ROM drive will
automatically reload any CD that has not been removed from the drive
when it initializes at boot time.

6.2.26. Left click Continue to begin the operating system setup. The system will
reboot.

6.3. Configuring the KVM Switch Box

Note: Perform the following ONLY IF the RACK option is being assembled. If
not, go to section “WINNT4.0 SERVER INSTALLATION”.

6.3.1. <Print Scrn> to access the Console Configuration Reporting (CCR)
interface.

6.3.2. At the “CCR Selection” screen <F2>

6.3.3. Press the <RIGHT> arrow key to move the highlight to the setup menu.

6.3.4. Using the <UP> and <DOWN> arrow keys, move the highlight to
NAMES. <ENTER>

6.3.5. With the highlight on the Port1 name (“COMPUTER 1” by default), type
FILE SERVER.

6.3.6. <ENTER> to save the new name.
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6.3.7. Using the <UP> and <DOWN> arrow keys, move the highlight to FLAG.
<ENTER>

6.3.8. At the “Flag Attributes” screen, highlight the Enabled setting and change
it to “NAMES TIMED” by using the <+> and <–> keys to adjust the
value.

6.3.9. <ENTER> to save the changed value.

6.3.10. <ESC> to exit CCR.

7. WINNT40 SERVER INSTALLATION
(PRIMARY DOMAIN CONTROLLER AND MEMBER)

7.1. Installing Windows NT Server 4.0

7.1.1. Boot Strapping

7.1.1.1. Boot up your system.

7.1.1.2. Load the Windows NT 4.0 Server compact disk into the CD–
ROM drive.

7.1.1.3. At the “Welcome to Setup” screen. <ENTER>

7.1.1.4. At the “Setup has recognized the following mass storage
devices...” screen. <ENTER>

7.1.1.5. At the “Setup has determined that one or more of your hard
disks has more than 1024 cylinders...” screen. <ENTER>

7.1.1.6. At the “Windows NT Licensing Agreement” screen <Page
Down> repeatedly to read the license and F8 to agree.

7.1.1.7. At the “Setup has determined that your computer contains the
following...” screen. <ENTER>

7.1.1.8. At the “The list below shows existing partitions and space
available...” screen, ARROW DOWN to select “Unpartitioned
Space” press C

7.1.1.9. At the “You have asked Setup…” screen, backspace to clear
the present entry and type 2048 to create a 2GB C drive.
<ENTER>

7.1.1.10. At the “The list below shows existing partitions and space
available...” screen, select “New (Unformatted)”. <ENTER>

7.1.1.11. At the “The partition you have chosen is newly created...”
screen, select “Format the partition using the NTFS file
system.” <ENTER>

7.1.1.12. At the “Setup installs Windows NT files onto your hard disk...”
screen. <ENTER>
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Note:  Verify that the default directory is \WINNT.

7.1.1.13. At the “Setup will now examine your hard disk(s)...” screen.
<ENTER>

Note:  Setup will now start copying files.

7.1.1.14. At the “This portion of Setup has completed...” screen, remove
the Windows NT 4.0 CD from the CD–ROM drive. <ENTER>

Note:  System will reboot twice to properly format all drives.

7.1.2. Gathering Information About Your Computer

7.1.2.1. Reinsert the Windows NT Server CD when prompted, wait One
(1) minute, and click OK.  Setup will copy files to your hard
drive.

7.1.2.2. At the “Welcome to the Windows NT Setup Wizard...” screen,
left click Next to begin “1) Gathering information about your
computer”.

7.1.2.3. At the “Name and Organization” screen, enter the hospital name
in the Name Field. In the Organization field, enter the name of
the organization the hospital is affiliated with, if the hospital is
not affiliated with an organization, enter the hospital name
again. Left click Next.

7.1.2.4. When prompted, enter the CD key number from the certificate,
Left click Next.

7.1.2.5. Verify the radio button “Per Server for” is selected and based on
the number of Btrieve licenses purchased; select the appropriate
number for “concurrent connections.”  Left click Next.

7.1.2.6. At the “Computer Name” screen, enter MUSE$$$XXX in the
Name field – where $$$ is an acronym for the hospital and
XXX is the MUSE node number of the computer.

Note:  This value represents the name of the computer.
Reference the Pre–Build Survey to verify this is correct.

7.1.2.7. Left click Next.
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7.1.2.8. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
ONLY

At the “Server Type” screen, select the “Primary Domain
Controller” radio button. Left click Next.

MEMBER SERVER INSTALL ONLY

At the “Server Type” screen, select the “Stand–Alone
Server” radio button. Left click Next.

7.1.2.9. At the “Administrator Account” screen, type in the password
Never!Mind in both edit fields.

Note:  The password is case sensitive.

7.1.2.10. Left click Next.

7.1.2.11. At the “Emergency Repair Disk” screen, select “No, do not
create...” radio button. Left click Next.

7.1.2.12. At the “Select Components” screen do the following:

Note:  The shortcut to selecting all features is to Uncheck the
appropriate box and re–check the same box with a single left
click.  Do this slowly so you don't cause a double–click.

The “Accessibility Options” box should be empty.
The “Accessories” box should be white with a black check.
Verify that the “Communications” box is white with a
black check.
The “Games” check box should be empty.
The “Multimedia” box should be white with a black check.
The “Windows Messaging” box will be gray with a black
check after performing the following steps:
Left double–click the “Windows Messaging” text.

The “Windows Messaging” check box should be checked.
The “Internet Mail” check box should be checked.
The “Microsoft Mail” check box should be Unchecked.

Left click OK.

7.1.2.13. Left click Next.

7.1.3. Installing Windows NT Networking

7.1.3.1. At the “Setup is now ready to guide you through installation...”
screen, Left click Next to begin “2) Installing Windows NT
Networking”.
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7.1.3.2. At the “Windows NT needs to know how this computer should
participate on a network...” screen, verify “Wired to the
network” is selected. Left click Next.

7.1.3.3. At the “Microsoft Internet Information Server lets you share...”
screen, Uncheck the box “Install Microsoft Internet Information
Server”. Left click Next.

7.1.3.4. At the “To have setup start searching for a network Adapter...”
screen, Left click Select from list.

7.1.3.5. Left click Have Disk…

7.1.3.6. Insert 422723–001 into the floppy disk drive, left click OK.

7.1.3.7. Verify that “Compaq Netelligent 10 or 10/100 PCI Intel
Controller” is selected, left click OK.

7.1.3.8. Left click Next.

7.1.3.9. At the “Select the networking protocols that are used...” screen,
Uncheck all network protocols except for “TCP/IP Protocol”.
Left click Next.

7.1.3.10. At the “Listed below are the service that will be installed...”
screen, left click the Select from list button to add the
following additional services.

Select “Microsoft TCP/IP Printing” and left click OK.
Select “Network Monitor Tools and Agent” and left click
OK.
Select “SNMP Service” and left click OK.

Left click Next.

7.1.3.11. At the “Windows NT is now ready to install networking
components...” screen left click Next.

7.1.3.12. At the “CPQSET” window, left click OK.

7.1.3.13. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
ONLY
At the “If there is a DHCP server on your network...”
message box left click No.

MEMBER SERVER INSTALL ONLY

At the “If there is a DHCP server on your network...”
message box left click Yes.

Note:  System must be attached to MEI network backbone.
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7.1.3.14. Configuring SNMP Service.

7.1.3.14.1. At the “Microsoft SNMP Properties” screen, select
the “Traps” tab.

7.1.3.14.2. Type public in the “Community Name” field box
and left click Add.

7.1.3.14.3. Left click the Add… button under the “Trap
Destinations” list box.

7.1.3.14.4. In the “IP Host or IPX Address:” field, type
MUSE$$$XXX.

Note:  MUSE$$$XXX = Local Computer Name.

7.1.3.14.5. Left click Add.

7.1.3.14.6. Left click OK.

7.1.3.15. Perform the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
ONLY

At the “Microsoft TCP/IP Properties” window, fill in the
following fields with the appropriate data
Note:  Reference the Pre–build survey to verify these IP’s.

IP Address: .........................128.9.9.1
Subnet Mask:..................255.255.0.0

Left click OK.

7.1.3.16. At the “You may use this page to disable network bindings…”
screen, left click Next.

7.1.3.17. Left click Next to start the network.

7.1.3.18. Perform one of the following based on the File Server:

Note:  Reference the Pre–Build Survey to verify this is correct.

PRIMARY DOMAIN CONTROLLER INSTALL
ONLY

At the “You have requested that Windows NT create a
Primary Domain Controller…” screen, enter MUSE$$$
(where $$$ is the acronym for the hospital) in the Domain
field. Left click Next.

Note:  This is the Domain name you are creating for the
hospital. This may take a few minutes to register.
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MEMBER SERVER INSTALL ONLY

At the “Select whether your computer will be participating
in a workgroup or domain…” screen, Verify “Computer
Name” is correct.

Left click “Domain” radio button.
Type MUSESIG
Left click on “Create a Computer Account in the Domain”
check box.
Left click Next
In the “User Name” field, type MuseAdmin
In the “Password” field, type Muse!Admin

Left click OK

7.1.4. Finishing Setup

7.1.4.1. At the “Setup is almost finished...” screen, left click Finish to
begin “3) Finishing Setup”.

7.1.4.2. At the “Date/Time Properties” property page set the date, time,
and time zone appropriately to where the machine is going. Left
click Close.

7.1.4.3. At the “Detected Display” message box, left click OK.

7.1.4.4. Left click OK.

7.1.4.5. At the “Windows NT has been installed successfully...” screen,
remove the Windows NT 4.0 Server CD from the CD–ROM
drive and remove 422723–001 from the floppy disk drive.

7.1.4.6. Left click Restart Computer.

7.2. Move the CD drive letter to Z:

7.2.1. Log in as Administrator.

Note:  You must press <CTRL><ALT><DEL> to logon.

Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY
In the “Domain” pull down box, select MUSE$$$

MEMBER SERVER INSTALL ONLY
In the “Domain” pull down box, select MUSE$$$XXX

Note:  MUSE$$$XXX = Local Computer Name

7.2.2. Type for password Never!Mind

7.2.3. At the “Welcome” window left click Close



Revision: P

AP 901107-XXX, REV P, PAGE 12 of 53

7.2.4. Left click Start >> Programs >> Administrative Tools >> Disk
Administrator.

7.2.5. Left click OK if its the first time its been used.

7.2.6. Left click the “CD–ROM 0” box.

Note:  Present drive letter is D:

7.2.7. Left click Tools >> Assign Drive Letter.

7.2.8. Pull down “Assign Drive Letter” and select Z: and left click OK.

7.2.9. Left click Yes to the “This new drive letter will happen immediately
dialog.”

7.3. Partition and format D: drive

7.3.1. Left click “Free Space” area in Disk 0.

7.3.2. Left click Partition >> Create Extended.

7.3.3. Left click OK. Left click Yes.

7.3.4. Left click “Free Space” area in Disk 0.

7.3.5. Left click Partition >> Create.

7.3.6. Verify that maximum size value is entered for logical drive. Left click
OK.

7.3.7. Left click Partition >> Commit Changes Now…

7.3.8. At the “Changes have been made to your hard disk configuration…”
screen, left click Yes.

7.3.9. At the “Disks were updated successfully” screen, left click OK.

7.3.10. Left click the “D:” unknown area in Disk 0.

7.3.11. Left click Tools >> Format.

7.3.12. Pull down “File System” and select “NTFS”.

7.3.13. Left click Start.

7.3.14. Left click OK to “Warning…”

7.3.15. Left click OK to “Format complete.”

7.3.16. Left click Close.

7.3.17. Close “Disk Administrator” window.
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7.4. Disable CD Autoplay and Update NT Source Path

7.4.1. Insert the MUSE Software CD into the CD–ROM drive.

7.4.2. Left click Start >> Run.

7.4.3. Type REGEDIT Z:\REG\CD_CHNGS.REG and left click OK.

7.4.4. Left click OK at the Registry Editor message box.

7.4.5. Remove the MUSE Software CD.

7.5. Install Compaq Support Software for Microsoft Windows NT 4.0

7.5.1. Load the Compaq SmartStart CD into the CD–ROM drive.

7.5.2. If the Compaq Diskette Builder window appears, close it.

7.5.3. Left click Start >> Run.

7.5.4. Type Z:\CPQSUPSW\NTSSD\SETUP.EXE and left click OK.

7.5.5. Select “Compaq System Management Driver”, left click Install.

7.5.6. Select “Compaq SMART/SMART–2 Array Controller”, left click Update.

7.5.7. At the “Compaq offers high availability…” screen, left click OK.

7.5.8. Select “Compaq Integrated Management Log Viewer”.  Left click Install.

7.5.9. Select “Compaq SCSI Controllers”, left click Install.

7.5.10. Select “Compaq Ethernet or Fast Ethernet Controller(s)”, left click
Update.

7.5.11. Select “ATI RAGE IIC Video Display Controller”, left click Install.

7.5.12. Select “Compaq Array Configuration Utility”, left click Install.

7.5.13. At the “Compaq Array…” prompt left click OK.

7.5.14. Remove the Compaq SmartStart CD from the CD–ROM drive.

7.5.15. Load the NT 4.0 Server CD into the CD–ROM drive.

7.5.16. Close the “Windows NT CD–ROM” window.

7.5.17. Select “HAL Recovery Option”, left click Install.

7.5.18. When the system is finished copying the required files, left click Exit to
close Setup.
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7.5.19. Remove the NT 4.0 Server CD and left click Reboot.

7.6. Configure Display Settings

7.6.1. Log in as Administrator.

7.6.2. At the “Welcome” window, uncheck the “Show this welcome…” box and
left click Close.

7.6.3. At the “Invalid Display Settings” message box, left click OK.

7.6.4. Configure the Settings in Display Properties as follows:

Desktop Area..................................................................1024 by 768 pixels
Color Palette................................................................................256 Colors
Refresh Frequency..........................................................................75 Hertz

7.6.5. Left click the Test button and verify the settings.

7.6.6. Left click OK to save and exit.

7.7. Installing Tape Device

7.7.1. Load the NT 4.0 Server CD into the CD–ROM drive.

7.7.2. Left click Start >> Settings >> Control Panel >> Tape Devices.

7.7.3. At the “New SCSI Tape Device Found” message box, left click OK. Files
will be copied to system.

7.7.4. At the “Tape Devices” property page, verify HPC1537A is selected, left
click OK.

7.7.5. Close “Control Panel” window.

7.7.6. Remove the Windows NT 4.0 Server CD from the CD–ROM drive.

7.8. Installing Digi Controller Driver

7.8.1. Insert the MUSE Software CD into the CD–ROM drive.

7.8.2. Left click Start >> Run

7.8.3. Type Z:\DIGI\V240\WINNT\INSTALL.BAT and left click OK.

7.8.4. While pressing <Alt> left double–click the Network Neighborhood icon
on the desktop.

7.8.5. At the “Network” setup screen left click the “Adapters” tab.

7.8.6. Left click Add…

7.8.7. At the “Select Network Adapter” screen left click Have Disk…
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7.8.8. At the “Insert Disk” screen, clear the edit box and type
C:\TEMP\WINNT\I386 and left click OK.

7.8.9. At the “Select OEM Option” screen select “Digi AccelePort 8r 920 (PCI)
Adapter” from the list, left click OK.

7.8.10. At the “Digi 8r 920(PCI) Adapter Setup” screen left click OK.

7.8.11. Left click Close.

7.8.12. At the “Do you want to restart your computer now?” prompt, left click No.

7.8.13. Left click Start >> Run

7.8.14. Type Z:\DIGI\V240\WINNT\REMOVE.BAT and left click OK.

7.9. Installing Windows NT Server 4.0 SP4 and Microsoft Data Access Components
2.0 SP1

7.9.1. Left click Start >> Run

7.9.2. Type Z:\BAT\SP4MDAC.BAT and left click OK.

Note: System will automatically copy files and setup apps.

7.9.3. At the “Microsoft Windows Year 2000...” prompt, left click Yes to restart
system.

7.10. Installing Internet Explorer 4.01 SP2

7.10.1. Log in as Administrator.

7.10.2. Left click Start >> Run

7.10.3. Type Z:\BAT\IE401SP2.BAT and left click OK.

Note: System will automatically copy files, setup apps and restart system.

7.11. Setting up the environment

7.11.1. Log in as Administrator.

7.11.2. Close the “Welcome – Microsoft Internet Explorer” window.

7.11.3. Enable Schedule Service to startup automatically and stop Licensing.

7.11.3.1. Left click Start >> Settings >> Control Panel >> Services.
7.11.3.2. Left click on “Schedule”.
7.11.3.3. Left click Startup and set the radio button AUTOMATIC.
7.11.3.4. Left click OK.
7.11.3.5. Left click on “License Logging Service”
7.11.3.6. Left click Startup and set the radio button DISABLED.
7.11.3.7. Left click OK.
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7.11.3.8. Left click Close.

7.11.4. Turn off debugging.

7.11.4.1. Left double–click the icon System.

7.11.4.2. Left click “Startup/Shutdown” tab.

7.11.4.3. Left click to uncheck the “Write debugging information to:”
check box.

7.11.4.4. Left click OK.

7.11.4.5. Left click NO at the “System settings change” window.

7.11.5. Set the computer description

7.11.5.1. Left double–click the icon Server.

Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY

In the “Description” edit box type MUSE$$$ PDC (MUSE
File Server)

Note:  Where “MUSE$$$” is the name of the Primary Domain
that was created during the NT network setup.

MEMBER SERVER INSTALL ONLY

In the “Description” edit box type MUSE File Server

7.11.5.2. Left click OK.

7.11.5.3. Close “Control Panel” window.

7.11.6. Turn on Auditing

7.11.6.1. Left click Start >> Programs >> Administrative Tools >>
User Manager for Domains.

7.11.6.2. Left click Policies >> Audit.

7.11.6.3. Left click the radio button “Audit these Events.”
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7.11.6.4. Fill out the matrix as follows:

SUCCESS FAILURE

Logon on Logoff X
File and Object Access
Use of User Rights
User and Group Management X
Security Policy Changes X X
Restart, Shutdown, and System X X
Process Tracking X

7.11.6.5. Left click OK and close “User Manager” window.

7.11.6.6. Remove the MUSE Software CD.

8. COMPAQ INSIGHT MANAGER INSTALLATION AND CONFIGURATION

8.1. Install Management Agents

8.1.1. Load the Compaq Management CD into the CD–ROM drive.

8.1.2. Left click Start >> Run.

8.1.3. Type Z:\AGENTS\WIN–NT\ENG\SETUP.CMD and left click OK .

8.1.4. Left click Continue.

8.1.5. At the “Compaq Insight Manager has added…” prompt, left click NO.

8.1.6. Left click OK at the “Insight Agents…” screen.

8.1.7. Left click OK at the “Installation is now complete” message.

8.1.8. Left click Exit to Windows NT.

8.2. Install Management Console

8.2.1. Left click Start >> Run.

8.2.2. Type Z:\INSIGHT\WIN32\ENG\SETUP.EXE and left click OK.

8.2.3. Left click Next.

8.2.4. At the “Installing Borland Database Engine…” screen, left click Next.

8.2.5. At the “Name and Organization” screen, enter the hospital name in the
Name Field. In the Company field, enter the name of the organization the
hospital is affiliated with, if the hospital is not affiliated with an
organization, enter the hospital name again.
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Left click Next.

8.2.6. Left click Yes to confirm the Name and Company.

8.2.7. Verify “Compaq Insight Manager…” is the only box that is checked, left
click Next.

8.2.8. Left click Next to the default location for Compaq Insight Manager.

8.2.9. Enter configuration options

8.2.9.1. Uncheck “Enable auto discovery of IPX servers”
8.2.9.2. Uncheck “Enable auto discovery of Remote Console NVT

servers”

8.2.10. Left click Next.

8.2.11. Left click Next to default Program Folder.

8.2.12. Left click Next to the current settings.

8.2.13. When Installation is finished, uncheck “…view the Read Me file”, left
click Finish.

8.2.14. Close the “Compaq Insight Manager” program group window.

8.3. COMPAQ UPS Management Software Installation

Note: Perform the following ONLY IF the UPS option is included with the
system.

Note:  Check customer order to see if this is as an ordered option. If Yes, install
the following. If not, go to section “Remove the Compaq Management CD–
ROM.”

8.3.1. Install Compaq Power Management Software

8.3.1.1. Left click Start >> Run.

8.3.1.2. Type Z:\CPQCPM\AGENTS\NT\ENG\SETUP.EXE and left
click OK.

8.3.1.3. Left click Continue.

8.3.1.4. Verify the “No” radio button is selected for the computer to be a
part of a UPS group, left click Continue.

8.3.1.5. At the “Communications Port Selection” screen, verify the
“Standard” radio button and COM1 are selected. Left click
Continue.
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8.3.1.6. Set Shutdown Timing Options to the following:

Wink Time (Seconds)............................................................... 60
Power Failure Countdown Time (Minutes).............................. 10
Time Needed to Down System (Seconds)................................ 90

8.3.1.7. Left click Continue.

8.3.1.8. At the Install Path screen, left click Continue.

8.3.1.9. At the “The Compaq Power Management Software was
successfully installed …” screen, left click OK.

8.3.1.10. Left click OK to the restart your computer prompt.

Note:  System will not shut down at this time.

8.3.2. Install Power Management Console

8.3.2.1. Left click Start >> Run.

8.3.2.2. Type Z:\CPQCPM\INSIGHT\ENG\SETUP.EXE and left
click OK.

8.3.2.3. At the “Welcome” screen, left click Next.

8.3.2.4. At the “Choose Destination Location” screen, left click Next.

8.3.2.5. At the “Information” screen, left click OK.

8.3.2.6. Left click OK to Setup is complete.

8.4. Remove the Compaq Management CD–ROM.

8.5. Restart the system.

8.5.1. Left click Start >> Shut Down…

8.5.2. Select the “Restart the computer?” radio button

8.5.3. Left click Yes. The system will reboot.

8.6. Configure Insight Manager

8.6.1. General Configuration

8.6.1.1. Log in as Administrator.
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8.6.1.2. At the “Welcome to the Compaq Insight…” window, left click
Cancel.

8.6.1.3. Uncheck the box “Show this next time…” and close the
“Welcome – Microsoft Internet Explorer” window.

8.6.1.4. Configure SNMP Service

8.6.1.4.1. Left click Start >> Settings >> Control Panel >>
Network.

8.6.1.4.2. Left click “Services” tab.
8.6.1.4.3. Left double-click SNMP Service
8.6.1.4.4. Left click “Security” tab.
8.6.1.4.5. In the “Accepted Community Names” window, left

click public to highlight.
8.6.1.4.6. Left click Edit.
8.6.1.4.7. Left click the “Community Rights” pull down and

select READ WRITE.
8.6.1.4.8. Left click OK.
8.6.1.4.9. Left click OK.
8.6.1.4.10. Left click Close.
8.6.1.4.11. Close “Control Panel” window.

8.6.1.5. Left click Start >> Programs >> Compaq Insight Manager
>> Compaq Insight Manager

8.6.1.6. At the “Startup checklist” screen, check the “Don’t show this
screen at startup” box located in the lower left–hand corner of
the window, left click OK.

8.6.1.7. Left click Setup >> Device List…

8.6.1.8. Left click IP Device List.

Note:  Do not choose the IPX Device List

8.6.1.9. Left click New.

8.6.1.10. In the Device Name field, enter MUSE$$$XXX

8.6.1.11. Left click the “ WINS/DNS IP Address Resolution” check box,
left click Add.

8.6.1.12. Left click Close.

8.6.1.13. At the “IP Device List” screen, left click OK.

8.6.1.14. At the “Device List Setup” screen, left click OK.
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8.6.2. UPS Configuration

Note: Perform the following ONLY IF the UPS option is included with
the system.

Note:  Check customer order to see if this is as an ordered option. If Yes,
install the following. If not, go to section “Close the “Compaq
Insight Manager” window.”

8.6.2.1. UPS Configuration

8.6.2.1.1. In the “Device List 1” window, left double–click
the “Network” folder, left double–click the “All
Devices” folder.

8.6.2.1.2. Under “Device Name”, locate MUSE$$$XXX and
left double–click it.

8.6.2.1.3. Left click the Recovery button.

8.6.2.1.4. Left click the UPS button.

8.6.2.1.5. Left click the Alert Handling button.

8.6.2.1.6. Left click “0 –$MACHINE is on battery….
shutdown in $MINUTES mins”

8.6.2.1.7. Right click the mouse icon next to “Disabled” text
underneath the “Execute Command” text and left
click Set from the popup menu.

Note: When you place the cursor over the text
“Disabled” a mouse cursor will appear. When this
happens, right click to activate Set popup menu.

8.6.2.1.8. Left click the “Execute Command” check box and
type in the edit field UPS.BAT SHUTMUSE

8.6.2.1.9. Left click Set. System will now store data.

8.6.2.1.10. Select “2 –$MACHINE shutdown has been
cancelled”

8.6.2.1.11. Right click the mouse icon next to “Disabled” text
underneath the “Execute Command” text and left
click Set from the popup menu.

Note: When you place the cursor over the text
“Disabled” a mouse cursor will appear. When this
happens, right click to activate Set popup menu.
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8.6.2.1.12. Left click the “Execute Command” check box and
type in the edit field UPS.BAT CANCEL

8.6.2.1.13. Left click Set. System will now store data.

8.6.2.1.14. After Insight Manager is finished storing data, left
click Close.

8.6.2.1.15. At the “UPS MUSE$$$XXX” screen, left click
Close.

8.6.2.1.16. At the “MUSE$$$XXX Recovery” screen, left click
the Environment button.

8.6.2.1.17. Right click the mouse icon next to  “Shut Down”
text next to the “Degraded Action:” text and left
click Set from the popup menu.

8.6.2.1.18. Verify “New Value” is set to “Continue”

8.6.2.1.19. Left click Set.

8.6.2.1.20. Left click Close.

8.6.2.1.21. At the “MUSE$$$XXX Recovery” screen, left click
Close.

8.6.2.1.22. At the “Device – MUSE$$$XXX” screen, left click
Close.

8.6.3. Close the “Compaq Insight Manager” window.

8.6.4. Add Insight Manager to Start–Up Group

Note:  After performing this section the Insight Manager will launch every
time you restart NT. You must minimize the application when this
happens, for it needs to be active at all times.

8.6.4.1. Insert the MUSE Software CD into the CD–ROM drive.

8.6.4.2. Left click Start >> Run.

8.6.4.3. Type CMD /K Z:\BAT\IM2STUP.BAT SETUP.EXE and left
click OK.

8.6.4.4. Left click Start >> Programs >> Startup, verify that Compaq
Insight Manager appears as one of the links inside the Startup
group. Close all visible windows.
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Note:  Be sure to check the common Startup group, not the
current user Startup group. The common Startup group
is the one closest to the bottom of the Programs
submenu.

8.7. Clear the Compaq Integrated Management Log.

8.7.1. Left click Start >> Programs >> Compaq System Tools >> Compaq
Integrated Management Log Viewer

8.7.2. Left click Log >> Clear All Entries

8.7.3. Left click Clear.

8.7.4. Left click Yes.

8.7.5. Close the “Compaq Integrated Management Log View” window.

9. CONFIGURING ADMINISTRATOR DESKTOP

9.1. Set the screen saver.

9.1.1. Right click on the desktop, left click Properties.
9.1.2. Left click the “Screen Saver” tab.
9.1.3. Choose the Logon Screen Saver from “Screen Saver” pull down menu.
9.1.4. Left click “Password Protected” check box.
9.1.5. Verify “Wait” is set to 15 minutes.
9.1.6. Left click OK to exit.

9.2. Move the Desktop icons to the Recycle Bin.

9.2.1. Right click on icon My Briefcase and select Delete.
9.2.2. Left click Yes to confirm delete.
9.2.3. Right click on icon Install Internet Information…  and select Delete.
9.2.4. Left click Yes to confirm delete.

9.3. Set the taskbar options

9.3.1. Left click Start >> Settings >> Taskbar…
9.3.2. Verify “Always on top” is selected.
9.3.3. Left click “Show small icons in Start menu.”
9.3.4. Verify “Show Clock” is selected.
9.3.5. Left click OK to exit.

9.4. Set the Explorer Options

9.4.1. Left double–click “My Computer” icon.
9.4.2. Left click View >> Toolbar. Toolbar should appear in window.
9.4.3. Left click View >> Options…
9.4.4. Left click the radio button “Browse folders by using a single window that

changes as you open each folder.”
9.4.5. Left click the “View” tab.
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9.4.6. Left click the radio button “Show all files.”
9.4.7. Left click the check button “Display the full path in the title bar.”
9.4.8. Un–select “Hide file extensions for known file types.”
9.4.9. Left click the check button “Display compressed files and folders with

alternate color.”
9.4.10. Left click OK. Close “My Computer” window.

9.5. Set the command prompt options

9.5.1. Left click Start >> Settings >> Control Panel >> Console.
9.5.2. Left click the “Options” tab. Default.
9.5.3. Left click the radio button “Large.”
9.5.4. Left click the “Layout” tab.
9.5.5. Enter 80 for the “Screen Buffer Size Width”. Default.
9.5.6. Enter 50 for the “Screen Buffer Size Height”.
9.5.7. Enter 80 for the “Window Size Width”. Default.
9.5.8. Enter 50 for the “Window Size Height”.
9.5.9. Left click OK. Close “Control Panel” window.

10. MICROSOFT INTERNET INFORMATION SERVER 4.0 INSTALLATION

10.1. Make sure that the MUSE Software CD is in the CD–ROM drive.

10.2. Left click Start >> Run

10.3. Type Z:\MUSEWEB\SETUP.CMD and left click OK.

10.4. At the “Setup” prompt, left click Yes.

10.5. At the “Setup” prompt, left click Yes.

Note:  Setup window will appear and start copying files. This procedure will last
for about 5–7 minutes. It will automatically reboot the system.

11. INSTALLING NETWORK PRINTER SUPPORT

Note: The following conditions must be met before continuing on with this section:
The printer must be configured using Jet Admin on the RSS Test PC.
If PDC: A printer connected to the Switch with an IP and Gateway set.
If Member: A printer connected to the MEI network with a known name.
Check customer order to see if it is called out as an option.

11.1. Log in as Administrator.

11.2. Left click Start >> Settings >> Printers

11.3. Left double–click icon Add Printer.

11.4. At the “Add Printer Wizard” screen, verify the radio button “My Computer” is
selected. Left click Next.
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11.5. Left click Add Port.

11.6. From the “Available Printer Ports” section, left click LPR Port.

11.7. Left click New Port.

11.8. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL
In the “Name or address…” edit field type XXX.XXX.XXX.XXX
Note:  XXX.XXX.XXX.XXX = the IP of the Printer.

MEMBER SERVER INSTALL
In the “Name or address…” edit field type $$$$$$$$$$
Note:  $$$$$$$$$$ = the name of the Printer based on Menu Printout.

11.9. In the “Name of printer or print…” edit field type raw.

11.10. Left click OK. Left click Close.

11.11. Left click Next.

11.12. Left click Have Disk.

11.13. Type Z:\HPPRINT\NT and left click OK.

11.14. Left click HP LaserJet 4000 Series PS in the “Printers” section.

11.15. Left click Next.

11.16. In the “Printer Name” section, type a unique name for the printer.

Note:  Default name should suffice unless otherwise stated by Pre–Build Survey.

11.17. Left click Next.

11.18. Left click the radio button “Shared” and type in the edit a unique name.

Note:  For one (1) printer, use LJ4K01.  If more, increase number.
Default name should suffice unless otherwise stated by Pre–Build Survey.

11.19. Left click Next.

11.20. Verify the radio button Yes is selected and left click Finish to print a test page.

11.21. If the page printed successfully, left click Yes. If not left click NO and follow the
instructions to troubleshoot the problem.

11.22. Close all visible windows.

12. DISKEEPER FOR WINDOWS NT SERVER 4.0 INSTALLATION
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12.1. Make sure that you are logged in as Administrator.

12.2. Make sure that the MUSE Software CD is in the CD–ROM drive.

12.3. Left click Start >> Run.

12.4. Type Z:\DISKPR\V40\X86\SETUP.EXE and left click OK.

12.5. At the “Welcome” screen, left click Next.

12.6. At the “Software License Agreement” screen, left click Yes.

12.7. At the “Choose Destination Location” screen, verify default directory is
C:\ExecSoft\Diskeep and left click Next.

12.8. At the “Choose Destination Location” screen, verify “Diskeeper” is program
folder and left click Next.

12.9. At the “Registration” screen, left click Next.

12.10. Left click the check box “Yes, I want to Launch Diskeeper.”

12.11. Left click Finish.

12.12. Left click Close in the “Welcome window.”

12.13. Left click Options >> Event Logging.
Verify/change the following table:

X Service Start and Stop
X Defrag Start and Stop

Defrag Files
Moved Files
Disk Information
File Information
Directory Information
Pagefile Information
MFT Information

12.14. Left click OK.

12.15. Close the “Diskeeper” window.

12.16. Diskeeper 4.1 Patch Installation

12.16.1. Left click Start >> Run.
12.16.2. Type Z:\DISKPR\V40\X86\PATCH\DK4UPDATE_I.EXE and left

click OK.
12.16.3. At the “Welcome” screen, left click Finish.
12.16.4. Left click Next.
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12.16.5. Left click Yes.
12.16.6. Left click Finish.

13. PCANYWHERE32 8.0 INSTALLATION

Note: The following condition must be met before continuing on with this section:
A 56K MultiTech modem attached to COM2 of the server.

13.1. Installing main program.

13.1.1. Remove the MUSE Software CD.  Insert the pcAnywhere CD into the
CD–ROM drive.

13.1.2. Left click Start >> Run.

13.1.3. Type Z:\CDINST.EXE and left click OK.

13.1.4. Highlight and left click on the Install Software option in the
“pcAnywhere CD–ROM installation Utility.”

13.1.5. At the “Welcome” screen left click Next.

13.1.6. At the “User Information” screen Enter/Verify information, left click
Next.

13.1.7. Read/verify the license agreement and left click Yes.

13.1.8. Accept the destination directory location and left click Next.
Verify default directory is C:\Program Files\pcANYWHERE.

13.1.9. Review the setup information on the “Setup Review” screen and left
click Next. Program will begin installing file to the computer.

13.1.10. Left click Next on “Symantec Support Solutions” screen.

13.1.11. Left click Next on “How to Reach Us” screen.

13.1.12. Left click Next on “Windows 95 Solutions” screen.

13.1.13. Left click Skip on “Online registration” screen.

13.1.14. Left click No to skip viewing the Readme file.

13.1.15. Left click Finish to restart the computer.

13.1.16. Remove the pcAnywhere CD from drive.

13.2. Installing pcAnywhere Host Service

13.2.1. Make sure the MUSE Software CD is in the CD–ROM drive.

13.2.2. Log in as Administrator.
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13.2.3. Left click Start >> Programs >> pcANYWHERE32 >>
pcANYWHERE.

13.2.4. If “Smart Setup Modem” window appears, do the following:

13.2.4.1. Left click Add Modem.

13.2.4.2. Left click check box “Don’t detect my modem…” Left click
Next.

13.2.4.3. Left click Have Disk

13.2.4.4. Type Z:\MULTITECH\NT

13.2.4.5. Left click OK

13.2.4.6. Left click MultiTech Systems MT5600ZDX

13.2.4.7. Left click Next

13.2.4.8. Left click COM2. Left click Next.

13.2.4.9. In the “What area(city) code …” edit box type YYY

Note:  YYY = The area code of the city.

Verify radio button “Tone Dialing” is selected. Left click Next.

13.2.4.10. Left click Finish.

13.2.4.11. Verify modem is MultiModem MT5600ZDX. Left click Next.

13.2.4.12. Verify TCP/IP is selected. Left click Next.

13.2.4.13. At the “Please select a port…” choose COM2. Left click
Finish.

13.2.5. Left click the BE A HOST PC button.

13.2.6. Right click on the MODEM icon and select the Properties dialog.

13.2.7. Verify/select MultiModem 5600ZDX is selected in the “Connection
Info” tab.

13.2.8. Left click “Settings” tab.

13.2.9. Verify/select in “Host Startup” Run Minimized is checked.

13.2.10. Verify/select in “Host Startup” Run as Service is checked.

13.2.11. Verify/select in “Host Options” Wait for Anyone is checked.

13.2.12. Verify/select in both sections, in “Security” Log off user is checked.

13.2.13. Left click “Callers” tab.
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13.2.14. Left click Use NT user privileges radio button.

13.2.15. Left double–click on “Add User” icon and do the following:

13.2.15.1. Verify “User”  radio button is selected. Left click Next.

13.2.15.2. In the “What domain…” select the MUSE file server
(Make sure you choose the machine name like MUSE$$$XXX
and not the domain name like MUSE$$$)

13.2.15.3. In the “Select the account…” select Administrator and left
click Next. Left click Finish.

13.2.16. Left click the “Security Options” tab.

13.2.17. In “Connection Options” left click the Blank this PC screen after
connection made.

13.2.18. Left click OK to save the properties settings for the MODEM
connection.

13.2.19. Left double–click the MODEM icon button to launch the service.

13.3. Switching pcAnywhere Host Service to Automatic

13.3.1. Left click Start >> Settings >> Control Panel >> Services.

13.3.2. Highlight the pcANYWHERE Host Service.

13.3.3. Left click Startup button and set the radio button AUTOMATIC.

13.3.4. Left click OK.

13.3.5. Verify that the “pcANYWHERE Host Service” has a status of
STARTED and a startup of AUTOMATIC, left click Close.

13.3.6. Close “Control Panel” window.

14. NT 4.0 SERVER RESOURCE KIT INSTALLATION

14.1. Make sure that you are logged in as Administrator.

14.2. Make sure that the MUSE Software CD is in the CD–ROM drive.

14.3. Left click Start >> Run.

14.4. Type Z:\NTRESKIT\SETUP.EXE and left click OK.

14.5. At the “Do you agree to these terms…” screen left click Accept.

14.6. At the “Windows NT Server…” screen, Left click Continue.

14.7. At “Name” enter in the hospital's name.
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14.8. At “Organization” enter in the hospital's affiliation or the hospital’s name again.
Left click OK.

14.9. Left click OK.

14.10. Accept the destination directory location and left click OK.
Verify the default directory is C:\NTRESKIT.

14.11. Left click Custom/Complete and left click Continue.

14.12. Left click OK to complete setup.

15. ST. BERNARD'S OPEN FILE MANAGER VERSION 5.1 INSTALLATION

15.1. Make sure that you are logged in as Administrator.

15.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

15.3. Left click Start >> Run.

15.4. Type Z:\OFM\V51\SETUP.EXE and left click OK.

15.5. At the “Welcome” screen, left click Next.

15.6. At the “Software License Agreement” screen, left click Yes.

15.7. At the “User Information” screen type in the following:

Name: MUSE$$$001
Company: Hospital Name
Serial: See OFM package for number

15.8. Left click Next.

15.9. At the “Choose Destination Folder” screen, verify default location to be
“C:\Program Files\OFM” left click Next.

15.10. At the “Select Program Folder” screen, verify default folder to be “Open File
Manager” left click Next.

15.11. At the “Start Copying Files” screen left click Next.

15.12. At the “Setup Complete” screen left click Finish.

15.13. At the “Open File Manager” window, left double click “OFM” icon.

15.14. Left click on the “+” sign to the left of the “Microsoft Windows Network” to
open.
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15.15. Left click on the “+” sign to the left of the Domain in which the File Server is in.

PDC .......................................................................................MUSE$$$
Member .................................................................................MUSESIG

15.16. You should now be able to see the File Server’s Computer Name in which you are
installing OFM to. Right click on “MUSE$$$001” and left click Install from the
pop-up menu.

15.17. At the “Install OFM” screen left click “MUSE$$$001” under the “System”
section and left click Install.

15.18. Left click Start and verify the green check mark by the Computer Name.

15.19. Left click File >> Exit and close all visible windows.

16. BTRIEVE 7.0 INSTALLATION – 5B ONLY

16.1. Make sure that you are logged in as Administrator.

16.2. Make sure that the MUSE Software CD is in the CD–ROM drive.

16.3. Left click Start >> Run.

16.4. Type Z:\BTRIEVE\V70_3\SETUP.EXE and left click OK.

16.5. At the “Pervasive.SQL Install Welcome” window, left click Next.

16.6. At the “Pervasive.SQL Setup Type” window, left click Custom.

16.7. At the “Select Server Engines” window, left click “Scalable SQL” to uncheck the
box and verify “Btrieve” to be the only box checked. Left click Next.

16.8. At the “Select Client Components Installation Directory” window, verify
C:\PVSW\ and left click Next.

16.9. At the “Select Components to Install” uncheck all boxes EXCEPT for “Client
Programs” and “Btrieve” and left click Next.

16.10. At the “Question” window “You selected to not install the ODBC…” left click
NO.

16.11. At the “Select Pervasive.SQL Software Folder” verify Pervasive SQL 7 and left
click Next.

16.12. At the “Select Services Mode” screen verify “Automatic” and left click Next.

16.13. Verify settings and left click Next.

Note:  System will copy files.
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16.14. At the “Setup User Count License” screen, insert the appropriate Btrieve floppy
into the A: drive and left click Install License.

16.15. At the “User Count License” screen, left click OK.

16.16. At the “32–bit Btrieve Functionality Check” screen left click Skip.

16.17. At the “Question” window, left click NO. Remove floppy from the A: drive.

16.18. Left click Finish to restart system.

17. BTRIEVE 6.15 INSTALLATION – 5A ONLY

17.1. Make sure that you are logged in as Administrator.

17.2. Make sure that the MUSE Software CD is in the CD–ROM drive.

17.3. Left click Start >> Run.

17.4. Type Z:\BTRIEVE\V615\XX\INSTALL.EXE and left click OK.

Note:  XX = the amount of licenses purchased.

17.5. At the “Pervasive Welcome” window left click Next.

17.6. At the “Installation Options” window left click Next.
Verify that all boxes are checked.

17.7. At the “Choose Destination Location” window left click Next.
Verify the default directory is c:\bti\winnt.

17.8. At the “Install will copy files…” left click Yes.

17.9. At the “Btrieve for Windows NT Service has been installed and is running…”
prompt left click Yes to stop it now.

17.10. At the “What type of program group...” Left click Next.
Verify radio box “Common Program Group…” is selected.

17.11. At the “Would you like to view...” left click No.

17.12. At the “Install is complete...” screen, left click OK. Close window.

18. VISUAL BASIC 4 INSTALLATION – 5A ONLY



Revision: P

AP 901107-XXX, REV P, PAGE 33 of 53

18.1. Make sure that you are logged in as Administrator.

18.2. Make sure that the MUSE Software CD is in the CD–ROM drive.

18.3. Left click Start >> Run

18.4. Type Z:\VISUALB4\SETUP.EXE and left click OK.

18.5. Left click OK.

18.6. Verify directory to be C:\PROJECT1\. Left click button.

18.7. At the “Project1 Setup…” message box, left click OK.

19. MUSE MAIL MESSAGING INSTALLATION

Note:  Check customer order to see if this is an ordered option. If Yes, install the
following. If not, go to next section.

19.1. Install the IIS 4.0 SMTP Server

19.1.1. Make sure that the MUSE Software CD is in the CD–ROM drive.

19.1.2. Left click Start >> Programs >> Windows NT 4.0 Option Pack >>
Windows NT 4.0 Option Pack Setup.

19.1.3. Left click Next.

19.1.4. Left click Add/Remove.

19.1.5. Left double–click the “Internet Information Server (IIS)” in the
“Components” list.

19.1.6. At the “Internet Information Server (IIS)” screen, left click the “SMTP
Service” check box.

19.1.7. Left click OK.

19.1.8. Left click Next.

19.1.9. Left click Next to accept the default mailroot directory.

Note:  Setup will now start copying files.

19.1.10. Left click Finish.

19.2. Configure the IIS 4.0 SMTP Server

19.2.1. Left click Start >> Programs >> Windows NT 4.0 Option Pack >>
Microsoft Internet Information Server >> Internet Service
Manager.

19.2.2. Left click “show tips on startup” to uncheck and left click Close.
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19.2.3. In the left window pane, left click the “+” sign to the left of the
“Internet Information Server” to open.

19.2.4. Left click the “+” sign to the left of “MUSE$$$XXX” to open.

19.2.5. Right click “Default SMTP Site” to access menu and left click
“Properties.”

19.2.6. Left click “Messages” tab and type in the following:

Maximum Message Size (kilobytes) .......................................30000
Maximum Session Size (kilobytes).........................................30000

19.2.7. Left click “Delivery” tab and type in the following:

Smart Host.......................................................................MUSESIG

19.2.8. Left click “Directory Security” tab.

19.2.9. In the “Relay Restrictions” section, left click Edit…

19.2.10. Left click “Allowed to Relay” radio button.

19.2.11. Left click OK.

19.2.12. Left click OK.

19.2.13. Left click Console >> Exit.

19.2.14. Left click Yes to save console settings.

19.2.15. Left click Start >> Settings >> Control Panel >> Services.

19.2.16. Make sure the following is set for the “Microsoft SMTP Service”

Startup .............................................................................Automatic
Status ....................................................................................Started

19.2.17. Left click Close.

19.2.18. Close “Control Panel.”

19.3. Install EMWAC POP3 Server Software

19.3.1. Left click Start >> Run.

19.3.2. Type Z:\POP3\INSTALL.BAT C:\WINNT and left click OK.

19.3.3. At the “Does the MUSE File Server…” prompt, select Yes/NO.
<ENTER>

19.3.4. At the “Registry Editor” prompt, left click OK.

20. MUSE SOFTWARE INSTALLATION – 5A ONLY
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20.1. Install MUSE Application Files.

20.1.1. Make sure that you are logged in as Administrator.

20.1.2. Make sure that the MUSE Software CD is in the CD–ROM drive.

20.1.3. Left click Start >> Programs >> Command Prompt.

20.1.4. Type Z: <ENTER>

20.1.5. Type CD\MUSE <ENTER>

20.1.6. Type INSTALL 1 <ENTER>

20.1.7. At the “License…” prompt, verify Yes and <ENTER>

20.1.8. At the “Time Zone Environment Variable”, select accordingly.

Note:  This will depend on the city you are shipping to.

20.1.9. At the “Add a Start MUSE CV Shortcut to the Desktop” prompt, verify
Yes. <ENTER>

20.1.10. Perform the following based on the File Server:

MEMBER SERVER INSTALL ONLY

Type CVUSER MuseAdmin <ENTER>
Type CVUSER MuseBkgnd <ENTER>

20.2. Perform one of the following based on the Sales Order:

CONVERSION INSTALL ONLY
If your system requires a customer database to be placed on the system, notify the
appropriate member of conversion to do this.  When done, they will call you back
to continue with the install.

NO CONVERSION OR NEW SYSTEM INSTALL ONLY
If your system is NEW or DOES NOT need a customer’s database installed on it,
install the default MUSE Database Files.

Type CD\MUSEDB <ENTER>
Type INSTALL 5000 <ENTER>
At the “License…” prompt, verify Yes and <ENTER>

20.3. Perform one of the following based on the File Server:

MEMBER SERVER INSTALL ONLY

Type cvsinst MUSESIG\MUSEBkgnd Muse!Bkgnd
d:\vol000\system\sysinf\services.asc <ENTER>
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20.4. MUSE CV WEB INSTALLATION ONLY

Note:  Check customer order to see if this is an ordered option. If Yes, install the
following. If not, go to next section.

20.4.1. Install MUSE CV WEB

20.4.1.1. Type CD\MUSEWEB <ENTER>

20.4.1.2. Type INSTALL Z:\MUSEWEB\ <ENTER>

20.4.1.3. At the “License…” prompt, verify Yes. <ENTER>

20.4.2. Install Adobe Acrobat Reader

20.4.2.1. Left click Start >> Run.

20.4.2.2. Type Z:\ADOBE\AR32E301.EXE and left click OK.

20.4.2.3. At the “This will install Adobe Acrobat…” screen, left click
Yes.

20.4.2.4. At the “Welcome” screen, left click Next.

20.4.2.5. At the “License Agreement” screen, left click Yes.

20.4.2.6. At the “Destination Directory” screen, left click Next.

20.4.2.7. At the “Setup Complete” screen, uncheck the “Display Acrobat
Reader 3.01 Readme file” check box, and left click Finish.

20.4.2.8. Left click OK to the “Setup is complete” message.

20.5. MUSE WORD DATABASE INSTALLATION ONLY

Note:  Check customer order to see if MUSE CV Word is an ordered option. If
Yes, install the following. If not, go to next section.

20.5.1. Type CD\MUSEWDDB <ENTER>

20.5.2. Type INSTALL <ENTER>

20.6. Install MUSE Update files

20.6.1. Type CD\MUSEUP <ENTER>

20.6.2. Type INSTALL –U <ENTER>

20.6.3. At the “License…” prompt, verify Yes. <ENTER>

20.7. Type EXIT. <ENTER>

20.8. Reboot the system.
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21. MUSE SOFTWARE INSTALLATION – 5B ONLY

21.1. MUSE CV Server and MUSE CV Web Installation

21.1.1. Log in as Administrator .

21.1.2. If any Btrieve 7.0 folders are open in the tool bar, close them now.

21.1.3. Left click Start >> Run

21.1.4. Type Z:\MUSE32\SETUP.EXE and left click OK .

21.1.5. At the “Welcome” screen, left click Next.

21.1.6. At the “Software License Agreement” screen, left click Yes.

21.1.7. At the “Select MUSE CV System NODE Type” screen, verify that the
“File Server” radio button is selected.

21.1.8. Left click Next.

21.1.9. At the “Select MUSE CV…” screen, make sure “MUSE CV
Application” check box is selected.

21.1.10. If you are installing MUSE CV Web, left click “MUSE CV Web”
check box.
Check customer order to see if this is an ordered option. If Yes, install
the MUSE CV Web. If not, do not check, skip this and move on.

21.1.11. Left click Next.

21.1.12. At the question screen “Add MUSE CV Desktop icon,” verify that the
Yes radio button is selected and left click Next.

Note:  System will copy files.

21.1.13. At the “Setup Complete” screen, verify “Yes, I want to restart my
computer now” radio button is selected and left click Finish to restart
the computer.

21.2. Perform the following based on the File Server:

MEMBER SERVER INSTALL ONLY

21.2.1. Make sure that you are logged in as Administrator.

21.2.2. Left click Start >> Programs >> Command Prompt.

21.2.3. Type CVUSER MuseAdmin <ENTER>

21.2.4. Type CVUSER MuseBkgnd <ENTER>

21.2.5. Type EXIT. <ENTER>
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21.3. Perform one of the following based on the Sales Order:

CONVERSION INSTALL ONLY
If your system requires a customer database to be placed on the system, notify the
appropriate member of conversion to do this.  When done, they will call you back
to continue with the install.

NO CONVERSION OR NEW SYSTEM INSTALL ONLY
If your system is NEW or DOES NOT need a customer’s database installed on it,
install the default MUSE Database Files.

21.3.1. Make sure that you are logged in as Administrator.

21.3.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

21.3.3. Left click Start >> Run

21.3.4. Type Z:\MUSEDB\SETUP.EXE and left click OK.

21.3.5. At the “Welcome” screen, left click Next.

21.3.6. At the “Software license agreement” screen, left click Yes.

Note:  System will copy files.

21.3.7. At the “Question” prompt, left click No and left click Next.

21.3.8. At the “Setup Complete” screen, left click “NO” radio button and left
click Finish.

21.4. Perform one of the following based on the File Server:

MEMBER SERVER INSTALL ONLY

21.4.1. Left click Start >> Programs >> Command Prompt.

21.4.2. Type cvsinst MUSESIG\MUSEBkgnd Muse!Bkgnd
d:\vol000\system\sysinf\services.asc <ENTER>

21.4.3. Type EXIT. <ENTER>

21.5. MUSE CV WEB INSTALLATION ONLY

Note:  Check customer order to see if this is an ordered option. If Yes, install the
following. If not, go to next section.

21.5.1. Install Adobe Acrobat Reader

21.5.1.21. Left click Start >> Run

21.5.1.22. Type Z:\ADOBE\AR32E301.EXE and left click OK.

21.5.1.23. At the “This will install Adobe Acrobat…” screen, left click
Yes.
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21.5.1.24. At the “Welcome” screen, left click Next.

21.5.1.25. At the “License Agreement” screen, left click Yes.

21.5.1.26. At the “Destination Directory” screen, Left click Next.

21.5.1.27. At the “Setup Complete” screen, uncheck the “Display Acrobat
Reader 3.01 Readme file” check box, left click Finish.

21.5.1.28. Left click OK to the “Setup is complete” message.

21.6. Install MUSE Update Files

21.6.1. Left click Start >> Programs >> Command Prompt
21.6.2. Type Z: <ENTER>
21.6.3. Type CD\MUSEUP <ENTER>
21.6.4. Type INSTALL -U <ENTER>
21.6.5. At the “License…” prompt, verify Yes. <ENTER>
21.6.6. Type EXIT <ENTER>

21.7. Reboot the system.

22. TESTING THE MUSE CV WEB INSTALLATION

Note:  Perform this section only if the MUSE CV WEB option has been installed,
otherwise go to the next section.

22.1. Log in as the following:

User ......................................................................................................MuseAdmin
Password..............................................................................................Muse!Admin

Domain PDC ............................................................................................MUSE$$$
Domain Member......................................................................................MUSESIG

22.2. At the “Welcome” window, left click Close.

22.3. Close the “Welcome – Microsoft Internet Explorer” window.

22.4. Make sure that the MUSE Software CD is in the CD–ROM drive.

22.5. Left click Start >> Run.

22.6. Type Z:\BAT\ADDTMPUS.BAT and left click OK.

22.7. Verify the commands completed successfully.

22.8. Press any key to close the command prompt window.

22.9. Left click Start >> Shut Down…

22.10. Select the “Close all programs and…?” radio button.
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22.11. Left click Yes.

22.12. Log in as the following:

User ......................................................................................CVWEBTEST
Password....................................................................................... cvwebtest

Domain PDC ................................................................................MUSE$$$
Domain Member..................................................................MUSE$$$XXX

22.13. At the “Welcome” window left click Close.

22.14. Close the “Welcome – Microsoft Internet Explorer” window.

22.15. Left double–click the “Internet Explorer” icon on the desktop.

22.16. Left click Next.

22.17. At the “Setup Options screen”, select the “I already have an Internet
connection…” radio button, left click Next.

22.18. Left click Finish.

22.19. Left click Stop to abort finding Microsoft Web Site or left click OK at the “A
connection with the server…” prompt.

22.20. Left click in the Address bar of the Internet Explorer window, type
MUSE$$$XXX. <ENTER>

22.21. In the “Enter Network Password” window, enter the following:

User name.............................................................................CVWEBTEST
Password.......................................................................................cvwebtest

22.22. Left click OK.

22.23. Verify that the “Welcome to the MUSE® CardioVascular Information System
Website” homepage is displayed.

22.24. Close the Internet Explorer window.

22.25. Left click Start >> Shut Down…

22.26. Select the “Close all programs and…?” radio button.

22.27. Left click Yes.

22.28. Log in as Administrator.

22.29. Left click Start >> Run.

22.30. Type Z:\BAT\DELTMPUS.BAT and left click OK.
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22.31. Verify the commands completed successfully.

22.32. Press any key to close the command prompt window.

22.33. Left click Start >> Shut Down…

22.34. Select the “Restart” radio button. System will reboot.

23. SETTING UP MUSE ENVIRONMENT

23.1. Log in as MuseAdmin. Password is Muse!Admin.

Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY
In the “Domain” pull down box select MUSE$$$

MEMBER SERVER INSTALL ONLY
In the “Domain” pull down box select MUSESIG

23.2. If the “Welcome” window appears, left click Close.

23.3. If the “Welcome – Microsoft Internet Explorer” window appears, close it.

23.4. Adding nodes to the server

23.4.1. Left click Start >> Programs >> Command prompt

23.4.2. Type CVUSER MuseXXX. <ENTER>

Note:  XXX is number of the node that you want to add.

The corresponding password will be Muse!XXX.

Repeat this step for as many users that you will have connecting to the
server.

23.4.3. Type Exit. <ENTER>

23.5. Configuring IMS

23.5.1. Left click Start >> Run

23.5.2. Type DCOMCNFG. Left click OK.

23.5.3. Select MUSE–CV IMS Cserver. Left click Properties.

23.5.4. Left click the “Security” tab.

23.5.5. Left click the “Use Custom Access Permissions” radio button. Left click
Edit button.

23.5.6. Left click Add.



Revision: P

AP 901107-XXX, REV P, PAGE 42 of 53

23.5.6.1. Left click “List Names From” and choose the local domain:
PDC ......................................................................MUSE$$$
Member ...................................................\\MUSE$$$XXX*

23.5.6.2. Left double–click Muse Users group.

23.5.6.3. Left double–click System group.

23.5.6.4. Verify they appear in “Add names” window along with “Type
of Access” being Allow Access. Left click OK.  Left click OK

23.5.7. Left click the “Use Custom Launch Permissions” radio button. Left click
Edit button.

23.5.8. Left click Add.

23.5.8.1. Left click “List Names From” and choose the local domain:
PDC .............................................................................MUSE$$$
Member...........................................................\\MUSE$$$XXX*

23.5.8.2. Left double–click Muse Users group.

23.5.8.3. Left double–click System group.

23.5.8.4. Verify they appear in “Add names” window along with “Type
of Access” being Allow Launch. Left click OK.  Left click OK

23.5.9. Left click “Identity” tab.

23.5.10. Left click “This User” radio button.

23.5.11. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL ONLY
In the “User” edit box type MUSE$$$\MuseBkgnd

Note:  Where MUSE$$$ = domain name of PDC.

MEMBER SERVER INSTALL ONLY
In the “User” edit box type MUSESIG\MuseBkgnd

23.5.12. In the “Password” edit box type Muse!Bkgnd and confirm the
password.

23.5.13. Left click OK.

23.5.14. Left click OK.
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23.6. Verify that IMS is configured properly.

23.6.1. Insert Cartridge into Tape Backup unit.

23.6.2. Left click Start >> Run.

23.6.3. Type CVIS0122. Left click OK.

23.6.4. Verify that the MUSE–IMS window is launched, close window.

23.6.5. Left click Start >> Run.

23.6.5.1. Type D:\VOL000\SYSTEM\SYSINF\IMS.INI. Left click
OK.

23.6.5.2. Add the following to the section – 5A ONLY

[Backup]
LastWeek=
ThisWeek=
UpdateOFM=FALSE

23.6.5.3. Change section to the following:

[AUTORUN]
BACKARC=FALSE
INTEGRITY=FALSE

23.6.5.4. Save file.

23.6.6. Left click Start >> Run.

23.6.7. Type SOON CVIS0122   –AUTORUN. Left click OK .

Note:  A window should appear and close down.

23.6.8. Start MUSE.

23.6.8.1. Left click Start >> Programs >> MUSE CVIS >>
Start MUSE CV.

23.6.8.2. Left click System >> System Status

23.6.8.3. Left click Select List >> Event Log

23.6.8.4. Visually check for the following entries

“IMS Started”
“IMS Ended”

23.6.8.5. Exit MUSE application. Left click System >> Exit.

23.6.9. Left click Start >> Run.

23.6.10. Type D:\VOL000\SYSTEM\SYSINF\IMS.INI. Left click OK.
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23.6.11. Change section to the following:

[AUTORUN]
BACKARC=TRUE
INTEGRITY=TRUE

23.6.12. Save file.

23.6.13. Configure nightly Auto Run time

23.6.13.1. Left click Start >> Run.

23.6.13.2. Type CVIS0122. Left click OK.

23.6.13.3. Left click System >> Set AutoRun Time.

23.6.13.4. Right click in the white Client area that is launched.

23.6.13.5. Left click Add.

23.6.13.6. Type in the command box CVIS0122   –AUTORUN

23.6.13.7. Set the days and hours of operation.

23.6.13.7.1. The “Every”  radio button should be selected.

23.6.13.7.2. Left click on every day of the week.

23.6.13.7.3. Set the time for 3:00 am.

23.6.13.7.4. Left click OK .

23.6.13.8. Verify a green check, all days chosen and time set to 3:00am.

23.6.13.9. Close all visible windows.

23.6.14. Installing Options Disk

23.6.14.1. Start MUSE by left double–clicking on icon Start MUSE CV

23.6.14.2. Left click System >> System Setup.

23.6.14.3. Left click System >> Install Options.

23.6.14.4. Copy “Authorization Code” and proceed to MUSE Options
station to set up the Options Disk #419719–001.

23.6.14.5. Once completed, insert Options disk into floppy drive and left
click Install.

23.6.14.6. Verify “Registered Name” and “Installed Options List” data to
be correct.

23.6.14.7. Remove floppy.

23.6.14.8. Close MUSE application and restart NT.
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23.7. CATH LAB INSTALLATION ONLY

Note:  Check customer order to see if this is as an ordered option. If Yes, install
the following. If not, go to next section.

23.7.1. Cath options must be turned on via the Options disk.

23.7.2. The file “APPLIST.ASC” must be edited and the “!” in front of
Configure Cath Lists… must be removed.

23.7.3. The file “BACKTASK.ASC” must be edited and the “;” in front of
324,\\MUSE$$$XXX must be removed.

23.8. MAC–LAB INSTALLATION ONLY

Note:  Check customer order to see if this is as an ordered option. If Yes, install
the following. If not, go to next section.

23.8.1. Share Drive for access.

23.8.1.1. Left click Start >> Run

23.8.1.2. Type Z:\MUSEDB\MLABADD.BAT  and left click OK .

23.8.2. The file “APPLIST.ASC” must be edited and the “!” in front of MAC–
LAB Assistant… must be removed.

23.9. ACC DATA EXPORT INSTALLATION ONLY

Note:  Check customer order to see if this is as an ordered option. If Yes, install
the following. If not, go to next section.

23.9.1. The file “APPLIST.ASC” must be edited and the “!” in front of ACC
Data Export… must be removed.

23.10. INVENTORY MANAGEMENT AND SCHEDULE BOARD
INSTALLATION ONLY

Note:  Check customer order to see if this is as an ordered option. If Yes, install
the following. If not, go to next section.

23.10.1. Inventory Management option must be turned on via the Options disk.

23.10.2. Schedule Board option must be turned on via the Options disk.

23.10.3. The file “BACKTASK.ASC” must be edited and the “;” in front of
612,1,1 must be removed. Also, the “1,1” must be changed to the
number of the client that will running it.

Note:  Only one instance of 612 can be activated on a networked
system.
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23.11. TFTP SERVER INSTALLATION ONLY

Note:  Check customer order to see if a Gateway client is to be installed. If Yes,
install the following. If not, go to next section.

23.11.1. The file “BACKTASK.ASC” must be edited and the line 325,1,1 must
be added. Also, the “1,1” must be changed to the number of the client
that will running it.

23.11.2. The file “BACKTASK.ASC” must be edited and the 340,1,1 must be
added. Also, the “1,1” must be changed to the number of the client that
will running it.

23.12. Installing the Bar Code font –5A ONLY

23.12.1. Logon as MuseAdmin.

23.12.2. Left click Start >> Settings >> Control Panel >> Fonts.

23.12.3. Left click File >> Install New Font …

23.12.4. Choose C:\mei directory.

23.12.5. Left click 3 of 9 Barcode (TrueType).

23.12.6. Left click OK .

23.12.7. Close all visible windows.

24. CONFIGURING MUSEADMIN DESKTOP

24.1. Set the screen saver.

24.1.1. Right click on the desktop, left click Properties.
24.1.2. Left click the “Screen Saver” tab.
24.1.3. Choose the Logon Screen Saver from “Screen Saver” pull down menu.
24.1.4. Left click “Password Protected” check box.
24.1.5. Verify wait is set to 15 minutes.
24.1.6. Left click OK to exit.

24.2. Move the “My Briefcase” folder to the Recycle Bin.

24.2.1. Right click on icon My Briefcase and select Delete.
24.2.2. Left click Yes to confirm delete.

24.3. Set the taskbar options

24.3.1. Left click Start >> Settings >> Taskbar…
24.3.2. Verify “Always on top” is selected.
24.3.3. Left click “Show small icons in Start menu.”
24.3.4. Verify “Show Clock” is selected.
24.3.5. Left click OK to exit.
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24.4. Set the Explorer Options

24.4.1. Left double–click “My Computer” icon.
24.4.2. Left click View >> Toolbar. Toolbar should appear in window.
24.4.3. Left click View >> Options…
24.4.4. Left click the radio button “Browse folders by using a single window

that changes as you open each folder.”
24.4.5. Left click the “View” tab.
24.4.6. Left click the radio button “Show all files.”
24.4.7. Left click the check button “Display the full path in the title bar.”
24.4.8. Un–select “Hide file extensions for known file types.”
24.4.9. Left click the check button “Display compressed files and folders with

alternate color.”
24.4.10. Left click OK. Close “My Computer” window.

24.5. Set the command prompt options

24.5.1. Left click Start >> Settings >> Control Panel >> Console.
24.5.2. Left click the “Options” tab. Default.
24.5.3. Left click “Large” from the “Cursor Size” section.
24.5.4. Left click the “Layout” tab.
24.5.5. Enter 80 for the “Screen Buffer Size Width.” Default.
24.5.6. Enter 50 for the “Screen Buffer Size Height.”
24.5.7. Enter 80 for the “Window Size Width.” Default.
24.5.8. Enter 50 for the “Window Size Height.”
24.5.9. Left click OK. Close “Control Panel” window.

*****************************************
NOTE:  AT THIS POINT, THE INSTALL OF THE MUSE FILE SERVER IS COMPLETE.
COMPLETE ANY NECESSARY CLIENT INSTALLATIONS AND THEN START THE

OVERALL TESTING USING TP MUSE 5A AT THIS TIME.  AFTER SUCCESSFUL
COMPLETION OF THE TP, RETURN TO THIS POINT AND COMPLETE THE AP.

****************************************

25. BURN–IN PROCEDURE

No burn–in is necessary.  This process is done by Avnet Computers.

26. CLEANUP

Perform one of the following based on the Sales Order:

CONVERSION INSTALL ONLY
Give system to the Conversion team.  When they return it back to you, complete
the rest of this AP.

NO CONVERSION OR NEW SYSTEM INSTALL ONLY
Continue with this AP.

26.1. Emptying Recycle Bin

26.1.1. Right click on Recycle Bin icon.
26.1.2. Select “Empty Recycle Bin”
26.1.3. Left click Yes.
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26.1.4. Reboot.

26.2. Disk Maintenance

26.2.1. Make sure that you are logged in as Administrator.

26.2.2. Left click Start >> Programs >> Diskeeper >> Diskeeper.

26.2.3. Close “Welcome” window.

26.2.4. Left click Defragment >> Select Disk.

26.2.5. Left click C:[NTFS].

26.2.6. Left click OK.

26.2.6.1. Process will now start and may take 5–10 minutes.

26.2.6.2. Let click OK when done.

26.2.7. Left click Defragment >> Select Disk.

26.2.8. Left click D:[NTFS].

26.2.9. Left click OK.

26.2.9.1. Process will now start and may take 5–10 minutes.

26.2.9.2. Left click OK when done.

26.2.10. Left click Advanced Tools >> Boot–Time Defragmentation.

26.2.11. Left click C:[NTFS].  Left click “Directory Consolidation” check box.
Left click Set.  Verify Directory Consolidation Set.

26.2.12. Left click D:[NTFS]. Left click “Directory Consolidation” check box.
Left click Set. Verify Directory Consolidation Set.

26.2.13. Left click Close.

26.2.14. At the “Diskeeper” prompt, left click OK, left click OK.

26.2.15. Close “Diskeeper” window.

26.2.16. Reboot system.

Note:  This process will reboot your system a few times. Wait until you
get a logon screen before continuing.

27. CREATING AN EMERGENCY REPAIR DISK
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27.1. Log in as Administrator.
27.2. Insert a floppy into  A: drive
27.3. Select Start >> Run
27.4. Type RDISK /S. Left click OK.
27.5. At the “Setup can create an Emergency Repair disk...” Screen, left click Yes.
27.6. At the “Label a floppy disk...” screen, left click OK.
27.7. At the “Windows NT repair information contains...” screen, left click OK.
27.8. Remove the floppy, date and label it as MUSE$$$XXX Emergency Repair Disk
27.9. Restart System.

28. TAPE BACKUP

28.1. Log in as MUSE ADMIN

28.2. Left click Start >> Programs >> MUSE CV Info System >> Integrated
Maintenance Suite >> Manual Backup

28.3. Insert “MONDAY” tape.

28.4. Left click Normal Daily.  Backup process will start.

28.5. Left click Start >> Programs >> MUSE CV Info System >> Integrated
Maintenance Suite >> Manual Backup

28.6. Insert “MONTHLY SERVICE” tape.

28.7. Left click Monthly Backup.  Backup process will start.

Note:  Check MUSE error log to verify backups ran correctly.

28.8. CONVERSION INSTALL ONLY

28.8.1. Left click Start >> Programs >> MUSE CV Info System >>
Integrated Maintenance Suite >> Advanced

28.8.2. Insert “CONVERSION” tape.

28.8.3. 5A INSTALLS:  Left click Backup Archive >> Backup Paths
5B INSTALLS:  Left click Backup Archive >> Do Manual Backup

28.8.4. Highlight all volumes.

28.8.5. Left click OK.  Backup process will start.

Note: If volumes are large enough this process may ask for multiple
tapes to be inserted.

28.8.6. Upon completion, give tape to Conversion and let them visually inspect
the system.

28.8.7. Multiple Archived Volumes
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Note:  Complete this section only if there are more then two volumes.

Note:  Vol0 and Vol[with the greatest number] should not be selected. They are
both active and will be done in the Daily Tape process. Only select the
Vol’s that are in between these two. They are not active and will not be
backed up unless told to do so. Also, for every additional volume, you
must have two extra tapes that must be added to the sales order as separate
line items.

For example, if you have the following scenario:

Vol0 È Template Volume – will be backed up in Daily Tape. Do not
select.
Vol1 È Archive Volume – You will create two [2] VOLUME 1 tapes and
backup.
Vol2 È Archive Volume – You will create two [2] VOLUME 2 tapes and
backup.
Vol3 È Active Volume – will be backed up in Daily Tape. Do not select.

28.8.7.1. Left click Start >> Programs >> MUSE CV Info System >>
Integrated Maintenance Suite >> Advanced

28.8.7.2. Insert VOLUME X tape.

Note:   X =  the number of the volume.

28.8.7.3. 5A INSTALLS:  Left click Backup Archive >> Backup Paths
5B INSTALLS:  Left click Backup Archive >> Do Manual
Backup

28.8.7.4. Highlight the appropriate VolX.

28.8.7.5. Left click OK.  Backup process will start.

28.8.7.6. Upon completion, remove tape, put in the second tape and
repeat section.  If there are more volumes to backup, like in the
example, repeat this section. For every volume there should be
two identical backup tapes that will be sent to the customer.

29. REMOVE TEMPORARY USERS

FOR MEMBER SERVER INSTALL ONLY

29.1. Log in as Administrator. In the “Domain” pull down box select MUSE$$$XXX

29.2. Left click Start >> Programs >> Administrative Tools >> User Manager for
Domains.

29.3. Left double–click “MUSE Users” in bottom window.

29.3.1. Select all users and left click Remove.

29.3.2. Left click OK.
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29.4. Left double–click “Administrators” in bottom window.

29.4.1. Select all users, except for Administrator, and left click Remove.

29.4.2. Left click OK.

29.5. Left double–click “Users” in bottom window.

29.5.1. Select all users, except the Administrator, and left click Remove.

29.5.2. Left click OK.

29.6. Left click Policies >> User Rights.

29.6.1. Left click check box “Show Advanced Users Rights”

29.6.2. Pull down “Right” menu, select Log on as a Batch Job.

29.6.3. Select “MUSE Background” user and left click Remove.

29.6.4. Pull down “Right” menu, select Log on as a Service.

29.6.5. Select all users and left click Remove.

29.6.6. Left click OK.

29.7. Close “User Manager” window.

30. SET SCREEN RESOLUTION

30.1. Left click Start >> Settings >> Control Panel >> Display.

30.2. Left click “Settings” tab.

30.3. Change the “Desktop Area” to be set at 640 by 480.

30.4. Left click OK.

30.5. At the “Display Settings” prompt, left click OK.

30.6. Display should be noticeably larger.  Close Control Panel.

30.7. Left click Start >> Shutdown.

30.8. Verify “Shutdown the computer?” radio button is selected.

30.9. Left click Yes.

30.10. At the “Shutdown Computer” prompt, power down File Server.

31. CONFIGURING THE COMPAQ UPS
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Note: Perform the following ONLY IF the UPS option is included with the system and
then check (RAID Voltage Options located on Pre–build) to see if the UPS should
be configured for 100v, 220v, or 240v and perform the following.

If the UPS is domestic 120v and does not need to be reconfigured for 100v, 220v,
or 240v, then skip this section.

31.1. Perform one of the following based on the (RAID Voltage Options):

CAUTION:  DO NOT press the OFF button while the UPS is in configuration
mode.  Doing so places the unit in Standby mode and disconnects
the load.

100 VAC UPS CONFIGURATION ONLY – JAPAN

Press the ON and Test/Alarm Reset buttons at the same time for one beep – see
Figure 1–1. (The UPS is now in Configuration mode)

Press the ON button until the 100/208v function LED is selected – see Appendix
Figure 1–1. (The UPS beeps as you scroll through each function LED and the
selected function LED blinks.)

Press the Test/Alarm Reset button to turn the 100/208v function on. (The
Function Status LED turns on when the function is on and off when the function
is off.)

Press the ON and Test/Alarm Reset buttons at the same time to return to
Operation mode. (Changes take effect immediately after returning to Operation
mode.)

220 VAC UPS CONFIGURATION ONLY – FOREIGN

Press the ON and Test/Alarm Reset buttons at the same time for one beep – see
Figure 1–1. (The UPS is now in Configuration mode)

Press the ON button until the 110/220v function LED is selected – see Appendix
Figure 1–1. (The UPS beeps as you scroll through each function LED and the
selected function LED blinks.)

Press the Test/Alarm Reset button to turn the 110/220v function on. (The
Function Status LED turns on when the function is on and off when the function
is off.)

Press the ON and Test/Alarm Reset buttons at the same time to return to
Operation mode. (Changes take effect immediately after returning to Operation
mode.)
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240 VAC UPS CONFIGURATION ONLY – FOREIGN

Press the ON and Test/Alarm Reset buttons at the same time for one beep – see
Figure 1–1. (The UPS is now in Configuration mode)

Press the ON button until the 127/240v function LED is selected – see Appendix
Figure 1–1. (The UPS beeps as you scroll through each function LED and the
selected function LED blinks.)

Press the Test/Alarm Reset button to turn the 127/240v function on. (The
Function Status LED turns on when the function is on and off when the function
is off.)

Press the ON and Test/Alarm Reset buttons at the same time to return to
Operation mode. (Changes take effect immediately after returning to Operation
mode.)

*****************************************
NOTE:  AT THIS POINT, YOU ARE READY TO SHIP THE SYSTEM.

REFERENCE TP MUSE 5A FOR PROPER SHIPPING INSTRUCTIONS.
*****************************************

32. APPENDIX

100/208 V function LED

127/240 V function LED

120/230 V function LED (Default)

Function Status LED

Test/Alarm Reset Button

OFF Button

ON Button

110/220 V function LED

Figure 1-1.  UPS Button and LED Function in Configure Mode
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1. PURPOSE

This procedure is intended as a guideline for the assembly of the following MUSE
products:

MUSE Workstation ............................................................................................901070-001

Based on what is called out on the customer order and the new OMAR structure, a
technician will be able to reference this document in order to create a system with
Windows 95 as its operating system.

2. SCOPE

This document applies to the GE-Marquette Medical Systems– Milwaukee
manufacturing facility.

3. RELATED DOCUMENTS

3.1. MUSE Network Series Manual
3.2. QS1004..........................................................................Product Burn-In Guidelines
3.3. QS1003................................ Quality Assurance Device History Record Guidelines
3.4. TP-MUSE 5A.................................................................. MUSE 5A Test Procedure

4. EQUIPMENT REQUIRED
All equipment is “OR EQUIVALENT”

4.1. Complete MUSE Client Customer Order
4.2. MUSE QA Calibrated Test ECG(s) Diskettes ..........................................MT-3561
4.3. Three SIGLAB 230VAC power cables (for 230VAC systems only)
4.4. MUSE Software CD 5A.........................................................................420858-001
4.5. MUSE Software CD 5B .........................................................................422436-001
4.6. MUSE MFG Tooling CD................................................................................S1402
4.7. Boot Disk ........................................................................................................S1407
4.8. MUSE File Server Configurator......................................................................S1408

5. SPECIAL CONDITIONS

The following test procedure will apply to both 115 VAC 50-60Hz systems as well as
230 VAC 50Hz systems.

6. PROCEDURE

6.1. Assembly of Vendor Equipment

6.2. Initial Set-up of Vendor Equipment

6.2.1. 100/115 VAC 50-60Hz Systems

Assemblies (115VAC 50-60Hz) - connect power cord supplied with
computer and monitor to standard 115VAC 60Hz outlet.

6.2.2. 230 VAC 50Hz Systems

Assemblies (230VAC 50Hz) - connect SIGLAB 230VAC power cable to
power connector on back of computer, monitor, and printer, then to
230VAC 50Hz power source.
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6.2.3. Connect monitor signal cable to the video connector on back of computer.

6.2.4. Connect MICROSOFT Mouse (403590-199) into Mouse Connector port
on back of computer.

6.2.5. If you are building a system with a Cybex KVM 2/4 port switch, connect
all keyboard, mouse and monitor ports from the Client into the necessary
slots on the switch.

7. BIOS SETTINGS FOR ALL ROCKAWAY COMPUTERS

7.1. Boot system.
7.2. <F2> to enter setup utility.
7.3. At the Bios Setup Utility Screen. <F9>
7.4. "Load default configuration now" Yes <ENTER>
7.5. <F10> "Save configuration changes and exit now!”
7.6. Verify Yes <ENTER>
7.7. System will now restart. <F2> to enter setup utility.
7.8. Set the appropriate “System Time” and “System Date.”
7.9. Go to “Advanced Screen” tab and set the “Plug & Play O/S” to <NO>
7.10. Go to “Power” tab.
7.11. Set “Power Management” to DISABLED
7.12. <F10> "Save configuration changes and exit now!"
7.13. Verify Yes <ENTER>
7.14. System will now restart.

8. IMAGECAST PROCEDURE

8.1. Insert Boot Floppy S1407 into floppy drive and power up.

8.2. Insert Tooling CD S1402 into CD-ROM drive.

8.3. At the “Press any key to continue…” prompt, <ENTER> and then select Client
<ENTER> and then select Win 95 <ENTER>

8.4. At the blue “ImageCast IC3 Client…” screen, once the system starts copying data,
remove the floppy.

8.5. System will take approximately 1-2 minutes to complete the process. It will then
reboot. Remove the MUSE MFG Tooling CD.

9. SETTING NETWORK ENVIRONMENT.

9.1. If the “Microsoft Network” prompt appears, left click Cancel.

9.2. If the “Enter Network Password” prompt appears, left click Cancel.

Note:  The network settings will be fixed in this section.

9.3. Left click Start >> Programs >> MS-DOS Prompt.

9.4. Type DEL C:\WINDOWS\MUSE042.PWL <ENTER>

9.5. Type Exit <ENTER>
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9.6. Left click Start >> Settings >> Control Panel >> Network

9.7. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL

9.7.1. Left click “TCP\IP”.
9.7.2. Left click Properties.
9.7.3. Left click the radio button “Specify and IP address.”
9.7.4. Type in the “IP Address” of the node.

128.9.9.node_id
9.7.5. Type in the “Subnet Mask” of the node.

255.255.0.0
9.7.6. Left click “DNS Configuration” tab.
9.7.7. Left click radio button “Enable DNS”.
9.7.8. Type MUSE$$$XXX in the “Host”

Note:  Where MUSE$$$XXX = Client Machine Name

9.7.9. Left click OK.

MEMBER SERVER INSTALL

Continue on…

9.8. Left click “Identification” tab.

9.9. Type MUSE$$$XXX for “Computer Name”.

Note:  MUSE$$$XXX È Name of Client node machine.

Acquisition Station.............................................................................................5-14
Gateway Station ...............................................................................................22-36
MUSE Workstation ........................................................................................42-123

9.10. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL

Type MUSE$$$ for “Workgroup”.

MEMBER SERVER INSTALL

Type MUSESIG for “Workgroup”.

9.11. Type MUSE$$$ WIN95 (MUSE NodeXXX) for “Computer Description”.

9.12. Left click “Configuration” tab.

9.13. Left click “Client for Microsoft Networks ” icon and left click Properties.
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9.14. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL

Type MUSE$$$ in the “Windows NT domain” edit field.

Note:  MUSE$$$ = Hospital’s domain.

MEMBER SERVER INSTALL

Type MUSESIG in the “Windows NT domain” edit field.

9.15. Left click OK.

9.16. Left click OK.

9.17. Left click Yes to restart the computer.

9.18. At the “Enter Windows Password” window, type in the following:

User Name:..............................................................................................MuseXXX

9.19. Left click OK.

9.20. Left click OK.

9.21. At the “Enter Network Password” window, verify MUSEXXX is in the “User
Name” field.

9.22. Type Muse!XXX in the “Password” edit field.

9.23. Perform one of the following based on the File Server:

PRIMARY DOMAIN CONTROLLER INSTALL

Verify MUSE$$$ is in the “Domain” field.

MEMBER SERVER INSTALL

Verify MUSESIG is in the “Domain” field.

9.24. Verify that the “Save this password…” check box is checked.

9.25. Left click OK.

10. INSTALL SHIELD APPLICATION

10.1. Insert Tool Disk S1408.

10.2. Left click Start >> Run

10.3. Type A:\SETUP.EXE. Left click OK.

10.4. At the “Welcome” screen, left click Next.
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10.5. Type in the appropriate data in the following edit fields:

Name ................................................................................................Hospital Name
Organization: .......................................................................Hospital Organization
Serial: ......................................................... XXXXX-OEM-XXXXXXX-XXXXX

10.6. Left click Next.

10.7. Verify “Yes, I want to restart…” radio button is selected.

10.8. Remove floppy.

10.9. Left click Finish. System will now restart.

11. SETTING UP LOCAL PRINTING

Note:  The following conditions must be met before continuing on:
A printer configured and attached to the LPT port on the computer.

11.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

11.2. Left click Start >> Settings >> Printers.

11.3. Left double click icon Add Printer.

11.4. At the “Add Printer Wizard” screen, left click Next.

11.5. Left click the radio button “Local Printer” and left click Next.

11.6. Left click Have Disk.

11.7. Type Z:\HPPRINT\WIN95 left click OK.

11.8. Left click HP LaserJet 4000 Series PS in the “Printers” section.

11.9. Left click Next.

11.10. From the “Available Ports” section, left click the port that the printer is attached
to.

11.11. Left click Next.

11.12. Verify “Printer Name” to be HP LaserJet 4000 Series PS in the edit field. Left
click Next.

Note:  This may change if customer so desires based on Pre-Build Survey.

11.13. Verify radio button “Yes (recommended)” is selected. Left click Finish.

11.14. Files will be copied to your system.

11.15. If the “Copying files…” prompt for the HP Laser Jet 4000 appears, left click
Cancel. At the “HP Laser Jet 4000 Series PCL 6…” prompt, left click OK.

Note: This may only happen if you have a printer connected to the LPT port.
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11.16. At the “HP Laserjet…” prompt, left click Yes if the page printed correctly.  If
not, reinstall the printer.

11.17. Right click “HP LaserJet 4000 Series PS” Icon.

11.18. Left click Sharing

11.19. Left click radio button “Shared As:”

11.20. Type in “Shared Name”; edit field a unique name.

Note:  For one (1) printer, use LJ4K01.  If more than one (1), increase number.
Reference Pre-Build Survey for correct name.

11.21. Left click OK.

11.22. Close “Printers” window.

12. MICROSOFT WORD 6.0 INSTALLATION

Note:  Check customer order to see if MUSE CV Word is an ordered option. If Yes,
install the following. If not, go to next section.

12.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

12.2. Left click Start >> Run

12.3. Type Z:\WORD60C\SETUP.EXE Left click OK.

12.4. At the “Microsoft Word 6.0c Setup” window, left click OK.

12.5. At the “Name and Organization Information” window type NodeXXX in the
“Name” field. Type Customer Name in the “Organization” field. Left click OK.

12.6. Left click OK to verify the information.

12.7. Left click OK at the “Microsoft Product ID number” window.

12.8. Verify “C:\WINWORD” is the install directory, left click OK.

12.9. Left click Complete/Custom button.

12.10. Left click Continue.

12.11. At the “Help for WordPerfect users” window, left click NO.

12.12. At the “Choose Program Group” window verify Microsoft Office and left click
Continue. Software will begin installing.

12.13. At the “Successful Completion” window, left click OK.

12.14. Start Word by left double clicking the Microsoft Word icon.

12.15. When the “Tip of the Day” window appears, left click OK.

12.16. Left click Tools >> Options.
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12.17. Left click “Save” tab.

12.18. Deselect the following checkboxes:

Allow Fast Saves
Automatic Save Every ___ Minutes

12.19. Left click OK to close the Options window and save your choices.

12.20. Left click View >> Ruler to turn rulers off.

12.21. Close Word. Close all visible windows.

12.22. Restart system.

13. MUSE MAIL MESSAGING CLIENT INSTALLATION

Note:  Check customer order to see if this is an ordered option. If Yes, install the
following. If not, goto next section.

13.1. Left click Start >> Settings >> Control Panel.

13.2. Left double-click Add/Remove Programs.

13.3. Left click “Windows Setup” tab.

13.4. Left double-click “Windows Messaging” selection.

13.5. Make sure that the following options are as follows:

“Internet Mail Services” check box is checked.
“Microsoft Mail Services” check box is unchecked.
“Windows Messaging” check box is checked.

13.6. Left click OK.

13.7. Left click OK at the “Add/Remove Programs” screen.

Note:  Files will be copied.

13.8. Left double-click the “Inbox” icon on the Windows 95 desktop.

13.9. At the “Inbox Setup Wizard” screen, select the “Use the following information
services” radio button and make sure the only entry, in the list which is checked,
is the “Internet Mail” option. Left click Next.

13.10. At the “TCP/IP is required…” dialog, left click OK.

13.11. At the “Click the method used to connect...” screen, choose “Network” and left
click Next.
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13.12. At the “Specify either an IP Address or a name...” screen, fill in the following
field:

Specify the Name ............................................................................MUSE$$$XXX
MUSE$$$XXX = MUSE File Server you are attaching to.

13.13. Left click Next.

13.14. At the “Click the mode for transferring messages...” screen, choose “Automatic”
and left click Next.

13.15. At the “Type in the E-Mail address for your mail account...” screen, enter the
following:

E-Mail Address.........................................................MUSE.CV.Mail@MUSE.org
Your Full Name..............................................................................MUSE CV Mail

13.16. Left click Next.

13.17. At the “Type in your mailbox account name and password...” screen, enter the
following:

Mailbox Name.........................................................................................MuseXXX
Password.................................................................................................Muse!XXX
MuseXXX = node where E-Mail Client is being installed

13.18. Left click Next.

13.19. At the “Personal Address Book” screen, accept the default value. Left click Next.

13.20. At the Personal Folders dialog” screen, accept the default value. Left click Next.

13.21. Left click Finish.

13.22. Close the E-Mail client.

13.23. Left double-click the “Mail” icon located in the Control Panel Applet.

13.24. On the “Services” tab window, left click Show Profiles.

13.25. On the “General” tab window of the Mail dialog, in the box showing the profiles
setup on the computer, there should only be one profile present. Select the
“Windows Messaging Settings” profile and left click Copy.

13.26. In the “Copy Profile” dialog, type MUSE CV Messaging in the “New Profile
Name” field and left click OK.

Note:  There should now be two profiles listed.

13.27. Select the original profile, “Windows Messaging Settings,” and left click
Remove. Left click Yes to remove the original profile.

13.28. In the Mail dialog, on the “General” tab window, make sure the profile selected
for the “When starting Windows Messaging, use this profile” field is showing the
MUSE CV Messaging profile as the current profile.
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13.29. Left click Close.

13.30. Close Control Panel.

14. MUSE SOFTWARE INSTALLATION – 5A ONLY

14.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

14.2. Install MUSE Application Files.

14.2.1. Left click Start >> Programs >> MS-DOS Prompt.
14.2.2. Type COMMAND /E:1024 <ENTER>
14.2.3. Type Z: <ENTER>
14.2.4. Type CD\MUSE <ENTER>
14.2.5. Type INSTALL XX <ENTER>

Note:  Where XX = node_id.

14.2.5.1. At the “License…” prompt, verify Yes <ENTER>

14.2.5.2. At the “Time Zone Environment Variable”, select accordingly
<ENTER>

Note:  This will depend on the city you are shipping to.

14.2.5.3. At the “Is this a Turnkey Workstation” prompt, verify Yes
<ENTER>

14.2.5.4. At the “Use MUSE Authentication” prompt, verify Yes
<ENTER>

14.2.5.5. At the “MEI writer board installed” select Yes/No <ENTER>

14.3. Install MUSE Update Files

14.3.1. Type CD\MUSEUP <ENTER>
14.3.2. Type INSTALL - U <ENTER>
14.3.3. At the “License…” prompt, verify Yes <ENTER>

14.4. Change location of server in WIN.INI.

14.4.1. Type EDIT C:\WINDOWS\WIN.INI <ENTER>
14.4.2. In the following section, change the values to reflect:

[MUSE]
Initial State: MainServerName=\\MUSE$$$001
Final State: MainServerName=\\MUSE$$$XXX

Note:  MUSE$$$XXX = File server you are attaching to.

14.4.3. Save file and close Edit window.
14.4.4. Type EXIT <ENTER>
14.4.5. Type EXIT <ENTER>

14.5. Restart system.
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15. MUSE SOFTWARE INSTALLATION – 5B ONLY

15.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

15.2. Left click Start >> Run

15.3. Type Z:\MUSE32\SETUP.EXE and left click OK .

15.4. At the “Welcome” screen, left click Next.

15.5. At the “Software License Agreement” screen, left click Yes.

15.6. At the “Select MUSE CV System NODE Type” screen, left click the appropriate
radio button for the type of system you are installing.

Acquisition .........................................................................................................5-14
Unity Gateway..................................................................................................22-36
Workstation ....................................................................................................42-115

15.7. Left click Next.

15.8. At the “Select MUSE CV…” screen, make sure “MUSE CV Application” radio
button is selected.

15.9. If you are installing MUSE Word, verify the “MUSE CV Word” check box is
checked.
Check customer order to see if this is an ordered option. If Yes, install the MUSE
CV Word. If not, do not check, skip this and move on.

15.10. Left click Next.

15.11. At the “MUSE node number selection” screen, type in the appropriate node id in
the field, left click Next.

15.12. At the “Enter MUSE CV File Server Name” screen, type in the name of the file
server you are attaching to in the field, left click Next.

Note:  Make sure that it is in the form \\MUSE$$$XXX

15.13. If the question screen “Is this a turnkey workstation” appears, left click Yes radio
button and left click Next.

15.14. If the question screen “Use MUSE Authentication” appears, left click Yes radio
button and left click Next.

15.15. At the question screen “Is there a MUSE writer board installed,” left click Yes or
NO radio button based on the sales order, left click Next.

Note:  System will copy files.

15.16. At the “Setup Complete” screen, verify “Yes, I want to restart my computer now”
radio button is selected and left click Finish to restart the computer.



Revision: G

AP 901070-W95, REV. G, PAGE 13 OF 19

16. CLEANUP

16.1. Emptying Recycle Bin

16.1.1. Exit MUSE application if running.
16.1.2. Right click on Recycle Bin icon.
16.1.3. Select “Empty Recycle Bin”
16.1.4. Left click Yes.

17. GE MMS WRITER BOARD VS SOUND INSTALL ONLY

Note:  If you are installing a system that requires a GE MMS writer board to be installed,
you must disable the sound at the BIOS level.

17.1. Boot system.
17.2. <F2> to enter setup utility.
17.3. Go to “Advanced Screen” tab.
17.4. Enter “Peripheral Configuration”
17.5. Set “Audio” to DISABLED
17.6. <F10> "Save configuration changes and exit now!"
17.7. Verify Yes <ENTER>
17.8. System will now restart.

18. PCI COMMUNICATION DEVICE [DIGI BOARD] INSTALL ONLY

Note:  The following condition must be met before continuing on with this section:
A Digi-Board installed correctly in the system.

18.1. Exit MUSE application if running.

18.2. Right click My Computer icon select Properties.

18.3. Left click “Device Manager” tab.

18.4. Left double click Other Devices.

18.5. Left click PCI Communication Device.

18.6. Left click Remove. Left click OK at “Confirm device removal” window.

18.7. Left click Test at “PCI Communication Device…” window.

18.8. Left click Close.

18.9. Restart the system.

18.10. At the “Update Device Driver Wizard” screen, the system detected the “PCI
Communication Device” left click Next.

18.11. Wait until the Other Locations… button is visible. Left click it.

18.12. Type Z:\DIGI\V100\WIN95  Left click OK .

18.13. Left click Finish.

18.14. Left click OK  at the “Insert Disk” prompt.

18.15. Type Z:\DIGI\V100\WIN95 Left click OK.
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18.16. Verify DigiAcelePort 4r920Pci in the “Controller Configuration” window.

18.17. Verify all ports are active and that they have COM 3 – 6 set.

18.18. Left click OK.  Wait while WIN95 sets ports.

18.19. This completes the Digi Board install for Windows 95.

19. SMC PCI ETHERNET NIC CARD

Note:  The following condition must be met before continuing on with this section:

A SMC NIC card installed correctly in the system.

19.1. Exit MUSE application if running.

19.2. Right click My Computer icon select Properties.

19.3. Left click “Device Manager” tab.

19.4. Left double click Other Devices.

19.5. Left click PCI Ethernet Controller.

19.6. Left click Remove.

19.7. Left click OK.

19.8. Left click Close. System will now restart.

19.9. At the “Update Device Driver Wizard” screen, the system detected the “PCI
Communication Device” left click Next.

19.10. Wait until the Other Locations… button is visible. Left click it.

19.11. Type Z:\SMCPCI  Left click OK .

19.12. Left click Finish.

19.13. Left click OK  at the “Insert Disk” prompt.

19.14. Type Z:\SMCPCI Left click OK.

19.15. If prompted with the window “Windows 95 CD-ROM” left click OK and type
C:\WIN95  in the edit field. Left click OK.

19.16. At the “DHCP Client…” prompt, left click NO.

19.17. Right click on the icon Network Neighborhood. Left click Properties.

19.18. If applicable, left click all “NetBEUI” instances and Remove.

19.19. Left click “TCP/IPÈSmc9432…” left click Properties.

19.20. Left click the radio button “Specify and IP address.

19.21. Type in the “IP Address” of the node.

126.8.8.1
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19.22. Type in the “Subnet Mask” of the node.

255.0.0.0

19.23. Left click OK.

19.24. Left click OK.

19.25. Left click Yes to restart system.

19.26. This completes the SMC NIC card install for Windows 95.

20. MUSE CV WORD INSTALLATION

Note:  The following conditions must be met before continuing on with this section:

MUSE CV Word Database installed on the File Server – 5A ONLY
A printer (or printer driver) installed on each client:

If no printer is attached, complete one of the following:
1. Install a shared printer via the Network [If one is available].

See “Setting up Network Printing” section that follows.
2. Install a “virtual” one. [If no printers are available].

See “Setting up Virtual Printing” section that follows.

Note:  The following conditions must be completed.
Microsoft Word 6.0c installed locally on each client.
MUSE CV Word application installed on each client – 5A ONLY

20.1. Setting up Network Printing

Note:  The following conditions must be met before continuing on:
A printer configured on the File Server and attached to the network.

20.1.1. Exit MUSE application if running.

20.1.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

20.1.3. Left click Start >> Settings >> Printers.

20.1.4. Left double click icon Add Printer .

20.1.5. At the “Add Printer Wizard” screen, left click Next.

20.1.6. Left click the radio button “Network Printer” and left click Next.

20.1.7. Left click Browse.

20.1.8. From the “Browse for Printer” window, find the name of the File
Server from which the printer is shared from. Left click the “+” at the
left of the name. This will show you any printers that may be attached.

Note: If no printer is seen, then you have chosen the wrong File Server
or the printer is not set up properly.

20.1.9. Left click the printer icon. Left click OK.
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20.1.10. Verify the “Network Path” field has the printer UNC name filled in.
Verify the radio button is set to “NO” for MS-DOS-based programs.

20.1.11. Left click Next.

20.1.12. Left click Have Disk.

20.1.13. Type Z:\HPPRINT\WIN95 left click OK

20.1.14. Left click HP LaserJet 4000 Series PS in the “Printers” section.

20.1.15. Left click Next.

20.1.16. Verify “Printer Name” to be HP LaserJet 4000 Series PS in the edit
field. Left click Next.

20.1.17. Verify radio button “Yes (recommended)” is selected. Left click
Finish.

20.1.18. Files will be copied to your system.

20.1.19. At the “HP Laserjet…” prompt, left click Yes if the page printed
correctly.  If not, reinstall the printer.

20.1.20. Close “Printers” window.

20.2. Setting up Virtual Printing

Note:  The following conditions must be met before continuing on:
No printers called out on Sales Order.

20.2.1. Make sure that the MUSE Software CD is in the CD-ROM drive.

20.2.2. Left click Start >> Settings >> Printers.

20.2.3. Left double click icon Add Printer.

20.2.4. At the “Add Printer Wizard” screen, left click Next.

20.2.5. Left click the radio button “Local Printer” and left click Next.

20.2.6. Left click Have Disk.

20.2.7. Type Z:\HPPRINT\WIN95 left click OK.

20.2.8. Left click HP LaserJet 4000 Series PS in the “Printers” section.

20.2.9. Left click Next.

20.2.10. From the “Available Ports” section, left click LPT1 printer.

20.2.11. Left click Next.

20.2.12. Verify “Printer Name” to be HP LaserJet 4000 Series PS in the edit
field. Left click Next.
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20.2.13. At the “Print a test page…” window, set the radio button to “NO”. Left
click Finish.

20.2.14. Files will be copied to your system.

20.2.15. Close “Printers” window.

20.3. MUSE CV Word Installation – 5A ONLY

20.3.1. Exit MUSE application if running.

20.3.2. Left click Start >> Run

20.3.3. Type Z:\MUSEWORD\SETUP.EXE  left click OK .

20.3.4. Left click Next. Software will begin installing.

20.3.5. Left click OK  at the “Setup is complete” prompt. The Notepad
application will be open.

20.3.6. Close Notepad.

20.3.7. Restart the system.

21. CATH INSTALLATION

Note:   The following conditions must be met before continuing on with this section:

On the MUSE File Server:
Cath Options must be turned on via the Options Disk.
The file “APPLIST.ASC” must be edited and the “!” in front of
Configure Cath Lists… must be removed.
The file “BACKTASK.ASC” must be edited and the “;” in front of
324,\\MUSE$$$XXX must be removed.

21.1. MAC-LAB Installation

Note:  The following conditions must be met before continuing on with this
section:

On the MUSE File Server:
The directory, D:\VOL000\TMP\MLAB, must be shared as the “H-
Drive.”
The file “APPLIST.ASC” must be edited and the “!” in front of
MAC-LAB Assistant… must be removed.

21.1.1. Adding MAC-LAB to the start-up group.

21.1.1.1. Exit MUSE application if running.

21.1.1.2. Right click on the Start button on the tool bar.

21.1.1.3. Left click Open button.

21.1.1.4. Left double click Programs icon.

21.1.1.5. Left double click StartUp icon.
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21.1.1.6. Left click File >> New >> Shortcut.

21.1.1.7. Type in C:\MEI\MLABASST.

21.1.1.8. Left click Next.

21.1.1.9. In the “Select name for shortcut” field, type MAC-LAB
Assistant.

21.1.1.10. Left click Finish.

21.1.1.11. Verify “Start MUSE CV” and “MAC-LAB…” icons in
window.

21.1.1.12. Close all windows.

21.1.1.13. Restart system.

21.2. Inventory Management and Schedule Board Installation

Note:  The following conditions must be met before continuing on with this
section:

On the MUSE File Server:
If Inventory, then Option must be turned on via the Options Disk.
If Schedule, then Option must be turned on via the Options Disk.
The file “BACKTASK.ASC” must be edited and the “;” in front of
612,1,1; must be removed. Also, the “1,1” must be changed to the
number of the client node that will be running it.

Note:  Only one instance of 612 can be activated on a networked system.

Examples:
Therefore, if you were to install Inventory Management or Schedule
Board on Node 42 then the line would be 612,42,42;

21.2.1. Boot system.

21.2.2. Left click System >> Inventory Management and verify that application
launches.

21.2.3. Left click System >> Schedule Board and verify that application
launches.
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22. TFTP INSTALLATION

Note:  The following conditions must be met before continuing on with this
section:
Install on a Gateway system.

22.1. On the MUSE File Server:

The file “BACKTASK.ASC” must be edited and the line 325,1,1; must be added.
Also, the “1,1” must be changed to the number of all client nodes that will be
running it.

The file “BACKTASK.ASC” must be edited and the line 340,1,1; must be added.
Also, the “1,1” must be changed to the number of all client nodes that will be
running it.

22.2. Restart WIN95 system, and verify application started in toolbar.

23. BURN-IN PROCEDURE

No burn in is necessary with MUSE systems.
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1. PURPOSE

This procedure is intended as a guideline for the assembly of the following MUSE
products:

MUSE Workstation ............................................................................................901070-001

Based on what is called out on the customer order and the new OMAR structure, a
technician will be able to reference this document in order to create a system with
Windows for Workgroups as its operating system. The main peripheral that defines this
system is the Synchronous Modem Module (SMM) that will be configured via a MUSE
File Server.

2. SCOPE

This document applies to the GE-Marquette Medical Systems– Milwaukee
manufacturing facility.

3. RELATED DOCUMENTS

3.1. MUSE Network Series Manual
3.2. QS1004..........................................................................Product Burn-In Guidelines
3.3. TP 800116-00X...........................................Muse Network Modem Test Procedure
3.4. MS-2035...............................Daily Check of Hi-Pot (Dielectric Withstand Testers)
3.5. QS1003................................ Quality Assurance Device History Record Guidelines
3.6. TP MUSE 5A .................................................................. MUSE 5A Test Procedure

4. EQUIPMENT REQUIRED
All equipment is “OR EQUIVALENT”

4.1. Complete MUSE SDLC Work Station Customer Order
4.2. TOS8650 HI-POT Tester or Equivalent
4.3. Three SIGLAB 230VAC power cables (for 230VAC systems only) ........MT-2433

MT-2537 or MT-2538
4.4. MUSE Software CD 5A.........................................................................420858-001
4.5. MUSE Software CD 5B .........................................................................422436-001
4.6. MUSE MFG Tooling CD................................................................................S1402
4.7. Boot Disk.........................................................................................................S1407

5. SPECIAL CONDITIONS

The following test procedure will apply to both 115 VAC 50-60Hz systems as well as
230 VAC 50Hz systems.

6. PROCEDURE

6.1. Assembly of Vendor Equipment

6.2. Initial Set-up of Vendor Equipment

6.2.1. 100/115 VAC 50-60Hz Systems
Assemblies (115VAC 50-60Hz) - connect power cord supplied with
computer and monitor to standard 115VAC 60Hz outlet.
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6.2.2. 230 VAC 50Hz Systems

Assemblies (230VAC 50Hz) - connect SIGLAB 230VAC power cable to
power connector on back of computer, monitor, and printer, then to
230VAC 50Hz power source.

6.2.3. Connect copy protect adapter to system Parallel I/F connector on back of
computer. 404216-002 is for all MUSE nodes.

6.2.4. Connect monitor signal cable to the video connector on back of computer.

6.2.5. Connect MICROSOFT Mouse (403590-199) into Mouse Connector port
on back of computer.

6.2.6. If you are building a system with a KVM 4 port switch, connect all
keyboard, mouse and monitor ports from the Client into the necessary
slots on the switch.

7. BIOS SETTINGS FOR ALL ROCKAWAY COMPUTERS

7.1. Boot system.
7.2. <F2> to enter setup utility.
7.3. At the Bios Setup Utility Screen. <F9>
7.4. "Load default configuration now" Verify Yes <ENTER>
7.5. <F10> "Save configuration changes and exit now!"
7.6. Verify Yes <ENTER>
7.7. System will now reboot. <F2> to enter setup utility.
7.8. Set the appropriate “System Time” and “System Date.”
7.9. Go to “Advanced Screen” tab and set the “Plug & Play O/S” to <NO>
7.10. Enter “Peripheral Configuration”
7.11. Set “Audio” to DISABLED
7.12. Go to “Power” tab.
7.13. Set “Power Management” to DISABLED.
7.14. <F10> "Save configuration changes and exit now!"
7.15. Verify Yes <ENTER>
7.16. System will reboot.

8. IMAGECAST PROCEDURE

8.1. Insert Tooling Floppy S1407 into floppy drive and power up.

8.2. Insert Tooling CD S1402 into CD-ROM drive.

8.3. At the “Press any key to continue…” prompt, <ENTER> and then select Client
<ENTER> and then select WFW 3.11 <ENTER>

8.4. At the blue “ImageCast IC3 Client…” screen, once the system starts copying data,
remove the floppy.

8.5. System will take approximately 7-10 seconds to complete the process. It will then
reboot. Remove the MUSE MFG Tooling CD.
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9. NETWORK AND SYSTEM TWEAKS

9.1. At the DOS prompt type WIN <ENTER>

9.2. Left double click Network icon.

9.3. Left double click Network Setup icon.

9.4. Left double click Microsoft TCP/IP-32 3.11a

9.5. PRIMARY DOMAIN CONTROLLER INSTALL

Edit IP and Gateway information appropriately

MEMBER SERVER INSTALL

Left click “Enable Automatic DHCP Configuration” box.
At the “Microsoft TCP/IP” prompt, left click Yes.

9.6. Left click OK.

9.7. Left click OK.

9.8. If applicable, at the “Windows Setup” prompt, left click OK.

9.9. If applicable, left click Continue.

9.10. Close “Network” window.

9.11. Left double click Main icon.

9.12. Left double click Control Panel icon.

9.13. Left double click Network icon.

9.14. Verify or type in the following

Computer Name = MUSE$$$XXX

Workgroup = MUSE$$$ [If Primary Domain]
Workgroup = MUSESIG [If Member Server]

Comment = MUSE$$$ WFW (NODEXXX)
Default Logon Name = MUSEXXX

Note:  XXX = Node ID. MUSE$$$ = Domain Name of PDC.

9.15. Left click Startup button.

9.16. Left click the “Log on to Windows NT…” checkbox.
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9.17. PRIMARY DOMAIN CONTROLLER INSTALL
Type MUSE$$$

MEMBER SERVER INSTALL
Type MUSESIG

9.18. Left click “Don’t display Message…” checkbox.

9.19. Left click OK.

9.20. Left click OK.

9.21. Left click Restart Computer.

10. MUSE SOFTWARE INSTALLATION

10.1. Install MUSE Application Files.

10.1.1. Make sure that the MUSE Software CD is in the CD-ROM drive.
10.1.2. Type COMMAND /E:1024 <ENTER>
10.1.3. Z: <ENTER>
10.1.4. Complete the following based on Version

5A ONLY – Type CD\MUSE <ENTER>

5B ONLY – Type CD\MUSE16 <ENTER>

10.1.5. Type INSTALL XX <ENTER>

Note: XX = node_id of computer.

10.1.5.1. At the “License…” prompt, verify Yes and <ENTER>

10.1.5.2. At the “Time Zone Environment Variable”, select accordingly.
Note: This will depend on the city you are shipping to.

10.1.5.3. At the “Is this a Turnkey Workstation” prompt, verify Yes
<ENTER>

10.1.5.4. Select how many SDLC Modems are installed. <ENTER>

10.2. Install MUSE Update Files

10.2.1. Type CD\MUSEUP <ENTER>

10.2.2. Type INSTALL <ENTER>

10.2.3. At the “License…” prompt, verify Yes and <ENTER>
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10.3. Change location of server in WIN.INI.

10.3.1. Type EDIT C:\WINDOWS\WIN.INI <ENTER>

10.3.1.1. In the following section, change the values to reflect:

[MUSE]
Initial State: MainServerName=\\Muse$$$001
Final State: MainServerName=\\Muse$$$XXX

Note: Muse$$$XXX = File server you are attaching to.

10.3.2. Save file.

10.4. Reboot.

10.5. At the “Domain Logon” prompt, type in Muse!XXX for the password.

Note:  Password is case sensitive.

10.6. Left click OK.

10.7. Setup is complete. Remember to activate this Client and it’s hardware on the
MUSE Server.

11. BURN-IN PROCEDURE

No burn-in is necessary with MUSE systems.

12. SAFETY CHECKS

12.1. MMS SDLC modem

12.1.1. Connect MT2433 to Top 4 modem connectors (phone jacks) one at a
time and the other end to the negative lead on the HI-POT tester. The
positive lead should remain connected to ground of the MT-2537 or
MT-2538 (depending on voltage configuration).

12.1.2. After testing each SDLC/Fax modem with the HI-POT, re-test by
sending data through the modem as per TP MUSE 5A to verify that
modem was not damaged.
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1. PURPOSE

This procedure is intended as a guideline for the assembly of the following MUSE
products:

HIS Test Box ......................................................................................................901070-001

Based on what is called out on the customer order and the new OMAR structure, a
technician will be able to reference this document in order to create a system with
Windows NT40 as its operating system.

2. SCOPE

This document applies to the GE-Marquette Medical Systems (GE MMS) – Milwaukee
manufacturing operation.

3. RELATED DOCUMENTS

3.1. MUSE Network Series Manual
3.2. QS1004..........................................................................Product Burn-In Guidelines
3.3. QS1003.................................Quality Assurance Device History Record Guidelines

4. EQUIPMENT REQUIRED
All equipment is “OR EQUIVALENT”

4.1. Complete HIS Test Box Customer Order
4.2. Three SIGLAB 230VAC power cables (for 230VAC systems only)
4.3. MUSE 5A Software CD ........................................................................420858-001
4.4. MUSE 5B Software CD .........................................................................422436-001
4.5. MUSE MFG Tool CD.....................................................................................S1403
4.6. Boot Disk.........................................................................................................S1407
4.7. MUSE File Server Configurator......................................................................S1408

5. SPECIAL CONDITIONS

The following test procedure will apply to both 115 VAC 50-60Hz systems as well as 230
VAC 50Hz systems.

6. PROCEDURE

6.1. Assembly of Vendor Equipment

6.2. Initial Set-up of Vendor Equipment

6.2.1. 100/115 VAC 50-60Hz Systems

Assemblies (115VAC 50-60Hz) - connect power cord supplied with
computer and monitor to standard 115VAC 60Hz outlet.
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6.2.2. 230 VAC 50Hz Systems

Assemblies (230VAC 50Hz) - connect SIGLAB 230VAC power cable to
power connector on back of computer, monitor, and printer, then to
230VAC 50Hz power source.

6.2.3. Connect monitor signal cable to the video connector on back of computer.

6.2.4. Connect MICROSOFT Mouse into Mouse Connector port on back of
computer.

7. BIOS SETTINGS FOR ALL ROCKAWAY COMPUTERS

7.1. Boot system.
7.2. <F2> to enter setup utility.
7.3. At the Bios Setup Utility Screen. <F9>
7.4. "Load default configuration now" Yes <ENTER>
7.5. <F10> "Save configuration changes and exit now!"
7.6. Verify Yes <ENTER>
7.7. System will now reboot. <F2> to enter setup utility.
7.8. Set the appropriate “System Time” and “System Date.”
7.9. Go to “Advanced Screen” tab and set the “Plug & Play O/S” to <NO>
7.10. Go to “Boot” tab and set the “Boot Device Priority” to the following:

Removable Devices
ATAPI CD-ROM Drive
Hard Drive
Network Boot
LANDesk ® Service A

7.11. <F10> "Save configuration changes and exit now!"
7.12. Verify Yes <ENTER>
7.13. System will reboot.

8. IMAGECAST PROCEDURE

8.1. Insert Boot Floppy S1407 into floppy drive and power up.

8.2. Insert Tooling CD S1403 into CD-ROM drive.

8.3. At the “Press any key to continue…” prompt, <ENTER> and then select Client
<ENTER> and then select HIS <ENTER> and then select 5A or 5B <ENTER>

8.4. At the blue “ImageCast IC3 Client…” screen, once the system starts copying data,
remove the floppy.

8.5. System will take approximately 5-6 minutes to complete the process. It will then
reboot. Remove the MUSE MFG Tooling CD.
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9. CUSTOMIZING NT 40 FOR USE

9.1. Log in as Administrator. Password is Never!Mind.

9.2. Left click Start >> Settings >> Control Panel >> Date/Time.

9.3. Set the correct date, time and Time Zone information based on the sales order.

9.4. Left click OK.

9.5. Close “Control Panel” window.

9.6. Insert Tool Disk S1408

9.7. Left click Start >> Run

9.8. Type A:\SETUP.EXE. Left click OK.

9.9. At the “Welcome” screen, left click Next.

9.10. At the “Type of File Server” screen, left click the HIS5A or HIS5B radio button.

9.11. Left click Next.

9.12. At the “User Information” screen, fill in the following edit fields:

Name: ............................................................................................Hospital’s Name
Company: ......................................................................... Hospital’s Organization
Serial: ..............................................................XXXXXOEMXXXXXXXXXXXX

9.13. Left click Next.

9.14. At the “Adjust Area Code” screen, fill in the following edit fields:

Area Code.........................................................................................................XXX

9.15. Left click Next.

9.16. Left click the appropriate “Time Zone” radio button.

9.17. Left click Next.

9.18. Verify “Yes, I want to restart…” radio button is selected.

9.19. Remove floppy.

9.20. Left click Finish. System will now restart.

9.21. Log in as Administrator. Password is Never!Mind.

9.22. Make sure that the MUSE Software CD is in the CD-ROM drive.

9.23. Left click Start >> Programs >> Command Prompt.
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9.24. Type Z: <ENTER>

9.25. Type CD\MUSEUP <ENTER>

9.26. Type INSTALL -U <ENTER>

9.27. At the “License…” prompt, verify Yes and <ENTER>

Note:  System will now copy files.

9.28. At the DOS prompt type EXIT <ENTER>

9.29. Left click Start >> Shutdown.

9.30. Left click “Restart the computer…” radio button and left click Yes. System will
now restart.

10. PCANYWHERE32 8.0 ADJUSTMENT

10.1. Log in as MuseAdmin. Password is Muse!Admin.

10.2. Left click Start >> Programs >> pcAnywhere32 >> pcAnywhere

10.3. Left click BE A HOST PC

10.4. Right click on MODEM icon and left click Properties.

10.5. Left click “Callers” tab.

10.6. Verify “Use NT user privileges” radio button is selected.

10.7. Left double Click on “Add User” icon.

10.8. Verify “User” radio button is selected. Left click Next.

10.9. In the “What domain…” pull down, select MUSEHIS124.

10.10. In the “Select the account…” pull down select Administrator.

10.11. Left click Next.

10.12. Left click Finish.

10.13. Left click OK.

10.14. Left click Exit.

10.15. Left click Start >> Settings >> Control Panel >> Modems

10.16. Left click Properties.

10.17. Left click “Connection” tab.

10.18. Left click Advanced…
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10.19. Type in the “Extra Settings” edit box ATM0.

10.20. Left click OK.

10.21. Left click OK.

10.22. Left click Close.

10.23. Close “Control Panel” window.

11. SETTING UP MUSE ENVIRONMENT

11.1. Installing Options Disk

11.1.1. Start MUSE by left double clicking on icon Start MUSE CV

11.1.2. Left click System >> System Setup.

11.1.3. Left click System >> Install Options.

11.1.4. Copy “Authorization Code” and proceed to MUSE Options station to
set up the Options Disk #419719-001.

11.1.5. Once completed, insert Options disk into floppy drive and left click
Install.

11.1.6. Verify “Registered Name” and “Installed Options List” data to be
correct.

11.1.7. Remove floppy.

11.1.8. Close MUSE application and restart NT.

12. INSTALLING LOCAL PRINTER SUPPORT

Note:  The following condition must be met before continuing on with this section:

A printer configured and attached to the LPT port on the server.
Check customer order to see if it is called out as an option.

12.1. Log in as Administrator. Password is Never!Mind.

12.2. Left click Start >> Settings >> Printers

12.3. Left double click icon Add Printer.

12.4. At the “Add Printer Wizard” screen, verify the radio button “My Computer” is
selected. Left click Next.

12.5. From the “Available Ports” section, left click the radio button that the printer is
attached to.

12.6. Left click Next.
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12.7. Left click Have Disk.

12.8. Type Z:\HPPRINT\NT and left click OK.

12.9. Left click HP LaserJet 4000 Series PS in the “Printers” section.

12.10. Left click Next.

12.11. In the “Printer Name” section, type a unique name for the printer.

Note:  Default name should suffice unless otherwise stated by Pre-Build Survey.

12.12. Left click Next.

12.13. Left click the radio button “Shared” and type in the edit a unique name.

Note:  For one (1) printer, use LJ4K01.  If more, increase number. Default name
should suffice unless otherwise stated by Pre-Build Survey.

12.14. Left click Next.

12.15. Verify the radio button Yes is selected and left click Finish to print a test page.

12.16. If the page printed successfully, left click Yes. If not left click NO and follow the
instructions to troubleshoot the problem.

12.17. Close the “Printers” window.

13. SMC PCI ETHERNET NIC CARD

Note:  The following condition must be met before continuing on with this section:
A SMC NIC card installed correctly in the system.
Check customer order to see if it is called out as an option.

13.1. Make sure that you are logged in as Administrator.

13.2. Make sure that the MUSE Software CD is in the CD-ROM drive.

13.3. Right click on the icon Network Neighborhood.  Left click Properties.

13.4. Left click “Adapters” tab

13.5. Left click Add

13.6. Left click Have Disk.

13.7. Type Z:\SMCPCI left click OK

13.8. Verify “SMC9432TX Ether Pro… and left click OK.  System will copy files.
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13.9. At the “Data Rate” pull down, verify “Auto Negotiate” and left click OK.

13.10. Left click Close.

13.11. Left click “Adapter” pull down and select “(2) SMC9432TX Ether Pro…

13.12. Type in the “IP Address” of the node:  126.8.8.1

13.13. Type in the “Subnet Mask” of the node:  255.0.0.0

13.14. Left click OK

13.15. Left click Yes to restart the system.

*****************************************
Note: At this point, the install of the MUSE HIS Test Box is complete. You can now start the

overall testing using TP MUSE 5A at this time.  After successful completion of the TP,
return to this point and complete the AP.

****************************************

14. CLEANUP

14.1. Make sure that you are logged in as Administrator.

14.2. Emptying Recycle Bin.

14.2.1. Right click on Recycle Bin icon.

14.2.2. Select “Empty Recycle Bin”

14.2.3. Left click Yes.

14.3. Disk Maintenance.

14.3.1. Left click Start >> Programs >> Diskeeper >> Diskeeper.

14.3.2. Close “Welcome” window.

14.3.3. Left click Defragment >> Select Disk.

14.3.4. Left click C:[NTFS].

14.3.5. Left click OK.

14.3.5.1. Process will now start and may take 5-10 minutes.

14.3.5.2. Let click OK when done.

14.3.6. Left click Defragment >> Select Disk.

14.3.7. Left click D:[NTFS].
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14.3.8. Left click OK.

14.3.8.1. Process will now start and may take 5-10 minutes.

14.3.8.2. Left click OK when done.

15. CREATING AN EMERGENCY REPAIR DISK

15.1. Make sure that you are logged in as Administrator.

15.2. Insert a floppy into  A: drive

15.3. Left click Start >> Run

15.4. Type RDISK /S. Left click OK.

15.5. At the “Setup can create an Emergency Repair disk...” Screen, left click Yes.

15.6. At the “Label a floppy disk...” screen, left click OK.

15.7. At the “Windows NT repair information contains...” screen, left click OK.

15.8. Remove the floppy, date and label it as MUSE$$$124 Emergency Repair Disk

15.9. Shut down system.

16. BURN-IN PROCEDURE

No burn-in is required with MUSE systems.
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1. PURPOSE

The purpose of this document is to define the procedure used to perform the testing of the
GE-MMS P/N: 900666-001 (Buffer Server Ethernet).

2. SCOPE

This test procedure is intended for use by the GE-Marquette Medical Systems,
Milwaukee manufacturing facility.

3. RELATED DOCUMENTS

3.1 MacLab System EX Pre-Installation Survey..............................PREINSTALL-003
3.2 ESD Protection Guidelines.......................................................................... MS2014
3.3 Burn-In Guidelines ...................................................................................... MS2116
3.4 Product Serialization Guidelines ..................................................................QS1002
3.5 QA Device History Record Guidelines ........................................................QS1003

4. EQUIPMENT REQUIRED
All equipment is “OR EQUIVALENT”

4.1 MacLab EX Board Fixture..................................................  tool # 100014-001/002
4.2 Windows NT Server...................................................................................MT-5257
4.3 Novell Netware Server ...............................................................................MT-5253
4.4 Ethernet Hub.................................................................................3Com Hub 8/TPC
4.5 Token Ring Concentrator ................................................ Thomas Conrad 1000TC3
4.6 MS-DOS 6.22 (shipped with system)
4.7 Ethernet/WFW CD ETH TCP/IP ...............................................................MT-5249
4.8 Ethernet/Novell CD ETH NV400 ..............................................................MT-5250
4.9 Buffer Server Load Diskette.......................................................................MT-5247

5. SPECIAL CONDITIONS/REQUIREMENTS

5.1 This assembly contains static sensitive devices.  Proper grounding procedures of
the operator MUST be observed when handling this assembly.  Refer to MS2014
(ESD Protection Guidelines) for further information.

5.2 For ease of reference in this document, required keyboard/mouse responses are
highlighted in bold lettering.  Screen prompts are shown in “quotations”.

5.3 Failure of any test or portion of test shall cause the rejection of the UUT.  After
rework, the entire test procedure shall be performed.

5.4 All tests shall be performed in the order specified, unless specifically instructed
otherwise within the procedure.



Revision: F

TP 419040-001, REV F, PAGE 4 OF 16

6. TEST PROCEDURE

6.1 Setup

6.1.1 Remove the computer system from the packaging.

6.1.2 Connect the monitor, mouse, and keyboard to the rear of the computer.

6.1.3 Connect a twisted-pair Ethernet cable between the unit-under-test (UUT)
Intel network card in slot 3 (bottom slot) and the Ethernet Hub.  Refer to
MacLab Test Network drawing in Appendix A as necessary.

6.2 Drive Partitioning / Op Sys Installation

NOTE:  This section cleans up the hard-drive for software installation.  It needs
to be performed ONLY IF the Buffer Server under test is being
reconfigured for a different protocol or software is being reinstalled.

6.2.1 Insert the MS-DOS (version 6.22) Disk 1 – Setup diskette into the floppy
drive on the UUT.

6.2.2 Apply power to the UUT, or press the “reset” button..  The system will
begin booting from the floppy drive, and is complete when the “Microsoft
MS-DOS 6.22 Setup” screen appears.

6.2.3 Press F3 to exit the setup utility, and F3 to exit the configuration menu
screen.

6.2.4 At the “A:\>” prompt, type FDISK <Enter>.  The Fixed Disk Setup
Program will begin.

6.2.5 Press 3 <Enter> (Delete partition or Logical DOS Drive).

6.2.6 Press 1 <Enter> (Delete Primary DOS Partition).

6.2.7 A “WARNING!  Data in the deleted Primary DOS partition will be lost.
What primary partition do you want to delete … ?” message will appear.

Press 1 <Enter>

6.2.8 An “Enter Volume Label … ?” question will appear.  Enter the volume
name that appears on the screen (default is MS-DOS_6).

6.2.9 An “Are you sure (Y/N) … ?” question is displayed.  Press Y <Enter>.

6.2.10 A “Primary DOS Partition deleted” message will appear.  Press ESC to
return to the “FDISK Options” menu.

6.2.11 Press 1 <Enter> (Create DOS Partition or Logical DOS Dirve).
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6.2.12 Press 1 <Enter> (Create Primary DOS Partition).

6.2.13 After a few seconds, a “Do you wish to use the maximum available size
for the Primary DOS Partition and make the partition active (Y/N)”
message will be displayed.

Press Y <Enter>

6.2.14 After a short delay, a “System will now restart” message will appear.

6.2.15 Make sure the MS-DOS (version 6.22) Disk 1 – Setup diskette is installed
in the floppy drive.

Press ANYKEY on the keyboard to restart the computer.

6.2.16 The system will reboot, and is complete when the “Microsoft MS-DOS
6.22 Setup” screen is displayed.

Press <Enter> to continue the DOS Setup program.

6.2.17 Using the keyboard arrow keys, highlight “Continue Setup and replace
your current version of DOS” menu option.

Press <Enter> to continue.

6.2.18 Using the arrow keys, highlight the “Format this drive (recommended)”
menu option.

Press <Enter> when complete.

6.2.19 The drive formatting process will begin.  Formatting progress will be
displayed in an information box.

6.2.20 Upon completion of the formatting, a “Microsoft MS-DOS 6.22 Setup”
screen will appear, displaying the system setting options.

6.2.21 Verify the settings, and follow the on-screen directions to change as
necessary.

6.2.22 Highlight the “The settings are correct.” menu item, and press <Enter>.

6.2.23 A “Microsoft MS-DOS 6.22 Setup” screen will appear, displaying
directory information.

6.2.24 MS-DOS files MUST be placed in directory “C:\DOS”.  Follow the on-
screen instructions to change as necessary.

Press <Enter> when complete.
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6.2.25 The MS-DOS 6.22 installation process will begin.  Follow screen
instructions when additional diskettes are required.

6.2.26 Upon completing the loading of Disk 3, remove the diskette from the drive
and press <Enter>.

6.2.27 A “MS-DOS Setup Complete” message will be displayed.  Press <Enter>
to restart the computer.

The boot process is complete when the “C:\>” prompt is displayed.

6.2.28 At the prompt, type ATTRIB  COMMAND.COM  <Enter> (not case
sensitive).  This will show the attributes of the command.com file.

The MS-DOS loading process makes this file “read-only” (R displayed
next to the name).

6.2.29 The MacLab Software download process requires the removal of the
“read-only attribute.

At the prompt, type ATTRIB  -R  COMMAND.COM  <Enter> (not
case sensitive).

6.3 Software Loading

6.3.1 Using the LAN survey of the customer’s site, select the appropriate load
CD from the following list:

Ethernet Topology

Operating System Protocol Load CD
WFW Netbeui, IPX/SPX, TCP/IP MT-5249
Novell IPX ver 4.00 MT-5250
WFW, Novell Netbeui, IPX/SPX (ver 4.00), TCP/IPMT-5250

6.3.2 Place the appropriate CD into the CD Loader Case and insert into the CD
ROM drive of the NT Server (MT-5257).

6.3.3 Verify that the NT Server has an active connection to the Ethernet Hub.

6.3.4 Insert the Buffer Server Load Diskette (MT-5247) into the floppy drive of
the Buffer Server under test.

6.3.5 Verify that the ethernet cable is connected to the UUT Intel network card
(slot 3).

6.3.6 Start the software initialization sequence as follows:

6.3.6.1 If the system power is off, apply power to the UUT.
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6.3.6.2 Power cycle the system, or press the reset button (if applicable).

6.3.7 The system will reboot, and the software configuration/loading process
will begin.  During the ‘net start’ configuration routine, a “Type your user
name, or press ENTER if it is MILLSEL:” prompt will appear.

Type administrator <Enter>.

A “Type your password:” prompt will then appear.

Type administrator <Enter>.

6.3.8 The software download process from the NT Server will begin.  The
process is complete when the “C:\>” prompt is displayed.

6.3.9 Remove load diskette from the Buffer Server under test, and power cycle
the system (or press the reset button).

6.3.10 For TCP/IP protocol systems ONLY, the following message will be
displayed during the Windows loading process:

DHCP.386

This DHCP client was unable to obtain an IP network address from a
DHCP server.  Do you want to see future DHCP messages?

Press Y for Yes or N for No:

Press Y.

NOTE:  This response should be given anytime this message appears on
the UUT

6.3.11 A “Corrupt Swap-File Warning” message may be displayed.  Press Y on
the keyboard to delete the corrupt swap file.  The loading process will
continue.

6.3.12 The “Welcome to Windows for Workgroups” welcome screen will appear.

Enter BUFFY for the password (not case sensitive).

Press <Enter> on UUT keyboard or select the OK menu button when
complete.

6.3.13 A MACLAB Assistant screen will appear, indicating that the boot
sequence has completed.
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6.4 Swap File

6.4.1 For initial swap file configurations, proceed as follows:

6.4.1.1 Press Alt+Tab on the UUT keyboard until the Program Manager
window appears.

6.4.2 If this is a subsequent configuration, proceed as follows:

6.4.2.1 Close the MACLAB Assistant window by selecting the “File”
menu followed by the “Exit to Windows” item.

6.4.2.2 A “MACLAB Assistant” window will be displayed, warning
about loss of bi-directional communication services.

Using the mouse, select Yes.

6.4.2.3 Close the MAC-LAB Report Transfer window by selecting the
“File” menu followed by the “Exit” item.

6.4.3 From the Program Manager screen, use the mouse to select the following:

Main program group.
Control Panel program group.
Enhanced program item.
Virtual Memory option.

6.4.4 A “Virtual Memory” window may appear, asking about setting the corrupt
file to zero length.  Select the Yes button.

The “Virtual Memory” screen will appear.  Press the Change>> button.

6.4.5 In the swap file size box, enter 0 as the new size.

Press <Enter> on the UUT keyboard, or select the OK menu button when
complete.

6.4.6 A “Virtual Memory” information window will be displayed, confirming
that the size-file type be set to None.

Select the Yes button.

6.4.7 A “Virtual Memory” window will appear, asking for confirmation on the
changes to the virtual memory settings.

Select the Yes button.
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6.4.8 A “Virtual Memory” window will be displayed, to restart Windows for
changes to take effect.

Select the Restart Windows button.

6.4.9 A “Windows for Workgroups” message will appear, warning of user dis-
connections.

Select the Yes button.

6.4.10 At the “Welcome for Windows for Workgroups” screen, enter BUFFY for
the password (not case sensitive)

Press <Enter> on the keyboard, or select the OK button when complete.

6.4.11 A MACLAB Assistant screen will appear, indicating that the boot
sequence has completed.

6.4.12 Press Alt+Tab on the UUT keyboard until the Program Manager window
appears.

6.4.13 From the Program Manager screen, use the mouse to select the following:

Main program group.
Control Panel program group.
Enhanced program item.
Virtual Memory option.
Change>> button.

6.4.14 In the swap file size box, verify that the new size is 20480 KB.

Press <Enter> on the UUT keyboard, or select the OK menu button when
complete.

6.4.15 A “Virtual Memory” window will be displayed, asking if your sure about
making the changes to virtual-memory settings.

Select the Yes button.

6.4.16 A “Virtual Memory” information window will appear, indicating that a
20512K permanent swap file has been created.

Select the OK button.

6.4.17 A “Virtual Memory” window will be displayed, to restart Windows for
changes to take effect.

Select the Restart Windows button.
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6.4.18 A “Windows for Workgroups” message will appear, warning of user dis-
connections.

Select the Yes button.

6.4.19 For TCP/IP protocol systems ONLY, the following message will be
displayed during the Windows loading process:

DHCP.386

This DHCP client was unable to obtain an IP network address from a
DHCP server.  Do you want to see future DHCP messages?

Press Y for Yes or N for No:

Press Y.

NOTE:  This response should be given anytime this message appears on
the UUT

6.4.20 At the “Welcome for Windows for Workgroups” screen, enter BUFFY for
the password (not case sensitive)

Press <Enter> on the keyboard, or select the OK button when complete.

6.4.21 A MACLAB Assistant screen will appear, indicating that the boot
sequence has completed.

6.5 MacLab Test

6.5.1 Connect a MacLab EX Test Fixture (or MacLab EX System) to the
Ethernet Hub.

6.5.2 Turn on power to the MacLab EX Test Fixture.

6.5.3 Using the arrow keys, highlight the “Admit a NEW patient” ADMIT menu
item on the MacLab EX Test Fixture and press <Enter>.

6.5.4 Using the TAB key, access the “Last Name” field and enter DOE
<Enter>.

6.5.5 Access the “First Name” field and enter JOHN <Enter>.

6.5.6 Press ESC to return to the main menu.

6.5.7 Using the arrow keys, access the “Service” menu on the MacLab EX Test
Fixture and press <Enter>.

6.5.8 Access the “LAN” menu item and press <Enter>.
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6.5.9 Verify the following information:

LAN type: NetBEUI
LAN status: Fully Loaded
Workstation Name: BUFFY000 (ACTIVE)

The above setup is required for communication to the Buffer Server under
test.  If the information does not match, correct as necessary.

6.5.10 Press ESC twice to return to the Main menu.

6.5.11 At the Buffer Server under test, verify that the admitted patient is visible
in the “Current Event Log” window of the MACLAB Assistant.

The signal light icon in the MACLAB Assistant screen should be green

6.5.12 Using the arrow keys on the MacLab EX Test Fixture, highlight the
“Adm/Dis” menu and press <Enter>.

6.5.13 At the “DISCHARGE” menu, highlight the “Discharge and save data to
workstation” menu item and press <Enter>.

6.5.14 The discharge function will take place and is complete when the
“ADMIT” menu is displayed.

6.5.15 At the Buffer Server under test, monitor the MACLAB Assistant screen.
When the signal light icon turns red, press Alt+Tab on the UUT keyboard
until the MAC-LAB Report Transfer window appears.

6.5.16 On the Buffer Server under test MAC-LAB report Transfer window,
verify that the patient record appears in the “List of Patient Reports”.

6.5.17 Highlight the patient record and press the Delete Report button.

6.5.18 The following information screen will be displayed:

Mac-Lab Report Transfer

Are you sure you want to delete the selected
report(s)?

Yes No

Select the Yes button.
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6.6 3Com Ethernet Card

6.6.1 Move the twisted pair ethernet connection from the Intel network card in
slot 3 (bottom slot) to the 3COM card in slot 2 (top slot). Refer to MacLab
Test Network drawing in Appendix A as necessary.

6.6.2 Press Alt+Tab on the UUT keyboard until the Program Manager window
appears.

6.6.3 From the “Program Manager” screen, use the mouse to select the
following:

Main program group.
Control Panel program group.
Network program item.

6.6.4 The “Microsoft Windows Network” window will open.

6.6.5 Verify that the “Workgroup” is FLAGWL, and change as necessary.

Select the OK button when complete.

6.6.6 If the “Workgroup” name was changed in the step above, the following
section is applicable:

6.6.6.1 A “Control Panel” window will be displayed, to restart Windows
for changes to take effect.

Select the Restart Windows button.

6.6.6.2 A “Windows for Workgroups” message will appear, warning of
user dis-connections.

Select the Yes button.

6.6.6.3 For TCP/IP protocol systems ONLY, the following message will
be displayed during the Windows loading process:

DHCP.386

This DHCP client was unable to obtain an IP network address from a
DHCP server.  Do you want to see future DHCP messages?

Press Y for Yes or N for No:

Press Y.

NOTE:  This response should be given anytime this message
appears on the UUT
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6.6.6.4 At the “Welcome for Windows for Workgroups” screen, enter
BUFFY for the password (not case sensitive)

Press <Enter> on the keyboard, or select the OK button when
complete.

6.6.6.5 A MACLAB Assistant screen will appear, indicating that the
boot sequence has completed.

6.6.6.6 Press Alt+Tab on the UUT keyboard until the Program Manager
window appears.

6.6.7 From the Program Manager screen, use the mouse to select the following:

Main program group.
File Manager program item.
Disk menu item.
Connect Network Drive … option.
Browse >> button.

6.6.8 Verify that the following workgroups appear in the “Show Shared
Directories on:” window:

FLAGWL
BUFFY000
GWLMAST

6.6.9 Select the Cancel button to return to File Manager.

6.6.10 For Ethernet Novell systems ONLY, the following section is applicable:

6.6.10.1 From the “File Manager” screen, use the mouse to select the
following:

Disk menu item
Connect Network Drive … option
NetWare … button

6.6.10.2 The “Netware Drive Connections” screen will appear.  Press the
“Drive Connections” button or press Alt+D on the
keyboard.

6.6.10.3 The Novell Server (BUFFER) should be displayed, as shown
below:

F: \\BUFFER\SYS\LOGON \

6.6.10.4 To return to the “Connect Network Drive” window, press the
“Exit” button or press Alt+X on the keyboard
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6.6.10.5 Press the Cancel button to return to the “File Manager” window.

6.6.11 Exit the File Manager by selecting the following:

File menu
Exit menu item

6.6.12 The main Program Manager window will be displayed.

7. CUSTOMER CONFIGURATION

NOTE:  This section needs to be performed if the Workstation / Networking
Information on the Pre-Installation Survey calls for an interface to a
MUSE workstation.

7.1 Close the MACLAB Assistant window by selecting the “File” menu followed by
the “Exit to Windows” item.

7.2 A “MACLAB Assistant” window will appear, warning of the loss of bidirectional
communication services.

Select the Yes. button

7.3 Close the MAC-LAB Report Transfer window by selecting the File menu
followed by the Exit item.

7.4 Using the Workstation / Networking information from the site survey, select the
appropriate software using the chart below:

Software MUSE 1B.0 MUSE 4A MUSE 4B MUSE 5A MUSE 5B
MacLab Assist 418978-001 418927-001 419400-001 421523-002 901201-001
Report XFER 418979-001 418979-001 418979-001 421412-002 421412-002
BTRIEVE N/A N/A N/A 421414-002 421414-002

NOTE:  The following sections should be repeated for the installation of each
software package.

7.5 Load the software diskette into the UUT.

7.6 From the “Program Manager” screen, use the mouse to select the following:

Main program group.
File Manager program item.
File menu.
Run … menu option.

NOTE:   The steps outline below should be performed for the installation of each
software package.

7.7 A “Run” window will be displayed.  Enter A:\Setup in the Command Line box.
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Press <Enter> on the UUT keyboard, or select the OK button when complete.

7.8 The setup routine on the diskette will run, installing the appropriate software.

7.9 Remove the diskette when the installation is complete.

7.10 Reboot the system under test, as necessary.

8. POST-TEST INSTRUCTIONS

8.1 Shutdown Windows for Workgroups on the UUT as follows:

8.1.1 From the “Program Manager” screen, use the mouse to select the
following:

File menu
Exit Windows … menu item

8.1.2 A “Exit Windows” confirmation screen will be displayed.  Select the OK
button.

8.1.3 A “Windows for Workgroups” message will appear, warning of user dis-
connections.

Select the Yes button.

8.1.4 The shutdown of windows is complete when the “C:\>” prompt is
displayed.

8.2 Turn off power to the UUT.

8.3 Remove all cabling from the Buffer/Server under test.

8.4 Return the Buffer Server under test to its original packaging.

8.5 Complete device history record.  Refer to QS1003 (QA Device History Record
Guidelines) for further information.
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Integrated Maintenance Suite: General Information
General Information

The Integrated Maintenance Suite (IMS) application is provided with 
the MUSE CV system for database backup and archive, as well as 
integrity checking, queue rebuilding, and system shutdown and restart. 
The system uses a third party package to allow the file server to remain 
online during backup and therefore all workstations will also remain 
active during backup. 

The MUSE CV system has been set up to automatically run the IMS 
application every night at 2:00 am. When the IMS application runs, it 
does the following tasks:

■ Integrity checking,

■ Database analysis.

■ Archive checking. Before doing a backup, the IMS applications 
checks if an archive should occur.

■ Database archive. If the sig filename approaches “255”, or the 
total size of Type 0 volume plus the size of the active volume 
approaches the capacity of the DAT backup tape (approximately 
4GB or 12GB), an automatic archive will occur.

■ Database backup. Database backup does not occur for systems 
which have been set up for network backup.

■ Detailed logging of messages.

Database Backup Under normal circumstances, the IMS application does a full backup 
every day to the DAT tape inserted at the file server.

A set of seven DAT tapes (4GB or 12GB) is provided for the 7-day backup 
rotation used by the IMS application. The IMS application requires that 
you sequence through the set of seven tapes, maintaining the same 
order every week. If the tapes are used out of sequence, the full backup 
is performed and an “out of sequence” warning is logged.

Network Backup If the user has agreed to use their own network backup, they assume full 
responsibility for all data residing on the file server. IMS will not perform 
any data backup.
Revision F 5-3MUSE CV information system
419931-012



Integrated Maintenance Suite: Daily Responsibilities
Daily Responsibilities

The following daily responsibilities are required in order to use the IMS 
application responsibly.

■ Rotate Backup Tapes. Insert the correct DAT tape every day.

■ Review the Event Log.

■ Review the Error Log, if necessary.

NOTE
For systems using the network backup
option, tape rotation is not required. 

NOTE
The MUSE CV system uses a third party
package to allow the file server to remain
online during backup. During periods of
heavy MUSE CV system traffic (for example,
more than normal acquiring, editing, printing,
and HIS link traffic), backup may skip some
files, therefore it is important to review the
Error and Event Logs to verify the integrity of
the backup.
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Integrated Maintenance Suite: Daily Responsibilities
Rotate Backup Tapes
(Not Required for
Network Backup)

A set of seven tapes (4 or 12GB) is required for the complete backup 
cycle required by the IMS application. This set of tapes comes with a set 
of labels which includes three kinds of labels:

■ A set of seven “day of the week” labels (Sunday through 
Saturday)

■ A set of “usage” labels (with a grid for recording date tape was 
used)

■ Two “archive” labels.

Each of the seven weekly tapes should have a “day of the week” label 
and a “usage” label affixed.

The MUSE CV system has been set up to automatically run the IMS 
application every night at 2:00 am. Therefore, every day before the 2:00 
am automatic backup, you must remove the previous backup tape and 
insert the next one.

1. Press the eject button on the DAT drive to eject the current tape.

2. Wait for the tape to rewind and eject.

3. Record the date(s) the tape was used on the usage grid.

4. Place the tape back into its jacket.

5. Find and insert the next day’s tape.

NOTE
With 005A software there is no magnetic
pre-labeling of DAT backup tapes.

IMPORTANT
In order to improve tape reliability, record the
date each tape is used. This includes each
time a tape may be re-used over a weekend
(for users that are unable to rotate tapes on
weekends).

NOTE
If the tape was ejected by IMS, review the
Event Log to determine why. It could be a
failed tape or an archive tape.
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Integrated Maintenance Suite: Daily Responsibilities
Review the Event Log

Check That the IMS Application
Ran

When the IMS Application runs, the following ten messages are logged 
to the Event Log:

■ IMS Ended
■ IMS Backup/Archive Ended
■ IMS Backup Archive: Sequence (X),(Ø)file errors (Does not appear 

in list when network backup is performed.)
■ IMS Using Network Backup (Appears in list only when network 

backup is performed.)
■ IMS Backup/Archive Started
■ IMS Integrity Ended
■ IMS Integrity Started (CHKPTRS)
■ IMS Integrity Ended 
■ IMS Integrity Started (DBANL)
■ IMS Started

All eight messages appear in the Event Log shown below. This indicates 
the IMS application ran.

NOTE
These ten messages indicate the IMS
application has run. If they are not listed in
the Event Log , call GE Marquette Service.

NOTE
The eight messages may not appear
consecutively. Other messages may appear
within the sequence.

MD1313-22A
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Integrated Maintenance Suite: Daily Responsibilities
Check for Integrity Errors Review the Event Log for the following message.

■ ERROR: Integrity Failed

Check for a Failed Backup
(Not Required for Network

Backup)

Review the Event Log sorted by Time. If you find any of the following 
messages, you must assume the backup has failed and you need to 
perform a manual backup. See “Manual Backup” for details.

■ ERROR: Unable to access the tape – Check to be sure a DAT tape 
was inserted.

■ ERROR: Backup/Archive: sequence (?), (#) files skipped (where ? is 
replaced by the rotation and # is replaced by a number).

■ ERROR: ntbackup.log size unchanged for 60 minutes  

Check for Proper Tape Rotation
(Not Required for Network

Backup)

Also check the Event Log to ensure for proper DAT tape rotation.

If the line Warning: current media sequence label (?), expected (??) 
appears in the Event Log (where ? and ?? are replaced by the rotation 
found and expected), this indicates that the tape was not rotated prior to 
the backup operation.

NOTE
If this message appears in the Event Log,
call GE Marquette Service.

NOTE
DO NOT assume a successful backup has
occurred if the Event Log contains no error
messages. It is possible that IMS may not
have run at all.

NOTE
If repeated failures occur due to skipped
files, it may be due to heavy MUSE usage
during backup. See "Changing the IMS Run
Time" for more information on re-scheduling
the time at which the IMS application runs.

NOTE
This Warning line does not indicate a failed
backup.

However, to ensure equal use of each tape
in the backup set, be sure you always
remember to rotate tapes. Users who are
unable to rotate tapes on the weekends will
always see warning on the weekends.
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Integrated Maintenance Suite: Daily Responsibilities
Check for System Messages Other system messages which may be logged to the Event Log by the 
IMS application are important to note.

■ Disk full warning messages. When the volume of data on the 
hard disk is reaching capacity, the IMS application begins 
logging messages to the Event Log. This message should first 
appear approximately 30 days before the hard drive is filled. 
When this message first appears in the Event Log, contact GE 
Marquette Service. It is necessary to add an additional hard 
drive to your fileserver.

■ Archive prediction. As the system approaches automatic archive 
conditions, the IMS application logs appropriate messages to 
the Event Log. IMS includes the predicted number of days until 
archive (based on daily use) in the Event Log.

Check for Archive (Not Required
for Network Backup)

If an archive has taken place, it will be noted in the Event Log. Also, the 
DAT tape will be ejected from the DAT drive in the fileserver.

1. Remove the archive backup tape from the DAT drive. Label it as 
noted in the Event Log. Slide the write protect tab off and store 
in a safe place.

2. Label a new blank DAT tape (PN 413628-001) to replace the 
daily tape removed from the rotation in step 1. (Label tape with 
the same “day of the week” label as the tape you removed.)

3. Insert the next day’s tape. The IMS application will make 
another archive backup copy the following night.

4. The next morning, after the IMS application has made the 
second archive backup tape, remove the tape and label it as 
noted in the Event Log. Write protect it and store it with the first 
archive backup tape.

5. Label another new DAT tape to replace the daily tap removed 
from the rotation in step 4. (Again, use the same “day of the 
week” as the tape you removed.)

Review the Error Log Review the Error Log for more specific information about the IMS 
application errors.

NOTE
Expect to see Warning: current media
sequence label (?), expected (?) messages
in the Event Log when the new DAT tapes
are encountered the next week.
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Integrated Maintenance Suite: Weekly Responsibilities
Weekly Responsibilities

Run the Cleaning
Cartridge

GE Marquette recommends cleaning the DAT drive once every week. 

1. Remove the current backup tape from the DAT drive.

2. Insert the cleaning cartridge (PN 409669-001) into the DAT 
drive.

3. Watch for the green drive light to blink as cleaning takes place.

The tape will be automatically ejected when cleaning is 
completed.

4. Remove the cleaning cartridge and insert the next backup tape.

NOTE
For systems using the network backup
option, cleaning is required only once a year.

NOTE
If the tape is automatically ejected without
the green light blinking that indicates that the
cleaning tape has been used up and it must
be replaced.

The estimated life of the cleaning cartridge
tape is 50 cleanings.
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Integrated Maintenance Suite: Monthly Responsibilities
Monthly Responsibilities

Update the Monthly
Backup Tape

1. Find and insert the Monthly Backup tape.

2. Select Start → Programs → MUSE CV Information System → 
Integrated Maintenance Suite → Manual Backup.

3. Select the Monthly Backup button.

4. Wait for the progress bar to disappear.

5. Wait for the tape to be ejected.

6. Remove the Monthly Backup tape.

7. Continue with “Update the Monthly Service Tape”.

Update the Monthly
Service Tape

1. Find and insert the Monthly Service tape.

2. Select Start → Programs → MUSE CV Information System → 
Integrated Maintenance Suite → Manual Backup.

3. Select the Monthly Service button.

4. Wait for the progress bar to disappear.

5. Wait for the tape to be ejected.

6. Remove the Monthly Service tape.

7. Insert the next backup tape from the front of the rotation stack.

NOTE
The following monthly responsibilities are
required if the systems are using database
backup and are recommended if the systems
are using network backup. 
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Integrated Maintenance Suite: Annual Responsibilities
Annual Responsibilities

Tape Replacement
(Backup Tapes)

To ensure integrity of the backup, GE Marquette recommends you 
replace the entire set of seven backup tapes once every year.

Replace the Cleaning
Cartridge

As mentioned previously, the expected life of the cleaning cartridge is 50 
cleanings. By cleaning the DAT drive once every week, you can expect to 
replace the cleaning cartridge (PN 409669-001) once every year.

NOTE
The following annual responsiblities are not
required if the systems are using network
backup.

NOTE
If your system has a 4GB DAT drive, be sure
you use 4GB DAT tapes for backup.
(4GB DAT tapes are labeled 120 meters-
DDS2.)

If your system has a 12GB DAT drive, be
sure you use 12GB DAT tapes for backup.
(12GB DAT tapes are labeled 125 meters-
DDS3.)
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Integrated Maintenance Suite: Miscellaneous
Miscellaneous 

Manual Backup

1. Select Start → Programs → MUSE CV Information System → 
Integrated Maintenance Suite → Standard.

2. Make sure that the correct tape is in the DAT drive.

3. Select Normal Daily.

4. Wait for the progress bar to disappear.

5. Review the Error and Event Logs. See “Review the Event Log” 
and “Review the Error Log” for details.

6. Eject the tape.

Changing the IMS Run
Time

The system is automatically set up to run the IMS application every 
night at 2:00 a.m. If you need to change the automatic backup time, 
follow the steps outlined below.

NOTE
During “Normal Daily” operation, manual
backup will not be performed on systems
which are setup for network backup. They
will, however, perform integrety checking,
archive checking and archive, if necessary.

NOTE
The IMS Run Time should always be set to a
time when the least amount of system
activity is occurring. For example, for
systems with a HIS interface, do not
schedule IMS to run when batch HIS
transmissions occur.
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Integrated Maintenance Suite: Miscellaneous
1. Select Start → Programs → MUSE CV Information System → 
Integrated Maintenance Suite → Advanced.

The Advanced window is displayed.

2. Select System → Set Auto Run Time.

3. Right click on the entry containing CVIS0122 – AutoRun and 
select Change.

4. Edit the time, select OK.

5. Close WinAt.

6. Close the MUSE-IMS Advanced window.

Getting the Media Create
Date and Label

1. Select Start → Programs → MUSE CV Information System → 
Integrated Maintenance Suite → Advanced.

2. Select Backup/Archive → Media Create Date.

3. Displayed will be status information and finally: Media Date 
(Tape created on 11/4/97).

4. Select Backup/Archive → Media Label.

5. Displayed will be status information and finally: Media Label

Other Files The IMS application writes information to several log files. Daily log files 
for the previous seven days are stored on the D-drive in Vol000 → 
System → Errlog. A partial list includes:

■ IMS_?.LOG

■ CHKPTRS.LOG

■ DBANAL.LOG

■ BACK_?.LOG

■ ARC_#_#.LOG
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Integrated Maintenance Suite: Disaster Recovery
Disaster Recovery

Introduction This section describes general guidelines for the recovery of MUSE CV 
005A systems. This information is intended to serve as a guide for 
preventative measures to backup and save configuration information 
after the system is modified.  Preventative steps must be taken to ensure 
proper recovery of the system in the event of failure.

System Information To rebuild the computer, it is necessary to have the following 
information about the computer.

■ Computer type, model number, and serial number

■ Computer BIOS manufacturer and revision level

■ Hardware configuration information, including IRQs, DMA 
addresses, I/O ports, and similar information

■ SCSI configuration information including; SCSI configuration 
information from SCSI setup program, which devices are 
terminated and how they are terminated, the SCSI ID and 
physical location on the chain of every SCSI device.

■ Which versions of the operating system are installed, and the 
partitions on which they are installed.

■ Partition information

Required Software To troubleshoot and rebuild a system it is necessary to have the 
following software.

■ Current operating system software

■ Current hardware device drivers for each device in the system

■ Current Service Pack and/or patches

■ NT boot disk

■ Emergency repair disk

■ Tape backups of the file server operating system and the data.

NOTE
Systems using network backup require
assistance from the I.S. Department if
disaster recovery is necessary. 
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Integrated Maintenance Suite: Disaster Recovery
NT Specific Recovery

Backing up the Registry The registry may be backed up using three different methods:

1. Using the emergency repair disk.  To restore from this backup, 
setup must be started from the 3 floppy disks and NT setup 
controls the restore.

2. Using Regedt32 to backup the registry.  This utility allows for 
individual keys to be saved and restored.  Useful for restoring 
only parts of the registry.

3. Using MUSE IMS and backing up the C-Drive. This allows 
NTBACKUP to be used to restore the entire registry from tape 
backup.

Windows NT reference books recommend that it is a good idea to 
backup the registry using several different sources.

Redoing the Emergency Repair
Disk

Redo the Emergency Repair Disk by running: rdisk /s on the file server 
or NT workstation node after changes have been made to:

■ Any global or local NT user or group configurations

■ Any changes to the registry

■ Any changes to the system or system profile(s)

■ Any changes to the disk (i.e. using Disk Administrator)

Reapplying the NT Service Pack Reapply the service pack if any changes are made to:

■ Network configuration

■ Any information is copied from the NT Server CD

Creating NT Boot Disks This Windows NT boot disk can access a drive that has the Windows NT 
file system (NTFS) or file allocation table (FAT) file system installed. The 
procedures in this article can be useful to work around the following 
boot problems: 

■ Corrupted boot sector. 

■ Corrupted master boot record (MBR). 

■ Virus infections. 

■ Missing or corrupt NTLDR or NTDETECT.COM. 

■ Incorrect NTBOOTDD.SYS driver. 

This boot disk can also be used to boot from the shadow of a broken 
mirror, although you may need to change the BOOT.INI to do that. 

This Windows NT boot disk cannot be used for the following problems: 

■ Incorrect or corrupt device drivers that have been installed into 
the Windows NT System directory. 

■ Boot problems that occur after the OSLOADER screen. 
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Integrated Maintenance Suite: Disaster Recovery
To work around or fix these problems, run the Emergency Repair disk, 
load the last known good control set, or reinstall Windows NT, if 
necessary. 

How to Create a Windows NT Boot
Floppy

The Windows NT floppy disk must include the files NTLDR (or 
SETUPLDR.BIN in Windows NT 3.5), NTDETECT.COM, BOOT.INI, and 
the correct device driver for your hard drive.

If You Do Not Have Access to a Computer Running Windows NT

1. Create a copy of the first Windows NT Setup disk using the 
DISKCOPY command, and then delete all files on the new disk. 

2. Copy the NTDETECT.COM and NTLDR files to the new disk. 

3. Rename the NTLDR file to SETUPLDR.BIN. 

4. Create a BOOT.INI file. 

The following is an example that works for a single partition 
SCSI drive with Windows NT installed under \WINNT, however, 
the exact value in the [operating systems] section depends upon 
the configuration of the Windows NT System you want to boot: 

[boot loader]

timeout=30

Default= scsi(0)disk(0)rdisk(0)partition(1)\winnt

[operating systems]

scsi(0)disk(0)rdisk(0)partition(1)\winnt=Windows NT

If your computer boots from an IDE, EIDE, or ESDI hard drive, 
replace the scsi(0) with multi(0). If you are running Windows NT 
3.5 or 3.51 and your system boots from the first or second SCSI 
drive, then you can also replace scsi(0) with multi(0). 

5. If you are using scsi(x) in the Boot.ini, copy the correct device 
driver for the SCSI controller in use on the computer, and then 
rename it to

NTBOOTDD.SYS. If you are using multi(x) in the Boot.ini, you 
do not need to do this. 

NOTE
The NTLDR, NTDETECT.COM, and
BOOT.INI files usually have their file
attributes set to System, Hidden, and Read-
Only. You do not need to reset these
attributes for this disk to work properly. For
more information on the structure of the
BOOT.INI file, see the following article in the
Microsoft Knowledge Base: ARTICLE-ID:
Q102873. (BOOT.INI and ARC Path Naming
Conventions and Usage)
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6. Start your computer using the floppy disk, and then log on to 
Windows NT. 

If You Do Have Access to a Computer Running Windows NT

1. Format a floppy disk using the Windows NT format utility. 

2. Copy NTLDR from the Windows NT Setup CD-ROM, Windows 
NT Setup floppy disk, or from a computer running the same 
version of Windows NT as the computer you want to access with 
the boot floppy. You may need to expand this file from NTLDR._ 
to NTLDR by using the following command line: 

EXPAND NTLDR._ NTLDR

3. Copy the NTDETECT.COM file to the disk. 

4. Create a BOOT.INI file or copy one from a running Windows NT 
computer and modify it to match the computer you are trying to 
access. Below is an example which will work for a single 
partition SCSI drive with Windows NT installed under \WINNT, 
however, the exact value in the [operating systems] section 
depends upon the configuration of the Windows NT computer 
you are trying to access: 

[boot loader]

timeout=30

Default= scsi(0)disk(0)rdisk(0)partition(1)\winnt

[operating systems]

scsi(0)disk(0)rdisk(0)partition(1)\winnt=Windows NT

If your computer starts from an IDE, EIDE, or ESDI hard drive, 
replace the scsi(0) with multi(0). If you are running Windows NT 
3.5 or 3.51 and your computer starts from the first or second 
SCSI drive, then you can also replace scsi(0) with multi(0). 

5. If you are using scsi(x) in the Boot.ini, copy the correct device 
driver for the SCSI controller in use on the computer and 
rename it to NTBOOTDD.SYS.

6. Start using the floppy disk, and then log on to Windows NT. 

Simple (Non-Setup Related) Boot Failures

If you have been running Windows NT successfully, and it fails to boot, 
you can use the following simple procedure to try and recover from the 
problem: 

1. Verify that the problem has not been caused by changes or 
failures in the hardware. Loose cables, bad cables, new cards, 

NOTE
If you are using multi(x) in the Boot.ini, you
can skip step 6..
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new drives, and even new settings on existing controllers can all 
cause boot problems. 

2. If Windows NT failed to boot after you installed a new device 
driver, try pressing the spacebar at the OSLOADER screen and 
selecting the Last Known Good option. If the boot process failed 
before you logged on to the system, this should correct the 
problem. 

3. Try creating an NTFS boot disk as described in the article 
Q119467: Creating a Boot Disk for an NTFS Partition. This will 
generally only help in a situation where your basic boot files 
(NTLDR, NTDETECT.COM, NTBOOTDD.SYS) or your 
BOOT.INI file are corrupted or incorrect. 

4. Boot from the Windows NT Setup disk (or run SETUPLDR on a 
RISC-based machine) and run the emergency repair process. 
For Windows NT 3.1, this requires an emergency repair disk, for 
Windows NT 3.5 an emergency repair disk may not be required 
but can help if the repair directory on the hard drive is damaged. 
This will solve most boot problems that involve bad system files 
or a corrupted registry.

Recovery Steps NT Boot Problems

Documentation exists that helps troubleshoot Windows NT boot 
problems.  The tools to have to recover from NT boot problems are:

1. Emergency repair disk

2. NT boot floppy

3. 3 setup floppies and NT CD

Typical boot failure messages
Table 5-1. Boot Failure Messages and Resolutions

Message Resolution

BOOT: Couldn’t find NTLDR
Please insert another disk.

Ntldr file is missing
Use the Emergency Repair process to 
recover

NTDETECT V1.0 Checking Hardware...
NTDETECT failed

Ntdetect.com is missing or boot.ini is 
bad
Use the Emergency Repair process to 
recover

Windows NT could not start because 
the following file Is missing or 
corrupt:
\winnt root\system32\ntoskrnl.exe
Please re-install a copy of the above 
file

Ntoskrnl.exe is missing
Use the Emergency Repair process to 
recover

I/O Error accessing boot sector file
Multi(0)disk(0)partition(1):\bootsect.
dos

Bootsect.dos is missing
Revision F5-18 MUSE CV information system
419931-012



Integrated Maintenance Suite: Disaster Recovery
Rebuilding a Bad Drive Use the Emergency Repair process to recover. Recovering a disk from 
scratch is an involved process for NT and MUSE version 005A. Recovery 
is based on the following assumptions:

1. Current usable backup of C-Drive exists

2. Current usable backup of D-Drive exists

3. Current usable backup of any active archive data exists.

You cannot restore an active NT partition using NT backup restore. The 
recovery process uses a temporary bootable NT FAT partition to restore 
the current C-Drive from tape. The entire process starting from a clean 
disk takes 3 hours. This does not include the time needed to physically 
replace the drive.

1. Install new drive into system or clean old drive to all free space

2. Create a minimum NT installation using the c:\junk directory.  
This installation should be a member server, no network 
installed, and the proper tape driver for the tape drive.  The 
purpose of this installation is to boot strap the system in order to 
restore the C-Drive tape.  Create a 1 Gig and 8 Gig partition.

3. Restore C-Drive from the tape of the last successful backup.

4. Boot from C-Drive and restore D-Drive data.  Restore the 
archive data in the order from newest to oldest.  Do not restore 
Vol000 and the active volume from any of the archive tapes.  As a 
final step, restore Vol000 and the active volume (Vol0XX) from 
the last backup.

5. Delete the c:\junk installation of NT Server.

This will bring the system back to the current point of the last 
backup.  All data will be lost from the time between the last 
backup and the time which the drive failed!

Windows 95 Specific
Recovery

Recovering a disk from scratch is an involved and manual process for 
WIN95 and MUSE version 005A. 

Refer to the build instructions for Windows 95 for more information on 
how to restore a WIN95 system.
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System Shutdown & Restart Procedures

Shutdown the MUSE CV
System

Shutdown all workstations attached to the file server by initiating a 
MUSE shutdown on the NT file server.  To initiate a system shutdown:

1. Login to the file server as MUSE Administrator.

◆ Press Ctrl + Alt + Delete to display Logon Information 
dialog box.

◆ Type MuseAdmin for User name

◆ Type Muse!Admin for Password (Password is case 
sensitive.)

◆ The correct domain may already be displayed in the 
Domain list, If not, scroll to display the correct domain.

◆ Select OK.

Once logged in, a teal desktop appears with icons on the left side 
and a task bar on the bottom.

2. Select Start → Programs → MUSE CV Information System → 
Integrated Maintenance Suite → Advanced to launch the MUSE 
CV-IMS Advanced window.

3. Select System → Shutdown/Restart to display all the Shutdown/
Restart options.

MD1313-25A
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The first three options in the Shutdown/Restart menu initiate 
the MUSE CV system shutdown process whereby all MUSE 
services running on the NT file server and all MUSE clients 
attached to the server are shutdown. The shutdown is a four-
minute process, allowing users of client workstations sufficient 
notification in order to exit their current application and log out.

The differences between the three options are as follows: 

◆ The Shutdown option will result in a system shutdown. 
Select this option when shutting down the system for 
maintenance or software upgrades.

◆ The Rebuild Queues option, in addition to shutting down 
the system, copies over new template versions of the queues 
as selected by the user from an additional dialog display.  
When the system is restarted, those queues are then rebuilt 
from scratch (not just validated) by the MUSE Service 
Control Manager task (CV_SCM).

◆ The Restart option is available for a single-step shutdown/
restart process for cases such as the need to activate MUSE 
CV system device configuration changes.   The Restart 
option results in the automatic restart of the MUSE CV 
system.

4. Select the appropriate Shutdown/Restart option.

5. After selecting the shutdown option, select OK from the warning 
dialog to begin operation.

For all options the Shutdown Pending … text appears in the IMS 
dialog context and a small blue flashing indicator appears in the 
lower right corner of the screen.  When the operation has 
completed, Shutdown OK. Code (0) is displayed in the IMS 
dialog context. (Note that the IMS dialog box will remain 
displayed until it is manually closed out.)

6. Select System → Exit to close the MUSE CV-IMS Advanced 
window.

7. If you selected Rebuild Queues or Restart in step 4, go to “Start-
Up Verification” on page 4-22.

8. If you selected Shutdown in step 4, go to “Shutdown the NT File 
Server” on page 4-22.
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Shutdown the NT File
Server

1. From the NT desktop, shutdown the NT file server by selecting 
Start → Shutdown... .

2. Select Shut down the computer? and click the Yes button. 

3. After NT has completed its shutdown process, a message box 
will appear stating that It is now safe to turn off your computer, 
followed by a Restart button. At this time, you may turn off the 
monitor and power down the NT server. 

4. At this time, you may also power down the workstation nodes 
and attached monitors if so desired.

Power Up Procedure 1. Power up the NT file server and attached monitor. 

2. Restart clients. Wait until the NT Begin Logon window appears 
and then power on the clients.

Start-Up Verification 1. Log into the MUSE CV system.

2. Verify that all nodes had shutdown and initialized. Look for 
<<<<Station Shutdown>>>> <<<<Station initialization>>>> in 
the Event Log.

MD1313-24A

NOTE
Clients which were not powered off will
restart automatically.

NOTE
If a node has not initialized, press its Reset
button to manually reboot.
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Assembly Descriptions

Introduction If you encounter a problem that is not addressed in the OEM manuals or 
if you would like further assistance, please call Technical Support at 
1-800-558-7070.

File Server Assembly and disassembly instructions can be found in the Intel or 
Compaq manuals that accompanied your system.

Desktop Client Assembly and disassembly instructions as well as basic troubleshooting 
procedures can be found in the Intel manuals that accompanied your 
system.

Monitors Basic troubleshooting procedures for the Sony monitors can be found in 
the Sony Operating Instruction manual that accompanied your 
monitor. The monitor is a field replaceable unit and should not be 
disassembled in the field.

UPS Basic troubleshooting procedures for the UPS can be found in the 
PowerVAR or Compaq manual that accompanied your UPS. The UPS is 
a field replaceable unit and should not be disassembled in the field.

HP LaserJet 4000N
Printer

Troubleshooting procedures and instructions for the removal and 
replacement of repairable items are provided in the HP Printer User’s 
Manual and Getting Started Guide that accompanied your printer.

MUSE Network Writer Please refer to Chapter 7, “MUSE Network Writer Module”, for 
assembly/disassembly and troubleshooting procedures.
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Assembly Block Diagram

The system level overview on the following page describes the function 
of each of the major assemblies in a typical MUSE CV system 
configuration. Please keep in mind that the diagram is only a 
representative sample, there are too many possible configurations to 
show them all.
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Assembly Block Diagram
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Theory of Operation The theory of operation gives you a very broad overview of the various 
functional units. Refer to the OEM manuals for additional information 
and troubleshooting procedures.

The MUSE CV system consists of computers connected together via a 
local area network (LAN). There are several different computers and 
each is used in a different way. File servers store large numbers of ECGs 
and “serve” requests from other computers on the network for files. 
Communication servers acquire ECGs from diskette, via modem, or 
through a local direct connection to a resting ECG analysis system. They 
then process the ECG and send it to the file server.

Workstation clients allow reports to be edited and printed. Physician 
stations allow a physician to change reports right in the computer, or 
dictate the changes for a technician to incorporate at a later time. 
Telephone retrieval stations allow a physician to call in to the system 
from a telephone and hear the diagnosis for a particular patient. 

Most often an ethernet local area network (LAN) system interconnects 
the MUSE CV system file servers, synchronous modem modules, and 
workstation clients together. Regardless of network technology, each 
computer on the network is called a “node” and has a “node ID” or 
“station ID” number that identifies it.

File Server The Intel tower file server contains a motherboard, a 266MHz PII Pro 
processor (CPU), a 9GB hard drive, 128MB RAM, an internal 24x CD-
ROM drive, 3.5” diskette drive, and DAT drive, and a power supply.

The hard drive stores the MS-DOS operating system, MUSE CV system 
software, and patient data. The diskette drive is used for updating 
software and running system diagnostics, and the DAT drive is used for 
system backups. The CE-ROM drive is used for software upgrades.

Workstation Client The workstation client contains a motherboard, a 233MHz Pentium 
processor (CPU), one 2.1GB hard drive, 32MB RAM, an internal 24x CD-
ROM drive, 3.5” diskette drive, and DAT drive, and a power supply.

The hard drive stores the MS-DOS operating system, MUSE CV system 
software, and patient data. The diskette drive is used for updating 
software and running system diagnostics, and the DAT drive is used for 
system backups. The CD-ROM drive is not used at the present time.

Synchronous Modem Module The synchronous modem module (SMM) contains a motherboard, a 
233MHz Pentium processor (CPU), one 2.1GB hard drive, 32MB RAM, 
an internal 8x CD-ROM drive and 3.5” diskette drive, and a power 
supply. 

The SMM’s primary role is to handle communications with other 
systems via an assortment of modems. Options to the communication 
server are: MEI modem, FAX option, CSI modem, 1500 defibrillator 
modem, and a Holter connection.
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Network Interface The system network interface card is a selectable option. Thin, thick, or 
twisted pair ethernet, and token ring networks are supported. 

PCB 34010 Writer Board The PCB34010 Writer Board, also known as the network writer board, is 
used to generate postscript files for output to a postscript printer. It also 
drives the MUSE Network Writer and enables the acquisition of ECGs 
from a MAC 8 resting ECG analysis system through the MAC 8 
acquisition cable.

MAC 8 Acquisition Cable The MAC 8 acquisition cable is an option which enables you to acquire 
ECGs directly from a MAC 8 resting ECG analysis system. This is 
accomplished through a direct local line to the workstation client.

Monitors The optional 15, 17, and 20” monitors are manufactured by Sony. The 
monitors are color, and incorporate the Trinitron display technology. 
The 15” monitor has a resolution of 1024 x 768 and the 17” and 20” 
monitors have a resolution of 1280 x 1024.

Printers Printer options include an HP LaserJet 4000N printer and a MUSE 
Network Writer thermal printer manufactured by GE Marquette 
Medical Systems. Additional information on the HP printer can be 
found in the OEM manual, and information on the Network Writer can 
be found in Chapter 7, “MUSE Network Writer Module”.

Uninterruptible Power Supply The UPS provides battery backup for a limited time after power has 
gone out. It also provides power conditioning. The MUSE CV system 
should be systematically shutdown in the event of a power outage. Do 
not rely on long term use of the UPS’s battery backup.
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General Fault Isolation

First Things to Ask If the unit is not working properly, save yourself some time 
troubleshooting by asking yourself these basic questions.

■ Is the unit turned on?

■ Have there been any changes in the use, location, or 
environment of the equipment that could cause the failure?

■ Has the unit been modified in any way, either in software or 
hardware?

■ Is operator error the cause of the problem? Try to repeat the 
user’s scenario exactly and compare that to the proper 
operation of the equipment. Check the operator’s manual as 
necessary.

Visual Inspection A thorough visual inspection of the equipment can save time. Small 
things—disconnected cables, foreign debris on circuit boards, missing 
hardware, loose components—can frequently cause symptoms and 
equipment failures that may appear to be unrelated and difficult to 
track.

Read the Disassembly Guidelines in the products OEM manual  before 
you perform an internal visual inspection of the components.

Take the time to make all the recommended visual checks (refer to the 
following visual inspection chart) before starting any detailed 
troubleshooting procedures.

Table 6-1. Visual Inspection List

Area Look for the following problems

I/O Connectors and Cables ■ Fraying or other damage
■ Bent prongs or pins
■ Cracked housing
■ Loose screws in plugs

Fuses ■ Type and rating, replace as necessary

Interface Cables ■ Excessive tension or wear
■ Loose connection
■ Strain reliefs out of place

Circuit Boards ■ Moisture, dust, or debris (top and bottom)
■ Loose or missing components
■ Burn damage or smell of over-heated components
■ Socketed components not firmly seated
■ PCB not seated properly in edge connectors
■ Solder problems: cracks, splashes on board, incomplete feedthrough, prior modifications or repairs
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Ground Wires/Wiring ■ Loose wires or ground strap connections
■ Faulty wiring
■ Wires pinched or in vulnerable position

Mounting Hardware ■ Loose or missing screws or other hardware, especially fasteners used as connections to ground 
panes on PCBs

Power Source ■ Faulty wiring, especially AC outlet
■ Circuit not dedicated to system

(Power source problems can cause static discharge, resetting problems, and noise.)

Table 6-1. Visual Inspection List (Continued)

Area Look for the following problems
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Maintenance: Introduction
Introduction

Recommended
Maintenance

A regular equipment maintenance program helps prevent unnecessary 
equipment and power failures and also reduces possible health hazards. 
This chapter contains instructions for the following recommended 
maintenance:

■ Inspecting and cleaning the unit

■ System Checkout 

Inspection Report To help you establish a systematic maintenance routine, GE Marquette 
Medical Systems recommends that, every six months, you perform the 
maintenance checks and test procedures on the “Preventive 
Maintenance Inspection Report,” included at the end of this chapter.

NOTE
Unless you have an Equipment Maintenance
Contract, GE Marquette Medical Systems
does not in any manner assume the
responsibility for performing the
recommended maintenance procedures.
The sole responsibility rests with the
individual or institution using the equipment.
GE Marquette Medical Systems service
personnel may, at their discretion, follow the
procedures provided in this manual as a
guide during visits to the equipment site.
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Required Tools and
Supplies

In addition to a standard set of hand tools, you will need the special 
tools and items listed below to maintain or repair the MUSE CV system. 

Table 7-1. Tools and Supplies

Item Part Number

Leakage Current Tester
120 V (or equivalent)
240 V (or equivalent)

MT-1216-01
MT-1216-02

Multimeter –

Preventive Maintenance Kit MUSEPC-PM-KIT

DAT Drive Cleaning Kit1

1. These items are included in the PM Kit, pn MUSEPC-PM-KIT

409669-001

Sony RL Drive Cleaning Kit1 409668-001

Sony RL Disk Cleaning Kit1 MOA-D51

Floppy Drive Cleaning Kit1 407546-001

Vacuum Cleaner1 VACUUM

Tape Drive Cleaning Kit 3613-901

Tape Head Demagnetizer 3613-902

Isopropyl Alcohol –

Dust Remover (compressed air) –

Small Tie Wraps for securing cables –
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Pre-service Procedures

System Shutdown Before opening the unit for maintenance or service, be sure to shut the 
system down and remove power. Instructions for shutting the system 
down can be found in “Powering On and System Shutdown” in 
Chapter 2.

In addition, the OEM manuals provide information regarding proper 
shutdown of individual systems and devices.
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Inspection and Cleaning

Visual Inspection Perform a visual inspection daily. Turn off the unit and remove power 
before making an inspection or cleaning the unit.

■ Check the case and display screen for cracks or other damage.

■ Regularly inspect all cords and cables for fraying or other 
damage.

■ Inspect all plugs, cables, and connectors for bent prongs or pins.

■ Verify that all cords, socketed components, and connectors are 
securely seated.

■ Inspect keys and controls for proper operation.

◆ Toggle keys should not stick in one position.

◆ Knobs should rotate fully in both directions.

Precautions Turn off the unit and remove all power before inspecting or cleaning. 

Do not immerse any part of the equipment in water.

Do not use organic solvents, ammonia based solutions, or abrasive 
cleaning agents which may damage equipment surfaces.

Do not use a cleaning solution or solvent on the cassette tapes. Doing so 
can cause loss of data or damage to the tape drive.

Do not use metal articles, such as a screwdriver, to clean the tape heads, 
or bring any magnetic material near the head assembly.

Exterior Cleaning Clean the exterior surfaces once per month, and more frequently if 
needed, with a clean, soft cloth and a mild dishwashing detergent 
diluted in water. 

■ Wring the excess water from the cloth. Do not drip water or any 
liquid on the writer assembly, and avoid contact with open 
vents, plugs, or connectors.

■ Dry the surfaces with a clean cloth or paper towel.

Cleaning the Monitor Screen Use a commercial glass cleaner.

■ Follow directions for use on product.

■ Use non-abrasive, antistatic lint-free cloth.

■ Wipe carefully and allow to dry.
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Interior Cleaning Complete any pre-service procedures prior to opening the unit or 
performing any interior cleaning. Clean the unit as needed, but at least 
once per month. 

The equipment is sealed before it leaves the factory. There should be no 
dust buildup on the surfaces of the interior PCB assemblies and 
components when you receive it. However, if dust is an environmental 
problem, use a commercially available dust remover (compressed air). 
Follow the manufacturer’s directions for use.

Cleaning the System Box Interior Follow these steps to clean the system box interior.

1. Power off the workstation. See “Powering Off the Workstation” 
in chapter 2, “Equipment Overview” for steps to power off the 
workstation. 

2. Detach the AC power cord before cleaning the interior of the 
system box.

3. Remove the system box top cover. See the OEM manual for your 
specific system for detailed information.

4. Clean the interior. See the “Preventative Maintenance 
Inspection Report” for more detail.

5. Replace the system box cover. Refer to the OEM manual for your 
specific system for detailed information.

Cleaning the Floppy Diskette Drive The floppy diskette drive cleaning kit is PN 407546-001. See Storage 
Device Cleaning Information, PN 409623-001, for detailed information 
on cleaning the floppy diskette drive. 

Cleaning the DAT Drive See the OEM manual for the steps required to clean the DAT drive tape 
heads.

WARNING

Only qualified
personnel should 
perform the following 
procedure.

M15287-30A

WARNING

Turn off power and 
disconnect power cord 
from AC power source 
before removing the 
cover.

M15287-23C
Revision F 7-7MUSE CV information system
419931-012



Maintenance: Inspection and Cleaning
Cleaning the CD-ROM Drive Follow these steps to clean the CD-ROM drive.

1. Open the CD-ROM drive.

2. Insert the cleaning CD-ROM, brushes down, into the drive.

3. Close the CD-ROM drive. The activity led blinks for about 10 
seconds.

4. Open the CD-ROM drive.

5. Remove the cleaning CD-ROM and place it in its case.

6. Close the CD-ROM drive.

Cleaning the Printer See the OEM manual for cleaning and adjusting instructions for the HP 
LaserJet 4000N printer. Maintenance instructions for the MUSE 
Network Writer are provided in Chapter 5, “MUSE Network Writer 
Module”. 

UPS Maintenance All UPS sub-systems used in MUSE CVIS systems use sealed lead acid 
batteries. These batteries do not require any specific preventive 
maintenance other than testing for functionality.

UPS Battery Care

Keep the area around the unit clean and relatively dust free. If the 
atmosphere is very dusty, clean the outside of the system periodically 
with a vacuum cleaner.

Battery Life

Battery life will vary based on ambient temperature and amount of time 
that the batteries are used.  Maintaining an ambient temperature of 
25°C (77°F) will help attain maximum battery life. Typical battery life is 
approximately 2 – 4 years. It is recommended that floor mount UPS 
systems be returned for battery replacement and testing every 3 years or 
sooner if the preventive maintenance tests described below fail.

The rack mounted UPS systems are designed to allow on site 
replacement of batteries. Contact your authorized service provider or 
follow the recommended procedures in the Rack Mount UPS manual.
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Maintenance: Inspection and Cleaning
UPS Testing

There is a self-test built into the UPS. This can be run from the front 
panel of the unit by depressing and holding the Test/Alarm Reset 
Button for 3 seconds. The unit will do an internal self-test. If a problem 
is found the unit will sound an alarm and an LED will turn on to indicate 
the nature of the problem. 

The test can be run from the Fail Safe III software.  

1. At the file server select Start → Programs → FailSafe III → 
FailSafe III console. 

2. From the console window select Maintenance → Test Hardware. 

3. At the test hardware window press the Test button. 

The system will respond with maintenance is running. After 
about 42 seconds the system will respond with a maintenance 
completed OK message. 

4. Close the FailSafe III window.

It is possible that if the system has gone for a long period of time without 
loss of input power the batteries could be in an unrecognized failed 
condition. It is also possible that the built in test may pass. During 
scheduled down time, the most thorough test is to disconnect the input 
power from the UPS with the full load applied to the system. The unit 
should maintain power to the system for the recommended amount of 
backup time based on the equipment load. Typically better than 5 
minutes.

NOTE
The following test should not be run on
system that is in operation. It should only be
done during scheduled down time for
preventive maintenance. The following test
disconnects the power from the line and
attempts to supply the load from batteries. If
the batteries can not hold the load the
system attached to the UPS will experience
a power failure.
Revision F 7-9MUSE CV information system
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Maintenance: Disassembly Guidelines
Disassembly Guidelines

PCB Assemblies Observe the following guidelines when working on all PCB assemblies:

■ Take precautions against electrostatic discharge damage.

■ Handle all PCB assemblies by their edges.

■ Use a heatsink when soldering any phototransistors, 
photodiodes, or optical isolators.

■ Repair breaks in PCB assembly tracks by bridging with wire 
from pad to pad. Do not lay solder across the breaks. (The heat 
from the soldering iron may cause the track to detach from the 
PCB assembly.)

■ After soldering, clean excess flux from the PCB assembly.

Hardware ■ Before disassembly, note the positions of any wires or looms 
(cables), marking them if necessary to ensure that they are 
replaced correctly. 

■ Save and set aside all hardware for re-assembly. 

Opening the File Server See the OEM manual for your specific system for the steps to open, 
disassemble, and reassemble your system.

Opening the HP LaserJet
4000NPrinter

Instructions on opening the HP printer, adding RAM, and other 
maintenance procedures can be found in the OEM manual.

Opening the MUSE
Network Writer

See Chapter 7, “MUSE Network Writer Module”, for instructions on 
opening the printer.

WARNING

Turn off power and 
disconnect power cord 
from AC power source 
before removing the 
cover.

M15287-23C
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Maintenance: System Checkout
System Checkout

Checkout Procedure Perform the following for all applicable options. Use this manual and 
the “MUSE CV information system operator’s manual” (PN 419931-001) 
for reference.

1. Node Initialization - Power up all nodes and ensure each 
initializes, error free, and you can log in.

2. Diskette Acquisition - Acquire test ECGs via electrocardiograph 
diskettes and ensure they plot according to report distribution.

3. Phone Acquisition - Acquire test ECGs via remote 
electrocardiograph modems and ensure they plot according to 
report distribution.

4. Local Acquisition - Acquire test ECGs via the front acquisition 
port and ensure they plot according to report distribution.

5. Holter - Locally transmit data from the Holter to the MUSE.

6. TRAM Module - Test that data is successfully flowing from the 
TRAM to the MUSE.

7. MAC LAB - Test that data can be sent from the MAC LAB to the 
MUSE.

8. SDLC - Acquire test ECGs via remote SDLC modems.

9. CSI - Acquire test ECGs via remote CSI modems.

10. RSS - Contact Tech Support to ensure remote logon is possible.

11. Remote Query - Test CSI modem connections if system has 
Remote Query.

12. Edit - View and edit an ECG from the Edit List.

13. Writer/Printers - Test writers to ensure they plot. Check for 
burned out dots, especially in the bar code region.

14. FAX - FAX a record to test fax modems.

15. On-line Archives - If the system has on-line archive drives, 
ensure that backup tapes are up to date.

16. Backups - Perform a manual normal daily backup . Check that 
all tapes are being successfully used. Replace tapes that are past 
their intended life span (customer should store old tapes for safe 
keeping).

NOTE
This procedure should be completed after
initial installation, routine maintenance, and
field upgrades or modifications.
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Equipment Safety Tests

Introduction The following paragraphs contain equipment safety tests to ensure that 
the MUSE CV system poses no electrical health hazards.  It is suggested 
that the equipment safety tests be performed every 6 months and every 
time a circuit board/assembly is removed and replaced.  The following 
table lists the tests.

Equipment necessary to perform these equipment safety tests includes 
a 110-volt leakage current tester, pn MT-1216-01AAMI, (referred to as 
tester) and a digital multimeter.  Note that for 220-volt use tester, PN 
MT-1216-02AAMI.

NOTE
Failure to implement a satisfactory
maintenance schedule may cause undue
equipment failure and possible health
hazards.  Unless an Equipment Maintenance
Contract exists, GE Marquette Medical
Systems does not in any manner assume
the responsibility for performing the
recommended maintenance procedures.
The sole responsibility rests with the
individual or institution using the equipment.
GE Marquette Medical Systems service
personnel may, at their discretion, use this
procedure as a helpful guide during visits to
the equipment site.

Table 7-2. Equipment Safety Tests

Test # Applies to Tools Required

1 File servers, acquisition 
servers/processing 
stations, and workstation 
computers that have the 
MAC 6/MAC PC Local 
Acquisition Port

110V ac  MT-1216-01AAM 220 V ac  
MT-1216-02AAMI (or equivalent) and 
DVOM

2 Same as above. Same as above.
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Maintenance: Equipment Safety Tests
Preparation for Tests

This procedure verifies that a properly wired outlet is used to furnish 
power to the MUSE CV system.  Note also that Chapter 6, 
“Troubleshooting” contains an additional and important power source 
verification procedure that should also be done.

■ Connect the appropriate leakage tester to the power outlet.

■ Insure that the GND switch on the leakage tester is in the down 
(closed) position.

■ Check the O, K, and R indicators for the condition according to 
the table below.  Normal polarity and ground is the desired and 
safe condition.

NOTE
The following procedure checks for proper
wiring of the power receptacle.  If the proper
indications of step A (normal polarity and
ground) are not obtained, the following
procedures will be ambiguous.  Do not
proceed until a properly wired outlet is found.

Table 7-3. Power Receptacle Wiring Check

Step
Indicator

Condition
O K R

A On On Off Normal polarity and ground

B Off On On Reverse polarity

C Off On Off No ground

D On Off On No neutral

E Off Off On No neutral/reverse polarity.

F Off Off Off No power.
Revision F 7-13MUSE CV information system
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Maintenance: Equipment Safety Tests
Test #1 – Ground-Wire-
Leakage-to-Ground Test NOTE

This diagram shows only a representation of
how a typical leakage current tester
functions.  Follow the instructions provided
with your leakage tester.

M13052-1C
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Maintenance: Equipment Safety Tests
Test #2 – Chassis-
Leakage-to-Ground

(Exposed Chassis) Test

\

NOTE
This diagram shows only a representation of
how a typical leakage current tester
functions.  Follow the instructions provided
with your leakage tester.

M13052-2C
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Maintenance: Miscellaneous Maintenance Form
Miscellaneous Maintenance Form

GE Marquette Medical Systems recommends that every six months you 
perform the maintenance checks and test procedures on the 
“Preventive Maintenance Inspection Report” (see following pages). 
These maintenance procedures can be performed more often if 
indicated.
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MUSE

Preventive Maintenance Inspection Report

Customer____________________________________ Customer Number ________________ Date __________________

FE ______________________________________ FE ID _______________ Call Number __________________________

Equipment Serial Number ______________________________________ MUSE Software Revision __________________

Configuration

Number of Servers ____________ Number of Nodes ___________

Network Type ________________ HIS (type) _________________

Tools Required

1. Standard hand tools (p.n. N/A)
2. Multimeter (p.n. N/A)
3. Leakage Current Tester (p.n. MT-1216)
4. Field Service Manual (p.n. 405355-001)-not required, reference only
5. Operator’s Manual (p.n. 417087-001)-not required, reference only
6. Isopropyl alcohol (p.n. N/A)
*These parts are included in the PM K

Visual Inspe
Inspect the following for excess wear and/

Cleaning
(Refer to the Field Serv

*Note: See instruction set included

Calibratio
There is no calibration required o
7. PM Kit (p.n. MUSEPC-PM-KIT)
8. *DAT Drive Cleaning Kit (p.n. 409669-001)
9. *Sony RL Drive Cleaning Kit (p.n. 409668-001)

10. *SONY RL Disk Cleaning Kit (p.n. MOA-D51)
11. *Floppy Drive Cleaning Kit (p.n. 407546-001)
12. *Vacuum Cleaner (p.n. VACUUM)
it (p.n. MUSEPC-PM-KIT)

ction
or any visual signs of damage.
1._______ Network Cabling (broken insulation)
2._______ Network Cabling (proper stress relief)
3._______ AC power Cord (s)
4._______ System Furniture
5. _______ Fans on all notes
6. _______ Internal & external system cables and connectors
7. _______ Console printer ribbon
8. _______ Laser printer EP cartridge
ice Manual)
1._______ Clean all internals of dust
2._______ Clean all keyboards
3._______ Clean all fans and air intakes
4._______ Clean all floppy drives
5._______ Clean all printer and writer platens
6. _______ Clean all mouse balls and contacts
7. _______ Clean all barcode readers
8. _______ Clean Optical drives and disks *
9. _______ Clean DAT drives *

10._______ Clean external surfaces
 with MUSEPC-PM-KIT. 

n
n the MUSE system.
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Electrical Safety Checks
Perform these checkouts for each node.

Node Number:

1. AC Line Voltage Checkout
_____  Line to neutral = 120V
_____  Line to ground = 120V
_____ Neutral to ground < 3V

After the outlet passes the above tests, check the neutral-ground loop resistance test.

_____  Neutral to ground < 2W

2. Leakage Test
Note: The following voltages apply to 120/240 VAC for MUSE Personal Computers.

Open Closed
Normal      Reversed Normal       Reversed

Ground wire leakage to ground (3500 µA max.) ______uA ______uA  NA NA
Chassis leakage to ground (3500 µA max.) ______uA ______uA ______uA ______uA
(exposed chassis)

3. Resistance Measurements
Ground pin to chassis _____  < 100 mΩ

Node Number:

1. AC Line Voltage Checkout
_____  Line to neutral = 120V
_____  Line to ground = 120V
_____ Neutral to ground < 3V

After the outlet passes the above tests, check the neutral-ground loop resistance test.

_____  Neutral to ground < 2W

2. Leakage Test
Note: The following voltages apply to 120/240 VAC for MUSE Personal Computers.

Open Closed
Normal      Reversed Normal       Reversed

Ground wire leakage to ground (3500 µA max.) ______uA ______uA  NA NA
Chassis leakage to ground (3500 µA max.) ______uA ______uA ______uA ______uA
(exposed chassis)

3. Resistance Measurements
Ground pin to chassis _____  < 100 mΩ

Neutral

Ground
Line

Neutral

Ground
Line
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Electrical Safety Checks
Perform these checkouts for each node.

Node Number:

1. AC Line Voltage Checkout
_____  Line to neutral = 120V
_____  Line to ground = 120V
_____ Neutral to ground < 3V

After the outlet passes the above tests, check the neutral-ground loop resistance test.

_____  Neutral to ground < 2W

2. Leakage Test
Note: The following voltages apply to 120/240 VAC for MUSE Personal Computers.

Open Closed
Normal      Reversed Normal       Reversed

Ground wire leakage to ground (3500 µA max.) ______uA ______uA  NA NA
Chassis leakage to ground (3500 µA max.) ______uA ______uA ______uA ______uA
(exposed chassis)

3. Resistance Measurements
Ground pin to chassis _____  < 100 mΩ

Diagnostic Tests
The following tests for and, if required, corrects  software viruses and performs disk drive optimization:

The tests, Anti Virus, Scan Disk, and Defragment, may take up to 1 hour per node.

1. Before proceeding, verify a good recent backup exists.
2. Shutdown and reboot the system into DOS mode.
3. At the DOS prompt, type CD\DOS <cr> .
4. Now scan for viruses, type MSAV  /L  /P  /R <cr> *Report to Tech Support if any viruses are detected.
5. After virus scanning, check the disks by typing SCANDISK <cr> *Errors should be checked by Tech Support.
6. After scan disk is complete, run the optimizer by typing DEFRAG <cr>  

Checkout Procedure
Use the Field Service Manual and User Manual for reference. Perform the following for all applicable options.

a. ❏ NODE INITIALIZATION Power up all nodes and ensure each initializes, error free, and you can log in.

b. ❏ DISKETTE ACQUISITION Acquire test ECG’s via cart diskettes and ensure they plot according to report distribution.

c. ❏ PHONE ACQUISITION Acquire test ECG’s via remote cart modems and ensure they plot according to report distribution.

d. ❏ LOCAL ACQUISITION Acquire test ECG’s via the front acq. port and ensure they plot according to report distribution.

e. ❏ HOLTER Locally transmit data from the Holter to the MUSE.

f. ❏ TRAM MODULE Test that data is successfully flowing from the TRAM to the MUSE.

g. ❏ MAC-LAB Test that data can be sent from the MAC LAB to the MUSE.

h. ❏ SDLC Acquire test ECG’s via remote SDLC modems.

Neutral

Ground
Line
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i. ❏ CSI Acquire test ECG’s via remote CSI modems.

j. ❏ RSS Contact Tech Support to ensure remote logon is possible.

k. ❏ REMOTE QUERY Test CSI modem connections if system has Remote Query.

l. ❏ EDIT View and edit an ECG from the Edit List.

m. ❏ WRITER/PRINTERS Test writers to ensure they plot. Check for burned out dots, especially in the bar code region.

n. ❏ REMOTE WORKSTATIONS Verify the Remote Workstations connection to the Host MUSE.

o. ❏ FAX FAX a record to test fax modems.

p. ❏ R/L ARCHIVES If the system has an optical drive, retrieve an ECG from each disk. (ex. 16A, 16B and 16C)

q. ❏ ON-LINE ARCHIVES If  the system has on-line archive drives, ensure that backup tapes are up-to-date.

r. ❏ BACKUPS Perform a non-scheduled complete backup. Check that all tapes are being successfully used. 
Replace tapes that are past their intended life span (customer should store old tapes for safe keeping).

Environment
Y N

Room Temperature: __________°F Static problems (ESD): ❏ ❏

Humidity: __________ Excessive Dust: ❏ ❏

Node(s) on UPS:           __________ 

Comments on any other environmental conditions that may effect operation or  reliability (static, temp., a.c. power, etc...)

___________________________________________________________________________________________________________

This report to be filed at customer site

Briefly describe all repairs/adjustments made and list all parts replaced:

___________________________________________________________________________________________________________

___________________________________________________________________________________________________________

___________________________________________________________________________________________________________

Additional Comments: 

___________________________________________________________________________________________________________

___________________________________________________________________________________________________________

___________________________________________________________________________________________________________

Customer Signature: ______________________________________ Date:____________________________________

FE Signature: _____________________________________________ Date:____________________________________
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FRU Checkout Procedure

FRU
Description

Tools Required Visual
Inspection

Cleaning Calibration Electrical
Safety Tests

Checkout
Procedure

HARDWARE
Monitors 1, 2, 3 3, 6 10 N/A ALL a, b, l

Keyboard, Mouse 1, 2, 3 3, 6 6, 10 N/A ALL a, b, l

Bar Code Reader 1, 2, 3 3, 6 7, 10 N/A ALL a, b, l

PC Box Assembly 1, 2, 3, 12 3, 5, 6 1, 3, 4, 8, 9, 10 N/A ALL ALL

PC Box Internal PCB’s 1, 2, 3, 12 3, 5, 6 1, 3, 4 N/A ALL ALL

Server disk drives 1, 2, 3, 12 5, 6 1, 3 N/A ALL ALL

Floppy drives 1, 2, 3, 11, 12 5, 6 1, 3, 4 N/A ALL a, b 

Power Supplies 1, 2, 3, 12 3, 5, 6 1, 3 N/A ALL a, b

MEI Writer Assembly 1, 2, 3 3, 5, 6 3, 5, 10 N/A ALL a, b, m 

MEI Writer components 1, 2, 3, 12 3, 6 1, 3, 5, 10 N/A ALL a, b, m

External Modems 1, 2, 3 3, 6 10 N/A ALL a, b, i, j, k, n, o 

Internal Modems 1, 2, 3, 12 5, 6 1, 3 N/A ALL a, b, i, j, k, n, o 

Printers (laser, dot matrix) 1, 2, 3 3, 5, 6, 7, 8 3, 5, 10 N/A ALL a, b, m

Sony R/L Drives 1, 2, 3, 10 5, 6 1, 3, 8 N/A ALL a, b, p, q, r

DAT Drive 1, 2, 3, 8, 12 5, 6 1, 3, 9 N/A ALL a, b, q, r

Non-Listed FRU’s Perform complete PM

No Parts Replaced none ALL none N/A none a, b, l, any applicable

SOFTWARE

Updates/Upgrades Perform complete PM
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MUSE Network Writer Module: Introduction
Introduction

The MUSE Network Writer module is made up of the MUSE Network 
Writer and the network writer interface pcb assembly. The MUSE 
Network Writer is a thermal printer used to print ECG reports and other 
information on thermally-sensitive paper. It communicates with a client 
computer using the network writer interface pcb assembly, which gets 
installed in the computer.

The goal of this section is to find the defective assembly in the MUSE 
Network Writer module (including the network writer interface), replace 
it and verify that the equipment is functioning properly once again. 

This section is made up of various subsections:

■ Theory, which provides an assembly level theory discussion on 
this module,

■ Controls, Connectors, and Indicators,
■ Cleaning,
■ Adjustments,
■ Selecting the Defective Assembly, and
■ Replacing the Defective Assembly.
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MUSE Network Writer Module: Theory
Theory

Introduction Following is a block diagram of the MUSE Network Writer module. 
Remember that the network writer interface pcb assembly is not really a 
part of the MUSE Network Writer. It is installed in the client computer, 
and allows communication between the computer and writer.

The MUSE Network writer module consists of the following field-
replaceable assemblies:

■ power supply assembly

■ network writer/local acquisition port interface pcb assembly

■ motor control pcb assembly

■ LED pcb assembly

■ writer door optical cable assembly

■ thermal writer assembly (made up of the following)

◆ thermal print head

◆ motor with tach assembly 

◆ optic cable assembly

Network Writer/
Local Acq Port
Interface PCB

Power Cord

Writer Interface Cable

Power Supply
Assembly

Motor Control
PCB Assembly

Optical
Cable

Assembly

Motor
w/Tach

Assembly

Thermal 
Print
Head

Door
Optical
Cable

Assembly

Thermal Writer Assembly

LED PCB
Assembly

MUSE Network Writer
Inlet/
Fuse

Base Figure Number-126B
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MUSE Network Writer Module: Theory
Power Supply Assembly The power supply in the MUSE Network Writer supplies 15 Vdc to the 
circuits in the writer. Nominal output current is 7.3 A. Input power can 
be either 90-132 Vac or 180-264 Vac. 

Network Writer Interface
PCB Assembly

The network writer interface pcb assembly interfaces the MUSE 
Network Writer with the client computer. It uses a 34010 graphics 
controller and shared RAM to get data from the motherboard in the 
MUSE Network host computer (file server or client computer). 

The host computer writes parallel graphics data to the video memory on 
the network writer interface, and tells the graphics processor on the 
network writer/local acquisition port interface that there is data to be 
printed. The graphics processor then accesses the data in the shared 
video memory and converts the data to a serial stream. The data is sent 
to the motor control pcb assembly in the MUSE Network Writer via the 
37-pin connector.

Different Versions/Compatibility There are several versions of the network writer interface pcb assembly. 
The original -001 version has a lot of hand modifications that were fixed 
with the -002 version. More memory was added to create the -003 
version. The -004 version supports the GE Marquette Medical Systems 
Lasergraph and other HP compatible laser printers at PCL5 (Printer 
Control Language level 5).

Motor Control PCB
Assembly

The motor control pcb assembly receives a serial stream of thermal 
print head data from the network writer/local acquisition port interface 
pcb assembly. It generates the specific signals that the thermal writer 
needs to print, and receives feedback from optical sensors on the paper 
queuing and writer door optical sensors.

The motor control pcb assembly has one 4-position DIP switch 
described in the following paragraphs.

Thermal Print Head Resistance To maintain proper printing darkness, the writer must compensate for 
normal production tolerances in thermal print head resistance. The 
overall range of thermal print head resistances is from 520 Ω to 780 Ω. 
This range is divided into 8 segments. Each segment corresponds to a 
unique setting of stations 1-3 on switch SW1.

A table of thermal print head resistances and their corresponding switch 
settings is provided in“Adjustments” later in this section.

Remember to check/change SW1 whenever the print head or writer 
assembly is replaced. If the resistance is set improperly, printing may be 
too light or too dark. Improper print head resistance could cause traces 
to fade or the print head to fail prematurely.

Internal/External Memory The 34010 graphics controller uses external ROM. This corresponds to 
DIP switch SW1 station 4 being OFF. This switch should never be 
changed.
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MUSE Network Writer Module: Theory
LED PCB Assembly The LED pcb assembly has 3 LEDs: writer fault, out of paper, and power 
on/printer busy. The writer fault LED is either red or amber. Red was 
used on early units. The color was changed to amber to satisfy a UL 
requirement. The writer fault LED is lit whenever the paper access door 
is open. The amber out-of-paper LED is lit when the optic queue sensor 
detects the end of the thermal paper (or a very large hole in the paper). 
The green power on/printer busy LED is on solid whenever power to the 
unit is turned on. It flashes whenever something is being printed. 
Control for all of these LEDs comes from the motor control pcb 
assembly.

Writer Door Optic Cable
Assembly

The writer door optic cable assembly is mounted next to the paper 
access door. Whenever the door is open, the sensor sends a signal to the 
motor control pcb assembly, which stops printing and turns on the 
writer fault LED on the LED pcb assembly.

The writer door optic cable assembly senses whether or not the paper 
access door is open. It does this by shining a light at a downward 
protrusion on the underside of the door. If the door is closed, the light is 
reflected back. If the door is open, there is no reflected light. 
Revision F8-6 MUSE CV information system
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MUSE Network Writer Module: Theory
Thermal Writer
Assembly

The thermal writer assembly receives motor and thermal print head 
information from the motor control pcb assembly, and actually does the 
printing. The thermal writer assembly is made up of three 
subassemblies described following.

Thermal Print Head The thermal print head is responsible for creating the dots on the 
thermal paper that make up the print out of the writer. This is done by 
sending the thermal print one vertical column of dots to the thermal 
print head. Each dot has 1 corresponding element that can be turned 
either on or off (on=dot or off=no dot) as the paper goes by. This vertical 
row is then written to the print head by heating up the elements that 
were turned “on” to about 170° F.

The thermal print head works as follows. First, serial data is clocked into 
shift registers by a clock signal from the motor control pcb assembly. 
When the shift registers are full, the data is loaded into latches. Finally, 
burn signals apply the data to transistors connected to resistive 
elements. Depending upon the data originally clocked into the shift 
registers, the thermal print head either prints a dot or no dot.

Motor with Tach Assembly The motor with tach assembly pulls the thermal paper past the thermal 
print head. The thermal print head then heats up various element dots 
that burn a dot onto the paper as it passes by. The motor with tach 
assembly can move the paper at four paper speeds which are selectable: 
5, 12.5, 25, and 50 mm/seconds. The motor with tach assembly must 
move the paper at a consistent and smooth speed to maintain the vital 
timing relationships of the ECG traces on the paper.

Optic Cable Assembly The optic cable assembly senses the presence or absence of paper. It 
does this by shining a light at the paper, if there is paper the light is 
reflected back. If no paper is present, there is no reflected light. This 
ability is used in the following ways by the writer:

■ Before the writer prints out a report or ECG strip, it needs to 
know whether there is paper installed. This is also checked 
during printing.

■ The thermal paper has queue holes that the writer uses to queue 
to the beginning of a sheet of the Z-fold paper. The writer backs 
the paper up small distance until a queue hole is sensed and 

Shift
Registers Latches Logic

Serial Data

Clock

Burn Signal

Load Signal

Thermal Print
Head Voltage

Resistive
Elements

MD1313-30A
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then proceeds with a report print out (like a 12 lead). When 
backing the paper up, if a queue hole is not sensed in a short 
period of time, the writer then proceeds forward to the next 
queue hole to begin printing. This process is used to print each 
report in a sequential manner, wasting less paper. When 
printing a rhythm strip, no queuing is done, the print out begins 
immediately.

Queue holes

➡

Queue holes 12-lead reportAfter rhythm, 
writer queues 
to next hole

Paper direction

12-lead report
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Controls, Connectors, and Indicators

Front/Top

Back

MUSE

Network Writer

marquette

MD1313-26A

Writer fault LED.
Lit when paper access 
door is open or a paper 
jam has occurred.

Out-of-paper LED.
Lit when MUSE Network 
Writer is out of paper.

Power on/printer busy LED. 
Lit steady when power is on. 
Flashing when MUSE 
Network Writer is printing.

CTLR
BD

F1

F2

WARNING

Replace only with the
same type and rating 
of fuse.

M15287-2B

MD1313-27A

CTLR BD connector. The cable from 
the network writer/local acquisition 
port interface pcb assembly in the 
file server, acquisition server/
processing station or workstation 
computer connects here.

Inlet power connector. 
Connect to wall outlet.

Fuses F1 and F2.
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Cleaning

Cleaning the Thermal
Print Head

The thermal print head should be cleaned every three months. With 
heavy use, or if other than GE Marquette thermal paper is used, there 
may be a buildup of thermal paper coating on the thermal print head 
that degrades print head performance (light or uneven printing). 

If this is happening, clean the thermal print head more often. To clean 
the thermal print head, you will need a nonwoven, nonabrasive cleaning 
material, such as a Techni-Cloth, and rubbing alcohol. Do not use paper 
toweling; it will scratch the thermal print head.

1. Lift the paper access door.

2. Move the paper release lever toward right side of unit.

3. Remove the thermal paper from the paper compartment.

4. Insert the cleaning material into the paper guide and feed 
through until it appears on top of the paper roller. 

5. Dampen the cleaning material with rubbing alcohol. Do not 
saturate the cloth! 

6. Move the paper release lever to the left, i.e. back toward the 
inside of the unit. Manually pull the cleaning material back and 
forth through the thermal writer several times to clean the 
thermal print head.

7. Remove the cleaning material. Allow the cleaning solution on 
the thermal print head to evaporate.

8. Replace the thermal paper.

9. Move the paper release lever to the engage position.

10. Close the cover to the paper compartment.
Revision F8-10 MUSE CV information system
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Adjustments

Thermal Writer
Adjustment Procedures

The chart paper may fail to advance properly for various reasons. There 
may be a problem with the way the paper is positioned in the paper 
compartment, with the position of the queuing sensor or with the paper 
tracking assembly.

Make sure the paper is properly installed in the paper compartment 
before you adjust the paper tracking assemblies. (If you need 
instructions for installing paper, see the operator’s documentation that 
came with the equipment.) Both improperly installed paper and 
improper pressure can cause the paper to track to one side or the other.

Paper Position Adjustment If the chart paper is advancing but pulling to one side, first check that 
the paper is properly positioned. 

1. Move the paper release lever to the right to disengage the 
thermal print head from the paper roller. 

2. Open the paper compartment door. 

3. Try shifting the paper from side to side. The paper should move 
freely with the thermal print head disengaged. 

Thermal Paper Tracking The thermal paper may fail to advance properly due to a problem with 
paper position in the paper compartment, the thermal paper tracking 
assembly, the position of the queuing sensor, or uneven printhead 
pressure.

■ If the thermal paper is advancing but pulling to one side, check 
that the thermal paper is properly positioned. 

■ If the ECG waveforms are not properly aligned on the thermal 
paper when printing starts, the adjustment screws may need 
adjustment.

■ If the paper is tracking to one side, wrinkling or tearing, the 
paper may be improperly positioned or the thermal printhead 

NOTE
Do not adjust the thermal print head spring
plunger screws to correct a paper tracking
problem.

NOTE
If the ECG waveforms are not properly
aligned on the chart paper when printing
starts, the queuing sensor may need to be
adjusted. See “Optic Cable Assembly
(Queuing Sensor) Adjustment” in this
section.
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pressure is uneven. Check the paper position using the steps 
below. If the paper is positioned properly, see “Thermal Paper 
Tracking Adjustment”.

Check that the thermal paper is properly positioned.

1. Press the thermal paper release push button to disengage the 
thermal print head from the thermal paper capstan/roller.

2. Open the thermal paper compartment door.

3. The top and bottom edges of the thermal paper should move 
freely and not press tightly against the paper tray.

Thermal Paper Tracking
Adjustment

1. Insert a small phillips head screw driver through the oval hole 
on the pressure spring and turn the adjustment screw 

NOTE
If the paper is tracking to the top, adjust the
pressure spring on the bottom. Only adjust
one spring.
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counterclockwise until the screw just touches the pressure 
spring.

2. While running a rhythm strip or 12 lead report, carefully adjust 
the screw counterclockwise until the paper tracks correctly.

3. Perform the Roller Test (see “Diagnostic Tests” in chapter 4, 
“Troubleshooting”) to make sure the printhead pressure is 
uniform across the entire length of the paper.

4. Gently tighten (clockwise) the other adjustment screw (the one 
NOT adjusted in step 1) until it meets the frame.

Thermal Print Head Pressure
Adjustment

Printing that is not uniformly dark across the width of the paper 
indicates that the thermal print head pressure needs adjustment. This 
adjustment may also need to be done after replacing the thermal print 
head. 

NOTE
Small adjustments reduce the pressure on
the printhead. Typically, no more than 1/4
turn is needed on only one spring.

Adjustment Screw

Pressure Springs

MD1021-303
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1. Remove the MUSE Network Writer cover. See “Removing/
Installing the Top Cover” if you need to.

2. Remove the spring plunger screws from the thermal writer 
assembly.

3. Apply the Vibra-tite to the area of the male screw threads that 
will be in the writer chassis when assembled (threads should be 
about half full).

4. Allow the Vibra-tite to cure for about 10 minutes.

5. Insert the screw into the writer chassis.

6. Adjust the screws for proper pressure. Use the MT-3434 plunger 
screw feeler gauge.

7. Screw in the screws until the amount of each screw that 
protrudes from the writer chassis is equal to the depth of the 
notch of the feeler gauge.

NOTE
The thermal print head is static sensitive.
Proper grounding is required when handling
the thermal print head. 

MD1313-28A
Vibra-tite
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If the feeler gauge is not available, the depth protruding from 
the chassis can be measured. The measurement is 0.53 inches.

Verify that the thermal writer module is operating properly.

8. Turn on the writer and print a couple of sample reports and look 
at the output.

9. Examine the tracings to verify that the writer is operating 
properly. 

◆ The paper should queue between each report.

◆ If the thermal print head pressure is correct, the printing 
will be uniform in darkness across the width of the paper. 

◆ A burned-out print head element will cause gaps in the 
output that line up horizontally.

◆ Uneven paper speed will cause the output to be wavy in 
spots.

10. If the writer is operating properly, replace the top cover.

MD1313-29A

Plunger Screw

Writer Chassis

Plunger Screw 
Depth Gauge

WARNING

High voltages exist in 
unit. Use insulated 
tools. Remove jewelry. 
Use only one hand 
when possible.

M15287-19B
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Optic Cable Assembly (Queuing
Sensor) Adjustment

If the ECG waveforms are not aligned on the thermal paper properly, the 
queuing sensor may need to be adjusted.

1. Remove the top cover. See “Removing/Installing the Top 
Cover”.

2. Remove the thermal paper from the paper compartment. With 
the thermal paper removed, the queuing sensor mounting 
bracket is visible in the front of the paper compartment. 

3. Blow any dust away from the optic sensor. Sometimes dust 
buildup can cause the sensor to not work properly. If there was a 
lot of dust, try printing a report to see if the problem is fixed 
before continuing with the next step.

4. The queuing sensor is mounted to a bracket and positioned 
directly under the capstan roller. Back out the screws holding 
the queuing sensor in place so the queuing sensor can be moved 
up or down.

5. Adjust the position of the queuing sensor in small increments 
(1/16- to 1/8-inch). Typically you will need to move it closer (up) 
to the capstan roller. The optimal position for the queuing 
sensor is 1/4-inch away from and pointing directly at (but not 
touching) the capstan roller. 

6. Print a couple of reports and look at the output.

7. Examine the tracings to verify that the writer is operating 
properly. 

◆ The paper should queue between each report.

◆ If the thermal print head pressure is correct, the printing 
will be uniform in darkness across the width of the paper. 

◆ A burned-out print head element will cause gaps in the 
output that line up horizontally.

◆ Uneven paper speed will cause the output to be wavy in 
spots.

8. If the writer is operating properly, replace the top cover.

WARNING

High voltages exist in 
unit. Use insulated 
tools. Remove jewelry. 
Use only one hand 
when possible.

M15287-19B
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Writer Door Optic Cable Assembly
Adjustment

If the writer fault LED on the front of the MUSE Network Writer does not 
indicate that the writer door is open, the writer door optic cable 
assembly may need cleaning.

Do this procedure with the MUSE Network Writer powered up.

1. Open the writer door.

2. The optic sensor is mounted to a bracket and pointed at a flange 
on the writer door (when the writer door is closed).

3. Blow any dust away from the optic sensor. Sometimes dust 
buildup can cause the sensor to not work properly. If there was a 
lot of dust, try closing the writer door to see if the problem is 
fixed before continuing with the next step.

4. Back out the screws holding the queuing sensor in place so the 
queuing sensor can be moved up or down.

5. Adjust the position of the optic sensor in small increments (1/
16- to 1/8-inch). The optimal position for the optic sensor is 1/
4-inch away from and pointing directly at (but not touching) the 
flange on the writer door. 

6. Watch the writer fault LED and close the writer door to see if the 
problem is fixed. If not, also check the writer door optic cable 
assembly, the LED pcb assembly, and the motor control pcb 
assembly.
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Jumper/Switch Settings

Motor Control PCB Assembly The motor control pcb assembly has 1 DIP switch.

SW1

Stations 1 – 3 set the thermal print head resistance according to the 
following table.

Station 4 sets the 78310 graphics processor to use external memory, and 
should always be OFF.

Network Writer/Local Acquisition
Port Interface PCB Assembly

The network writer/local acquisition port interface pcb assembly has 1 
jumper.

W1

Jumper W1 sets the I/O address of the network writer/local acquisition 
port interface pcb assembly. The state of W1 depends upon how many 
network writer/local acquisition port interfaces are in the computer. It 
should be set as follows.

Table 8-1. Thermal Print Head Resistance

Thermal Print Head 
Resistance SW1-1 SW1-2 SW1-3

520 Ω to 547 Ω off off off

548 Ω to 575 Ω on off off

576 Ω to 605 Ω off on off

606 Ω to 637 Ω on on off

638 Ω to 670 Ω off off on

671 Ω to 705 Ω on off on

706 Ω to 741 Ω off on on

742 Ω to 780 Ω on on on

Table 8-2. Jumper W1 I/O States

State I/O Address Comment

Removed 300H1

1. I/O address 300H cannot be used with the Rockaway workstation unless
onboard audio is disabled.

Use for 1st network writer/local acquisition 
port interface in a computer.

Installed 310H Use for 2nd network writer/local acquisition 
port interface in a computer.
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Known Problems

Static The plastic writer door on early MUSE Network Writers caused erratic 
writer behavior due to static. Replace the plastic writer door with a 
metal door and handle. See the parts list for the MUSE Network Writer 
assembly to find out the part number that you need to order. (Reference 
Tech Memo DPCMUSE-003-4.)

Failure to Load Writer
DRAM During Boot

This problem occurs in -001, -002, and -003 versions of the network 
writer/local acquisition port interface pcb assembly when the MUSE 
Network Series system is upgraded to version 002A software.

Capacitors C30 and C31 must be changed from 100 pF to 330 pF. Order 
capacitors pn 1281-331, quantity 2. On the -001 version of the board, 
there may not be reference designations silk screened on the board. C30 
and C31 are the capacitors that are piggy-backed across U24. (Reference 
Tech Memo DPCMUSE-016-2.)
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Selecting the Defective Assembly

Writer Diagnostics The diagnostics for the MUSE Network Writer are found in the Service 
directory. To run them, you must first get to DOS. 

To get to the Service directory, do the following steps.

1. From the C:\MEI> prompt, type cd.. and press the Enter key.

2. From the C:\> prompt, type cd service and press the Enter 
key.

Writer Tests Writer tests must be run from the computer to which the MUSE 
Network Writer is connected. If the MUSE Network writer is connected 
to a client, you must borrow a keyboard and VGA monitor from another 
workstation on the network. Alternately, you can borrow from another 
IBM-compatible personal computer. Use any monitor from the MUSE 
Network as all work for these tests.

The first test is a good check of the network writer/local acquisition port 
interface pcb assembly and the writer as a whole. It prints all 17 or so 
report formats to the MUSE Network Writer. Printing all those reports 
takes several minutes, but you can quit out of the test by pressing the 
ESC key.

From the C:\SERVICE> prompt, type pspool allfmts and press the 
Enter key. The power on/printer busy LED flashes while printing is 
going on. When all reports are finished or you escape from the printing, 
the power on/printer busy LED goes on solid. Other tests you can run 
here are:

■ pspool e — prints ECG report formats

■ pspool h — prints high-resolution reports

■ pspool p — prints pacemaker reports

The next test is more complex, and not all of the options are for testing 
the MUSE Network Writer.

1. From the C:\SERVICE> prompt, type host and press the Enter 
key. A screen with many small boxes and one large box appears.

2. Type halt and press Enter.

3. Type boot and press Enter. This activates the small port boxes 
on the top of the screen. Notice that the port box that is missing 
on the top of the screen is enlarged at the bottom of the screen. 
Use the arrow keys to move other small port boxes to the 
bottom of the screen.

The only 2 ports that will help at this point are “port A-b” and 
“port C-d”. In addition, some tests also use “console-a” (where 
you were when you halted and booted).

4. Use the arrow keys to enlarge the port A-b on the bottom of the 
screen.
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5. Type ? and press Enter to get a list of commands. You can do 
this whenever you need to. The commands that start with the 
letter “w” are for the writer. The following steps run through 
these commands.

6. Type wdiag and press Enter. This prints a writer test pattern. 
This test keeps running until you type wstop and press Enter.

◆ Make sure that the diagonal lines are not wavy and that the 
distance between tick marks measures correctly. Wavy lines 
mean the roller is out of round, and should be replaced. 
Inaccurate measurements means that either the roller is out 
of round, or that the motor is going too fast or slow.

◆ Make sure that the darkness of the lines is consistent from 
top to bottom. Inconsistent darkness from top to bottom 
means that thermal print head pressure needs adjustment.

◆ Make sure there are no breaks in the black lines. Breaks in 
the lines means that an element in the thermal print head is 
burned out, and the print head needs replacing. 

7. Type wque and press Enter. The writer should queue the 
thermal paper. If not, check the optical sensor for dust buildup 
and proper position.

8. Type wrunout and press Enter. The thermal paper feeds to the 
next sheet, much like a form feed.

9. Type wcom and press Enter. This sends commands to the 
writer that make the writer step repeatedly at about 1 second 
intervals. To end this test, use the arrow keys to get the console-a 
box at the bottom of the screen. Type halt and press Enter, 
then boot and Enter — just like you did before.

10. Use the arrow keys to get the port A-b box on the bottom of the 
screen again. Type ? and Enter if you want to see the 
commands.

11. Type wset and Enter. The writer settings appear on the screen.

MAC 6/MAC PC Local Acquisition
Port Tests

Port C-d tests the MAC 6/MAC PC Local Acquisition Port and a portion 
of the network writer interface pcb assembly.

1. Use the arrow keys to get port C-d on the bottom of the screen. 
Note that the display says 0 ECGs were received.

2. Connect a GE Marquette cardiograph to the MAC 6/MAC PC 
Local Acquisition Port on the computer and transmit an ECG.

3. The display in port C-d now should say that 1 ECG was received. 
If you transmit more ECGs, they should register in port C-d. The 
actual ECG files for this test go into the Service directory, not 
into the customer’s database.

4. To get out of the writer diagnostics, type halt and Enter.

5. Next, hold down the Ctrl key and press the C key. This gets you 
back to the service directory.
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Removing/Installing the
Top Cover

To remove the top cover of the MUSE Network Writer:

1. Set the power switch to the 0 or “off” position. Unplug the 
power cord from the wall receptacle.

2. Unplug the MUSE Network Writer from the MUSE CV system.

WARNING

Turn off power and 
disconnect power cord 
from AC power source 
before removing the 
cover.

M15287-23C
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3. Disassemble the writer as shown below. Remember to 
disconnect the LED cable.

Installation To attach the top cover, reverse the above procedure.

MUSE

NETWORK WRITER

marquette

2 Places

2 Places

2 Places

B

A

E

C

D MD1313-137A
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Removing/Installing the
Writer Door Optic Cable

Assembly

Removal To remove the writer door optic cable assembly:

1. Remove the top cover. See “Removing/Installing the Top 
Cover”.

2. Before replacing the sensor, make sure there is no dust buildup 
on it. Dust could cause the optic sensor to malfunction.

3. Remove 2 screws holding the optic sensor as shown below.

4. Disconnect the optic cable assembly from the motor control 
pcb assembly.

Installation To install a new writer door optic cable assembly, reverse the above 
procedure. After installation:

1. Connect the power cord and turn the writer on.

2. Watch the writer fault LED and close the writer door to make 
sure the optic sensor is positioned properly.

MD1313-32A

WARNING

High voltages exist in 
unit. Use insulated 
tools. Remove jewelry. 
Use only one hand 
when possible.

M15287-19B
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Removing/Installing the
LED PCB Assembly

Removal Follow these steps to remove the LED pcb assembly.

1. Remove the top cover. See “Removing/Installing the Top 
Cover”.

2. Remove the LED pcb assembly from the top cover as shown 
below:

Installation To install the LED pcb assembly:

1. Reverse the above procedure. 

2. Connect the power cord and turn the writer on. Make sure all 
LEDs work.

marquette

MUSE

NETWORK WRITER

B

A

2 Places

MD1313-33A
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Removing/Installing the
Writer/Tray Assembly

Removal Follow these steps to remove the writer/tray assembly from the MUSE 
Network Writer:

1. Remove the top cover. See “Removing/Installing the Top 
Cover”.

2. Remove the writer/tray assembly as shown below:

Installation Reverse the above procedure to install the writer/tray assembly.

A

C

B

4 Places

MD1313-34A
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Removing/Installing the
Thermal Writer

Assembly

Removal Follow these steps to remove the thermal writer assembly.

1. Remove the top cover. See “Removing/Installing the Top 
Cover”.

2. Remove the writer/tray assembly. See “Removing/Installing the 
Writer/Tray Assembly”.

3. Remove the thermal writer assembly from the paper tray as 
shown below:

Installation Reverse the above procedure to install a new thermal writer assembly.

1. Be sure to write down the thermal print head resistance that is 
found on the end of the new thermal print head. You will need 
this resistance value to properly set switch SW1 on the writer 
interface pcb assembly.

2. Set switch SW1 on the writer interface pcb assembly. See 
“Jumper/Switch Settings” earlier in this section.

A

B
A MD1313-35A
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Disassembly/Assembly Remove the unit’s top cover.

Exploded View This illustration shows an exploded view of the Thermal Writer 
Assembly for reference during disassembly/assembly. Replacing the 
entire assembly is recommended due to its complexity. See Chapter 8, 
“Parts Lists and Drawings” for other field replaceable parts.

WARNING

High voltages exist in 
unit. Use insulated 
tools. Remove jewelry. 
Use only one hand 
when possible.

M15287-19B

WARNING

Only qualified
personnel should 
perform the following 
procedure.

M15287-30A

Paper Tray

4 PL

4 PL

Writer Sub-Assembly

Screws

Washer
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Removing/Installing the
Thermal Print Head

1. Disconnect the writer cables. Press the paper release push 
button to disengage the thermal paper capstan/roller. Slide the 
print head release slide bar until print head is loose.

2. If a rubber bumper pad is installed on the printhead release 
bracket, remove and discard it. 

3. Remove and discard print head.

NOTE
The thermal print head is static sensitive.
Proper grounding is required when handling
the thermal print head. Avoid touching the
pins of the thermal print head. Work on a
static-free work surface.

Slide Bar

MD1021-305

Rubber Bumper
MD1021-304
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4. Install new print head.

5. Slide the print head release slide bar until print head is locked 
into position.

6. Install a new rubber bumper pad PN 4616-001 on the printhead 
release bracket.

7. Reconnect the writer cable.

8. Print a rhythm strip to verify the print head alignment. The 
leading edge of each calibration pulse should not deviate more 
than ±0.5 mm from the vertical edge.

9. If the thermal print head pressure is correct, the printing will be 
uniform in darkness across the width of the thermal paper.

10. If the writer is operating properly, replace the top cover.

NOTE
Make sure print head includes the two brass
alignment pegs.

MD1154-102A

I

II

TOLERATE NO MORE THAN 0.5 mm VARIATION
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Removing/Installing the
Optic Cable Assembly

(Queuing Sensor)

If the queuing sensor is positioned correctly (1/4-inch away and pointed 
directly at capstan roller), but queuing does not work properly, then the 
queuing sensor should be replaced. 

1. Remove the top cover. See “Removing/Installing the Top 
Cover”.

2. Remove the thermal writer assembly. See “Removing/Installing 
the Writer/Tray Assembly” and “Removing/Installing the 
Thermal Writer Assembly”.  

3. Remove the screw securing the optic cable assembly (queuing 
sensor) to the mounting bracket.

4. Install the new optic cable assembly onto the mounting bracket 
and secure it with the screw that was previously removed.

5. Adjust the position of the queuing sensor as directed in the 
paragraphs titled “Optic Cable Assembly (Queuing Sensor) 
Adjustment” in this section.

6. Install the thermal writer assembly in the MUSE Network 
Writer. See “Removing/Installing the Writer/Tray Assembly” 
and “Removing/Installing the Thermal Writer Assembly”.

7. Connect the power cord and turn on the MUSE Network Writer.

8. Print several reports and examine the output.

◆ The paper should queue between each report.

◆ If the thermal print head pressure is correct, the printing 
will be uniform in darkness across the width of the paper. 

◆ A burned-out print head element will cause gaps in the 
output that line up horizontally.

◆ Uneven paper speed will cause the output to be wavy in 
spots.

9. If the writer is operating properly, replace the top cover.

NOTE
The thermal print head is static sensitive.
Proper grounding is required when handling
the thermal writer assembly. Avoid touching
the pins on the thermal print head. Work on a
static-free work surface.

WARNING

High voltages exist in 
unit. Use insulated 
tools. Remove jewelry. 
Use only one hand 
when possible.

M15287-19B
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Removing/Installing the
Power Supply Assembly

Removal Follow these steps to remove the power supply assembly.

1. Remove the top cover. See “Removing/Installing the Top 
Cover”.

2. Remove the writer/tray assembly. See “Removing/Installing the 
Writer/Tray Assembly”.

3. Remove the power supply assembly as shown below:

Installation Reverse the above procedure to install a new power supply assembly.

6 Places

B

C

D

A

3 Wires
7 Wires

MD1313-36A
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Removing/Installing the
Motor Control PCB

Assembly

Removal Follow these steps to remove the thermal writer assembly.

1. Remove the top cover. See “Removing/Installing the Top 
Cover”.

2. Remove the writer/tray assembly. See “Removing/Installing the 
Writer/Tray Assembly”.

3. Remove the fuse holder/inlet power connector, but leave the 
wires connected. (Do this to gain access to the screw in the 
bottom corner of the writer.) There are tabs on the sides of the 
connector that press in to release the connector.

4. Remove the motor control pcb assembly as shown below:

Installation Reverse the above procedure to install a new motor control pcb 
assembly.

B
A

A

MD1313-37A

A

A

C

B
2 Places6 Places

3 Places

MD1313-38A
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Parts Lists: Ordering Parts
Ordering Parts

Introduction The parts lists and assembly drawings in this chapter supply enough 
detail for you to order parts for the assemblies considered field 
serviceable.

If you require additional information, schematic diagrams, or 
troubleshooting assistance, contact Technical Support.

To order parts, contact Service Parts at the address or telephone number 
on the, “How to Reach Us...,” page provided at the beginning of this 
manual.
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Field Replaceable Units

The following items may not be assigned separate manufacturing part 
numbers because they are normally part of a larger assembly. Since they 
are considered field replaceable units (FRUs), they have specific service 
part numbers so they can be ordered and replaced by service 
technicians. Contact Tech Support for FRU information for assemblies 
used on previous configurations.

NOTE
Verify part numbers before ordering service parts
(FRUs). See the tech memo series for this
product for changes or additions to this list.

Table 9-1. Field Replaceable Units

Item Part Number

File Server Computer, INTEL, Nightshade N440BX 900124-801

Bezel Assembly (811152) FRU615917

Fan Bracket (811210) FRU650566

Chassis (811226) FRU651331

Cable, Floppy (811235) FRU654277

Peripheral Drive Rail, 10-Pack (811256) FRU659250

SLT1TERM Terminator Card, 20-Pack (815364) FRU660391

Non-PFC Power Supply, 275W (811265) FRU661386

PFC Power Supply, 275W (816571) FRU661387 

PFC Power Supply, 300W (817877) FRU682139

CPU Retention Mechanism, 10-Pack (815361) FRU669496A

Fan Assembly, 100CFM, 120mm (816569) FRU670060/662116

Front Panel Cable, 10-Pack (817879) FRU684601

Front Panel (817888) FRU695948

L Cover, 10-Pack (818134) FRU650532

L Cover, 10-Pack (818134) FRU650532

Access Cover, 10-Pack (818133) FRU687819

N440BX Country Kit, 10-Pack (817925) FRU687059

CMPTR CPU P3-500 2001640-003
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MEM 256MB DIMM PC100 ECC 2001640-004

DISK DRIVE 18GB LVD 1 INCH 2001640-005

DISK DRIVE CDROM 40X IDE SONY 2001640-006

CABLE RIBBON SCSI 68P W/ TERM 5CONN 3FT 2001640-007

TERMINATOR CPU SLOT 1 2001640-008

CABLE RIBBON IDE 2001640-009

Desktop Client 901070-001

Cocoa Beach Riser FRU674517

Enclosure Assembly FRU668166

Chassis, NLX FRU673679

Side Plate Assembly FRU668541‘

Device Bracket FRU669197

FDD, 3 mode, Dusty Beige FRU682025

Misc parts Assembly FRU690002FAN

Speaker Mount Assembly (Reuters) FRU681699

FDD, Bracket FRU669199

PS, 160/145, NPFC, PS2 FRU668424

PS, 160/145, W/PFC, PS2 FRU668242PFC

Drive, Floppy, 1.44MB, 3-Mode FRU624055

HP Laser Jet 4050N Printer

Toner Cartridge 900623-902

Compaq RAID Server 421519-101

COMPUTER PROLIANT 3000R 450MH 422402-001

SDRAM DIMM KIT 128MB 10NS 422402-002

DDS3 DAT DRIVE 421572-003

SMART2DH RAID CONTROLLER 421572-004

REDUNDANT POWER SUPPLY 421572-005

REDUNDANT FAN KIT 421572-006

ACCELEPORT 8R 920 SER MLTPLR 412946-005

CABLE 8 PORT DB9M 414961-002

Table 9-1. Field Replaceable Units (Continued)

Item Part Number
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KEYBOARD W/TRACKBALL 421572-012

Compaq RAID Server With Rack / UPS 120V 421519-102

COMPUTER PROLIANT 3000R 450MH 422402-001

SDRAM DIMM KIT 128MB 10NS 422402-002

DDS3 DAT DRIVE 421572-003

SMART2DH RAID CONTROLLER 421572-004

REDUNDANT POWER SUPPLY 421572-005

REDUNDANT FAN KIT 421572-006

ACCELEPORT 8R 920 SER MLTPLR 412946-005

CABLE 8 PORT DB9M 414961-002

RACK 22U, COMPAQ 421572-008

KVM SWITCH 4 PORT 421572-009

KVM CABLE SET 421572-010

UTILITY SHELF 421572-011

KEYBOARD W/TRACKBALL 421572-012

KEYBOARD DRAWER 421572-013

MODEM RACK 12 POSITION 418768-001

HUB LINKBUILDER TP/8 10BT 120V 414582-201

UPS, 3KVA 421572-015

Compaq RAID Server With Rack / UPS 220V 421519-103

COMPUTER PROLIANT 3000R 450MH 422402-001

SDRAM DIMM KIT 128MB 10NS 422402-002

DDS3 DAT DRIVE 421572-003

SMART2DH RAID CONTROLLER 421572-004

REDUNDANT POWER SUPPLY 421572-005

REDUNDANT FAN KIT 421572-006

ACCELEPORT 8R 920 SER MLTPLR 412946-005

CABLE 8 PORT DB9M 414961-002

RACK 22U, COMPAQ 421572-008

KVM SWITCH 4 PORT 421572-009

Table 9-1. Field Replaceable Units (Continued)

Item Part Number
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KVM CABLE SET 421572-010

UTILITY SHELF 421572-011

KEYBOARD W/TRACKBALL 421572-012

KEYBOARD DRAWER 421572-013

MODEM RACK 12 POSITION 418768-001

HUB LINKBUILDER TP/8 10BT 120V 414582-201

UPS, 3KVA, 208-240V 421572-020

NOTE
Item numbers refer to figures on page 9-12
and page 9-13.

Table 9-1. Field Replaceable Units (Continued)

Item Part Number

Table 9-2. Field Replaceable Units - Compaq PNs

Item Description Part Number

Chassis (RAID File Server):

1  Chassis 306574-001

2 Side Access Panel 298364-001

3 Access Panel Kit
a) U-Channel Access Panel
b) Top Access Panel 327835-001

4 Front Bezel Door 298360-001

5 Fixed Front Bezel 298361-001

6 Rack-Mount Bezel Plate 298363-001

7 Locking Casters 296227-001

8 Caster Mounting Support 330485-001

SYSTEM COMPONENTS (RAID File Server):

9 Front Fans 306576-001

10 Rear Fan 306577-001

11 Redundant High-Speed Fan 326873-001 *

12 Hot-Plug Power Supply, 750W 1 69286-002

13 Integrated Management Display with Cable 271930-001
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14 Power Switch with LED 387738-001

15 4.5 V Battery Replacement 160274-001

16 Processor, 400/100 MHz 313624-001

17 Processor Power Module 327660-001

18 SCSI Simplex Hot-Plug Cage
a) Hot-plug drive cage with simplex board
b) Removable media panel 179781-001

Boards (RAID File Server):

19 Hot-Plug Power Supply Backplane Board 306571-001

20 System I/O Board with Subpan 306561-001

21 Netelligent 10/100 TX UTP PCI Controller  317606-001

22 IDE CD-ROM with Tray 328707-001

23 1.44-MB Diskette Drive 160788-001

Memory (RAID File Server):

24 24 32-MB SDRAM Memory Module (100 MHz) 317747-001 *

25 25 64-MB SDRAM Memory Module (100 MHz) 317745-001*

26 26 128-MB SDRAM Memory Module (100 MHz) 317756-001

27 27 256-MB SDRAM Memory Module (100 MHz) 317749-001 *

28 28 512-MB SDRAM Memory Module (100 MHz) 317748-001 *

Cable Kits:

29 Miscellaneous Signal Cable Kit 306565-001 *

30 Miscellaneous Power Cable Kit 306566-001 *

31 Wide SCSI Cable with Terminator, 3D, 22-inch 306579-001 *

Miscellaneous:

32 Keyboard 160648-XXX *

33 Miscellaneous Hardware Kit
a) power supply blank panel
b) blank bezel
c) I/O slot card guide * 306567-001

34 Hot-Plug Hard Drive Slot Cover 296200-001

35 Fan Air Baffle (includes miscellaneous parts) 328008-001

36 Return Kit (NA) 298336-001 *

Table 9-2. Field Replaceable Units - Compaq PNs (Continued)

Item Description Part Number
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* Not shown on drawing

37 Carton and Buns (International) 298336-002 *

38 Maintenance and Service Guide 179782-001 *

39 Illustrated Parts Map 179783-001 *

Optione:

40 Processor, 450/100 MHz 179780-001 *

41 SCSI Duplex Hot-Plug Cage 306572-001 *

42 18.2-GB Wide-Ultra Hard Drive with Tray 313764-001 *

43 9.1-GB Wide-Ultra Hard Drive with Tray 199888-001

44 4.3-GB Wide-Ultra Hard Drive with Tray (1-inch) 242622-001 *

45 2.1-GB Wide-Ultra Hard Drive with Tray (1-inch) 242603-001 *

46 Tower-to-Rack Conversion Kit 298337-001 *

47 Option Board Retainer 271918-001 *

48 Display Module 271930-001 *

49 Locking Caster 296227-001 *

50 Processor Board with Tray 179779-001 *

51 Memory Board 270183-001 *

Table 9-2. Field Replaceable Units - Compaq PNs (Continued)

Item Description Part Number
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2
3b

3a

33a

1

33b

18b

34

5

8

76

18a

4

MD1313-41A
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12

1026

13

1

21

18b

9
15

18

14

18a

35

23

17

16

20

22

43

 
MD1313-42A
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FSHRD (Rev A)

Item Number Item Description

FSHRD_SYS_VER MUSE FILE SRVR SYS VERSION PTO OPT CLASS

FSHRD_5A_SYS MUSE FILE SRVR 5A SYSTEM VERSION

FSHRD_5B_SYS MUSE FILE SERVER 5B SYSTEM VERSION

FSHRD_SRVR_TYPE MUSE FILE SRVR TYPE PTO OPT CLASS

FSHRD_TWR_SRVR MUSE TOWER FILE SERVER 8GB

FSHRD_TWR_SRVR_16GB MUSE TOWER FILE SRVR W/16GB

FSHRD_18GB_RAID MUSE 18GB RAID SERVER

FSHRD_45GB_RAID MUSE 45GB RAID SERVER

FSHRD_18GB_RAID_W/RACK MUSE 18GB RAID SERVER W/RACK

FSHRD_45GB_RAID_W/RACK MUSE 45GB RAID SERVER W/RACK

MUSE_MONITORS MUSE MONITORS PTO OPTION CLASS

420609-001 MONITOR 15" COLOR 100-240V

408057-008 MONITOR 17" COLOR SONY

411937-004 MONITOR 21" COLOR SONY

CUST_SUPP_MON CUSTOMER SUPPLIED MONITOR

FSHRD_WRITERS MUSE FILE SRVR WRITERS PTO OPT CLASS

800080-005 PCB 34010 WRITER

MUSE_THRML_PRNTR_BRD MUSE THERMAL PRINTER W/INTFC BRD

900623-003 KIT LSR PRNTR W/WRTR BRD

900623-001 KIT LSR PRNTR PS2 100-120V

FSHRD_ADDTNL_OPT MUSE SERVER ADDTNL OPT PTO OPT CLASS

FSHRD_UPS_RAID MUSE UPS FOR RAID SERVER

POWERCORDS POWERCORD GENERIC PTO OPTION CLASS

80274-006 CORD PWR 125V 6FT STR

80274-004 CORD PWR 125V 6FT SE

401855-001 PWR CRD CONT EURO 10A 250V 8FT

401855-002 PWR CORD BRITISH 10A 250V 8FT

401855-003 PWR CORD ITALIAN 10A 250V 8FT
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401855-004 PWR CORD ISRAELI 10A 250V 8FT

401855-005 WIRE HARNESS 10A 125V 6.5FT

401855-006 WIRE HARNESS 10A 250V 6.5FT

401855-007 PWR CORD SWISS 10A 250V 8FT

401855-008 PWR CORD INDIAN 10A 250V 8FT

401855-009 DANISH 220VAC/50HZ,STRESS

401855-010 PWR CORD AUSTRALN 10A 250V 8FT

401855-101 PWR CORD 10A 8FT CONT EURO STR

401855-102 PWR CORD 10A 8FT BRITISH STR

401855-103 PWR CORD ITALIAN 10A 8FT STR

401855-104 PWR CORD ISRAELI 10A 8FT STR

401855-107 PWR CORD SWISS 10A 8FT STR

401855-108 PWR CORD INDIAN 10A 8FT STR

401855-109 PWR CORD DANISH 10A 8FT STR

401855-110 PWR CORD AUST 10A 8FT STR

401855-201 POWER CORD 16A EURO

401855-202 POWER CORD 13A BRITISH

401855-203 POWER CORD 16A ITALIAN

401855-204 POWER CORD 16A ISRAELI

401855-210 POWER CORD 15A AUST

405535-002 CORD POWER STR 125V 15A 12FT

405535-006 CORD POWER RA 125V 13A 10FT

5509-001 CORD POWER 18-3 SJT

405535-001 POWER CORD RA 125V 13A 12F

414582-222 POWER ADAPTER 230VAC/DC ME

414582-224 POWER ADAPTER 240VAC/DC AA

414582-225 POWER ADAPTER 240VAC/DC UK

415359-001 PWR CRD EURO ADAPTER 1FT

414582-223 POWER ADAPTER 100VAC/DC JAP

FSHRD_LANG LANGUAGE PTO OPTION CLASS MUSE FILE SERVER 
HARDWARE

901073-003 KIT MUSE USER INTFC FILE SRVR

Item Number Item Description
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901073-004 KIT MUSE USER FSRVR GER

901073-005 KIT MUSE USER FSRVR FRE

901073-006 KIT MUSE USER FSRVR ITA

901073-007 KIT MUSE USER FSRVR SPA

901073-008 KIT MUSE USER FSRVR SWE

901073-009 KIT MUSE USER FSRVR DUT

419931-012 MUSE FIELD SERVICE MANUAL 5A

FSHRD_AS_PARTS MUSE FILE SRVR AUTOSLCT PARTS PTO OPT CLASS

405864-011 ASSY MUSE NTWK WRTR

405864-012 ASSY MUSE NTWK WRTR 220-240V

405864-013 ASSY MUSE NTWK WRTR 240V BRIT

408230-008 LABEL CE MARK

408472-202 UPS 120V 60HZ 1.5KVA W/SER CBL

408997-001 CBL 10BASE-T UTP 15FT

411374-203 UPS 220V 1.5KVA W/SER CBL

415847-003 MUSE CV SYS EDITING VIDEO NTSC

419931-032 MUSE RAID 5A INSTALL INST

421520-001 DRV HARD DISK 9.1GB SCSI PL

421572-020 UPS, 3KVA, 208-240V

421860-001 CD REQ MUSE COMPAQ RAID SYS

6511-008 PWR STRIP 15A 125V 6 OUTLETS

800080-005 PCB 34010 WRITER

900124-701 MUSE TOWER FILE SERVER

900623-001 KIT LSR PRNTR PS2 100-120V

901074-001 KIT MUSE 9GB HARD DRIVE

901107-101 COMPAQ SERVER ASSY

901107-102 COMPAQ SERVER ASSY W/UPS 120V

901107-103 COMPAQ SERVER ASSY W/UPS 220V

901124-001 KIT MUSE DAT TAPES/LBLS/CLNG

421572-015 UPS, 3KVA

419931-010 MUSE 5A INSTALLATION INSTRUCT

Item Number Item Description
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414582-201 HUB LINKBUILDER TP/8 10BT 120V

414582-203 HUB OFFICECONN TP/8 10BT 120V

415359-001 PWR CRD EURO ADAPTER 1FT

415359-003 PWR CORD ADAPTER 1FT ASTL/NZEA

415359-004 PWR CORD ADAPTER 1FT UK

Item Number Item Description
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FSSFT (Rev A)

Item Number Item Description

FSSFT_SFTWR_VER FSSFT SOFTWARE VERSION PTO OPT CLASS

2000392-001 KIT MUSE (10) CONCURRENT USERS 5A

2000392-002 KIT MUSE(20)CONCURRENT USERS 5A

2000392-003 KIT MUSE (50) CONCURRENT USERS 5A

2000392-004 KIT MUSE (100) CONCURRENT USERS 5A

FSSFT_5A_SFTWR FSSFT 5A SOFTWARE MODULES

2000392-005 KIT MUSE [10] CONCURRENT USERS 5B

2000392-006 KIT MUSE [20] CONCURRENT USERS 5B

2000392-007 KIT MUSE [50] CONCURRENT USERS 5B

2000392-008 KIT MUSE [100] CONCURRENT USERS 5B

FSSFT_5B_SFTWR FSSFT 5B SOFTWARE MODULES

FSSFT_PROCDR_MOD FSSFT PROCEDURE MODULES PTO OPT CLASS

417516-001 ECG RESTING MODULE MUSE

417516-002 SERIAL COMPARISON MODULE MUSE

417516-004 EXERCISE MODULE MUSE

417516-005 ECHO MODULE MUSE

417516-006 NUCLEAR MODULE MUSE

417516-008 EP MODULE MUSE

417516-009 PACEMAKER MODULE MUSE

417516-010 HOLTER MODULE MUSE

417516-011 CHEST PAIN MODULE MUSE

417516-012 PRE HOSPITAL MODULE MUSE

417516-013 SURGERY MODULE MUSE

417516-014 HISTORY/PHYSICAL MODULE MUSE

417516-015 DISCHARGE SUMMARY MODULE MUSE

FSSFT_CATH_DATA_STOR FSSFT CATH DATA STORAGE

FSSFT_CATH_ADMIN FSSFT CATH ADMINISTRATION

FSSFT_MNGMNT_MOD FSSFT MANAGEMENT MODULES PTO OPT CLASS
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MUSE_CV_DB_APP MUSE CV DATABASE APP

FSSFT_CV_WORD FSSFT CARDIO VASCULAR WORD

417516-019 INVENTORY MODULE MUSE

417516-020 SCHEDULING MODULE MUSE

901206-001 KIT MUSE ACC REGISTRY DRV/SW

FSSFT_ACCESS_MOD FSSFT ACCESS MODULES PTO OPT CLASS

FSSFT_WEB MUSE CV WEB SFTWR

FSSFT_MESSAGING MUSE CV MESSAGING SFTWR

FSSFT_API MUSE CV API SFTWR

FSSFT_CATH_NTWK FSSFT CATHLAB NTWK CONFIG PTO OPT CLASS

MLAB_TCP/IP_NBEUI MACLAB (TCP/IP AND NETBEUI)

MIDAS_TCP/IP MIDAS TCP/IP

MLAB_MIDAS MACLAB AND MIDAS (TCP/IP AND NETBEUI)

419719-001 DISK MUSE OPTIONS DISK

3727-304 DISKETTE 3.5IN DS HD SGLE/BULK

70362-007 LABEL DISKETTE-RED PMS 201

419720-001 CODE MUSE OPTIONS DISK

FSSFT_AS_PARTS FSSFT AUTO SELECT PARTS PTO OPT CLASS

2000424-001 KIT MUSE CV DATABASE APP 5A ENG

2000424-002 KIT MUSE CV DATABASE APP 5B ENG

417087-037 MUSE CV WORD TRAINING VIDEO

419931-005 CARDIOWINDOW OP MANUAL 005A

900958-112 KIT CARDIOWINDOW ADMIN 5A

901020-101 KIT MUSEWORD SERVER 5A

901020-201 KIT MUSEWORD SERVER 5B

901080-001 KIT MUSE CV WEB

901207-001 KIT MUSE API SFTWR 5B

901147-001 KIT MUSE MESSAGING 5A

900958-201 KIT CARDIOWINDOW ADMIN 5B ENG

416057-001 INSTROMEDIX/MUSE INTRFC INST

2001215-001 KIT OPTION MUSE MESSAGING 5B

Item Number Item Description
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CLHRD (Rev A)

Item Number Item Description

CLHRD_LANG MUSE CLIENT HARDWARE LANGUAGE PTO OPTION CLASS

901073-003 KIT MUSE USER INTFC FILE SRVR

901073-004 KIT MUSE USER FSRVR GER

901073-005 KIT MUSE USER FSRVR FRE

901073-006 KIT MUSE USER FSRVR ITA

901073-007 KIT MUSE USER FSRVR SPA

901073-008 KIT MUSE USER FSRVR SWE

901073-009 KIT MUSE USER FSRVR DUT

CLHRD_SYS_VER MUSE CLIENT HRDWR SYS VER PTO OPT CLASS

CLHRD_5A_SYS KIT MUSE CLIENT 5A SYSTEM

CLHRD_4B_SYS MUSE CLIENT 4B SYSTEM

CLHRD_5B_SYS KIT MUSE CLIENT 5B SYSTEM

CLHRD_PC_TYPE MUSE CLIENT HRDWR PC TYPE PTO OPT CLASS

CLHRD_CLIENT_PC CLIENT HRDWR CLIENT PC

CLHRD_GATEWAY CLHRD CLIENT HRWR GATEWAY

CLHRD_CLIENT_MAC8 MUSE CLIENT W/MAC 8 ACQ

CLHRD_GTEWY_MAC8 MUSE CLIENT GATEWAY W/MAC

CLHRD_SMM_MDM_FAX KIT CLIENT SMM W/MODEM AND FAX

CLHRD_SMM_2MDM_FAX CLIENT SMM W/(2) MODEMS AND FAX

CLHRD_4B_COM_FAX CLIENT 4B COM SRVR SDLC/FAX PTO OPT CLASS

CLHRD_4B_COM_FAX_MAC CLIENT 4B COMM SRVR W/FAX/MAC PTO OPT CLASS

MUSE_MONITORS MUSE MONITORS PTO OPTION CLASS

420609-001 MONITOR 15" COLOR 100-240V

408057-008 MONITOR 17" COLOR SONY

411937-004 MONITOR 21" COLOR SONY

CUST_SUPP_MON CUSTOMER SUPPLIED MONITOR

CLHRD_WRITERS CLHRD WRITERS PTO OPT CLASS

MUSE_WRTR_BRD MUSE WRITER INTERFACE BOARD
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MUSE_THRML_PRNTR_BRD MUSE THERMAL PRINTER W/INTFC BRD

MUSE_LSR_PRNTR_BRD MUSE LASER PRINTER 120V W/INTFC BRD

MUSE_LSR_PRNTR MUSE LASER PRINTER 120V

CLHRD_ADDNTL_OPT MUSE CLIENT HD ADDTNL OPT PTO OPT CLASS

CLHRD_CSI_MODEM CLHRD CSI MODEM(S) PTO OPTION CLASS

MUSE_X-MODEM MUSE X-MODEM (DEFIB) PTO OPT CLASS

CLHRD_DICTATION MUSE CLIENT DICTATION PTO OPT CLASS

POWERCORDS POWERCORD GENERIC PTO OPTION CLASS

80274-006 CORD PWR 125V 6FT STR

80274-004 CORD PWR 125V 6FT SE

401855-001 PWR CRD CONT EURO 10A 250V 8FT

401855-002 PWR CORD BRITISH 10A 250V 8FT

401855-003 PWR CORD ITALIAN 10A 250V 8FT

401855-004 PWR CORD ISRAELI 10A 250V 8FT

401855-005 WIRE HARNESS 10A 125V 6.5FT

401855-006 WIRE HARNESS 10A 250V 6.5FT

401855-007 PWR CORD SWISS 10A 250V 8FT

401855-008 PWR CORD INDIAN 10A 250V 8FT

401855-009 DANISH 220VAC/50HZ,STRESS

401855-010 PWR CORD AUSTRALN 10A 250V 8FT

401855-101 PWR CORD 10A 8FT CONT EURO STR

401855-102 PWR CORD 10A 8FT BRITISH STR

401855-103 PWR CORD ITALIAN 10A 8FT STR

401855-104 PWR CORD ISRAELI 10A 8FT STR

401855-107 PWR CORD SWISS 10A 8FT STR

401855-108 PWR CORD INDIAN 10A 8FT STR

401855-109 PWR CORD DANISH 10A 8FT STR

401855-110 PWR CORD AUST 10A 8FT STR

401855-201 POWER CORD 16A EURO

401855-202 POWER CORD 13A BRITISH

401855-203 POWER CORD 16A ITALIAN

Item Number Item Description
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401855-204 POWER CORD 16A ISRAELI

401855-210 POWER CORD 15A AUST

405535-002 CORD POWER STR 125V 15A 12FT

405535-006 CORD POWER RA 125V 13A 10FT

5509-001 CORD POWER 18-3 SJT

405535-001 POWER CORD RA 125V 13A 12F

414582-222 POWER ADAPTER 230VAC/DC ME

414582-224 POWER ADAPTER 240VAC/DC AA

414582-225 POWER ADAPTER 240VAC/DC UK

415359-001 PWR CRD EURO ADAPTER 1FT

414582-223 POWER ADAPTER 100VAC/DC JAP

CLHRD_AS_PARTS CLIENT HRDWR AUTO SELCT PARTS PTO OPT CLASS

405835-009 ASSY MAC6/8 ACQ DESKSIDE

405835-010 ASSY MAC 6/8 ACQ DESKSIDE CE

407122-002 LABEL MUSE NETWORK WRITER

700081-002 HARNESS, MUSE COMI

700461-002 HARN MAC 8/MUSE WRITER SERIAL

800080-005 PCB 34010 WRITER

900129-501 MUSE NETWORK WORKSTATION 120V

900129-502 MUSE NETWORK WORKSTATION 220V

900135-501 MUSE COMMUNICATION SERVER

900266-103 PS/2 BARCODE WAND W/EDIT LABEL

900471-402 KIT NTWK MUSE TWISTED PAIR

900585-501 KIT TRAM 12SL GATEWAY

900585-601 KIT TRAM 12SL GATEWAY 5A

900680-501 MUSE GATEWAY

900684-003 KIT MUSE DIGIBOARD

900684-004 KIT MUSE DIGIBOARD

901078-001 KIT MUSE DISKETTE ACQ

901096-001 ASSY CABLE/BRACKET MAC8/MUSE

900135-502 MUSE COMMUNICATION SERVER CE

Item Number Item Description
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405864-011 ASSY MUSE NTWK WRTR

405864-012 ASSY MUSE NTWK WRTR 220-240V

405864-013 ASSY MUSE NTWK WRTR 240V BRIT

900623-001 KIT LSR PRNTR PS2 100-120V

Item Number Item Description
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CLSFT (Rev A1)

Item Number Item Description

CLSFT_SYS_VER CLIENT SFTWR VERSION PTO OPT CLASS

CLSFT_5A_SYS CLIENT 5A SYSTEM SW PTO OPT CLASS

CLSFT_4B_SYS CLSFT 4B SYSTEM SW PTO OPT CLASS

CLSFT_5B_SYS CLIENT 5B SYS SFTWR PTO OPT CLASS

CLSFT_MMS_HRDWR MUSE CLIENT TYPE PURC W/MMS HDWR PTO OPT CLASS

CLSFT_WS_SW1 CLIENT WS SW SFTWR

CLSFT_GTEWY_SW1 CLSFT GATEWAY SFTWR

CLSFT_GTEWY_WS_SW1 CLIENT GATEWAY WKSTN SOFTWARE

CLSFT_SMM_SW1 CLIENT SMM SOFTWARE

CLSFT_CSI_MDM_MOD1 CLIENT CSI MODEM MODULE SOFTWARE

CLSFT_4B_COMM_SRVR1 CLIENT 4B COMM SERVER SFTWR

CLSFT_CLNT_CSH_COPIES CLSFT CLIENT SW COPIES CUST SUPP PTO OPT CLASS

CLSFT_(1)_CS_CSH CLIENT SFTWR (1) CUST SUP HW

CLSFT_(2)_CS_CSH CLIENT SFTWR (2) CUST SUP HW

CLSFT_(3)_CS_CSH CLIENT SFTWR (3) CUST SUP HW

CLSFT_(4)_CS_CSH CLIENT SFTWR (4) CUST SUP HW

CLSFT_(5)_CS_CSH CLIENT SFTWR (5) CUST SUP HW

CLSFT_(6)_CS_CSH CLIENT SFTWR (6) CUST SUP HW

CLSFT_(7)_CS_CSH CLIENT SFTWR (7) CUST SUP HW

CLSFT_(8)_CS_CSH CLIENT SFTWR (8) CUST SUP HW

CLSFT_(9)_CS_CSH CLIENT SFTWR (9) CUST SUP HW

CLSFT_(10)_CS_CSH CLIENT SFTWR (10) CUST SUP HW

CLSFT_(20)_CS_CSH CLIENT SFTWR (20) CUST SUP HW

CLSFT_(50)_CS_CSH CLIENT SFTWR (50) CUST SUP HW

CLSFT_(100)_CS_CSH CLIENT SFTWR (100) CUST SUP HW

CLSFT_FULLWS_CSH CLSFT FULL WRKSTA LIC 4B PTO OPT CLASS

CLSFT_(1)_WS_CSH WRKSTN SFTWR (1)  CUST SUPP HW

CLSFT_(2)_WS_CSH WRKSTN SFTWR (2)  CUST SUPP HW

CLSFT_(3)_WS_CSH WRKSTN SFTWR (3)  CUST SUPP HW
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CLSFT_(4)_WS_CSH WRKSTN SFTWR (4)  CUST SUPP HW

CLSFT_(5)_WS_CSH WRKSTN SFTWR (5)  CUST SUPP HW

CLSFT_(6)_WS_CSH WRKSTN SFTWR (6)  CUST SUPP HW

CLSFT_(7)_WS_CSH WRKSTN SFTWR (7) CUST SUPP HW

CLSFT_(8)_WS_CSH WRKSTN SFTWR (8) CUST SUPP HW

CLSFT_(9)_WS_CSH WRKSTN SFTWR (9)  CUST SUPP HW

CLSFT_(10)_WS_CSH WRKSTN SFTWR (10) CUST SUPP HW

CLSFT_(20)_WS_CSH WRKSTN SFTWR (20)  CUST SUPP HW

CLSFT_(50)_WS_CSH WRKSTN SFTWR (50)  CUST SUPP HW

CLSFT_(100)_WS_CSH WRKSTN SFTWR (100)  CUST SUPP HW

CLSFT_DSKTP_LIC CLSFT DESKTOP LIC 4B CUST SUPP PTO OPT CLASS

CLSFT_(1)_DS_CSH DESKTOP (1) CUST SUPP HW

CLSFT_(2)_DS_CSH DESKTOP (2) CUST SUPP HW

CLSFT_(3)_DS_CSH DESKTOP (3) CUST SUPP HW

CLSFT_(4)_DS_CSH DESKTOP (4) CUST SUPP HW

CLSFT_(5)_DS_CSH DESKTOP (5) CUST SUPP HW

CLSFT_(6)_DS_CSH DESKTOP (6) CUST SUPP HW

CLSFT_(7)_DS_CSH DESKTOP (7) CUST SUPP HW

CLSFT_(8)_DS_CSH DESKTOP (8) CUST SUPP HW

CLSFT_(9)_DS_CSH DESKTOP (9) CUST SUPP HW

CLSFT_(10)_DS_CSH DESKTOP (10) CUST SUPP HW

CLSFT_(20)_DS_CSH DESKTOP (20) CUST SUPP HW

CLSFT_(50)_DS_CSH DESKTOP (50) CUST SUPP HW

CLSFT_(100)_DS_CSH DESKTOP (1) CUST SUPP HW

CLSFT_CV_WORD_COPIES CLSFT CV WORD COPIES PTO OPT CLASS

CLSFT_(1)_CV_WORD MUSE WRKSTN (1) CV WORD

CLSFT_(2)_CV_WORD MUSE WRKSTN (2) CV WORD

CLSFT_(3)_CV_WORD MUSE WRKSTN (3) CV WORD

CLSFT_(4)_CV_WORD MUSE WRKSTN (4) CV WORD

CLSFT_(5)_CV_WORD MUSE WRKSTN (5) CV WORD

CLSFT_(6)_CV_WORD MUSE WRKSTN (6) CV WORD

Item Number Item Description
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CLSFT_(7)_CV_WORD MUSE WRKSTN (1) CV WORD

CLSFT_(8)_CV_WORD MUSE WRKSTN (8) CV WORD

CLSFT_(9)_CV_WORD MUSE WRKSTN (9) CV WORD

CLSFT_(10)_CV_WORD MUSE WRKSTN (1O) CV WORD

Item Number Item Description
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WSHW (Rev A1)

Item Number Item Description

WSHW_LANG LANGUAGE PTO OPTION CLASS HIS INTERFACE HARDWARE

901073-003 KIT MUSE USER INTFC FILE SRVR

901073-004 KIT MUSE USER FSRVR GER

901073-005 KIT MUSE USER FSRVR FRE

901073-006 KIT MUSE USER FSRVR ITA

901073-007 KIT MUSE USER FSRVR SPA

901073-008 KIT MUSE USER FSRVR SWE

901073-009 KIT MUSE USER FSRVR DUT

901073-012 KIT MUSE USER FSRVR ENGUK

MUSE_MONITORS MUSE MONITORS PTO OPTION CLASS

420609-001 MONITOR 15" COLOR 100-240V

408057-008 MONITOR 17" COLOR SONY

411937-004 MONITOR 21" COLOR SONY

CUST_SUPP_MON CUSTOMER SUPPLIED MONITOR

WSHW_WRITERS HIS WRITERS PTO OPTION CLASS

900623-003 KIT LSR PRNTR W/WRTR BRD

800080-005 PCB 34010 WRITER

900623-001 KIT LSR PRNTR PS2 100-120V

WSHW_ETHRNT_BOARD HIS ADDITIONAL ETHERNET BOARD

WSHW_CSI/MULTI_MDMS HIS CSI/MULTI MODEMS PTO OPT CLASS

MUSE_CSI_MODEMS MUSE CSI MODEMS PTO OPT CLASS

900192-001 KIT MODEM MUSE NETWORK

WSHW_SYS_VER HIS WORKSTA SYS VERSN PTO OPT CLASS

WSHW_SYS_4B HIS WRKSTA SYS 4B PTO OPT CLASS

WSHW_SYS_5A HIS WRKSTA SYS 5A PTO OPT CLASS

WSHW_SYS_5B HIS WRKSTA SYS 5B PTO OPT CLASS

MUSE_RSS_MODEMS MUSE RSS MODEMS PTO OPT CLASS

900723-301 KIT MTECH MODEM EXT 56K 120V
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900723-306 KIT MUSE MODEM 56K EXT UK

900723-308 KIT MUSE MODEM 56K EXT 220V

900723-312 KIT MTECH MODEM EXT 56K ASTL

900723-315 KIT MUSE MODEM 56K EXT BEL

900723-322 KIT MUSE MODEM 56K EXT JAP

900723-326 KIT MUSE MODEM 56K EXT NETH

900723-327 KIT MUSE MODEM 56K EXT NEW ZEA

900723-329 KIT MUSE MODEM 56K EXT POL

900723-337 KIT MUSE MODEM 56K EXT HKNG

900723-339 KIT MUSE MODEM 56K EXT SLVK

900723-340 KIT MUSE MODEM 56K EXT EURO/CE

700021-001 CABLE INTFC MAC LINK

1747-125 CONN PLUG D 25M,

1746-109 CONN RCPT D 9F

1800-301 CONTACT F 20G 24-20

1800-201 CONTACT M 20G 24-20

4901-003 CABLE 3 COND 3/22

1739-102 CONN COV 9PIN D

1739-104 CONN COV D 25 PIN

1747-999 CONN JACK SCREW-D (PKG OF 2)

4535-001 TIE WRAP 4.00LG X .125W

4533-201 SPLICE CE 22-14,

4899-002 WIRE 22 STRD BLACK

4899-003 WIRE 22 STRD RED

4899-004 WIRE 22 STRD GREEN

POWERCORDS POWERCORD GENERIC PTO OPTION CLASS

80274-006 CORD PWR 125V 6FT STR

80274-004 CORD PWR 125V 6FT SE

401855-001 PWR CRD CONT EURO 10A 250V 8FT

401855-002 PWR CORD BRITISH 10A 250V 8FT

401855-003 PWR CORD ITALIAN 10A 250V 8FT

Item Number Item Description
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401855-004 PWR CORD ISRAELI 10A 250V 8FT

401855-005 WIRE HARNESS 10A 125V 6.5FT

401855-006 WIRE HARNESS 10A 250V 6.5FT

401855-007 PWR CORD SWISS 10A 250V 8FT

401855-008 PWR CORD INDIAN 10A 250V 8FT

401855-009 DANISH 220VAC/50HZ,STRESS

401855-010 PWR CORD AUSTRALN 10A 250V 8FT

401855-101 PWR CORD 10A 8FT CONT EURO STR

401855-102 PWR CORD 10A 8FT BRITISH STR

401855-103 PWR CORD ITALIAN 10A 8FT STR

401855-104 PWR CORD ISRAELI 10A 8FT STR

401855-107 PWR CORD SWISS 10A 8FT STR

401855-108 PWR CORD INDIAN 10A 8FT STR

401855-109 PWR CORD DANISH 10A 8FT STR

401855-110 PWR CORD AUST 10A 8FT STR

401855-201 POWER CORD 16A EURO

401855-202 POWER CORD 13A BRITISH

401855-203 POWER CORD 16A ITALIAN

401855-204 POWER CORD 16A ISRAELI

401855-210 POWER CORD 15A AUST

405535-002 CORD POWER STR 125V 15A 12FT

405535-006 CORD POWER RA 125V 13A 10FT

5509-001 CORD POWER 18-3 SJT

405535-001 POWER CORD RA 125V 13A 12F

414582-222 POWER ADAPTER 230VAC/DC ME

414582-224 POWER ADAPTER 240VAC/DC AA

414582-225 POWER ADAPTER 240VAC/DC UK

415359-001 PWR CRD EURO ADAPTER 1FT

414582-223 POWER ADAPTER 100VAC/DC JAP

WSHW_NTWK HIS WRKSTA NETWORK PTO OPT CLASS

900471-402 KIT NTWK MUSE TWISTED PAIR

Item Number Item Description
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408997-001 CBL 10BASE-T UTP 15FT

700461-002 HARN MAC 8/MUSE WRITER SERIAL

4901-026 CABLE 28 AWG FLAT 26 COND

1803-126 CONN POL 26P F RBN

1746-225 CONN RCPT 25F RBN CA

1747-996 SOCKET JACKSCREW D CONN LONG

406978-005 BRACKET IBM G370

1746-209 CONN RCPT D 9F RBN CA

4901-110 CABLE 10 COND 28 AWG

1803-110 CONN POL 10P F

405721-004 ADAPTER ETHERNET 10/100 PCI

900471-202 KIT NTWK MUSE TWISTED PAIR

418295-001 ETHER EZ COMBO NETWORK ADAPTER

407122-004 LABEL MUSE NETWORK ETHER PORT

408997-001 CBL 10BASE-T UTP 15FT

414733-001 DISK SMC ETHERNET

Item Number Item Description
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D900124A MUSE Nightshade Integrated
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MUSE NIGHTSHADE INTEGRATED SERVER – PN 900124-801A

Find 
Num Item Number Item Description Qty

1 2001640-002 CMPTR SERVER NIGHTSHADE 1

2 2001640-003 CMPTR CPU P3-500 1

3 2001640-004 MEM 256MB DIMM PC100 ECC 1

4 2001640-005 DISK DRIVE 18GB LVD 1 INCH 1

5 2001640-006 DISK DRIVE CDROM 40X IDE SONY 1

6 2001640-007 CABLE RIBBON SCSI 68P W/ TERM 5CONN 3FT 1

7 2001640-008 TERMINATOR CPU SLOT 1 1

8 2001640-009 CABLE RIBBON IDE 1
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Compaq Server Assy, 901107-1XX

COMPAQ SERVER ASSY – 901107-101A

Item Part Number Item Description Qty

1 421519-101 COMPAQ SERVER 1

422402-001 COMPUTER PROLIANT 3000R 450MH 1

422402-002 SDRAM DIMM KIT 128MB 10NS 1

421572-003 DDS3 DAT DRIVE 1

421572-004 SMART2DH RAID CONTROLLER 1

421572-005 REDUNDANT POWER SUPPLY 1

421572-006 REDUNDANT FAN KIT 1

412946-005 ACCELEPORT 8R 920 SER MLTPLR 1

414961-002 CABLE 8 PORT DB9M 1

421572-012 KEYBOARD W/TRACKBALL 1

2 404525-001 LABEL BLANK 2 X 3/4 2

3 418201-001 LABEL MUSE CV INFO SYSTEM 1

4 404525-119 LABEL UID SOFTWARE 1

COMPAQ SERVER ASSY W/UPS 120V – 901107-102A

Number Part Number Item Description Qty

1 421519-102 COMPAQ SRVR W/RACK/UPS 100-120 1

422402-001 COMPUTER PROLIANT 3000R 450MH 1

422402-002 SDRAM DIMM KIT 128MB 10NS 1

421572-003 DDS3 DAT DRIVE 1

421572-004 SMART2DH RAID CONTROLLER 1

421572-005 REDUNDANT POWER SUPPLY 1

421572-006 REDUNDANT FAN KIT 1

412946-005 ACCELEPORT 8R 920 SER MLTPLR 1

414961-002 CABLE 8 PORT DB9M 1

421572-008 RACK 22U, COMPAQ 1

421572-009 KVM SWITCH 4 PORT 1

421572-010 KVM CABLE SET 2

421572-011 UTILITY SHELF 2

421572-012 KEYBOARD W/TRACKBALL 1

421572-013 KEYBOARD DRAWER 1

418768-001 MODEM RACK 12 POSITION 1

414582-201 HUB LINKBUILDER TP/8 10BT 120V 1
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421572-015 UPS, 3KVA 1

2 404525-001 LABEL BLANK 2 X 3/4 2

3 418201-001 LABEL MUSE CV INFO SYSTEM 1

4 404525-119 LABEL UID SOFTWARE 1

COMPAQ SERVER ASSY W/UPS 120V – 901107-102A (Continued)

Number Part Number Item Description Qty

COMPAQ SERVER ASSY W/UPS 220V – 901107-103A

Item Item Number Item Description Qty

1 421519-103 COMPAQ SRVR W/RACK/UPS 200-240 1

422402-001 COMPUTER PROLIANT 3000R 450MH 1

422402-002 SDRAM DIMM KIT 128MB 10NS 1

421572-003 DDS3 DAT DRIVE 1

421572-004 SMART2DH RAID CONTROLLER 1

421572-005 REDUNDANT POWER SUPPLY 1

421572-006 REDUNDANT FAN KIT 1

412946-005 ACCELEPORT 8R 920 SER MLTPLR 1

414961-002 CABLE 8 PORT DB9M 1

421572-008 RACK 22U, COMPAQ 1

421572-009 KVM SWITCH 4 PORT 1

421572-010 KVM CABLE SET 2

421572-011 UTILITY SHELF 2

421572-012 KEYBOARD W/TRACKBALL 1

421572-013 KEYBOARD DRAWER 1

418768-001 MODEM RACK 12 POSITION 1

414582-201 HUB LINKBUILDER TP/8 10BT 120V 1

421572-020 UPS, 3KVA, 208-240V 1

2 404525-001 LABEL BLANK 2 X 3/4 2

3 418201-001 LABEL MUSE CV INFO SYSTEM 1

4 404525-119 LABEL UID SOFTWARE 1
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Parts Lists: Compaq Server Assy, 901107-1XX
UPS

PC-1

PC-2

Keyboard
Drawer

Keyboard
Drawer

Notes:
1.  To improve access to Rack Internals:
     Remove screws from front and rear corners
     of Side Panel.  Remove Panel.  For
     shipment, reinstall Side Panel.

2.  To replace Ethernet Hub with Switch:
     A. Disconnect all Ethernet Cables from Hub.
     B. Remove Hub and Hub Power Adapter.
     C. Replace Hub with Switch and connect power.
     D. Reconnect Ethernet Cables to Switch.
For shipment, secure Switch with Tie Straps.

3.  For the -002, and -003, place Label (Item3) on
     front door of rack, centered below the
     Compaq Logo as shown.

KVM

(See Note 1)
SIDE VIEW W/SIDE PANEL REMOVED

///////// SHELF /////////  ////

///////// SHELF /////////

KVM

HUB

COMPAQ 3

Server
(Ref 421519-101)

See Detail

SERVER

PC-2

PC-1

UPS

Modem Rack

Hub
See Note 2

4.  This drawing is part of a product OMAR Structure.
     Any dash numbers need to be added to the
     following drawing:  "FSHRD-OMAR" see OMAR
     shop paper for final configuration.

.5 Ref.
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Parts Lists: Compaq Server Assy, 901107-1XX
DRIVE BAY TABLE:

Drives
Number of

use
Bays to

4 0-3
7 0-6

0

1

2

3

4

5

6

7

FRONT

REAR

901107-101
SERVER DETAIL

7 Ref
Place Label (Item 3) as
shown for the -101 only.
for -102/-103 see Note 3

Drive Bay
Locations

CE Label
apply in
area shown

Hard Drive Installation:
Remove the necessary Drive Bay Filler Plates, and discard.  Install the
Hard Drives with the Logo facing up, per Drive Bay Table, and secure the
Drive Latches.

To install Power Cords (-001 only):
1.  Remove the Power Supply Protector Plate at the rear of the server.
     Reinstall parts for later.
2.  For shipment, reinstall Plate.

Before powering the server:
1.  Remove the Top Cover Panel and reseat all I/O Boards at rear of server.
2.  Replace Cover.

For Shipment:
For each Drive, apply Label provided, to Right-Hand Drive Latch.  Mark
Label with appropriate Bay Number.  Remove Drive from Server and pack
separately.

3

2

4

2 of 4
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Parts Lists: Compaq Server Assy, 901107-1XX
DC 10 9 4
8

1
5

18

VKM

2 M K I V

K

DC

M K V M K V M K V M K M

1 2 3 4

Monitor

KB PDP

to UPS

to UPS
to UPS

to UPS

to UPS

to UPS

to UPS

to UPSto Ext.
Ethernet

Hub Power
Supply

For other than
120V install 1 ft
Power Cord Adptr
as shown

to Ext.
Phone Jack

to Ext.
Phone Jack

to Ext
Phone Jack

Modem Rack

AC

DC

DC DC

Ethernet Hub

Not
Connected

Keypad/Trackball

KVM Switch

PC-2
CSI

PC-1
SDLC

Server

UPS

Ethernet Switch
Optional

to Server

to PC2

to PC1

to EXT. AC

DIAGRAM
INTERCONNECTION

CONFIGURATIONS TABLE SHOWN
CONFIG. #4 FROM PC

V

K

M

B(Com2)

A(Com1)

Install Heavy Duty Line Cord for-103

3 of 4
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Parts Lists: Compaq Server Assy, 901107-1XX
PC Configurations:

#
Config.

Location
PC Function

1 PC1
PC2

Filler Plate
Filler Plate

2 PC1
PC2

SDLC PC
Filler Plate

3 PC1
PC2

CSI PC
Filler Plate

(shown)
4

PC1
PC2

SDLC PC
CSI PC

5 PC1
PC2

SDLC PC
SDLC PC

6 PC1
PC2

CSI PC
CSI PC

Modem/PC Interconnections:

Configs.
PC

Bay
Modem

Type
Modem

to...
Serial cable connects

1,2,5 12 RSS Server - B(Com2)

3,4
1 CSI PC1/PC2 - Com1
2 CSI PC1/PC2 - Com2
12 RSS Server - B(Com2)

6

1 CSI PC1 - Com1
2 CSI PC1 - Com2
3 CSI PC2 - Com1
4 CSI PC2 - Com2
12 RSS Server - B(Com2)

12

101112

3

5

8

6

9

4

7

To Phone Jack
DC
Pwr

Server
To PC or

MODEM RACK (REAR VIEW)

Modem Bays

CABLE ROUTING
CSI (REAR VIEW)

CABLE ROUTING
SDLC (REAR VIEW)

Rack
To Modem

To UPS/PDU

To UPS

Jack
To Phone

AC

AC

MODEM DETAIL

PC DETAIL

To Install External Modems:
Set Modems in appropriate Bay per Modem Detail and connect per Modem/PC
Interconnections Table. Secure Cables as shown in Modem Detail.

For Shipment:
Insert Packing Foam between Modems and Door to prevent vibrations.

To Install the 1st PC(PC-1)
Remove the Filler Plate from the front of the Rack in the PC-1 area. Set the PC on
the Shelf, forward-facing, flush with the front of the Shelf. Connect the appropriate
Cables provided (KVM #1 and Ethernet). Connect per Modem Detail and route Cables as
shown per Cable routing views.

To Install the 2nd PC(PC-2)
Remove the Filler Plate from the front of the Rack in the PC-2 area. Set the PC-2 on
top of PC-1, forward-facing, aligned with PC-1. Connect the appropriate Cables provided
(KVM #2 and Ethernet). Connect per Modem Detail and route Cables as shown per Cable
routing views.

For Shipment:
Disconnect all Cables from all PC's. Remove PC's from Rack and pack separately. Any
Filler Plates should be shipped along with unit, not discarded.
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Parts Lists: 901070-001 (Rev E) MUSE Desktop Assembly
901070-001 (Rev E) MUSE Desktop Assembly

901070-001E MUSE Desktop Assembly

Item Item Number Item Description Qty

1 410783-201 COMPUTER ROCKAWAY DESKTOP 1

2 419793-002 SDRAM 32MB DIMM 1

3 2000714-001 DISK DRIVE HARD 4.3G ULTRA ATA EIDE 3.5 1

4 45074-608 SCREW BDGH 6-32X1/4 3

5 410784-105 DISK DRIVE CDROM 40X EIDE (NOT DVD) 1

6 404525-001 LABEL BLANK 2 X 3/4 1

7 420862-003 LABEL MUSE ROCKAWAY BOX POWER 1

8 418201-001 LABEL MUSE CV INFO SYSTEM 1
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Parts Lists: 901070-001 (Rev E) MUSE Desktop Assembly
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Parts Lists: 901070-001 (Rev E) MUSE Desktop Assembly
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Parts Lists: 900135-501(Rev G) Communication Server
900135-501(Rev G) Communication Server

Item Part Number Item Description Qty

1 410783-112 CMPTR INBUS 133MHZ 80MB ZAPPA 1

2 404525-001 LABEL BLANK 2 X 3/4 1

3 413739-001 LABEL SET MUSE 1

4 6121-218 DRIVE HARD DSK 2.1GB AT 1

5 900881-001 KIT MS-DOS 6.2 LIC/DISK 1

6 414752-001 CODE MUSE VENDOR 1

7 900881-004 KIT PCI VIDEO BOARD LIC/DISK 1

8 900881-011 KIT MUSE CD-ROM/DISK 1

9 900881-002 KIT WFW 3.1 LIC/DISK 1

10 45000-604 SCREW SEMS PH 6-32X1/4, 4
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Parts Lists: 900135-501(Rev G) Communication Server
occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

(-501)

(-502)

Ref

To COM1 Connection
on the Mother -Board

Detail A Connections

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

Detail B Adapter

ACQ Port Option
Mounting Screws
supplied by interior
cover plate removal
See Detail A for 
Connector placement

8

1 Ref

Pop off Cover - to remove
Screws.  Then install
Adapter internally as
shown.  See Detailed
instructions in
TP•300123-XXX

10 4 PL

2 Print Model and
Serial number
to be determined

4

Part of ACQ Port
Ref See Detail A

Ref Code Adapter and
Label - Model and Serial
Number to be determined.
Mounted to "LPT" Port.
(-502, the Adapter is
mounted internally
See Detail B)

7

  CBL 10 Base - T
Ref only

MEI Modem
Option

Network Writer PCB
Ref only
See Detail A
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Parts Lists: 900680-501 (Rev G) MUSE Gateway
900680-501 (Rev G) MUSE Gateway

Item Part Number Item Description Qty

1 410783-112 CMPTR INBUS 133MHZ 80MB ZAPPA 1

2 900881-011 KIT MUSE CD-ROM/DISK 1

3 6121-218 DRIVE HARD DSK 2.1GB AT 1

4 900881-001 KIT MS-DOS 6.2 LIC/DISK 1

5 900881-004 KIT PCI VIDEO BOARD LIC/DISK 1

8 900881-002 KIT WFW 3.1 LIC/DISK 1

9 413739-001 LABEL SET MUSE 1

10 404525-001 LABEL BLANK 2 X 3/4 1

11 414752-001 CODE MUSE VENDOR 1

12 45000-604 SCREW SEMS PH 6-32X1/4, 4
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Parts Lists: 900129-5XX (Rev J) Network Workstation
900129-5XX (Rev J) Network Workstation

900129-501 Rev J

Item Part Number Item Description Qty

1 410783-112 CMPTR INBUS 133MHZ 80MB ZAPPA 1

2 900881-004 KIT PCI VIDEO BOARD LIC/DISK 1

3 403590-199 MICROSOFT MOUSE 1

4 6121-218 DRIVE HARD DSK 2.1GB AT 1

5 900266-103 PS/2 BARCODE WAND W/EDIT LABEL 1

6 413739-001 LABEL SET MUSE 1

7 900881-001 KIT MS-DOS 6.2 LIC/DISK 1

8 900881-011 KIT MUSE CD-ROM/DISK 1

9 900881-002 KIT WFW 3.1 LIC/DISK 1

10 414752-001 CODE MUSE VENDOR 1

13 404525-001 LABEL BLANK 2 X 3/4 1

15 45000-604 SCREW SEMS PH 6-32X1/4, 4

16 900508-001 KIT MUSE KEYBOARD ENGLISH 1

19 422310-001 MOUSEPAD GE MARQUETTE 1

900129-502 Rev J

Item Part Number Item Description Qty

1 410783-112 CMPTR INBUS 133MHZ 80MB ZAPPA 1

2 900881-004 KIT PCI VIDEO BOARD LIC/DISK 1

3 403590-300 MOUSE, EMI 1

4 6121-218 DRIVE HARD DSK 2.1GB AT 1

5 900266-103 PS/2 BARCODE WAND W/EDIT LABEL 1

6 413739-001 LABEL SET MUSE 1

7 900881-001 KIT MS-DOS 6.2 LIC/DISK 1

8 900881-011 KIT MUSE CD-ROM/DISK 1

9 900881-002 KIT WFW 3.1 LIC/DISK 1

10 414752-001 CODE MUSE VENDOR 1

13 404525-001 LABEL BLANK 2 X 3/4 1

15 45000-604 SCREW SEMS PH 6-32X1/4, 4

16 900508-001 KIT MUSE KEYBOARD ENGLISH 1

19 422310-001 MOUSEPAD GE MARQUETTE 1
Revision F 9-45MUSE CV information system
419931-012



Parts Lists: 900129-5XX (Rev J) Network Workstation
5 

Monitor Option
Ref 405866-006 (15")
Ref 408057-007 (17")
Ref 411937-003 (20")

Part of Furniture
Option Kit
Ref 900136-002

1 See Sheet 2

3

19

16

1 of 2
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Parts Lists: 900129-5XX (Rev J) Network Workstation
Mac 8 Harness
Ref only
See Detail A

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

(-501)

(-502)

Ref

To COM1 Connection
on the Mother -Board

Detail A Connections

Network Writer PCB
Ref only
See Detail A Ref Optional

Soundboard Kit
900811-001

Ref Optional
Network Interface Card
900471-40X

Cable 10BASE - T
Ref only

2

1

Ref Code Adapter and
Label - Model and Serial
Number to be determined.
Mounted to "LPT" Port.
(-502 the Adapter is
Mounted internally
See Detail B)

13

4

Pop off Cover - to remove
Screws, then install
Adapter internally as
shown.  See Detailed
instructions in
TP #900123-XXX. 

ACQ Port Option
Mounting Screws
supplied by interior
cover plate removal
See Detail A for
connector placement

8

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

occupees par des patients.

ATTENTION: Ne pas utiliser dans les salles

CAUTION: For use in nonpatient areas only.

MAC 8

Diskette

Read

MAC PC

MAC 6

Detail B Adapter
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Parts Lists: 405864-011 (Rev A) Network Writer Assembly
405864-011 (Rev A) Network Writer Assembly

Item Part Number Item Description Qty
1 1903-006 CONN FUSE HLDR/SW/IEC .10 PNL 1
2 400303-104 WRITER ASSEMBLY MAC VU 1
4 401493-001 FOOT RUBBER .75DIA 8-32THD 4
5 402019-001 SCREW 100FLHD 4-40 X 3/8 8
6 404525-001 LABEL BLANK 2 X 3/4 1
8 4528-005 CLAMP CORD SMALL 1
9 405715-001 BEZEL MUSE NTWK WRTR 1

10 405820-001 LABEL LED MUSE NETWORK WRTR 1
11 405874-001 INSULATOR MUSE WRTR PWR SPLY 1
12 405875-001 PWR SPLY 15V 110W SWITCHER 1
13 4520-806 WASHER LOCK EXT/INT #6 1
16 45000-606 SCREW SEMS PH 6-32 X 3/8, 4
17 45046-810 SCR PHIL FLH 8-32 X 5/8 SS 2
18 45074-408 SCREW BDGH 4-40 X 1/4, 3
19 45074-608 SCREW BDGH 6-32X1/4 12
20 45142-002 HINGE INVISIBLE SOSS 101 2
22 4521-706 NUT HEX KEPS 6-32, 2
23 4550-031 WASHER BELLEVILLE .56X.19X.028 2
24 4641-606 SCREW BLK PH 6-32 X 3/8, 4
25 4640-808 SCREW BLK W/WSHR 8-32 X 1/2 4
26 80307-053 WIRE, 16GA GRN/YEL 4L 1
27 58016-004 TRAY PAPER MUSE WRITER 1
28 58017-002 BUTTON PPR TRAY MTG CASE 15 2
29 420310-001 S/OFF 3/8 HEX 1.63 LG 8-32F/F 4
30 420311-001 S/OFF 3/8 HEX 2.00 LG 8-32F/F 1
31 700083-001 CBL INT PWR MUSE WRTR 1
33 800118-001 PCB MUSE WRTR MOT CONT 1
34 800120-001 PCB MUSE WRTR LED 1
36 700111-001 CBL PWR/PWR SPLY MUSE WRTR 1
39 80616-001 CABLE 10 COND RBN 11IN 1
40 80862-002 CABLE PWR DIST MUSE NTWK WRTR 1
42 4520-004 WASHER FLAT SS #4, 1
43 4502-410 SCREW PH 4-40 X 5/16, 1
44 88114-006 CBL DOOR OPT SNSR MUSE WRTR 1
45 420447-001 BRACKET SENSOR 1
46 420287-001 KIT METAL MUSE NTWK WRTR 1
47 408230-008 LABEL CE MARK 1
48 4656-406 SPACER M/F 4-40 X 0.375 3
49 80307-041 WIRE 16GA BROWN 2.5L 1
Revision F9-48 MUSE CV information system
419931-012



Parts Lists: 405864-011 (Rev A) Network Writer Assembly
51 4851-070 ADHESIVE LOCKTITE 425 .01
52 700145-001 CABLE MUSE WRITER INTCON 1
53 1910-212 FUSE 3AG 2 1/2A SB 2
54 9402-024 PAPER CHART 155MM FF CASE/8-STRESS 1
55 407200-001 ASSY BOX MUSE NTWK WRTR 1
56 406831-001 HANDLE WRITER DOOR 1
57 411780-002 BUTTON WRITER MAC 6/15/VU MAX1 1

Item Part Number Item Description Qty

26

BD
CTLR

F1

F2

CAUTION

WARNING-RISK OF
FIRE. REPLACE FUSES

AS MARKED.
F1&F2-2.5ASB/250V

2.5A/100-120V
50-60 Hz

1

H
I A
C

LO A
C

G
N

D

E1

MUSE

NETWORK WRITER

T
B

1

T
B

2

N L

N

N

L

2 PL
2 PL

2 PL

3 PL

See View D

3 PL

27

18
34

33

43
42
51

11

48

4 PL

E1 Ref
Ref

25

W6 Ref

Label printed with Model and
Serial Number (to be determined)

40

17

6 PL

Remove these two
screws from Writer Assy
then reassemble with Sensor
Bracket in place

19

2 PL

4 PL

2 PL
See View B

24

Ref
420285-001

46

TB1, TB212

8

CE Mark Label47
W8 Ref44

10

45

2

6

4

22

2 PL

at F1 and F2
See View C

24

1
53

4 PL16

8 PL Ref W2

Notched corner
towards this corner

5

9

28

2 PL

Ref

W3

Ref
405655-004

20
56

19

36
57

46

Ref
420286-001

46

13
22

36

Ref26

2223

Adhesive Tape
applied to Base

View A

View B

View C

View AView D

J1

Lead
Ident.

Item
No.

From
CKT. PT. Item No.

To
CKT. PT. Item No.

W1

W2
W5

W6

W7

36

26
39

40

31

1, J1-L
1, J1-N
7, E1
1, J1-Ground
34, J1

33, J3

TB2-7 (RED)
TB2-6 (RED)
TB2-5 (RED)

TB2-8 (BLK)
TB2-9 (BLK)
TB2-10 (BLK)

TB2-4 (WHT/RED)
TB2-11 (WHT/BLK)

12

12, TB1-AC HI
12, TB1-AC LO
12, TB1-Ground

7, E1
33, J2

2

33

J1 (Paper Sensor)
J2 (Motor)
J3 (Print Head)
J1-1
J1-2
J1-3
J1-4
J1-6
J1-7
J1-8
J1-9
Revision F 9-49MUSE CV information system
419931-012



Parts Lists: 405864-012 (Rev A) Network Writer Assembly (220-240V)
405864-012 (Rev A) Network Writer Assembly (220-240V)

Item Part Number Item Description Qty
1 1903-006 CONN FUSE HLDR/SW/IEC .10 PNL 1
2 400303-104 WRITER ASSEMBLY MAC VU 1
4 401493-001 FOOT RUBBER .75DIA 8-32THD 4
5 402019-001 SCREW 100FLHD 4-40 X 3/8 8
6 404525-001 LABEL BLANK 2 X 3/4 1
8 4528-005 CLAMP CORD SMALL 1
9 405715-001 BEZEL MUSE NTWK WRTR 1

10 405820-001 LABEL LED MUSE NETWORK WRTR 1
11 405874-001 INSULATOR MUSE WRTR PWR SPLY 1
12 405875-001 PWR SPLY 15V 110W SWITCHER 1
13 4520-806 WASHER LOCK EXT/INT #6 1
14 412084-004 SPACER A4 .05 THK MAC15/6/VU 1
15 412084-003 SPACER A4 .125 THK MAC15/6/VU 1
16 45000-606 SCREW SEMS PH 6-32 X 3/8, 4
17 45046-810 SCR PHIL FLH 8-32 X 5/8 SS 2
18 45074-408 SCREW BDGH 4-40 X 1/4, 3
19 45074-608 SCREW BDGH 6-32X1/4 12
20 45142-002 HINGE INVISIBLE SOSS 101 2
21 412203-001 SCREW, FLT HD M3 X 8MM LG, 2
22 4521-706 NUT HEX KEPS 6-32, 2
23 4550-031 WASHER BELLEVILLE .56X.19X.028 2
24 4641-606 SCREW BLK PH 6-32 X 3/8, 4
25 4640-808 SCREW BLK W/WSHR 8-32 X 1/2 4
26 80307-053 WIRE, 16GA GRN/YEL 4L 1
27 58016-004 TRAY PAPER MUSE WRITER 1
28 58017-002 BUTTON PPR TRAY MTG CASE 15 2
29 420310-001 S/OFF 3/8 HEX 1.63 LG 8-32F/F 4
30 420311-001 S/OFF 3/8 HEX 2.00 LG 8-32F/F 1
31 700083-001 CBL INT PWR MUSE WRTR 1
33 800118-001 PCB MUSE WRTR MOT CONT 1
34 800120-001 PCB MUSE WRTR LED 1
36 700111-001 CBL PWR/PWR SPLY MUSE WRTR 1
39 80616-001 CABLE 10 COND RBN 11IN 1
40 80862-002 CABLE PWR DIST MUSE NTWK WRTR 1
42 4520-004 WASHER FLAT SS #4, 1
43 4502-410 SCREW PH 4-40 X 5/16, 1
44 88114-006 CBL DOOR OPT SNSR MUSE WRTR 1
45 420447-001 BRACKET SENSOR 1
46 420287-001 KIT METAL MUSE NTWK WRTR 1
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Parts Lists: 405864-012 (Rev A) Network Writer Assembly (220-240V)
47 408230-008 LABEL CE MARK 1
48 4656-406 SPACER M/F 4-40 X 0.375 3
49 80307-041 WIRE 16GA BROWN 2.5L 1
51 4851-070 ADHESIVE LOCKTITE 425 .01
52 700145-001 CABLE MUSE WRITER INTCON 1
53 1908-160 FUSE METRIC 1.6A SL0-BLO 2
54 9402-021 CHART PAPER 195MM A4 FF CASE/8 1
55 407200-001 ASSY BOX MUSE NTWK WRTR 1
56 406831-001 HANDLE WRITER DOOR 1
57 411780-002 BUTTON WRITER MAC 6/15/VU MAX1 1

Item Part Number Item Description Qty
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Parts Lists: 405864-012 (Rev A) Network Writer Assembly (220-240V)
25

26

BD
CTLR

F1

F2

CAUTION

WARNING-RISK OF
FIRE. REPLACE FUSES

AS MARKED.
F1&F2-2.5ASB/250V

2.5A/100-120V
50-60 Hz

2
3
0
V

A
C

VAC
115

1

H
I A
C

LO A
C

G
N

D

E1

MUSE

NETWORK WRITER

T
B

1

T
B

2

N L

N

N

L

2 PL
2 PL

2 PL

3 PL

See View E
Relocate Jumper Wire
from 115V AC Post
to 230V AC Post

3 PL

27

18
2 PL21

34

15

14

33

11

48

4 PL

E1 Ref
Ref

W6 Ref

Label printed with Model and
Serial Number (to be determined)

40

17

6 PL

Remove these two
screws from Writer Assy
then reassemble with Sensor
Bracket in place

19

2 PL

4 PL

2 PL
See View B

24

TB1, TB2
See View D

12

CE Mark Label47
W8 Ref44

10

45

2

6

4

22

2 PL

at F1 and F2
See View C

24

1
53

4 PL16

8 PL Ref W2

Notched corner
towards this corner

5

9

28

2 PL

Ref

W3

Ref
405655-004

20
56

19

36
57

46

Ref
420286-001

46

13
22

36

Ref26

2223

Adhesive Tape
applied to Base

View A

View D

View B

View C

View A
View E

J1

Ref
420285-001

46

8

43
42
51

Lead
Ident.

Item
No.

From
CKT. PT. Item No.

To
CKT. PT. Item No.

W1

W2
W5

W6

W7

36

26
39

40

31

1, J1-L
1, J1-N
7, E1
1, J1-Ground
34, J1

33, J3

TB2-7 (RED)
TB2-6 (RED)
TB2-5 (RED)

TB2-8 (BLK)
TB2-9 (BLK)
TB2-10 (BLK)

TB2-4 (WHT/RED)
TB2-11 (WHT/BLK)

12

12, TB1-AC HI
12, TB1-AC LO
12, TB1-Ground

7, E1
33, J2

2

33

J1 (Paper Sensor)
J2 (Motor)
J3 (Print Head)
J1-1
J1-2
J1-3
J1-4
J1-6
J1-7
J1-8
J1-9
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Parts Lists: 405864-013 Rev A) Network Writer Assembly (240 V) Brit
405864-013 Rev A) Network Writer Assembly (240 V) Brit

Item Item Number Item Description Qty
1 1903-006 CONN FUSE HLDR/SW/IEC .10 PNL 1
2 400303-104 WRITER ASSEMBLY MAC VU 1
4 401493-001 FOOT RUBBER .75DIA 8-32THD 4
5 402019-001 SCREW 100FLHD 4-40 X 3/8 8
6 404525-001 LABEL BLANK 2 X 3/4 1
8 4528-005 CLAMP CORD SMALL 1
9 405715-001 BEZEL MUSE NTWK WRTR 1

10 405820-001 LABEL LED MUSE NETWORK WRTR 1
11 405874-001 INSULATOR MUSE WRTR PWR SPLY 1
12 405875-001 PWR SPLY 15V 110W SWITCHER 1
13 4520-806 WASHER LOCK EXT/INT #6 1
14 412084-004 SPACER A4 .05 THK MAC15/6/VU 1
15 412084-003 SPACER A4 .125 THK MAC15/6/VU 1
16 45000-606 SCREW SEMS PH 6-32 X 3/8, 4
17 45046-810 SCR PHIL FLH 8-32 X 5/8 SS 2
18 45074-408 SCREW BDGH 4-40 X 1/4, 5
19 45074-608 SCREW BDGH 6-32X1/4 12
20 45142-002 HINGE INVISIBLE SOSS 101 2
21 412203-001 SCREW, FLT HD M3 X 8MM LG, 2
22 4521-706 NUT HEX KEPS 6-32, 2
23 4550-031 WASHER BELLEVILLE .56X.19X.028 2
24 4641-606 SCREW BLK PH 6-32 X 3/8, 4
25 4640-808 SCREW BLK W/WSHR 8-32 X 1/2 4
26 80307-053 WIRE, 16GA GRN/YEL 4L 1
27 58016-004 TRAY PAPER MUSE WRITER 1
28 58017-002 BUTTON PPR TRAY MTG CASE 15 2
29 420310-001 S/OFF 3/8 HEX 1.63 LG 8-32F/F 4
30 420311-001 S/OFF 3/8 HEX 2.00 LG 8-32F/F 1
31 700083-001 CBL INT PWR MUSE WRTR 1
33 800118-001 PCB MUSE WRTR MOT CONT 1
34 800120-001 PCB MUSE WRTR LED 1
36 700111-001 CBL PWR/PWR SPLY MUSE WRTR 1
39 80616-001 CABLE 10 COND RBN 11IN 1
40 80862-002 CABLE PWR DIST MUSE NTWK WRTR 1
42 4520-004 WASHER FLAT SS #4, 1
43 4502-410 SCREW PH 4-40 X 5/16, 1
44 88114-006 CBL DOOR OPT SNSR MUSE WRTR 1
45 420447-001 BRACKET SENSOR 1
46 420287-001 KIT METAL MUSE NTWK WRTR 1
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Parts Lists: 405864-013 Rev A) Network Writer Assembly (240 V) Brit
47 408230-008 LABEL CE MARK 1
48 4656-406 SPACER M/F 4-40 X 0.375 3
49 80307-041 WIRE 16GA BROWN 2.5L 1
50 401861-001 KIT LABELS MAC VU ST BR 1
51 4851-070 ADHESIVE LOCKTITE 425 .01
52 700145-001 CABLE MUSE WRITER INTCON 1
53 1908-160 FUSE METRIC 1.6A SL0-BLO 2
54 9402-021 CHART PAPER 195MM A4 FF CASE/8 1
55 407200-001 ASSY BOX MUSE NTWK WRTR 1
56 406831-001 HANDLE WRITER DOOR 1
57 411780-002 BUTTON WRITER MAC 6/15/VU MAX1 1

Item Item Number Item Description Qty
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Parts Lists: 405864-013 Rev A) Network Writer Assembly (240 V) Brit
25

26

BD
CTLR

F1

F2

CAUTION

WARNING-RISK OF
FIRE. REPLACE FUSES

AS MARKED.
F1&F2-2.5ASB/250V

2.5A/100-120V
50-60 Hz

2
3

0
V

A
C

VAC
115

1

H
I A
C

LO A
C

G
N

D

E1

MUSE

NETWORK WRITER

T
B

1

T
B

2

N L

N

N

L

2 PL
2 PL

2 PL

3 PL

See View E
Relocate Jumper Wire
from 115V AC Post
to 230V AC Post

3 PL

27

18
2 PL21

34

15

14

33

11

48

4 PL

E1 Ref
Ref

W6 Ref

Label printed with Model and
Serial Number (to be determined)

40

17

6 PL

Remove these two
screws from Writer Assy
then reassemble with Sensor
Bracket in place

19

2 PL

4 PL

2 PL
See View B

24

TB1, TB2
See View D

12

CE Mark Label47
W8 Ref44

10

45

2

6

4 50

22

2 PL

at F1 and F2
See View C

24

1
53

4 PL16

8 PL Ref W2

Notched corner
towards this corner

5

9

28

2 PL

Ref

W3

Ref
405655-004

20
56

19

36
57

46

Ref
420286-001

46

13
22

36

Ref26

2223

Adhesive Tape
applied to Base

View A

View D

View B

View C

View A
View E

J1

Ref
420285-001

46

8

43
42
51

Lead
Ident.

Item
No.

From
CKT. PT. Item No.

To
CKT. PT. Item No.

W1

W2
W5

W6

W7

36

26
39

40

31

1, J1-L
1, J1-N
7, E1
1, J1-Ground
34, J1

33, J3

TB2-7 (RED)
TB2-6 (RED)
TB2-5 (RED)

TB2-8 (BLK)
TB2-9 (BLK)
TB2-10 (BLK)

TB2-4 (WHT/RED)
TB2-11 (WHT/BLK)

12

12, TB1-AC HI
12, TB1-AC LO
12, TB1-Ground

7, E1
33, J2

2

33

J1 (Paper Sensor)
J2 (Motor)
J3 (Print Head)
J1-1
J1-2
J1-3
J1-4
J1-6
J1-7
J1-8
J1-9
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Parts Lists: 400303-104 Rev C) 8-Inch Writer Assembly
400303-104 Rev C) 8-Inch Writer Assembly

Item Item Number Item Description Qty
1 413453-002 WRITER SUB-ASSY MAC VU 1
2 411101-002 TRAY PPR CS216 MAC VU 1
3 411059-006 SCREW SEMS PH M3-.5X6 ZIN, 4
5 4520-006 WASHER FLAT SS #6, 4
6 57966-001 STRAP PAPER PULLER 12 IN WTR 1
7 57967-001 PLATE PAPER PULLER 12IN WTR 1
8 412203-001 SCREW, FLT HD M3 X 8MM LG, 2

3
3

1

3 2 PL

2 PL

67

8 2 PL

5 2 PL

5 2 PL

Install Item 6 with
glossy side up
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Parts Lists: 413453-002 Rev E) Writer Sub-Assembly
413453-002 Rev E) Writer Sub-Assembly

Item Item Number Item Description Qty
2 413785-001 SCREW FLAT&EXTT SEMS M3 X 6 2
3 411864-001 TAPE - BUTTON UNIVERSAL 1
4 4534-905 TERM FASTON .25 DUAL 45 BLADES 2
5 415472-001 COVER ROLLER STAMPED C-SCAN 1
6 4616-001 PAD RBR BUMP .5 OD, 1

4
2

2

6

3

5

2 PL

2 PL

2 PL
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Parts Lists: 900723-XXX International Modems
900723-XXX International Modems

Generic 220V

Germany

France

900723-008A Generic 220V 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT 220V 407109-008        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-308A Generic 220V 56K
Item Description Part Number Qty

1 MODEM MULTITECH 56K EXT 220V 407109-308        1
2 LABEL MUSE MODEM MULTITECH-56 415266-002        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-340A Euro/CE 220V 56K
Item Description Part Number Qty

1 MODEM 56K EUmEXT 220V 407109-340 1
2 LABEL MUSE MODEM MULTITECH-56 415266-002        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-002A Germany, 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT GER 407109-005        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-003A France 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT FRE 407109-007        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1
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Parts Lists: 900723-XXX International Modems
Sweden

United Kingdom

Spain

Italy

Australia

900723-006A Sweden 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT SWE 407109-009        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-007A United Kingdom 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT UK 407109-006        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-010A Spain 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT SPA 407109-010        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-011A Italy 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT ITA 407109-011        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-012A Australia 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT ASTL 407109-012        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1
Revision F 9-59MUSE CV information system
419931-012



Parts Lists: 900723-XXX International Modems
Austria

Bahrain

Belgium

Czechoslovakia

900723-013A Austria 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT AUST 407109-013        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-014A Bahrain 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT BAHR 407109-014        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-015A Belgium 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT BEL 407109-015        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-315A Belgium 56K
Item Description Part Number Qty

1 MODEM MULTITECH 56K EXT BEL  407109-315       1
2 LABEL MUSE MODEM MULTITECH-56 415266-002 1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-016A Czechoslovakia 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT CZEC 407109-016        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1
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Parts Lists: 900723-XXX International Modems
Denmark

Finland

Hungary

Iceland

Ireland

900723-017A Denmark 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT DEN 407109-017        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-018A Finland 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT FINL 407109-018        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-019A Hungary 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT HUNG 407109-019        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-020A Iceland 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT ICEL 407109-020        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-021A Ireland 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT IRE 407109-021        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1
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Japan

Russia

Malaysia

Mexico

900723-022A Japan 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT JAP 407109-022        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-322A Japan 56K
Item Description Part Number Qty

1 MODEM MULTITECH 56K EXT JAP 407109-322        1
2 LABEL MUSE MODEM MULTITECH-56 415266-002        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-023A Russia 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT RUSS 407109-023        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-024A Malaysia 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT MALY 407109-024        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-025A Mexico 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT MEX 407109-025        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1
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Parts Lists: 900723-XXX International Modems
Netherlands

New Zealand

Norway

900723-026A Netherlands 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT NETH 407109-026        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-326A Netherlands 56
Item Description Part Number Qty

1 MODEM MULTITECH 56K EXT NETH 407109-326        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-027A New Zealand 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT NZEA 407109-027        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-327A New Zealand 56K
Item Description Part Number Qty

1 MODEM 56K EXT NEW ZEAL 407109-327 1
2 LABEL MUSE MODEM MULTITECH-56 415266-002 1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001 1

900723-028A Norway 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT NOR 407109-028        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1
Revision F 9-63MUSE CV information system
419931-012



Parts Lists: 900723-XXX International Modems
Poland

Portugal

Singapore

South Africa

900723-029A Poland 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT POL 407109-029        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-329A Poland 56K
Item Description Part Number Qty

1 MODEM MULTITECH 56K EXT POL 407109-329        1
2 LABEL MUSE MODEM MULTITECH-56 415266-002        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-030A Portugal 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT PORT 407109-030        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-031A Singapore 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT SING 407109-031        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-032A South Africa 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT SAFR 407109-032        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1
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Switzerland

Turkey

Ukraine

Hong Kong

Slovak Republic

900723-033A Switzerland 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT SWIT 407109-033        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-034A Turkey
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT TURK 407109-034        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-035A Ukraine 19.2K
Item Description Part Number Qty

1 MODEM MULTITECH 19.2K EXT UKR 407109-035        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-337A Hong Kong 56K
Item Description Part Number Qty

1 MODEM MULTITECH 56K EXT HKNG 407109-337        1
2 LABEL MUSE MODEM MULTITECH-56 415266-002        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

900723-339A Slovak Republic 56K
Item Description Part Number Qty

1 MODEM MULTITECH 56K EXT SLVK 407109-339        1
2 LABEL MUSE MODEM MULTITECH-56 415266-002        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1
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Parts Lists: Kits
Kits

900811-001 (Rev C) – KIT MUSE DICTATION

900811-001 (Rev C) – KIT MUSE DICTATION

Item Part Number Item Description Qty

1 417702-002 DISK SOUND BLASTER 4171 1

2 406044-004 PCB SOUNDBLASTER SB 4171 1

3 407268-002 HEADSET STEREOPHONE/MICRO KOSS 1

4 407268-003 HEADSET VOLUME CONTROL KOSS 1

900684-003 (Rev C) – KIT MUSE DIGIBOARD

Item Part Number Item Description Qty

2 412946-002 BOARD SERIAL PORT MULTIPLEXER 1

3 414945-002 DISK DIGIWARE 1.4.4 1

4 414961-001 CABLE DIGIBOARD 4 PORT 1

900684-004 (Rev B) – KIT MUSE DIGIBOARD

Item Part Number Item Description Qty

1 412946-004 SERIAL PORT MULTIPLXR 920 PCI 1

2 414961-001 CABLE DIGIBOARD 4 PORT 1

3 407122-013 LABEL MUSE NETWORK 1

900471-201 (Rev C) – KIT NTWK MUSE THIN ETHERNET

Item Part Number Item Description Qty

1 418295-001 ETHER EZ COMBO NETWORK ADAPTER 1

2 407122-004 LABEL MUSE NETWORK ETHER PORT 1

3 406405-001 ADAPTER BNC TEE F-M-F 1

4 700109-015 CBL PVC THIN-NET COAX 15FT 1

4 414733-001 DISK SMC ETHERNET 1

901215-001 (Rev A) – KIT MUSE WRITER BRD/CBL NON-CE

Item Part Number Item Description Qty

1 800080-005 PCB 34010 WRITER

2 700461-002 HARN MAC 8/MUSE WRITER SERIAL
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901206-001 (Rev A1) – KIT MUSE ACC REGISTRY DRV/SW

Item Part Number Item Description Qty

1 422185-001 ZIP DRIVE EXT PARALLEL PORT 1

2 422186-001 DISK 100MB ZIP 10 PACK .3

3 417516-022 ACC REGISTRY MODULE MUSE 1

4 419719-001 DISK MUSE OPTIONS DISK 1

901124-001 (Rev A) – KIT MUSE DAT TAPES/LBLS/CLNG

Item Part Number Item Description Qty

1 413628-201 DAT CARTRIDGE 125 METER DDS-3 11

2 409669-001 DAT TAPE HEAD CLEANING KIT 1

3 420920-001 LABEL SET MUSE DAT TAPES 1

2000390-001 (Rev A) – KIT MUSE FS UPGR 200MHZ 5A ENG

Item Part Number Item Description Qty

1 6121-928 DRIVE HRD 9.1GB LP ULT 1

2 45000-603 SCREW SEMS PH 6-32 X 3/16 PHIL 1

3 420859-001 CODE REQ MUSE VENDOR SFTWR 1

4 407109-301 MODEM MULTITECH 56K EXT 120V 1

5 415266-002 LABEL MUSE MODEM MULTITECH-56K 1

6 420858-001 CD-R MUSE VENDOR SOFTWARE PKG 1

7 419931-019 MUSE FIELD UPGRADE INSTR 005A 1

8 413628-001 DAT CARTRIDGE 120 METER DDS-2 11

9 420920-001 LABEL SET MUSE DAT TAPES 1

10 421341-001 CABLE SERIAL 9 PIN UPS 1

11 421075-001 DISK MUSE RESIDUAL TRANSFER 1

12 421424-001 CARTON DISK DRIVE W/FOAM 1

13 700139-001 CA IBM/AT DB9 F/DB25 M 6FT 1

14 409669-001 DAT TAPE HEAD CLEANING KIT 1

22 419931-012 MUSE FIELD SERVICE MANUAL 5A 1

23 901063-021 KIT MUSE FILE SRV VENDR SW INT 1
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901072-001 (Rev B) – Kit MUSE DAT Drive 12GB 

Find Num Item Number Item Description Qty

1 413627-004 DRIVE DAT DDS-3 12GB 1

2 413628-201 DAT CARTRIDGE 125 METER DDS-3 11

3 409669-001 DAT TAPE HEAD CLEANING KIT 1

4 413629-001 MOUNTING KIT DDS-2 DAT 1

5 418212-001 ADAPTER 68 TO 50 PIN 1

6 411059-001 SCREW SEMS PH M3- .5X8 4

7 420920-001 LABEL SET MUSE DAT TAPES 1
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Parts Lists: Sub-Assemblies
Sub-Assemblies

Wire 16 GA Brown 2.5L
(PN 80307-041B)

Wire 16 GA Grn/Yel 4L
(PN 80307-053A)

Cable 10 Conductor
Ribbon 11 Inch (PN

80616-001H)

NOTE
Sub-assemblies in this section are in
numerical order by Part Number.

Item Description Part Number Qty
3 RCPT FASTON .032 X .250 16-14 405582-007        2

15 WIRE 16 STRD BROWN 4889-007          0.21

Item Description Part Number Qty
1 TERMINAL .250X.032 FIQC 16-14 410039-001        1
2 TERMINAL 6 RING 16-14 4531-106          1
3 WIRE 16 STRD GN/Y 4889-036          0.33

Item Description Part Number Qty
1 CONN POL 10P F RBN 1803-110          2
2 CABLE 10 COND 28 AWG 4901-110          1.02
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Parts Lists: Sub-Assemblies
Cable Power Dist MUSE
Network Writer (PN

80862-002A)

Cable Door Opt Sensor
MUSE Writer (PN 88114-

006)

Item Description Part Number Qty
1 CONN POL 50P F RBN 1803-150          1
2 CONN POL 26P F RBN 1803-126          1
3 CONN,PLUG WO/MTG EARS M RBN 1813-110          1
4 CONN POL 14P F RBN 1803-114          1
5 CABLE 28AWG FL 50 COND 4901-050          0.71

Item Description Part Number Qty
1 CONT STD .025F 26-22 1779-003          4
2 CONN HSG PLZS .1 10P 2X5 1783-110          1
3 SENSOR 2797-125          1
4 TUBING FIT-221 1/8 BLK 4882-104          0.50
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Parts Lists: Sub-Assemblies
MAC6/8 Acquisition
Deskside Assy – (PN

405835-009D)

Kit Metal MUSE Network
Writer (PN 420287-

001B)

Cable Internal MUSE
Network I/O (PN 700081-

001B)

MAC 6/8 Acquisition Deskside Assy – 405835-009D

Item Part Number Description Qty

1 405789-004 PLATE FRONT I/O MAC 8/MUSE 1

2 411045-002 BRKT MTG I/O PNL MUSE 1

3 411660-002 LABEL MAC 8/MUSE AM PORT 1

5 45074-412 SCREW BDGH 4-40X3/8, 7

6 4644-710 NUT HEX KEPS 10-32 2

7 700081-001 CBL INTERNAL MUSE NTWK I/O 1

8 800080-005 PCB 34010 WRITER 1

9 800106-004 PCB MUSE I/O NETWORK CE 1

10 5516-011 CABLE STRAIGHT 6FT NON-KEYED 1

11 4520-004 WASHER FLAT SS #4, 3

12 700461-002 HARN MAC 8/MUSE WRITER SERIAL 1

13 700060-004 CABLE MAC 8/MUSE CSI INTFC 6FT 1

16 700491-002 CABLE D9 M/D9 F MAC 8/MUSE 1

Item Description Part Number Qty
1 DOOR ACCESS WRITER MUSE 405655-004        1
2 CHASSIS MUSE NTWK WRTR 420285-001        1
3 COVER MUSE NTWK WRTR 420286-001        1

Item Description Part Number Qty
1 CONN POL 10P F RBN 1803-110          2
2 CABLE 10 COND 28 AWG 4901-110          1.75
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Parts Lists: Sub-Assemblies
Cable INT Power Writer
(PN 700083-001C)

Cable PVC Thin-net Coax
15Ft (PN 700109-015B)

Cable Pwr/Pwr Supply
MUSE Writer (PN

700111-001D)

Item Description Part Number Qty
2 CONTACT MR F 26-18AWG 1787-001          8
3 CONN RCPT MR AMP 9F 1786-509          1
4 TERMINAL 6 RING 22-16 4531-006          8
5 WIRE 18 STRD BLK 4888-002          5.50
6 WIRE 18 STRD RED 4888-003          5.50
7 WIRE 22 STRD WHT/BLK 4899-011          1.83
8 WIRE 18 STRD WH/RD 4888-012          1.83

Item Description Part Number Qty
1 CONN BNC CRIMP FOR PVC MALE 406407-002        2
2 CBL PVC THIN-NET COAX CRIMP 406537-001        15

Item Description Part Number Qty
1 TERMINAL 6 RING 22-16 4531-006          4
2 TUBING FIT-221 1/4 BLK 4882-106          0.37
3 CORD POWER 16-3 SJT 5510-004          1.83
4 RCPT FASTON .032 X .250 16-14 405582-007        2
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Parts Lists: Sub-Assemblies
Cable Writer Intcon (PN
700145-001A)

Harness MAC 8/MUSE
Writer Serial (PN

700461-002C)

Cable D9 M/D9 F MAC 8/
MUSE (PN 700491-002E)

Item Description Part Number Qty
1 SHELL D CONN 37PIN EMI 3M 1739-537          2
2 CONN D TYPE RBN M 37PIN 3M 1747-737          2
3 STRAIN RELIEF 37PIN D CONN 3M 1747-992          2
4 CABLE RND RBN W/SHLD 37 COND 4901-337          6

Item Description Part Number Qty
1 CABLE 28 AWG FLAT 26 COND 4901-026          1.09
2 CONN POL 26P F RBN 1803-126          1
3 CONN RCPT 25F RBN CA 1746-225          1
4 SOCKET JACKSCREW D CONN LONG 1747-996          2
5 BRACKET IBM G370 406978-005        1
6 CONN RCPT D 9F RBN CA 1746-209          1
7 CABLE 10 COND 28 AWG 4901-110          2
8 CONN POL 10P F RBN 1803-110          1

Item Description Part Number Qty
1 CONN COV 9PIN D 1739-102          2
3 CONN RCPT D 9F 1746-109          1
4 CONN PLUG D 9M 1747-109          1
5 CONN JACK SCREW-D (PKG OF 2) 1747-999          2
6 CONTACT M 20G 24-20 1800-201          9
7 CONTACT F 20G 24-20 1800-301          9
8 TIE WRAP 4.00LG X .125W 4535-001          2
9 CABLE 3 COND 3/22 4901-003          1.50
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Parts Lists: Sub-Assemblies
Kit Modem (PN 900192-
001C)

PS/2 Barcode Wand with
Edit Label (PN 900266-

103E)

Twisted Pair PCI (PN
900471-402D)

Kit Keyboard – English
(PN 900508-001D)

Item Description Part Number Qty
1 PCB MUSE NETWORK MODEM 800116-001        1
2 CBL TEL 4 COND MOD PLUG 14FT 80159-014         2
3 LABEL FCC MODEM MUSE 407160-002        1
4 LABEL MUSE NETWORK MODEM 407122-001        1

Item Description Part Number Qty
1 BARCODE READER KEYWAND 413999-001        1
2 EDIT LABEL 414226-002        1

Item Description Part Number Qty
1 ETHERLINK 3/16 BIT COMBO 414582-001 1
2 LABEL MUSE NETWORK ETHER PORT 407122-004        1
3 CBL 10BASE-T STP 15FT 408997-001        1
4 DISK 3COM ELINK III 4.1 414811-001 1

Item Description Part Number Qty
1 KEYBOARD PS/2 CONN INTEL ENG 408237-101 1
2 LABEL MUSE KEYBOARD 413738-001        1
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Parts Lists: Sub-Assemblies
Kit Laser Printer PS2 –
100-120V (PN 900623-

001D)

Kit Laser Printer PS2 –
220-240V (PN 900623-

002E)

Item Description Part Number Qty
1 LASER PRINTER, 4000N, 100-120V 413678-201 1
2 CABLE PARALLEL PRNTR 8-12 FT 6119-101 1
4 PAPER 20LB BOND WHITE 8 1/2x11 9242-101 1
5 PAPER CS BOND 8-5 X 11 5PKS/CS 9402-053 0.20
6 LABEL LASERGRAPH PRINTER 420522-001 1
7 LABEL MUSE NETWORK LASER PRTR 407122-012 1

Item Description Part Number Qty
1 LASER PRINTER, 4000N 220-240V 413678-202 1
2 CABLE PARA PRNT W/FERR 8-12FT 6119-103          1
4 PAPER 20LB BOND WHITE 8 1/2x11 9242-101          1
5 PAPER CS BOND 8-5 X 11 5PKS/CS 9402-053          0.20
6 LABEL LASERGRAPH HELLIGE VRSN 420522-002 1
7 LABEL MUSE NETWORK LASER PRTR 407122-012        1
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Parts Lists: Sub-Assemblies
Kit Multitech Modem –
120V (PN 900723-001A)

Kit PCI Video Board (PN
900881-004C)

Kit MUSE CD-ROM/Disk
(PN 900881-011B)

Item Description Part Number Qty
1 MODEM MULTITECH 19.2K EXTERNAL 407109-004        1
2 LABEL MUSE MODEM MULTITECH 19. 415266-001        1
3 CA IBM/AT DB9 F/DB25 M 6FT 700139-001        1

Item Description Part Number Qty
1 BOARD VIDEO HI-RES VX+ 415997-005        1
2 DISK ATI GRAPHICS XPRESS 2.22 418585-001        1

Item Description Part Number Qty
1 CD-ROM DRIVE SONY 24X IDE 410784-102 1
2 DSK MUSE CD VENDOR SONY DRIVER        418250-001        1

NOTE
Do NOTconnect office connect switch to
another switched port. The port to which the
switch is connected must be able to handle
multiple MAC layer addresses.
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Standard Abbreviations 

A

A ampere
A-ang antianginal
A-arh antiarrhythmic
A-coa anticoagulants
A-hyp antihypertensive
A1 - A4 auxiliary leadwires
AAMI American Association of Medical 

Instrumentation
ABP ambulatory blood pressure
ac, AC alternating current
ACLS Advanced Cardiac Life Support
A/D analog-to-digital
Adj adjustable
AG automotive glass
Ah ampere hours
AHA American Heart Association
Al aluminum
AllRam all RAM
AllSec all sector
AllTrk all track
ALT alternate
Alt-Off alternate offset
am, AM acquisition module, ante meridiem
AM-1 acquisition module-1
AM-1M acquisition module-1 modified
AM-2 acquisition module-2
AM-3 acquisition module-3
AM-4 acquisition module-4
amp ampere
Ampl amplifier
AMU ambulatory monitoring unit
ANA analog
ANLG analog
AnsrTone answer tone
A/O Analog Output
ASCII American Standard Code for Information 

Interchange
ASSY assembly
Attn attention
AUG August
AUST Australian
AUSTRALN Australian
Auto automatic
AutoRhym automatic rhythm
AUX auxiliary
aVF augmented left leg lead
avg average
aVL augmented left arm lead

aVR augmented right arm lead
AWG American Wire Gage

B

Bd board, baud
BDGH binding head
BetaB beta blockers
BKSP backspace
BLK black
BLU blue
Blvd boulevard
BP blood pressure
BPM beats per minute
BRIT Britain
BRN brown
BSI British Standards Institute
Btu British thermal unit

C

CalcBlk calcium blockers
CAPOC Computer Assisted Practice of 

Cardiology
CASE Computer Aided System for Exercise
Catoprl Catopril
Cauc Caucasian
Cer ceramic
CFM cubic feet/minute
CGR computer graphic record
Ch, CH channel
C/L center line
CLK clock signal
Clonid Clonidine
cm centimeter
cm2 square centimeters
Cmd command number
CMMR common mode rejection ratio
CMOS complementary metal-oxide 

semiconductor
c/o in care of
COM1 communications port 1
COM2 communications port 2
ComLink communications link
Comp composition
Confrmd confirmed
Cont, CONT Continental, continued
Coumadn Coumadin
CPR cardiopulmonary resuscitation
CPU central processing unit
CR diode
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CRC cyclic redundancy check
CRD cord
crt, CRT cathode ray tube
CSA Canadian Standards Association
CTRL control

D

D/A digital to analog
DA damping relay
dac, DAC digital-to-analog converter
DAN Danish
Dat/Tim date/time
dBm decibel (referenced to 1 milliwatt into 

600 ohms)
dc, DC direct current
DD double density, day
DDD Digital Diagnostic Diskette
DEC Digital Equipment Corporation, 

December
Del delete
DEMO demonstration
DES designation
DevId device identification
Diag diagnostic
Digital Digitalis
Digitox Digitoxin
Digox digoxin
Digoxin Digoxin-Lanoxin
DIP dual in-line package
Dirctry directory
Diurt diuretics
DOB date of birth
DOS disk operating system
DP diametral pitch
DPST double-pole, single-throw
DRAM dynamic RAM
DR/DT digital recording/digital transmission
DSKTP desktop
Dysopyr Dysopyramide

E

E enable, vector electrode site, vector lead
ecg, Ecg, ECG electrocardiogram
ECO Engineering Change Order
EDIC Electrocardiograph Digital Information 

Center
EEPROM electrically erasable programmable ROM
e.g. for example
EGA enhanced graphics adapter
EMF electromotive force
EMI electromagnetic interference
ENG English
EOF end of file
EPIC Electronic Patient Information Chart

EPLD electrically programmable logic device
EPROM eraseable, programmable, read-only 

memory
ESD electrostatic discharge
etc, etc. et cetera
EURO Europe, European
EXP Expanded

F

F fuse, Farad, female
F1-F5 function keys 1 through 5
Fax facsimile
FCC Federal Communications Commission
FE front end
FILH fillister head
FLH flat head
FLRAM flash RAM
FR French
FrntEnd front end
FSK frequency shift keying
ft foot, feet
Furosem Furosemide

G

g gram, acceleration due to gravity
GB Great Britain
GERM German, Germany
GND ground, digital ground (dc common)
GRN green
GRY gray

H

H high, vector electrode site, vector lead
HDLC high-level data link control
Hex, HEX hexagon, hexadecimal
HH hour
HiRes high-resolution
Hr hour
Hydral Hydralazine
Hz Hertz (cycles per second)

I

I on, input, vector electrode site
I, II, III limb leads
II vector lead
IC integrated circuit
ID identification
i.e. that is
IEC International Electrotechnical Commission
in inch
IN input
inc, inc., INC incorporated
Info information
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Ins insert
I/O input/output
I/P input
ISA industry standard architecture
Isosorb Isosorbide
IT Italian, Italy

J

JAN January
JIS Japan Industrial Standards

K

k, K kilo, 1000, 1024
Kb, KB kilobyte
kg, Kg kilogram
kHz, KHz kilohertz
kV, KV kilovolt
Kyb keyboard

L

L line
L1 level one
L2 level two
LA left arm
lb pound
LCD liquid crystal display
Lcl Line local line
Ld Grps lead groups
LED light-emitting diode
LH left hand
Lidoca Lidocaine
LL left leg
Loc location
LocPc Local MAC PC
LogRetry log retry
Ltd limited

M

m meter
M megabyte, metric, vector electrode site, 

vector lead, male
mA milliamperes
MAC Microcomputer Augmented Cardiograph
mains voltage voltage of a supply mains between 2 line 

conductors of a polyphase system or 
voltage between the line conductor and 
the neutral of a single-phase system

max maximum
Measure measurements
Med medications
MEM memory
MF metal film
MHz megahertz

min minutes, minimum
Misc miscellaneous
mm millimeter
MM minute
MMM month
mm/mV millimeter per millivolt
mm/s millimeter per second
MMS Marquette Medical Systems
Modem modulator/demodulator
MOS metal oxide semiconductor
MPE metallized polycarbonate expitaxial
ms milliseconds
MS-DOS Microsoft Disk Operating System
MTBF mean time between failures
mtg mounting
MTR MOTOR
MUSE Marquette Universal System for 

Electrocardiography
mux multiplexer
mV millivolt
mVR minus (inverted) aVR

N

N neutral
n/a not available
NA not applicable
NC no connection
Nitrate nitrates
NLQ near letter quality
NMI non-maskable interrupt
NMOS N-channel metal-oxide semiconductor
No number
NO normally open
norm normal
nS nanoseconds
NSR Normal Sinus Rhythm

O

O off, original
OE other errors
OEM original equipment manufacturer
OH off-hook relay
OneSec one sector
ORG orange
Orig original
OUT output
oz ounce

P

P P wave (section of the ECG waveform)
p-p peak-to-peak
PA P wave amplitude
Params parameters
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Passwds passwords
PatData patient data
PatInfo patient information
PATN patient
PC printed circuit, personal computer
PCB printed circuit board
pF picofarad
Pgm program
PgmId program identification
Phenoth Phenothiazide
Phenytn Phenytoin
PID patient identification digit
PLCC plastic leadless chip carrier
PM power module
pm, PM post meridiem, preventive maintenance
PM-2 Power Module-2
PM-3 Power Module-3
pn, PN part number
PNH pan head
PPA P wave amplitude
PR ECG signal interval
Pro-Off progressive offset
Procain Procainamide
PROM programmable read-only memory
Propran Propranolol
PSK phase shift keying
PSU power supply unit
Psych psychotropic
PUP pull-up signal
PVC polyvinyl chloride
PWM pulse-width modulation
PWR power
PWR CRD power cord

Q

Q transistor
QA quality assurance, Q wave amplitude
QAD Quality Assurance Deviation
QAM quadrature amplitude modulation (phase 

and amplitude modulation)
QC quality control
QD Q wave duration
QRS QRS complex (portion of ECG waveform), 

interval of ventricular depolarization
QT QRS interval
QTC QRS interval
QTY quantity
Quinid Quinidine

R

R resistor, red, reset
RA right angle, right arm or R wave 

amplitude
RAM random access memory

RC resistor capacitor
RD R wave duration
Ref reference, refresh
REN Ringer Equivalence Number
Reserp Reserpine
REV revision
RevdBy reviewed by
RevXmit reverse transmission
rf radio frequency 
RFI radio frequency interference
RGB red, green, blue
RI ring indicate
RL right leg
RMR Rhythm and Morphology Report
ROM read only memory
RPA R wave amplitude
RPD R wave duration
rpt, Rpt report
RTC real time clock
RTN return
RVS reverse
R/W read/write

S

12SL 12 simultaneous leads
s, S second, select, switch
SA s wave amplitude
SB slow-blow
SCL safe current limits
SD schematic diagram, S wave duration
SE serial input/output errors
sec second
sec.s seconds
SEER Solid-state Electronic ECG Recorder
SING Singapore
SP Spanish
SPA S wave amplitude
SPDT single-pole, double-throw
SRAM static RAM
ST-T ST-T wave (section of the ECG 

waveform)
standrd, Standrd standard
STD standard
STE ST segment displacement at the end
STJ ST segment displacement at the J point
STM ST segment displacement at the mid-

point between STJ and STE
stmts, Stmts statements
SumRam some RAM
supply mains permanently installed power source
SVT power cord type; 300 V
sw, SW switch, software
SW Swedish, Sweden
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T

T Tone touch tone
TA T wave amplitude
Tant tantalum
TDML treadmill
TE timeout errors
Tech technical
Thiazid Thiazide
TM trademark
Tot total number or errors
TP test point
TPA T’ wave amplitude
TRAM Transport Remote Acquisition Monitor
Tricyli Tricylic antidepressant
TTL transistor-transistor logic, TTL levels
TVS transient voltage suppressor

U

UE undefined errors
uF microfarad
UL Underwriters’ Laboratory, Inc
Unconf unconfirmed
UUT unit-under-test

V

v, V volt, volts
V1-V6 precordial leads
V123 V1, V2, V3
V3R precordial lead
V456 V4, V5, V6
V4R precordial lead
V ac volts, alternating current
V dc voltage, direct current
VA volt-amperes
Var variable
VDE Verband Deutscher Elektrotechniker 

(German regulatory agency)
Vent. ventricular
VF ventricular fibrillation
VGA video graphics array
VIA versatile interface adapter
VIO violet
Volt voltage
VRAM video RAM
vs versus

W

w/ with
W watt
Warfar Warfarin
WHT white
WI Wisconsin

X

x by (as in “8-1/2 x 11”)
XCV transceiver
XYZ orthogonal leads

Y

Y year, yellow
yr year
yrs years
YY year

Symbols

↑ SHIFTed or alternate function
µ micro
µF microfarad
µs, µsec microsecond
68K 68000
& and
# number
°C degrees Celsius
°F degrees Fahrenheit
Ω Ohm, ohm
% percent
 registered
> greater than
< less than
* An asterisk after a signal name indicates 

the signal is active at its relatively lower 
potential, or “active-low.” Signals 
without the asterisk suffix are active at 
their relatively higher potential, or 
“active-high.”

12SL 12 simultaneous leads
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Appendix B: Technical Description: Intel File Server
Intel File Server

Table B-1. Intel File Server – Intel N440BX

System Unit

GE Marquette PN: 2001640-002

Intel PN: S0NSCL0X0KSD

Features: N440BX (Nightshade) computer with NC440LX Motherboard, Columbus II Chassis, 
floppy, No CPU, No CDROM.

Processor 500-MHz Pentium® III processor with 100-MHz system bus; 512 KB integrated L2 
cache. 

Columbus II Chassis

Product regulations label (attached to 
chassis) including the following 
markings: 
UL and cUL Listing Marks 

CE Mark 
NEMKO Mark 
FCC, Class B Markings (Declaration of Conformity) 
ICES-003 (Canada Compliance Marking)

Dimensions
Height
Width
Depth

19.3" (49.02 cm)
8.3" (21.08 cm)
17.7" (44.96 cm)

Weight 41 lbs (19 kg), shipping weight 

Color Beige (Intel Color Standard 513505)

Drive Bays – Internal Six @ 3.5"; height 1.0" or three @ 3.5"; height 1.6"

Peripheral Bays – External
(not certified for hard drive use)

Three @ 5.25"; 1/2 height (1.6")
One @ 3.5"; 1/3 height (1.0")

Security Chassis-intrusion switch for alert over network (enabled by server management 
software which ships with Intel's server boards) Lockable side cover and hot-swap 
drive bay

Electrical Power Supply

AC Voltage and Frequency 115v/60 Hz; 230v/50 Hz

DC Power Supply 300W PFC 

+5V 26A maximum continuous

+5V standby .8A maximum continuous

+12V 10A maximum continuous

+3.3V 16A maximum continuous

-5V .25A maximum continuous

-12V 0.5A maximum continuous

Remote Voltage Sense Senses voltage levels on server board for more precise power supply voltage 
regulation, leading to more efficient use of power
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Appendix B: Technical Description: Intel File Server
System Cooling Three fans total Three 120mm fans. One 80mm fan (in power supply) 
All fans provide RPM data to server board for fan failure prediction and detection

Front Panel Power/Reset
Power button (momentary), system reset button LEDs
Power, hard drive activity

Serviceability
The following are the suggested times 
needed for a trained field service 
technician to perform maintenance 
procedures, after diagnosis of the 
system condition: 

Remove cover 1 min.
Remove and replace disk drive 5 min.
Remove and replace power supply 5 min.
Remove and replace fan 5 min.
Remove and replace expansion board 5 min.
Remove and replace front panel board 5 min.
Remove and replace baseboard (with no expansion boards) 10 min.

Environment

Ambient Temperature
Operating Temp.
Nonoperating/storage Temp.

+10° C to +35° C
-40° C to +70° C ambient

Relative Humidity
Non-operating 95% @ 30° C noncondensing

Acoustics less than 45 dB at typical office temperature
(65-70° F)

Electrostatic discharge 20KV per Intel Environmental test specification

Safety Regulations

The chassis when integrated with an Intel N440BX server board and configured as outlined in the Columbus II Chassis 
Subassembly Installation Guide, complies with the following Safety and EMC Regulations: 

U.S. & Canada UL 1950 - CSA 950-95, 3rd Edition (UL and cUL)

EN60 950 2nd Edition (with 
Amendments 1 to 3) (CE Mark 
Complies with EC Directive 73/23/
EEC) 

EN60 950 2nd Edition (with Amendments 1 to 3) (CE Mark Complies with EC 
Directive 73/23/EEC) 

International International IEC 950 2nd Edition (with Amendments 1to 4):
CB Certificate and Report 

Norway, Sweden, Denmark, Finland EMKO-TSE (74-SEC) 207/94; NEMKO Licensed 

Australia, New Zealand AS/NZS 3260 (based on IEC 950 CB Certificate and Report) 

Electromagnetic Compatibility

US FCC CFR 47 Part 15, Class B

Canada ICES-003, Class B

Europe, CE Mark EN55022, Class B & EN50082-1 (CE Mark-Complies with EC Directive 89/336/EEC) \
International CISPR 22, Class B 2nd Edition

International CISPR 22, Class B 2nd Edition 

Japan VCCI, Class B (ITE) (based on CISPR 22 Requirements) 

Table B-1. Intel File Server – Intel N440BX (Continued)
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Appendix B: Technical Description: Intel File Server
Australia, New Zealand AS/NZS 3548 (based on CISPR 22)

Hard Disk Drive

GEMMS PN 2001640-005

Manufacturer Seagate

Mfg Part Model/Number Barracuda 18LP Family /ST318275LW

Description 18.21GB LVD 1

1-inch

Speed 7200 rpm

Seek time 6.9 ms avg

CD-ROM Drive

GEMMS PN 2001640-006

Manufacturer Sony

Mfg Part Number CDU701-F2

Description 40X IDE

Ribbon Cable

GEMMS PN 2001640-007

Manufacturer Adaptec

Mfg Part Number ACK-W2W-5IT

Description Cable Ribbon, SCSI, 68-pin w/termination, 5CONN, 3ft

1. LVD (Low Voltage Differential) devices are defined under the Ultra2 subset of the SCSI-3 standard. Industry wide, the terms 
Low Voltage Differential (LVD) and Ultra2 SCSI are used interchangeably.

Table B-1. Intel File Server – Intel N440BX (Continued)
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Appendix B: Technical Description: Compaq Server – ProLiant 3000R
Compaq Server – ProLiant 3000R

Table B-2. Compaq Server – ProLiant 3000R

System Unit

GE Marquette Part Number: 422402-001

Description: COMPAQ PROLIANT 3000R, 450MHZ PII, 512K, 128MB RAM, RACK MOUNTABLE

Dimensions (H x W x D) 20.5 x 12.7 x 24.5 in / 52.1 x 32.3 x 62.2 cm

Weight (Model 1, U.S.) 75 lbs / 34 kg

Input Requirements Low range High range

Rated Input Voltage 100 to 120 V 200 to 240 V

Rated Input Frequency 50 to 60 Hz 50 to 60 Hz

Rated Input Current 8 A 6 A

Power Supply Output Power Low range High range

Rated Steady-State Power 500 W 750 W

Maximum Peak Power 540 W 780 W

Temperature Range

Operating 50° to 95°F 10° to 35°C

Non-operating -20° to 140°F -30° to 60°C

Relative Humidity (noncondensing)

Operating 20% to 80% 20% to 80% 20% to 80% 20% to 80%

Nonoperating 5% to 90% 5% to 90%

Maximum Wet Bulb Temperature 101.7°F 38.7°C

Heat Dissipation 2594 BTU/h 3754 BTU/h

Power Supply

Input Specifications US Metric

Nominal Line Voltage 100 to 120 VAC 200 to 240 VAC

Range Input Line 90 to 132 VAC 180 to 270 VAC

Frequency Range 47 to 63 Hz 47 to 63 Hz

Power Factor 0.95 0.95

Input Current 8 A at 100 VAC 6 A at 200 VAC

Inrush Current <150 A at 132 VAC (cold start) <150 A at 132 VAC (cold start)

Holdup Time 20 ms from zero crossing at 20 ms from zero crossing at
120 VAC 120 VAC

General Specifications To 104°F and 5,000 ft To 40°C and 1,524 m
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Appendix B: Technical Description: Compaq Server – ProLiant 3000R
Full Output Rating To 90°and 10,000 ft To 32°C and 3,048 m
(derate linearly)

Minimum Load 1.0 A on + 5 V output 1.0 A on +5 V output
1.0 A on +12 V output 1.0 A on +12 V output
0.5 A on +3.3 V output 0.5 A on +3.3 V output

Ambient Temperature Range

Operating 50° to 104°F 10° to 40°C

Storage -40° to 149°F -40° to 65°C

Dielectric Voltage Withstand

Input to Output 3000 VAC/min 3000 VAC/mi

Input to Ground 1500 VAC/min 1500 VAC/mi

Common and Differential Mode 
(superimposed on AC line)

2500V, 1 µs, damped sinusoid 600 V, 10 µs pulse 20% step change in AC
input voltage

SDRAM Dual Inline Memory Modules

Size 16, 32, 64, 128, 256, or 512 MB single DIMM SDRAM

Speed 60 ns or faster

Upgrade Requirement Bank of one SDRAM DIMM installed or removed at a time

NOTE: Use only 16, 32, 64, 128, 256 or 512 MB; buffered; gold-connector; ECC; 4-K or 8-K refresh rate SDRAM DIMMs.

1.44-MB Diskette Drive

Size 3.5 in

LED Indicators (front panel) Green

Read/Write Capacity per Diskette (high/
low density)

1.44 MB/720 KB

One One

Drive Height One-third

Drive Rotation 300 rpm

Transfer Rate bits/sec (high/low) 500 K/250 K

Table B-2. Compaq Server – ProLiant 3000R (Continued)

CAUTION
Use only SDRAM DIMMs of the same size, 
speed, and manufacturer. SDRAM DIMMs 
from other sources may adversely affect 
data integrity. Power-On Self-Test (POST) 
will warn of non-supported SDRAM Dimms.

M15287-082A
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Appendix B: Technical Description: Compaq Server – ProLiant 3000R
Bytes/Sector 512

Sectors/Track (high/low) 18/9

Tracks/Side (high/low) 80/80

Access Times

Track-to-Track (high/low) 3 ms/6 ms

Average (high/low) 169/94 ms

Settling Time 15 ms

Latency Average 100 ms

Cylinders (high/low) 80/80

Read/Write Heads Two

IDE CD-ROM Drive

U.S. Metric

Dimensions

Height 1.7 in 42.9 mm

Weight 5.9 in 150.1 mm

Depth 8.1 in 208.0 mm

Weight 2.1 lb 950 g

Capacity

Mode 1, 12 cm 540 MB

Mode 2, 12 cm 630 MB

Sustained 150 KB/s

Access Times

Full Stroke <200 ms

Random <100 ms

Bus Rate 4.0 MB/s

Cache/Buffer 128 KB/s

Start-up Time

Single <7 s

Multisession <30 s

Stop Time <4 s

Table B-2. Compaq Server – ProLiant 3000R (Continued)
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Error Rates
Soft Error
Hard Error
Seek Error

10-9

10-12

10-6

Laser Parameters
Type
Wave Length
Divergence Angle
Output Power

Semiconductor laser GaAlAs
780 +/- 25 nm
53.5 +/- 1.5 degrees
0.14 mW

Audio Interface

Line Out Connector

RMS Output Voltage .07 VRMs

S/N Ratio 80 dB

Channel Separation 65 dB

THD and Noise .01% @ 1kHz

Frequency Response 20 to 20 kHz, (+1/-3 dB)

Digital Audio Out Connector 2 pin digital audio out connector described in the ARAPI Spec., 2.6, Section 11.1 
included. This serial digital audio out conforms to the IEC-958 EIAJ CP-1201 
format.

Integrated Dual-Channel Wide-Ultra SCSI Controller

Drives Supported Up to seven SCSI-2 and/or Wide-Ultra devices per channel

Data Transfer Method 32-Bit PCI bus master

SCSI Channel Transfer Rate 40 MB/s per channel

Maximum Transfer Rate per PCI Bus 133 MB/s

SCSI Termination Active Termination

SCSI Connectors Channel A: 1 internal Channel B: 1 internal, 1 external

9.1GB Hot-Plug Hard Drive

Rotational Speed 7,200

Logical Capacity 9100

Height 1.0 inch / 2.5 cm

Size 3.5 inches / 8.9 cm

Interface Wide-Ultra

Transfer Rate Synchronous (Max) 40 MB/s

Table B-2. Compaq Server – ProLiant 3000R (Continued)
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Seek Time:
Single Track
Average
Full Stroke

1.9 ms
7.5 ms
15.0 ms

Physical Configuration
Bytes/Sector
Logical Blocks (in millions)

512
17,7735

Operating Temperature 50º to 95º F / 10º to 35º

Rack-Mounted UPS

GE Marquette Part Numbers: 421572-015 (Low voltage model)
421572-020 (High voltage model)

Electrical Input:

Nominal Voltage:
Low Voltage Model High Voltage Model
120 V (default) 230 V (default)
100, 110, 120, 127 V (selectable) 208, 220, 230, 240 V (selectable)

Voltage Range: -30% to +20% at full load for nominal voltages
-35% to +20% for short-term brown-outs

Nominal Frequency:
Low Voltage Model High Voltage Model
60 Hz 50/60 Hz
50/60 Hz if 100 V or 110 V
selected

Connections:
Low Voltage Model High Voltage Model
6-foot line cord with NEMA 16 A (10 A, 1500 VA)
L5-30 plug (Detachable 5-15 IEC-320, plug male inlet
1500 VA)

Electrical Output:

Power Levels: (rated at nominal inputs)
Low Voltage Model High Voltage Model
R3000: 2880 VA, 2250 W R3000h: 2880 VA, 2250 W

Regulation On-Line: +6% to -10%; within Computer Business Equipment Manufacturers Association 
Guidelines: (+10% to -15% using extended range)

Regulation On-Battery (Nominal 
Voltage +5%)

Low Voltage Model High Voltage Model
115 V for 110, 120 & 127 V 230 V for 220, 230, & 240 V
102 V for 110 V 204 V for 208 V

Voltage Wave Shape: Sine Wave

Overcurrent Protection: On-line: Resettable Circuit Breaker
On-Battery: Active current limit and short circuit protection.

Noise Filtering: MOVs and line filter for normal and common mode noise.

Connections:
Low Voltage Model High Voltage Model
NEMA receptacles Six or nine IEC-320 outlets

Battery:

Table B-2. Compaq Server – ProLiant 3000R (Continued)
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Voltage: 24 VDC for 1500 VA, 48 VDC for 3000 VA

Type: Sealed, maintenance-free, lead-acid

Charging: Advanced charging for faster recovery; 3 to 8 hours

Backup Time: 5 minutes at full load with a new battery.

Indicators and Controls:

Serial Communication: Intelligent serial communication to provide alarms with history, measured, 
parameters, self-test, and many other features; contact your authorized dealer for 
Compaq Management software.

Interface: Ergonomic indicators including Wiring Fault, Battery Service, Communication, 
Operation, System Normal, bar graphs for Input Level, Battery Charge Level,
% Load.

Contact Closures: Input Failure, Low Battery

Physical Properties:

Surge Suppression: Manufactured sith surge suppressors that meet UL 1449

Operating Temperatures: 0°C to 40° (32°F to 104°F) UL tested 25°C (77°F)

Relative Humidity: 0% to 95% non-condensing

Operating Altitude: Up to 10,000 feet above sea level

Audible Noise Less than 45 dBA

Dimensions: R3000: 19 x 5.25 x 22.3 in. (48.2 x 13.3 x 56.6 cm)

Weight:
Low Voltage Model High Voltage Model
R3000: 132 lbs. (60 kg) R3000h: 132 lbs. (60 kg)

Table B-2. Compaq Server – ProLiant 3000R (Continued)
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21-inch Color Monitor

Table B-3. 21-inch Color Monitor

GE Marquette Part Number: 411937-004

CRT: 20" 40% Flatter Trinitron CRT with Short Neck CRT Design
90 deflection

Viewable Image Size: 19.8" measured diagonally

Aperture Grille Pitch: 0.25-0.27mm (variable)

Horizontal Scan Range: 30-107 kHz

Vertical Scan Range: 46-160 Hz

Maximum Resolution: 1600 x 1200 @ 85Hz

Color Temperature Presets: 5000 Kelvin
6500 Kelvin
9300 Kelvin
3 User-adjustable settings (Bias/Gain Controls)

Signal Inputs: Analog RGB: 0.7Vp-p, 75 ohm termination 
External Sync Signals: Composite 1-5 Vp-p, polarity-free TTL 
Sync on Green: 0.3Vp-p, negative

Power Requirements: 100-240V AC; 50/60Hz

Power Management: International Energy Star, NUTEK, and VESA
DPMS compliant 
Operation: 160 watts (maximum) 
Suspend: 15 watts (maximum) 
Active off: 5 watts (maximum) 
Power off: 0 watt

Dimensions (W x H x D): 19.6" x 19.9" x 18.7"

Weight: 68.3 lbs

Operating Temperature: 50°F-104°F (10°C-40°C)

Operating Humidity: 10%-80%, non-condensing

Regulation Compliance: Safety: UL 1950, CSA 950, EN60950 (TUV, GS mark/
CEmark), SEMKO, NEMKO, EI, DEMKO

Emission/EMI: FCC Class B, IC Class B, MPR II (TUV) (full 
compliance), CISPR22B, TCO '95

X-ray: DHHS, DNHW, PTB
Ergonomic: ZH1/618, ISO9241-3.8

Designed for: Microsoft Windows NT and Windows 95 Macintosh 
Compatible

Plug and Play: DDC-1, DDC-2AB

Inputs: 15-pin mini D-sub
5 BNC connector
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17-inch Color Monitor

Table B-4. 17-inch Color Monitor

GE Marquette Part Number: 408057-008

CRT size: 17" Trinitron®

Viewable Image Size: 16" 

Aperture Grille Pitch: 0.25 mm

Screen Treatment: Anti-Reflective Coating

Horizontal Scan Range: 30-85 kHz

Vertical Scan Range: 48-120 Hz

Maximum Resolution; 1280 x 1024 @ 75Hz

Color Temperature Presets: 5000 Kelvin
9300 Kelvin
User-Adjustable

Signal Inputs: Analog RGB
0.7Vp-p, 75ohm Termination

External Sync Signals: Separate/Composite TTL, polarity-free TTL
Sync on Green: 0.3Vp-p, negative

Input Connectors: 15 pin mini D-sub

Power Requirements: 100-120/220-240V AC; 50-60Hz

Power Management: International Energy Star, NUTEK, and VESA
DPMS Compliant
Operation: 120 watts (maximum)
Suspend: 8 watts (maximum)
Active Off: 8 watts (maximum)
Power Off: <1 watt

Dimensions (W x H x D): 16.0" x 17.0" x 16.5"

Weight: 39.7 lbs.

Operating Temperature: 50°F-95°F (10°C-35°C)

Operating Humidity: 10-80% (non-condensing)

Regulation Compliance: Safety:  UL 1950, CSA 22.2 No. 950, EN60950 (TUV, GS 
mark), NEMKO, SEMKO, DEMKO

Emission/EMI: FCC Class B, IC Class B, EN55022, MPR II (TUV) 
(full compliance), TCO 95

X-ray: DHHS, DNHW
Ergonomic: ZH-1/618, ISO9241-3, ISO9241-8

Designed for: Microsoft Windows® 98, Windows 95, Macintosh 
Compatible 

Plug and Play: DDC-1, DDC2B/A, DDC2Bi, DDC/CI, DMI Compliant 
VESA: Generalized Timing Formula
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15-inch Color Monitor

Table B-5. 15-inch Color Monitor

GE Marquette Part Number: 420609-001

CRT: 15” Trinitron w/short neck design
90° Deflection

Viewable Image Size: 14.0” Measured Diagonally

Aperture Grille Pitch: 0.25mm

Horizontal Scan Range: 30-70KHz

Vertical Scan Range: 50-120 Hz

Maximum Resolution: 1024 X 768 @ 85Hz
1280 X 1024 @ 60Hz

Signal Inputs: Analog RGB: 0.7Vp-p, 75 ohm termination
External Sync Signals: Composite 1-5 Vp-p, polarity-free TTL

Sync on Green: 0.3Vp-p, Negative

Power Requirements: 100-120/220-240V AC, 50/60Hz

Dimensions (W x H x D:) 14.5" X 15.4" X 15.1"

Weight: 30.9 lbs

Operating Temperature: 50° -104°F

Operating Humidity: 10-80%, Non-Condensing

Regulatory Compliance: Safety:  UL 1950, CSA 950, EN60950 (CEMARK)
Emission/EMI: FCC CLASS B, MPR II, CISPR22B

X-ray: DHHS
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Client

Table B-6. Client

GE Marquette Part Number: 410783-201

Description: NX440LX 266 MHZ PENTIUM II MOTHERBOARD WITH 32MB, VIDEO, ETHERNET, 
SOUND. NLX DESKTOP CHASSIS WITH FLOPPY DRIVE, [1] EXTERNAL 5.25", [1] 
EXTERNAL 3.5", [1] INTERNAL 3.5", POWER SUPPLY

Processor Intel Pentium II processor

Processor Clock Speed 266MHz

Standard RAM 64MB

Hard Disk Drive 4.3G ULTRA ATA EIDE 3.5" (See Table B-7 "Client Hard Drive")

Diskette Disk Drive 1.44MB 3.5”

CD-ROM Drive Internal Toshiba XM-6502B CD-ROM (See Table B-8, "Client CD-ROM Drive")

Keyboard Intel enhanced 101 with numeric keypad

Mouse 2-button control

Bar code reader Keyboard connected

Height (with feet installed) 11.81 cm (4.7" )

Width 43.75 cm (17.2" )

Depth 44.45 cm (17.5" ) with chassis lock and cover thumbscrew
43.18 cm (17.0" ) excluding lock and thumbscrew

Weight (without peripherals) 8.2 kg (18 pounds)
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Client Hard Drive 

Table B-7. Client Hard Drive

GE Marquette Part Number: 2000714-001

Description: 4.3G ULTRA ATA EIDE 3.5"

Manufacturer, Model Quantum, QM304300CR-A

Specifications

Form Factor 3.5” (low profile)

Interface ATA/4, Ultra ATA/66

Formatted Capacity (MB)1 4,310

Disk Drive Configuration

Recording Surfaces 2

ATA Logical :
Cylinders 
Heads
Sectors

14,848
9
63

Performance Specifications

Typical Seek Times 2(ms)
Average 
Track-to-Track 
Full Stroke 

9.5
2.0
18.0

Average Rotational Latency (ms) 5.56

Rotational Speed (RPM) 5,400

Internal Data Rate (Mb/sec) Up to 194

Data Transfer Rates (Buffer-to-Host) 
(MB/sec)

Ultra DMA/66 
Ultra DMA/33 
PIO Mode 4 

66.6
33.3
16.6

Buffer Size (KB) 512

Typical Power on to Drive Ready (sec) 9.5

Reliability Specifications

Start/Stop Cycles (ambient) 50,000

Nonrecoverable Data Errors (per bits 
read) 

<10 per 1015

Warranty3 (years) 3
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Physical Specifications

Dimensions-inches (mm)
Width 
Length 
Height 

4.00 (101.6)
5.75 (146.1)
1.00 (25.4)

Weight-pounds (kg) 1.26 (0.5)

Environmental Limits

Operating
Temperature 
Non-Condensing Humidity (%) 

(°C) 5 to 55
5 to 85

Non-Operating
Temperature (°C) 
Non-Condensing Humidity (%) 

-40 to 65
5 to 95

Sound Power (bels, typ)
Idle 
Seek 

3.4
3.9

Power Specifications

Nominal Voltage (V) +5/+12

Voltage Margin (%) ±5/±10

Typical Power Draw (W)
Idle 
Operating4

6.2
8.8

Peak Current (mA on +5/+12 V) 700/1,830

1. Quantum defines a megabyte (MB) as 106 or 1,000,000 bytes.
2. Seek times are at nominal conditions and include settling.
3. This warranty is standard when products are purchased directly through authorized Quantum distributors/dealers.

Unless otherwise agreed, a one-year warranty is provided to all OEM purchasing directly from Quantum. End-user
warranties provided by computer manufacturers may vary. 

4. Operating is 40% seek, 30% read, 20% active, and 10% write.

Table B-7. Client Hard Drive (Continued)
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Client CD-ROM Drive

Table B-8. Client CD-ROM Drive

General

GE Marquette PN: 410784-105

Description Disk Drive CDROM 40X EIDE

Manufacturer, Model Toshiba, XM-6502B

Interface: ATAPI

Compatible CD-ROM Standards: Red-Book Photo CD CD-EXTRA
Yellow-Book Video CD CD-RW (Read)
CD-ROM XA CD-I CD-R (Read
CD-I Bridge CD-G

Performance

User data capacity: 650MB

Data Transfer rate - 17.3X - 40X 1,297 - 3,000 KBytes/s

Rotational Speed - 17.3X - 40X CAV 8,500 rpm

IDE Interface Burst Transfer Rates 16.7 MBytes/s
8.33 Single-word DMA
16.7 Multi-word DMA
33.3 Ultra DMA

Access Time 80ms

Memory Buffer 128Kbytes

Reliability

MTBF 100,000 hours

Hard Error Rate: mode 1
(with up to 5 retries and layered ECC on)

10-15 max

Soft Error Rate: mode 2  
(with up to 5 retries) 

10-12 max

Seek Error Rate 10-6 max

Audio

Number of Channels 2

Frequency Response 20Hz to 20,000 Hz

Signal-to-noise Ratio 83dB Typ.

Total Harmonic Distortion 0.014% Typ.

Line Output .75V RMS

Environmental

Ambient Temperature
Operating 
Storage 

5° to 50° C (41° to 122° F)
-20° to 60° C (-4° to 140° F)
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Relative Humidity
Operating
Storage 

8% to 80%
5% to 95%

Acoustical Noise <45dB

Power

DC Voltage and Current 
Requirements 

5V ±5%, 12V ±5%

Physical

Height 5.75" (146mm)

Width 1.6" (41.5mm)

Depth 7.6" (193mm)

Weight 1.67 lbs (0.76kg)

Connectors

DC input AMP 1-480424-0

IDE Interface Connector 40 Pin ATAPI Standard

Analog Audio Line Output Connector 4 Pin ATAPI Standard

Regulatory

Certified by the following regulatory 
agencies:

UL
CSA
TUV
FCC Class B
CE
CB
DHHS

Table B-8. Client CD-ROM Drive (Continued)
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HP Laser Printer

Table B-9. HP LaserJet 4050N Printer

GEMMS PN 2001162-005

Manufacturer/Model Hewlett Packard / C4253A 

Description HP LASERJET 4050N Printer, 16 MB RAM, Ethernet (BNC, 10BASET). Parallel and 
RS-232 9PIN serial interfaces, PostScript Level 2, HP PCL 6, 120V
Included: Toner cartridge, 500-sheet paper tray, power cord, drivers, and 
documentation.

Speed 17 pages per minute (ppm)
133 MHz RISC microprocessor
First page out = 15 seconds
"RIP ONCE" capability with 16 MB or hard disk option.

Resolution 300 dpi with PCL5e/HP’s PostScript
Level 2 emulation (PS) 
600 dpi with PCL5e/PS 
HP FastRes 1200 (PCL6, PS) 
HP ProRes 1200 at engine speed (17 ppm) (PCL6, PS) 

Typefaces 100 Scalable TrueType (80 built-in, 30 via HP FontSmart) Euro symbol 

Memory Options 8 MB RAM standard (4050/4050 T) 16 MB RAM standard (4050 N/ 4050 TN) 

Optional Memory 4, 8, 16, MB EDO DIMMs
4, 8, 16, 32, 64 MB SDRAM DIMM

Mass Storage Options 2 and 4 MB Flash DIMMs 
Greater than 1GB hard disk

Expansion Slots 3 100-pin DIMM slots 
2 enhanced I/O (EIO) slots

Interface Bidirectional IEEE 1284-compliant parallel CJ3113A - 10/100Base-TX (bundled with 
4050 N/4050 TN) HP Fast InfraRed Receiver (FIR) RS232 9-pin serial Paper 
Handling Connector (PHC) 

Optional Networking 10Base-T and 10Base-2
10/100Base-TX
Token Ring
LocalTalk 

 Paper Trays 100-sheet Tray 1 
Size: 76 x 127 mm to 2
16 x 356 mm
(3 x 5 inches to legal) 

500-sheet Tray 2
Size: letter, legal, A4 

Paper Path Straight through from Tray 1 to Rear
Output Bin or to Top Output Bin

Output Capacity 250-sheet Top Output Bin 
50-sheet Rear Output Bin

 Paper Handling Options Duplexer, Envelope Feeder, Optional
500-sheet Universal Tray Assembly
Revision FB-20 MUSE CV information system
419931-012



Appendix B: Technical Description: HP Laser Printer
Physical Specifications

Height 34.3 cm (13.3 inches)
38.5 mm (15.5 inches)

Width 39 cm (15.4 inches)
39 cm (15.4 inches)

Depth 61.64 cm (24.27 inches)
61.64 cm (24.27 inches)

Depth (trays/rear output bin open) 100.76 cm (39.67 inches)
100.76 cm (39.67 inches)

Weight (without toner cartridge) 17.85 kg (39.27 lbs.)
20.71 kg (45.66 lbs.)

Electrical specifications

Printer State
Printing
Standby 
PowerSave (default activation
time, 30 minutes) 
Off

Power Consumption (average, in watts) 
330 watts
22 watts
20 watts

Minimum recommended circuit capacity

Voltage
100-127 Volts 
220-240 Volts 

Amps 
8 amps 
4 amps 

Power requirements (acceptable line 
voltage) 

Voltage Hz
100-127 Volts 50-60 Hz 
220-240 Volts 50-60 Hz 

Environmental specifications

Condition
Operating Temperature

Relative Humidity

Specification
10 to 32 degrees C (50 to 90 degrees F)

20% to 80% 

Acoustic emissions (per ISO 9296)

Condition
 
Printing, 17 ppm 
Printing, 8 ppm 
PowerSave

Specification

Lwad = 6.6 bels (A) 
Lwad = 6.2 bels (A) 
 Lwad = 0 bels (A) 

Safety certifications

Safety IEC 950:1991+A1+A2+A3 / EN
60950:1992+A1+A2+A3+A4+A11 
IEC 825-1:1993 / EN 60825-1:1994 Class 1 (Laser/LED)

Table B-9. HP LaserJet 4050N Printer (Continued)
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EMC

IEC 1000-3-2:1995 / EN61000-3-2:1995 
IEC 1000-3-3:1994 / EN61000-3.3:1995 
FCC Title 47 CFR, Part 15 Class B (2)) /
ICES-003, Issue 2 / VCCI-2 (1)) 
AS / NZS 3548:1992 / CISPR 22:1993 Class
B (1))

Supplementary Information: The product herewith complies with the requirements of the following Directives 
and carries the CE-marking accordingly: 

the EMC directive 89/336/EEC 

the Low-Voltage Directive 73/23/EEC 

[1] The product was tested in a typical configuration with Hewlett-Packard 
Personal Computer Systems. 

[2] This Device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: This device may not cause harmful interference, and 
this device must accept any interference received, including interference that 
may cause undesired operation.

Table B-9. HP LaserJet 4050N Printer (Continued)

CISPR 22:1993+A1 / EN
55022:1994 Class B (1) 
EN 50082-1:1992 
IEC 801-2:1991 / prEN
55024-2:1992 - 
IEC 801-3:1984 / prEN
55024-3:1991 - 
IEC 801-4:1988 / prEN
55024-4:1992 -

4 kV CD, 8 kV
AD 
4 V/m 
0.5 kV Signal 
Lines 
1.0 kV Power
Lines
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Zip Drive Parallel Port

Table B-10. Zip Drive Parallel Port

Performance

GE Marquette Part Number: 422185-001

Average seek time: 29 milliseconds

Sustained transfer rate: 
Maximum:
Minimum:

1.40MB/sec.
0.79MB/sec.

Typical throughput: up to 20MB/minute

Rotational speed: 2941 RPM

Average start/stop time: 3 seconds 

Long format time (surface verify): 10 minutes (avg.)

Short format time: 10 seconds (avg.)

Buffer size: 32K 

Reliability and Service

MTBF: 100,000 hours 

Service life: 5 years 

Bit error rate: 1 in 1012 

Disk drop height/shock tolerance: 8ft/1000G

Disk (estimated) shelf life: 10 years 

Warranty-drive/media: 1 year/limited lifetime 

General

Disk storage capacity: Uses 100MB Zip disks 

Operating system compatibility: DOS; Windows 3.1x, 95, NT; Mac OS; OS/2

Interface: parallel port

Connection type: Two 25 pin female (allows for printer pass-through)

Power requirements: 5V, 1A continuous, 1.7 A peak

Acoustical noise (operating): Less than 32 dBA

SCSI termination: On board, switchable

Dimensions (LxWxH):
Metric 35mm x 133mm x 182mm

Weight:
Metric 454.0 grams

Read/write protection: Via software (optional password protection)

Operating Conditions
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Temperature:
Operating:
Storage:
Shipping: 

10° to 32°C 
-22° to 52°C 
-40° to 60°C 

Relative humidity (non-condensing):
Operating:

Non-operational: 

10% to 80%

10% to 90%

Vibration:
Operational:

Non-operational:

0-7g @ 5-17Hz., 0-25g @ 17-500 Hz.

5g @ 60-500Hz., 2g @ 27-60 Hz., 1.3g @ 5-27 Hz.

Shock @ 11ms duration 1/2 sine 
wave:

Operational:

Non-operational:

7g

100g

Altitude (operating): 10,000 feet maximum

Table B-10. Zip Drive Parallel Port (Continued)
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Appendix B: Technical Description: MUSE Network Writer
MUSE Network Writer

Table B-11. MUSE Network Writer

GE Marquette Part Numbers: 405864-011 
405864-012 (220-240V)
405864-013 (240V)

Type Thermal dot array (horizontal 1000 dots/inch at 25mm/sec; vertical 200 dots/inch)

Channels Up to 12

Frequency response 0.01 to 100 Hz, 0.091 to 40 Hz, 0.01 to 20 Hz, user selectable

Sensitivity 5, 10, and 20 mm/mV

Paper speeds 5, 12.5, 25, and 50mm/sec, user selectable

Paper type Thermal, perforated, 21.59 cm x 27.94 cm (8-1/2 x 11 inch), Z-fold, 300 sheets/
pack (European A4 style paper available.)
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Appendix B: Technical Description: Safety
Safety

Table B-12. Safety

Item Description

Certification UL listed, CSA certified, CE according to 93/42/EEC Medical Device Directive

Type of Protection Against Electrical 
Shock

Class I Equipment

Degree of Protection Against Ingress 
of Liquids

Ordinary

Handling of Disposable Supplies and 
Other Consumables

■ Use only parts and accessories manufactured or recommended by GE Marquette.
■ Follow manufacturer’s instructions for use for disposable/consumable product.
■ Follow local environmental guidelines concerning the disposal of hazardous 

materials (e.g. lead acid batteries).

Mode of Operation Continuous

Patient Leakage Current Not applicable - no patient connections

Degree of Protection Against Electrical 
Shock

Not applicable - no patient connections

Maintenance Frequency ■ Recommended user daily visual inspection and cleaning.
■ Recommended six-month routine maintenance checks and test procedures 

performed by qualified technical personnel.

Repair Guidelines Calibration instructions, equipment descriptions, and all other service information to 
repair those parts of the equipment designated as field repairable by qualified 
technical personnel is available in the service manual.
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